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If you want to… See… 

set up Event Center for Windows Sett ing up Event Center for Windows 

make sure your system can handle Universal 
Communications Format (UCF) media f iles 

Checking your system for UCF Compatibility  

get prepared for an event Preparing for an event (on page 3)  

 

Setting up Event Center 
To participate in an event, you must set up Event Center on your computer. 
Once you schedule, start, or join an event for the first time, your event service 
Web site starts the setup process. However, to save time, you can set up the 
application at any time before scheduling, starting, or joining an event. 
  

If you want to… See… 

get an overview  of system requirements  System requirements for Event Center for 
Window s 

set up Event Center for Windows Sett ing up Event Center for Windows 

check your system for UCF compatibility  Checking your system for UCF Compatibility  
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System requirements for Event Center for Windows 
You can find the system requirements and other information about compatible 
browsers and operating systems on the User Guides page for your service: 

1 Log in to your WebEx Event Center site. 

2 On the WebEx Event Center navigation bar, click Support > User 
Guides. 

3 On the right side of the page, under Release Notes and FAQs, click the 
link for release notes. 

 

Setting up Event Center for Windows 
Before installing Event Center, ensure that your computer meets the minimum 
system requirements. For details, see System requirements for Event Center 
for Windows (on page 2). 

If you are not using the Windows operating system, please refer to our FAQ, 
which includes information about setting up Event Center on other operating 
systems. 

To go to the list of FAQs: 

1 On your Event Center Web site, on the left navigation bar, click Support > 
User Guides. 

2 On the User Guides page, under Release Notes and FAQs, click the link 
for FAQs (Frequently Asked Questions). 

A list of questions displays, arranged by topic. Look for your information 
about your operating system under Minimum System Requirements. 

To set up Event Center for Windows: 

1 On the navigation bar, expand Set Up, and then click Event Manager. 

The Set Up page appears. 

2 Click Set Up. 

3 If a security dialog box appears, click Yes. 

Setup continues. A progress message box appears, indicating the 
progress of setup. 

4 On the Setup Complete page, click OK. 
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You can now start, schedule, or join an event.  
  

Note:  
 Alternatively, you can download the Event Manager for Windows Installer from the 

Support page on your Event Center Web site, and then install Event Manager on 
your Web browser. This option is useful if your system does not allow you to install 
Event Manager directly from the Set Up page. 

 If you or another attendee plans to share Universal Communications Format (UCF) 
media files during an event, you can verify that the required components are 
installed on your system to play the media files. For details, see Checking your 
system for UCF Compatibility (on page 3). 

 

Preparing for an event 
To take advantage of the many features available in an event, check your 
system and then install some tools to extend event capabilities. 

 Check your system for UCF compatibility (if you have presentations with 
animations, save them as .ucf so event attendees can view these effects) 
More… (on page 3) 

 Set up and install Cisco WebEx Connect More… (on page 4) 

 Share a remote computer, if this feature is available More… (on page 4) 
 

Checking your system for UCF Compatibility 
If you intend to play or view Universal Communications Format (UCF) media 
files during the event, either as a presenter or an attendee, you can verify that 
the following components are installed on your computer: 

 Flash Player, for playing a Flash movie or interactive Flash files 

 Windows Media Player for playing audio or video files 

Checking your system is useful if you or another presenter plans to share a 
UCF multimedia presentation or standalone UCF media files. 

To check your system for UCF compatibility: 

1 On the navigation bar, do one of the following: 

 If you are a new event service user, click New User?. 
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 If you are already an event service user, expand Set Up, then click 
Event Manager. 

2 Click Verify your rich media players. 

3 Click the links to verify that the required players are installed on your 
computer. 

  

Note: The option to check your system for required rich media players is available only if 
your Event Center Web site includes the UCF option. 

 

About WebEx Connect 
Use WebEx Connect, the instant messenger for business users to send 
secure instant messages, invite or remind participants, and manage an event. 
Connect integrates with Microsoft Outlook corporate directories and 
calendars, encrypts messages and scans them for viruses, and offers quick 
access to business conferencing services from WebEx. 

To download WebEx Connect: 

1 Log in to your Event Center Web site. 

2 On the Event Center navigation bar, click Support > Downloads. 

3 Scroll down to the section of the page describing WebEx Connect. 

4 Click the link to learn more about this product and download it. 
 

About sharing a remote computer 
Use remote computer sharing to show all event participants a remote 
computer. Depending on how you set up the remote computer, you can show 
the entire desktop or just specific applications. Use remote computer sharing 
to show attendees an application or file that is available only on a remote 
computer. 

Attendees can view your remote computer, including all your mouse 
movements, in a sharing window on their screens. 

You can share a remote computer during an event for which you are the 
presenter, if: 

 You have installed the Access Anywhere Agent on the remote computer 
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 You logged in to your Event Center Web site before joining the event, if 
you are not the original event host 

For information about setting up a computer so you can access it remotely, 
refer to the Access Anywhere User's Guide. 
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C h a pt er  2 

Planning is essential to delivering a successful online event. By taking the 
time to specify the details of an event, you can make your event as effective 
and engaging as possible for your attendees. 

The Schedule an Event page on your Event Center Web site offers a variety 
of features that let you specify details for an online event according to your 
needs. 

To access the Schedule an Event page: 

1 Log in to your Event Center Web site. 

2 On the left navigation bar, click Host an Event > Schedule an Event. 
 

Getting started 
These tasks can help you get started in planning your event: 

 Define your roles. For details, see Defining your roles (on page 8). 

 Determine whether to host a listed or an unlisted event. For details, see 
Specifying whether the event is listed or unlisted (on page 10). 

 Determine registration options for attendees. For details, see Specifying 
registration options for attendees (on page 10). 

 Create invitation lists for attendees and panelists. For details, see Inviting 
participants to your event (on page 22). 

 Use the automated email management system to send out invitations, 
reminder, and other follow-up communications. For details, see Sending 
email messages to participants (on page 31). 

Planning an Event 
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 Set up audio options for the event. For details, see Selecting audio 
conference options (on page 42). 

 Play a presentation while attendees wait for you to join the event. For 
details, see Sharing a presentation or document automatically (on page 
50). 

 

Adding security for your event 
When you are scheduling or running an event, you can provide security for 
the event by doing any of the following: 

 Require a password—If you specify a password, attendees must provide 
this password to join the event. 

 Make the event "unlisted"—When scheduling an event, you can specify 
the event as unlisted. An unlisted event is not displayed on the List of 
Events page on your Event Center Web site. Attendees obtain complete 
information about the event from your invitation email message. 

 Require attendees to provide their registration IDs—For either a listed 
or an unlisted event, you can request registration and require attendees to 
provide their registration IDs before joining the event. If you specify this 
option, each attendee receives a unique registration ID after you approve 
his or her registration request. For more information, see Requiring a 
registration ID for joining an event (on page 11). 

 Restrict access to the event—Once all attendees have joined an event, 
you can prevent additional attendees from joining it by restricting access to 
the event. For details, see Restricting access to an event (on page 189). 

  
 

Tip: Choose a level of security based on the event's purpose. For example, if you 
schedule an event to discuss your company picnic, you probably need to specify only a 
password for the event. However, if you schedule an event in which you will discuss 
sensitive financial data, you may want to make the event unlisted. 

 

Defining your roles 
Your event production team can be broken down into the following roles: 
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Role Description 

host the part icipant w ho schedules, starts, manages, and ends the event 
and des ignates the presenter, panelists, and polling coordinator 

The event host initially is the presenter. After the invited panelists join 
the event, the host can pass the presenter control to any of the 
panelists at any time during the event. 

presenter  the part icipant, w ith the presenter control symbol , w ho is 
responsible for sharing and presenting information during the event.  

panelist a participant w ho is primarily respons ible for assisting the presenter 
and participating in presentation. For more information, see About 
panelist roles and privileges (on page 187). 

polling coordinator  the part icipant, w ith the symbol, w ho is responsible for prepar ing a 
poll questionnaire and conducting a poll dur ing the event.  

attendee a participant w ho mainly listens or w atches and does not present 
information dur ing the event 

The following figure shows an example of the different roles in an event. 
  
 

 

 
 

Tips for assigning responsibilities 
Create a document or storyboard that defines how you plan to produce the 
event. 
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Example. The document or storyboard can include the information for host, 
presenter, and panelist assignments, such as who will start and end the 
presentation, present slides, demonstrate software, handle the Q & A session, 
act as the poll coordinator, reply to chat messages, and so on. 

 

Specifying whether the event is listed or unlisted 
When scheduling an event, you can specify how the event is displayed on 
your Event Center Web site: 

 Listed—The event appears on the List of Events page for anyone who 
visits your Event Center Web site. A listed event may or may not require 
registration. 

 Unlisted—The event does not appear on the List of Events page on your 
Event Center Web site. Attendees receive an invitation email message 
that includes complete instructions about joining the event. An unlisted 
event may or may not require registration. 

To make an event listed or unlisted: 

On the Schedule an Event page, under Basic Information, select one of the 
following: 

 Listed 

 Unlisted 
 

Specifying registration options for attendees 
When scheduling an event, you can: 

 Request attendees to register More… (on page 11) 

 Require a registration ID for joining the event More… (on page 11) 

 Requiring a registration password More… (on page 12) 

 Setting approval rules for event registrants More… (on page 12) 

 Customize the registration form More… (on page 13) 

 Specify a destination Web page after registration More… (on page 22) 
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Requesting attendees to register 
Whether your event is listed or unlisted, you can request attendees to register 
for your event. 

Attendees receive an invitation email message that includes information about 
the event, including the registration password, if you specify one, and a link 
that they can click to register for the event. 

To request registration for an event: 

On the Schedule an Event page, select Required at Registration. 
  

 

 
 

Requiring a registration ID for joining an event 
You can add security to your event by requiring that attendees provide their 
registration IDs to join the event. 

Attendees receive an invitation email message that includes a link that they 
can click to register for the event. Once you approve an attendee’s 
registration request, the attendee receives a unique registration ID in a 
confirmation email message. 

To require a registration ID for joining an event: 

1 On the Schedule an Event page, at Registration, select Required. 

2 In the Attendees & Registration section, select Yes at Registration ID 
required. 
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Requiring a registration password 
Specify a registration password only if you want to limit attendance to those 
whom you invite to register. The attendees that you invite receive an invitation 
email message, which contains the registration password and a link they can 
click to register for the event. 

To specify a registration password for an event: 

1 On the Schedule an Event page, at Registration, select Required. 

2 In the Attendees & Registration section, select Yes at Registration 
password, and specify a password in the text box. 

 

Setting approval rules for registrants 
If you require approval for registration requests, you can set up approval rules 
to automatically approve or reject registrants using logical strings (For 
example, you can require that an attendee’s company name must contain the 
word WebEx.). 

To set approval rules for registrants: 

1 On the Schedule an Event page, go to the Attendees & Registration 
section. 

2 At Approval required, select Yes. 

3 Click Set up approval rules. 

The Approval Rules window appears. 

4 See the following figure to learn how to set up rules. 
  
 

 

 

 

 
 Select a parameter from this drop-dow n list. 

 Select a logical string in this drop-dow n list. 
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 Type the w ord or w ords that you w ant to include in the approval rule.  

 Select an action in this drop-dow n list. 

 
To match the case of the text prov ided by a registrant to that of the text in , select 
Match case. 

5 When you finish setting up a rule, click Add Rule . 

The approval rule appears in the Rules list. 

6 When you finish adding rules, click Save . 
 

Customizing the registration form 
You can customize the registration form by adding or changing the questions. 

A registration form contains these two types of questions: 

 Standard Questions—Selecting the check box under the option 
indicates that it is an optional question on the registration form. Selecting 
the check box under the option indicates that it is a required question on 
the registration form. 

 My Custom Questions—You can add text boxes, check boxes, option 
buttons, and drop-down lists to the registration form and customize the 
questions. 

After you add a customized option to the registration form, you can edit it 
at any time. You can also reorganize the questions by using the up and 
down arrows. 

To customize a registration form: 

1 On the Schedule an Event page, go to the Attendees & Registration 
section, and then click the link at Registration form. 

The Customize Registration Questions page appears. 

2 Under Standard Options, do the following: 

 For each option that you want to appear on the registration form, select 

the check box under . 

 For each option for which you want to require attendees to provide 
information, select the check box under . 
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3 Under My Custom Questions, add any of these types of questions: 

 Text Box. 

For details, see About the Add Text Box window (on page 15). 

 Check Boxes. 

For details, see About the Add Check Boxes window (on page 17). 

 Option Buttons. 

For details, see About the Add Option Buttons window. (on page 18) 

 Drop-Down List. 

For details, see About the Add Drop-Down List window (on page 19). 

4 To select questions you have previously saved, click My Registration 
Questions. 

For details, see About the Add From My Registration Questions/Survey 
Questions window (on page 21). 

5 Optional. To reorganize your questions, click the up and down arrows in 
the Change Order column. 

  
 

 

 

  

6 When you finish adding customized questions, click Save . 

7 Click Close  in the window that appears. 
 

Displaying lead scores and company names on the Attendee List 

During the event, you can have the Attendee List display these two types of 
information next to the name of each attendee: 

 the attendee's response to the "Company" question on the registration 
form  

 the attendee's total lead score based on his or her responses to the 
questions on the registration form  
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You can sort the Attendee List 
based on the scores or search 
for a company name and gain a 
better understanding of w hich 
attendees should be given 
priority dur ing the event. 

  
  

Important: If you want to display lead scores and company names on the Attendee List, 
you must do these two things on the registration form: 
 Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add 

Drop-Down List windows. 
 Specify that the "Company" and all questions with assigned scores are required 

information—that is, select the symbol . 

For more information, see Customizing the registration form (on page 13) and About lead 
scores (on page 20). 

 
 

About the Add Text Box window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Event Description 
& Options section. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 
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 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 In the window that appears, click Text Box. 

If you are creating or editing a registration form, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section. 

2 Click the link next to Registration form. 

3 In the window that appears, click Text Box. 

What you can do in this window 

Specify a text question that requires attendees to type information or answers 
in the text box provided on the survey or registration form. 

Options in this window 

  

Use this option ...  To ...  

Text box label Compose a text question. A text box label can contain a 
maximum of 256 characters. 

Type Specify w hether the text box contains a single line or mult iple 
lines. If  you select Multi-line, specify a number of lines in the 
Height box. 

Width Specify the w idth of the text box, in characters. The number 
that you specify determines how  wide the text box appears on 
the survey or registration form but does not affect the number 
of characters that an attendee can type in the text box. A text 
box can contain a maximum of 256 characters. 

Height Specify the number of lines that the text box contains. To 
specify the number of lines, you must f irst select Multi-line 
next to Type. If  you do not specify a number, Event Center 
uses the default height, w hich is one line. 
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About the Add Check Boxes window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Event Description 
& Options section. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 

 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 In the window that appears, click Check Boxes. 

If you are creating or editing a registration form, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section. 

2 Click the link next to Registration form. 

3 In the window that appears, click Check Boxes. 

What you can do in this window 

Specify questions that allow attendees to select multiple answers or choices 
on the survey or registration form. Each answer or choice appears next to a 
check box. 

Options in this window 

  

Use this option ...  To ...  

Group label for check boxes Compose a question. 

Note If you are adding only one check box and 
do not want a group label, leave this box blank. 
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Use this option ...  To ...  

Check box 1 to 9 Compose the answ ers or choices, and specify w hich 
check boxes are selected or cleared by default on the 
survey or registration form. 

To add check boxes to the form, use the Add drop-
dow n list. 

Score Specify a score for each response to the question. For 
more information, see About lead scores (on page 20). 

 

About the Add Option Buttons window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Event Description 
& Options section. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 

 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 In the window that appears, click Option Buttons. 

If you are creating or editing a registration form, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section. 

2 Click the link next to Registration form. 

3 In the window that appears, click Option Buttons. 

What you can do in this window 

Specify questions that allow attendees to select one single answer or choice 
on the survey or registration form. Each answer or choice appears next to an 
option button. 
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Options in this window 

 

Use this option ...  To ...  

Group label for option buttons Compose a question. 

Default choice Specify w hich is the default answ er or choice. 

Choice 1 to 9 Compose the answ ers or choices. 

To add option buttons, use the Add drop-
dow n list. 

Score Specify a score for each response to the 
question. For more information, see About 
lead scores (on page 20). 

 

About the Add Drop-Down List window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Event Description 
& Options section. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 

 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 In the window that appears, click Drop-Down List. 

If you are creating or editing a registration form, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section. 

2 Click the link next to Registration form. 

3 In the window that appears, click Drop-Down List. 
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What you can do in this window 

Specify questions that allow attendees to choose one single answer or choice 
on the survey or registration form. Each answer or choice appears in the drop-
down list. 

Options in this window 

  

Use this option ...  To ...  

Label for drop-down list box Compose a question. 

Default choice Specify w hich is the default answ er or choice. 

Choice 1 to 9 Compose the answ ers or choices. 

To add option buttons, use the Add drop-
dow n list. 

Score Specify a score for each response to the 
question. For more information, see About 
lead scores (on page 20). 

 

About lead scores 
When customizing a survey or registration form, you can specify a score for 
each response to a question. Your site administrator can later generate a 
report that shows each attendee’s total score, so you can identify the most 
qualified leads from the scores as well as the other information you have 
gathered from the survey or registration form. 

During the event, you can have the Attendee List display these two types of 
information next to the name of each attendee: 

 the attendee's response to the "Company" question on the registration 
form  

 the attendee's total lead score based on his or her responses to the 
questions on the registration form  
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You can sort the Attendee List 
based on the scores or search 
for a company name and gain a 
better understanding of w hich 
attendees should be given 
priority dur ing the event. 

  
  

Important: If you want to display lead scores and company names on the Attendee List, 
you must do these two things on the registration form: 
 Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add 

Drop-Down List windows. 
 Specify that the "Company" and all questions with assigned scores are required 

information—that is, select the symbol . 

For more information, see Customizing the registration form (on page 13) and About lead 
scores (on page 20). 

 
 

About the Add From My Registration Questions/Survey 
Questions window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Event Description 
& Options section. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 



Chapter 2: Planning an Event 

 

22 

 

 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 In the window that appears, click My Survey Questions. 

If you are creating or editing a registration form, do the following: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section. 

2 Click the link next to Registration form. 

3 In the window that appears, click My Registration Questions. 

What you can do in this window 

Select questions that you have previously saved, and then add them to this 
survey or registration form. 

Options in this window 

  

Use this option ...  To ...  

Check boxes Select a question, and then c lick Add to add 
it to the current form. 

Links for the questions  Edit a question, and then save it.  

 

Specifying a destination Web page after registration 
You can specify a destination Web page that displays once an attendee 
submits the registration form. 

To specify a destination URL: 

1 On the Schedule an Event page, go to the Attendees & Registration 
section. 

2 At Destination URL after registration, type a URL in the text box. 
 

Inviting participants to your event 
To invite attendees and panelists to your event using the WebEx automated 
email system, do the following: 
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1 From the Schedule an Event page, create invitation lists.  

For details, see Creating an invitation list and inviting attendees to your 
event (on page 23) or Creating an invitation list and inviting panelists to 
your event (on page 28). 

2 After you schedule the event, the Send Event Emails page displays 
immediately. 

3 Select the recipients on the page, and click Send Now. 

  
 

Note: Clicking Send Later takes you to the Event Information page, on which you can 
send invitation email messages at a later time. 

 
 

Creating an invitation list and inviting attendees to your event 
You can select contacts from an existing address book or add new contacts 
on your Event Center Web site. 

If you have a large number of contacts in a distribution list, you can import the 
distribution list in the CSV (comma-separated/comma-delimited values) 
format. 

To create an invitation list and invite attendees to your event: 

1 On the Schedule an Event page, go to the Attendees & Registration 
section. 

2 Click Create invitation list. 

3 In the window that appears, add any of the following: 

 new attendees who are not already contacts in one of your address 
books. For details, see Adding a new contact to your invitation list (on 
page 24). 

 contacts and contact groups already in your address books on the 
Event Center Web site. For details, see Adding existing contacts to 
your invitation list (on page 26). 

 distribution list in the CSV format. For details, see Importing a 
distribution list to your invitation list (on page 28). 

4 When you finish specifying options on the Schedule an Event page, click 
Schedule This Event. 
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5 On the Send Event Emails page, select the recipients, and then click Send 
Now. 

  
 

 

 

 

  
 

 Note: Clicking Send Later takes you to the Event Information page, on which you 
can send invitation email messages at a later time. 

6 Click OK and Continue  on the messages that appear on your screen. 

Each attendee that you invite receives an invitation email message, which 
includes a link that the attendee can click to obtain more information about 
the event and to join the event. 

  
 

Note: Once you start the event, you can still invite more attendees. For details, see 
Inviting attendees to an event in progress. 

 
 

Adding a new contact to your invitation list 
When scheduling an event, you can add a new contact to your invitation list—
that is, an attendee who is not already a contact in one of your address books 
in My WebEx on the Event Center Web site. Once you specify information 
about a new contact, you can also add the contact to one of your address 
books. 
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To add a new contact to your event invitation list: 

1 If you have not already done so, click Create Invitation List on the 
Schedule an Event page.  

For details, see Creating an invitation list and inviting attendees to your 
event (on page 23) and Creating an invitation list and inviting panelists to 
your event (on page 28). 

2 Under New Attendee or New Panelist, provide information about the 
contact. 

For more information about the Time zone, Language, and Locale options, 
see About time zones, languages, and locales (on page 25). 

3 Optional. To add the new contact to your Personal Contacts address book, 
select the Add new attendee in my address book or Add new panelist 
in my address book check box. 

4 Optional. To add a new panelist as an alternate host, one who can start 
this event and act as the host, select the Invite as alternate host check 
box. 

  

 Note: An alternate host must have an account on your site. In addition, only a 
panelist can be an alternate host. 

 

5 Click Add to Invitation List. 

The contact displays under Attendees to Invite or Panelists to Invite. 

6 Click Invite . 

  
 

Tip:  
 To view a list of the attendees or panelists you selected for an event, click View 

invitation list in the Attendees & Registration or Presenters & Panelists section. 
 To delete a contact from an attendee or panelist invitation list, click Edit invitation 

list in the Attendees & Registration or Presenters & Panelists section. Select the 
contact, click Delete, and then click OK. 

 

About the time zone, language, and locale options 

Host only 

For each attendee you plan to invite to your event, you can select a language, 
time zone, and locale in which your invitation displays text, dates, and times.   
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You can specify time zones, languages, and locales for an attendee when you 
are: 

 adding a new contact (A new contact is an attendee who is not already in 
one of your address books in My WebEx.)  

 editing an existing contact (The settings you specify here will replace the 
contact's original settings.)  

  

Important:  
 If you customize an email template, attendees will receive customized email 

messages in your language, rather than in the languages specified in attendee 
settings.  

 If you do not customize an email template, attendees will receive email messages in 
the languages specified in attendee settings. 

 For details about customizing email messages, see About customizing email 
messages (on page 35). 

 

Adding existing contacts to your invitation list 
When creating event invitation lists, you can select contacts in the following 
lists: 

 Personal Contacts—Includes any individual contacts that you have added 
to your personal address book. If you use Microsoft Outlook, you can 
import the personal contacts that you keep in an Outlook address book or 
folder to this list of contacts. 

 Company Address Book—Your organization's address book, which 
includes any contacts that your site administrator has added to it. If your 
organization uses a Microsoft Exchange Global Address List, your site 
administrator can import its contacts to this address book. 

To add an existing contact to your event invitation list: 

1 If you have not already done so, click Create Invitation List on the 
Schedule an Event page. 

For details, see Creating an invitation list and inviting attendees to your 
event (on page 23) or Creating an invitation list and inviting panelists to 
your event (on page 28). 

2 In the Create Attendee Invitation List window or Create Panelist Invitation 
List window, click Select Contacts. 
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3 In the View drop-down list, select one of the following contact lists: 

 Personal Contacts 

 Company Address Book 

The contact list that you selected displays. 

4 Select the check box for each individual contact or contact group that you 
want to add to your list of attendees or panelists. 

When selecting contacts, you can do the following: 

 In the Index, click a letter of the alphabet to display a list of contacts 
whose first names begin with that letter. For example, the name Susan 
Jones appears under S. 

 To search for a contact in the list that you are currently viewing, type 
text that appears in either the contact's name or email address in the 
Search for box, and then click Search. 

5 Do either or both of the following: 

 Click Add Attendees or Add Panelists. 

 Optional. To add a panelist from your existing contacts as an alternate 
host, select that contact and click Add as an alternate host. 

  

 Note: An alternate host must have an account on your site. In addition, only a 
panelist can be an alternate host. 

 

The contacts that you selected display under Attendees to Invite or 
Panelists to Invite. 

6 To add the selected contacts to your invitation list, click Invite. 

  
 

Tip:  
 To view a list of the attendees or panelists you selected for an event, click View 

invitation list in the Attendees & Registration or Presenters & Panelists section. 
 To delete a contact from an attendee or panelist invitation list, click Edit invitation list 

in the Attendees & Registration or Presenters & Panelists section. Select the contact, 
click Delete, and then click OK. 
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Importing a distribution list to your invitation list 
Adding a large number of contacts to your invitation list is easy if you have 
them in a distribution list in the CSV (comma-separated/comma-delimited 
values) format. 

To import a distribution list to your event invitation list: 

1 If you have not already done so, open the Create Invitation List window 
from the Schedule an Event page.  

For details, see Creating an invitation list and inviting attendees to your 
event  (on page 23)or Creating an invitation list and inviting panelists to 
your event (on page 28). 

2 Click Import CSV Files. 

3 Follow the instructions on your screen to upload a distribution list. 

4 When the system finishes importing all the contacts in the list, click Close . 
 

Creating an invitation list and inviting panelists to your event 
You can select contacts from an existing address book or add new contacts 
on your Event Center Web site. 

If you have a large number of contacts in a distribution list, you can import the 
distribution list in the CSV (comma-separated/comma-delimited values) 
format. 

To create an invitation list and invite panelists to your event: 

1 On the Schedule an Event page, go to the Presenters & Panelists section. 

2 Click Create invitation list. 

3 In the window that appears, add any of the following: 

 new attendees who are not already contacts in one of your address 
books. For details, see Adding a new contact to your invitation list (on 
page 24). 

 contacts and contact groups already in your address books on the 
Event Center Web site. For details, see Adding existing contacts to 
your invitation list (on page 26). 
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 distribution list in the CSV format. For details, see Importing a 
distribution list to your invitation list (on page 28). 

4 When you finish specifying options on the Schedule an Event page, click 
Schedule This Event. 

5 On the Send Event Emails page, select the recipients and then click Send 
Now. 

  
 

 

 
  
 

 Note: Clicking Send Later takes you to the Event Information page, on which you 
can send invitation email messages at a later time. 

 

  

6 Click OK and Continue  on the messages that appear on your screen. 

Each panelist that you invite receives an invitation email message, which 
includes a link that the panelist can click to obtain more information about 
the event and to join the event. 

 

Editing an invitation list 
When scheduling or editing an event, you can edit your invitation list for both 
attendees and panelists. 

To edit an invitation list: 

1 On the Schedule an Event or Edit Event page, go to the Attendees & 
Registration section or Presenters & Panelists section, as appropriate. 
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2 Click Edit invitation list. 

3 Click the contact's name in the Name column. 
  
 

 

 
 

 

Once you click the name of the 
contact, you can edit the contact 
information in the Edit Attendee or 
Edit Panelist section. 

  

4 Make your changes. 

5 Click Update Invitation List. 
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Sending email messages to participants 
  

If you want to ... See ... 

get an overview  of sending email messages 
to your event participants  

About sending email messages to 
participants (on page 31) 

learn about the various email messages you 
can send or customize w hen scheduling or 
edit ing an event 

About the Email Messages section (on page 
31) 

include iCalendar attachments in your email 
messages 

Including iCalendar attachments in email 
messages  (on page 34) 

 

About sending email messages to participants 
When scheduling an event, you can choose from various types of participant 
email messages, such as registration status, reminders, and follow-ups, in the 
Email Messages section. The WebEx automated email system will send 
selected email messages at t imes you specify. For details, see About the 
Email Messages section (on page 31). 

In addition, you can customize the templates by editing, rearranging, or 
deleting the content and variables—code text that Event Center uses to 
substitute for your specific event information. For details, see About 
customizing email messages (on page 35). 

 

About the Email Messages section 

How to access this section 

On the left navigation bar of your Event Center Web site, under Host an 
Event, click Schedule an Event, and then go to the Email Messages 
section. 

What you can do in this section 

Select or customize email messages that you want to send to event 
participants. 
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To customize an email message template, click the link for that email 
message. For example, click the Attendees link to customize the invitation 
email message to attendees. 

To select a type of email message to participants, select the appropriate 
check box. For example, select the Thank You for Attending check box to 
send a follow-up email message after the event ends. 

Options in this section 

  

Using this option ...  You can do the follow ing ...  

Email Format Select Plain Text to send all email messages 
in plain text format. 

Select HTML to send all email messages w ith 
the formatting you w ant, such as number ing, 
bullets, bold face, and italics. 

Invitation emails Click the Attendees link to customize the 
invitation email message to attendees. 

Click the Panelists link to customize the 
invitation email message to panelists. 

Note For details, see Customizing an 
email message for a specific event (on 
page 37). 
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Using this option ...  You can do the follow ing ...  

Registration emails Select the check boxes to send notif ications 
to registrants about their registration status. 

Pending—Notif ies that you have received the 
attendee’s registration and that it is pending 
approval. 

Approved—Notif ies that you have accepted 
the attendee’s registration. This email 
message contains a link the attendee can 
click to join the event. 

Rejected—Notif ies that you have declined 
the attendee’s registration request. The 
default email message does not contain a 
reason for rejection, so you may w ant to 
customize the message. 

Event In Progress—Sends an email 
message to the attendees you invite after you 
start the event. Click this link to customize the 
email message. 

Note To customize the email messages 
for Pending, Approved, Rejected, and 
Event In Progress, click the links. For 
details, see Customizing an email 
message for a specific event (on page 
37). 

Event updated emails Customize the email messages that are sent 
to event participants about event updates. 
When you update your event, you can 
choose to send an event updates email to 
any of the follow ing recipients (These options 
appear after you click Update This Event on 
the Edit Event page.): 

All Approved Registrants—Sends an email 
message to only those w hose registration has 
been approved 

All Attendees—Sends an email message to 
all the attendees you invite using the WebEx  
email system 

All Panelists—Sends an email message to 
all the panelists you invite using the WebEx 
email system 
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Using this option ...  You can do the follow ing ...  

Reminder emails Select the check boxes to send reminders to 
registrants at specif ic times. 

1st Reminder—Sends an email message 
reminding registrants to join the event. 

2nd Reminder—Sends a second email 
message reminding registrants to join the 
event. 

Note To customize the reminder email 
messages, click the links. For details, 
see Customizing an email message for a 
specific event (on page 37). 

Follow-up emails Select the check boxes to send follow -up 
email messages to attendees. 

Thank You for Attending—Thanks an 
attendee for attending the event, and 
contains information about how  the attendee 
can provide feedback on the event. 

Absentee Follow-Up Email—Informs an 
absentee that the event has occurred, and 
provides the host’s contact information. Event 
Center sends this message to each registrant 
who did not attend the event. 

Note To customize the follow-up email 
messages, click the links. For details, 
see Customizing an email message for a 
specific event (on page 37). 

 
 

Including iCalendar attachments in email messages 
To let invited participants add the scheduled event to their calendar programs, 
such as Microsoft Outlook, you can include an iCalendar item in your email 
messages, such as those for invitation, event updates, and registration 
confirmation. 

To include iCalendar attachments in your email messages: 

1 On the Schedule an Event page, go to Email Messages. 

2 Select Include iCalendar Attachments. 
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Event Center includes an iCalendar attachment, in the .ics format, in your 
email messages. If a participant opens the .ics file, a meeting item opens. 
The participant can then save the meeting item in his or her calendar. 

 

Customizing email messages 
 

If you want to ... See ... 

get an overview  of customizing email 
messages 

About customizing email messages  (on page 
35) 

customize an email message for an event 
that you are scheduling or editing 

Customizing an email message for a specific 
event (on page 37) 

customize an email message template for 
events that you may schedule in the future 

Customizing an email message for future 
events (on page 38)  

 

About customizing email messages 
Event Center provides up to three templates for each type of email message. 
You can customize them on these two levels: 

 event level—for a specific event that you are currently scheduling or 
editing. For details, see Customizing an email message for a specific 
event.  (on page 37) 

 host level—for all future events you will schedule. The changes you make 
on this level automatically apply to any future event that you schedule on 
your Event Center Web site. For details, see Customizing an email 
message for future events (on page 38). 

 

About the Edit Event Email/Template Name: [template name] 
page 

How to access this page 

1 Do one of the following, as appropriate: 

 On the left navigation bar of your Event Center Web site, click Host an 
Event > Email Templates. 
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 On the Schedule an Event or Edit Event page, go to the Email 
Messages section. 

2 Select an email template that you want to customize, and then click Edit. 

Options on this page 

  

Use this option ...  To ...  

Email Template Name Enter a different name for this template if  it’s 
necessary. 

Available only if  you are customizing the 
template for all future events. 

From name Enter the sender ’s name. This name appears 
in the email message that participants 
receive. 

From email Enter the sender ’s email address. This 
address appears in the email message that 
participants receive. By default, Event Center 
uses this variable, %SenderEmailAddress%, 
which retrieves the corresponding information 
from the mail server for your Event Center 
Web site. The default email address is 
messenger@webex.com.  

Reply to email Enter the email address to w hich you w ant all 
replies to this message to be sent. By default, 
Event Center uses this variable, 
%HostEmail%, w hich retrieves the 
corresponding information specif ied in your 
user profile. 

Note To specify a different email 
address, delete the entire variable—the 
text and the percentage signs together, 
and then type the new email address in 
the box. 

Subject Enter a subject that w ill appear in the subject 
line of the email message. 

Header image Click Add to add a header image in this email 
message. 

Available only in HTML templates. 

Footer image Click Add to add a footer image in this email 
message. 

Available only in HTML templates. 



 Chapter 2: Planning an Event 

 

37 

 

Use this option ...  To ...  

Revert to Default Revert the template to the original state, 
which is set up by your site administrator. 

Preview Preview  the email message in the text or 
HTML format that you selected. 

Save Save the changes you make. 

  
 

Tip: WebEx recommends that you set up an email account that you can use exclusively 
for producing events. You can specify that address in the Reply to email box. For 
example, you can set up an account with the address events@your_company.com. 

 
 

Customizing an email message for a specific event 
When you are scheduling or editing an event, you can customize an email 
message template for the specific event by editing, rearranging, or deleting 
the content and variables—code text that Event Center uses to substitute for 
your specific user or event information. 
  
 

Important: You can delete or rearrange variables, but never change the text in a 
variable. For example, in this variable, %ParticipantName%, do not change the text 
ParticipantName within the percentage signs. If you change it, Event Center cannot 
substitute the correct text from your user or event information. 
  

To customize an email message for an event: 

1 On the Schedule an Event page or Edit Event page, in the Email 
Messages section, click the link for the email message that you want to 
customize. 

For more information, see About the Email Messages section (on page 
31). 

2 Select a template in the Select email message  drop-down list, and then 
click Edit. 

3 Make your changes on the Edit Event Email: [template name] page. 
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For details, see About the Edit Event Email/Template Name: [template 
name] page (on page 35). 

4 To save the changes you make, click Save > OK. 
 

Customizing an email message for future events 
You can customize email message templates for all future events you will 
schedule on your Event Center Web site. The changes you make on this level 
automatically apply to any future event that you schedule. 

You customize an email message template by editing, rearranging, or deleting 
the content and variables—code text that Event Center uses to substitute for 
your specific user or event information. 
  
  

Important: You can delete or rearrange variables, but never change the text in a 
variable. For example, in this variable, %ParticipantName%, do not change the text 
ParticipantName within the percentage signs. If you change it, Event Center cannot 
substitute the correct text from your user or event information. 
  

To customize an email message template for future events: 

1 On the left navigation bar of your Event Center Web site, click Host an 
Event > Email Templates. 

2 Choose the type of email message you want to edit in the For: drop-down 
list, and then click one of the templates in the HTML or plain text section, 
depending on your need. 

3 Click Edit. 

4 Make your changes on the Template name: [template name] page. 

For details, see About the Edit Event Email/Template Name: [template 
name] page (on page 35). 

5 To save the changes you make, click Save . 

  
 

Note: To revert the email message to its original, default state, click Revert to Default. 
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About variables in an email template 
A variable is composed of text surrounded by two percentage signs. Each 
variable used in Event Center email templates is replaced in actual messages 
by corresponding information specified in an attendee’s registration data, in 
your user profile, on the Event Information page, and so on. 

This table describes each of the variables and how you can use them. 
  
 

This variable Is replaced by… 

%AttendeeName% 
the f irst and last names that the attendee specif ied 
when registering for or joining the event 

%Disclaimer% 

This variable is replaced by the follow ing text: 

IMPORTA NT NOTICE: This WebEx service inc ludes a 
feature that allows audio and any documents and 
other materials exchanged or view ed during the 
session to be recorded. By joining this session, you 
automatically consent to such recordings. If  you do not 
consent to the recording, do not join the session. 

%DownloadInstruction% 

This variable is replaced by the follow ing instructions 
for dow nloading the Event Center application: 

To join the event more quickly, you can set up the 
softw are that you need to join the event before it 
starts. Go to the URL above, then clic k Set Up. 

%EmailFooter% 

This variable is replaced by the follow ing format: 

http://www.webex.com 
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This variable Is replaced by… 

%EnrollmentID% 

the registration ID for the attendee 

Event Center automatically creates this ID for an 
attendee after you approve his or her registration 
request. If  this event does not require registration, this 
variable is replaced by the follow ing text:  

This event does not require a registration ID. 

%EventAddressURL% 

a hyperlink 

You can use this in event descriptions. 

%EventPassword% 

the event passw ord that you specif ied w hen 
scheduling the event. If  you do not require a passw ord, 
this variable is replaced by follow ing text: 

This event does not require a passw ord. 

%EventTimeZone% 
the time zone that you specif ied w hen scheduling the 
event 

%HostEmail% the email address that you specif ied in your user 
profile 

%HostName% the f irst and last names that you specif ied in your user 
profile 

%HostPhone% 
the phone number that you specif ied in your user 
profile 

%JoinURL% 
a hyperlink  

You can use this in instructions for joining the event. 

%JoinURLStr% 

a URL that doesn't contain a hyperlink 

You can use this in instructions for joining the event. 

Example. You can use the variable in this w ay: To 
join the event, <a href="%JoinURLStr%">click 
here.</a> 

 

%MeetingDate% 

the date that you specif ied w hen scheduling the event 
in the follow ing format: 

Day, Month DD, YYYY—for example: Fr iday, April 12, 
2009 
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This variable Is replaced by… 

%MeetingInfoURL% 
the URL for the Event Information page for the event 

Event Center automatically creates the URL once you 
schedule an event. 

%MeetingTime% 
the time that you spec if ied w hen scheduling the event 
in the follow ing format: 

HH:MM [am/pm]—for example: 12:30 pm 

%PanelistName% the panelist’s f irst and last names that you specif ied 
when scheduling the event 

%ParticipantName% the f irst and last names that the participant specif ied 
when either registering for or joining the event 

%RegistrationPassword% the passw ord you specif ied for attendees to register 
for the event 

%SenderEmailAddress% 

the email address specif ied on the email server for 
your Event Center Web site.  

The default address is: messenger@w ebex.com 

%TeleconferenceInfo% 

This variable is replaced by the follow ing text: 

To join the teleconference, call %CallInNumber% and 
enter the meeting number. 

The variable %CallInNumber% is replaced by the 
numbers that you specif ied w hen scheduling the 
event. 

%Topic% 
the event name that you specif ied w hen scheduling 
the event 

%UCFAttendeeVerifyPlayers% 

If  UCF is turned on for this event, and you select 
Request Attendees to verify rich media players  
when scheduling the event, the follow ing displays: 

The playback of UCF (Universal Communications 
Format) rich media f iles requires appropr iate players. 
To view  this type of rich media f iles in the event, 
please check w hether you have the players installed 
on your computer by going to [URL]. 
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Selecting audio conference options 
To provide audio during an event, choose from these audio options on the 
Schedule an Event or Edit Event page: 
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Audio options Descriptions 
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Audio options Descriptions 

WebEx 
Teleconferencing 
Service 

 

An integrated teleconference. 

Enter the number of callers that you expect to join the teleconference in 
the Estimated number of callers box. If  you expect more than 125 
callers for the teleconference, please contact your WebEx account 
manager to increase your audio conference capacity.  

 

Select one of these types of WebEx teleconferences: 

 Attendees call in—Attendees call a phone number to join the 
teleconference and assume the charges for their calls.  

 Attendees receive a call back—Attendees provide their phone 
numbers once they join the event, and then receive call-backs at the 
phone numbers they provide. You or your organization assumes the 
charges for the calls. Recorded instructions guide the attendee 
through the process of connecting to the teleconference. 

For more information, see Setting up a teleconference for an event  (on 
page 46). 

 

Whether you select Attendees call in or Attendees receive a call 
back, you can select any of these options: 

 Allow access to teleconference via global call-in numbers—
Allow s attendees in different countries to call in using WebEx 
international call- in numbers. A list of numbers—such as toll-free or 
local numbers—appears on attendees ’ screens once they join the 
event. 

For a list of toll-free calling restrict ions by country, go to 
www.w ebex.com/pdf/tollfree_restrictions.pdf. 

The phone number displays in a message box on attendees’ 
screens once they join the event. When an attendee calls the phone 
number, recorded instructions guide the attendee through the 
process of entering a teleconference in the event.  

 Broadcast audio stream to all attendees—Provides one-w ay 
audio stream from a teleconference to attendees ’ computers. Rather 
than connecting to a teleconference, attendees can listen to the 
audio port ion of the event through their speakers or headsets. For 
more information, see Broadcasting audio streams to all attendees 
(on page 220). 

 Mute upon entry for all participants—Mutes participants’ 
telephones once they join the WebEx teleconference. Panelists can 
unmute their ow n phones. How ever, attendees need the host to 
unmute their phones. 
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Audio options Descriptions 

Other teleconference 
service 

A teleconference that a third-party service provides. Enter in the text box 
instructions for joining a teleconference. The instructions display in a 
message box on attendees ’ screens once they join the event. For more 
information, see Setting up a teleconference for an event (on page 46). 

 

When you use a third-party service provider, you can select this option: 

Broadcast audio stream to all attendees—Provides one-w ay audio 
stream from a teleconference to attendees’ computers. Rather than 
connecting to a teleconference, attendees can listen to the audio portion 
of the event through their speakers or headsets. For more information, 
see Using a third-party teleconference for audio broadcast (on page 
222). 

Note If  more than 500 participants w ill attend your event, you can use 
either a third-party teleconferencing service or the WebEx Operator-
Assisted Audio Conference Services. To learn more about the WebEx 
Operator-Assisted Audio Conference Services, contact your WebEx 
account manager. 
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Audio options Descriptions 

Cisco Unified 
MeetingPlace Audio 
Conferencing 

An integrated audio conference. If  you select this option, choose the type 
of conference: 

 Attendees call in: Select if  you w ant customers to dial a number to 
join 

 Attendees receive call back: Select if  you w ant customers to type 
in a phone number and receive a call back from the conferencing 
service. 

A participant must have a direct phone line to receive a call from the 
conferencing service. How ever, a participant w ithout a direct phone line 
can join an audio conference by dialing a call-in number, w hich is alw ays 
available in the meeting w indow . 

Whichever option you choose, you can select any of these options: 

 Broadcast audio stream to all attendees—Provides one-w ay 
audio stream from a teleconference to attendees ’ computers. Rather 
than connecting to a teleconference, attendees can listen to the 
audio port ion of the event through their speakers or headsets. For 
more information, see Broadcasting audio streams to all attendees 
(on page 220). 

 Mute upon entry for all participants—Mutes participants’ 
telephones once they join the WebEx teleconference. Panelists can 
unmute their ow n phones. How ever, attendees need the host to 
unmute their phones. 

Integrated VoIP A voice conference in w hich participants use computers w ith audio 
capability to communicate over the Internet rather than the telephone 
system. Integrated VoIP can be either half-duplex, w hich lets only one 
attendee speak at a t ime, or full-duplex, w hich allows up to tw o 
participants to speak at the same time. 

For more information, see Setting up an Integrated VoIP conference for 
an event (on page 48). 

No Teleconference No teleconference is available in the event.  

To provide audio in the event, select Integrated VoIP. 

 

 

Setting up a teleconference for an event 
Teleconferencing options may differ, depending on which options your 
organization uses. 

To set up a teleconference: 

1 On the Schedule an Event or Edit Event page, go to Teleconference. 
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2 Select one of the following options: 

 WebEx Teleconference Service . 

For the WebEx teleconference service, select one of the following: 

 Attendees call in 

 Attendees receive a call back 

Enter the number of estimated callers in the Estimated number of 
callers box. 

 Cisco Unified MeetingPlace Audio Conferencing. 

For Cisco Unified MeetingPlace audio conferencing, select one of the 
following: 

 Attendees call in 

 Attendees receive a call back 

 Other teleconference service—The event includes a teleconference 
that another service provides. Enter in the text box instructions for 
joining the teleconference. The instructions display in a message box 
once an attendee joins the event. 

3 If you want to allow attendees in different countries to call in using WebEx 
international call-in numbers, select Allow access to teleconference via 
global call-in numbers. 

4 If you want to provide one-way audio to attendees without requiring them 
to join your teleconference, select Broadcast audio stream to all 
attendees. 

5 If you want to mute all participants’ telephones once they join the event, 
select Mute upon entry for all participants. 

6 Click Schedule This Event or Update . 

  
 

Note: Once you schedule the event, instructions for joining the teleconference display in 
the Join Teleconference dialog box once participants join the event. 
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Setting up an Integrated VoIP conference for an event 
You can set up Integrated VoIP in addition to or as an alternative to a 
teleconference. 

To set up an Integrated VoIP conference: 

1 On the Schedule an Event or Edit Event page, go to Teleconference. 

2 Select the Integrated VoIP check box. 

3 Click ScheduleThis Event or Update This Event. 

  
 

Note:  
 If you set up an Integrated VoIP conference, you must start the conference 

before the other participants can start using it in the event. 
 Only participants whose computers meet the system requirements for 

Integrated VoIP can participate in the conference. 
 If you use WebEx Recorder to record the event and want to capture audio in 

the recording, ensure that the correct audio compression scheme is selected. 
For details, refer to the WebEx Recorder and Player User’s Guide, which is 
available on the User Guides page on your Event Center Web site. 

System requirements for Integrated VoIP 

To participate in an Integrated VoIP conference, you must ensure that your 
computer meets the following system requirements: 

 a supported sound card 

For a list of supported sound cards, refer to the Frequently Asked 
Questions page on your Event Center Web site. You can access this page 
from your site's Support page. 

 speakers or headphones 

 microphone, if you want to speak during the conference 

  
 

Tip: For better audio quality and greater convenience, use a computer headset with a 
high-quality microphone. 
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Setting up a dual-mode voice conference 
You can set up a dual-mode voice conference for an event—that is, an audio 
conference that includes both a teleconference and an Integrated VoIP 
conference. In a dual-mode voice conference, participants can use either type 
of conference. 

In a dual-mode voice conference, a participant can listen to audio using either 
a phone or speakers attached to his or her computer. To speak, a participant 
can use either a phone or microphone attached to his or her computer. 

For details about setting up a teleconference and Integrated VoIP conference, 
see: 

 Setting up a teleconference for an event (on page 46) 

 Setting up an Integrated VoIP conference for an event (on page 48) 
 

Playing alerts when participants join or leave a 
teleconference 

When scheduling an event, you can specify the type of tone that plays in all 
participants' phones once a participant joins or leaves the teleconference. 
This option is applicable only if you use integrated teleconference. 

To specify sound alerts: 

1 On the Schedule an Event or Edit Event page, go to Additional Event 
Options. 

2 In the Entry and exit tone drop-down list, choose one of the following 
options: 

 Beep—A simple tone plays once a participant either joins or leaves the 
teleconference. 

 Announce name—Upon joining the teleconference, a participant must 
record his or her name, which is then played in the teleconference. The 
participant’s name is also played if he or she leaves the 
teleconference. 

 No tone—No alert plays in participants' phones once a participant 
joins or leaves the teleconference. 
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Sharing a presentation or document 
automatically 

When scheduling an event, you can set up a Universal Communications 
Format (UCF) presentation that plays automatically for the participants while 
they wait for the event to start. 

You can specify one of the following: 

 A UCF presentation plays automatically in the content viewer once a 
participant joins the event. If the presentation contains multiple pages, you 
can also specify that it automatically advances its pages at a specified 
interval. 

 A Web page appears once a participant joins the event. Participants can 
then browse Web pages while they wait for you to start the event. 

  
 

Important:  

The presentation or document that you select must: 
 Be in the Universal Communications Format (UCF). 
 Reside in your personal folders in the My WebEx area on your Event Center Web 

site. You can select a UCF file that already resides in your folders or upload a new 
file to your folders when scheduling an event. 

  

To automatically share a file once an attendee joins an event: 

1 On the Schedule an Event, go to Event Description & Options. 

2 At UCF autoplay options, do one of the following: 

 In the text box, type the Web address or URL that you want to share 
automatically. 

 Locate and upload a UCF file by clicking Add and doing the following 
on the Add/Select Presentation page: 

 If the file resides in your personal folders on the Event Center Web 
site, select the file. 
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 If the file does not yet reside in your personal folders on the Event 
Center Web site, click Browse , select the file, and then click 
Upload. Then select the file. 

 Click Done . 

For details, see About the Add/Select Presentation page (on page 52). 

3 If you specify to show a UCF presentation, not a Web page, do one of the 
following: 

 To specify that the presentation starts automatically when a participant 
joins, select Start automatically. 

 To allow attendees to control viewing of the presentation, select Allow 
attendees to control file . 

4 Optional. To specify that the presentation plays continuously during auto 
play, select Continuous play. 

5 In the Advance page every drop-down list, select the length of 
intermittence in seconds between each slide. 

  
 

Important:  

If you share a UCF multimedia presentation that includes rich media files, such as audio 
or video files, do the following: 
 Ensure that each media file is embedded in the presentation file or resides on a 

publicly accessible Web server. If the presentation contains a link to a media file 
that resides on your computer, participants cannot view that media file. For more 
information about creating UCF multimedia presentations, refer to the guide Getting 
Started with WebEx Universal Communications Toolkit by going to Support > User 
Guides on the left navigation bar of your Event Center Web site. 

 Ensure that each media file is set to play automatically for participants. For more 
information about setting this option for a UCF media file, refer to the guide Getting 
Started with WebEx Universal Communications Toolkit by going to Support > User 
Guides on the left navigation bar of your Event Center Web site. 

 Select Allow attendees to control file on the Schedule an Event page. If you do 
not select this option, the pages or slides in the document or presentation will 
advance automatically, which may prevent some participants from viewing the 
media files. 
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About the Add/Select Presentation page 

What you can do on this page 

 Select a file already in your personal folders on the Event Center Web site 
to play automatically while participants wait for the event to start. 

 Upload a new file to your personal folders on the Event Center Web site to 
play automatically while participants wait for the event to start. 

Options on this page 

 

Option Description 

File name box Type the name of the f ile to upload to your folder. 

Browse button Click to select a UCF presentation or document that resides in your 
personal folders. 

Upload button Click to upload the specif ied f ile to your folder. 

Select radio button Select the button for the f ile to be added to the event. 

Name Indicates the names of the f iles residing in your folder. 

Description Describes the folder or f ile. 

Size Indicates the size of the folder or f ile in kilobytes. 

Done button Click to add the specif ied f ile to your event and to have it play 
automatically w hile partic ipants w ait for the event to start.  

 

Specifying basic information 
  

If you want to ... See ... 

specify the event type and topic  Specifying an event type and topic  (on page 
53) 

automatically delete the event after it ends  Automatically deleting an event after it ends 
(on page 53)  
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If you want to ... See ... 

copy event information from a pre-defined 
template to the Schedule an Event page 

Using an event template during scheduling 
(on page 54)  

create or edit an event template Creating or editing an event template  (on 
page 55) 

specify an event passw ord Specifying an event password  (on page 56)  

assign the event for a program Assigning your event to a program  (on page 
56) 

specify a tracking code Specifying tracking codes for a scheduled 
event  (on page 57)  

reduce the netw ork bandw idth consumption 
for joining the event 

Reducing network bandwidth usage (on page 
57) 

 

Specifying an event type and topic 
When scheduling an event, you must specify the event type and topic. 

To specify an event type and topic: 

1 On the Schedule an Event or Edit Event page, choose an event type in the 
Event type  drop-down list. 

2 Type a topic for the event in the Event name text box. 

  
 

Note:  
 Your site administrator sets up the event type, which specifies what features are 

available during an event. If your site administrator specifies more than one event 
type, you must choose one in the drop-down list. 

 An event topic cannot contain any of these characters: \ ` " / & < > = [] 
 

Automatically deleting an event after it ends 
When scheduling an event, you can specify to automatically delete the event 
from My Meetings in My WebEx after the event ends. 
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Examples. 

 You select the Delete from My Meetings when completed option, 
schedule the event for 10 a.m. to 11 a.m., and then start and end the 
event. The event will be removed from My Meetings in My WebEx at 11:01 
a.m. or at the time you end the event, whichever comes later. 

 You leave the Delete from My Meetings when completed check box 
cleared and schedule the event. Then you start and end the event. The 
event is always listed in My Meetings in My WebEx. 

  
 

Note: Whether or not you select the Delete from My Meetings when completed option, 
you can always run reports from My WebEx to view information about your events. For 
more information, see Generating reports (on page 430). 

 

Using an event template during scheduling 
Event templates allow event hosts to shorten scheduling time and store their 
favorite settings. The Event template  drop-down list lists the following 
templates: 

 My templates—created by yourself and displayed only if you log in to your 
Event Center Web site. 

 Standard templates—created by your site administrator and made 
available for the event hosts in your organization. 

 System template—set up by your WebEx service; the name of the system 
template is displayed in brackets in the drop-down list. 
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If you choose to use a template, the information in the template, including the 
event name, description, password, teleconference options, registration 
options, customized registration questions, and email templates, is 
automatically copied to the Schedule an Event page. You can edit the 
information or options before scheduling the event. 
  
 

Note: The participant list, panelist information, and registrant data are not copied to the 
Schedule an Event page. 
  

To choose an event template: 

On the Schedule an Event page or Edit Event page, in the Event template 
drop-down list, choose a template. 

 

Creating or editing an event template 
You can create or edit a template from the Schedule an Event page. The 
templates you create or edit on this page will be included under My templates 
in the Event template  drop-down list. 
  

Note: Only the site administrator can edit or create the Standard templates. However, 
you can save a Standard template as a new template under My templates. 

To create an event template: 

1  Do one of the following as appropriate: 

 Specify the options on the Schedule an Event. 

 Choose a template in the Event template  drop-down list. 

2 Click Save as template  on the bottom of the Schedule an Event page. 

3 In the window that appears, type the name of the new template in the 
Template name  text box. 

4 Click Save . 

To edit an existing event template: 

1  In the Event template  drop-down list, choose the template that you want 
to edit. 
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 Note: You can modify only the templates under My templates. Only the site 
administrator can edit the Standard templates. 

2 Make your changes to the options in the template. 

3 Click Save as template  on the bottom of the Schedule an Event page. 

The Template name  text box displays the name of the template you 
chose. 

4 Click Save . 

5 Click OK in the confirmation message box. 
 

Specifying an event password 
While scheduling an event, you can set a password that participants must 
provide to access or view information about the event. 

To set an event password: 

1 On the Schedule an Event or Edit Event page, go to Basic Information. 

2 Type a password in the Event password box. 
  

 Note: An event password cannot contain space or double quotation marks (“”).  

3 Type the password again in the Confirm password box. 
 

Assigning your event to a program 
If you want to add your event to a program on your Event Center Web site, 
you can do so when scheduling the event. Attendees can register for all the 
events in a program at one time. 

To add an event to a program: 

1 On the Schedule an Event or Edit Event page, go to Basic Information. 

2 Choose a program in the Program drop-down list. 

A dialog box appears asking you to confirm adding this event to the 
program you just chose. 

3 Click OK to add the event to the program list. 
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This event is grouped with the program you selected and can be viewed 
on the List of Events by Program page on your Event Center Web site. 

To create a new program, click Add a new Program. For details, see 
Creating a program (on page 91). 

 

Specifying tracking codes for a scheduled event 
Your site administrator can specify that the tracking code options appear on 
the Schedule an Event page. Tracking codes can identify your department, 
project, or other information that your organization wants to associate with 
your events. Tracking codes can be optional or required, depending on how 
your site administrator sets them up. 

To specify tracking codes for a scheduled event: 

1 On the Schedule an Event or Edit Event page, go to Tracking codes, and 
then select a code label in the box. 

2 Do one of the following: 

 If a list of codes appear in the box, select a code from the list. 

 Type a code in the appropriate box. 

  
 

Tip: If your site administrator has also specified that the same tracking code options 
appear in your user profile, you can edit your user profile to specify the tracking codes. 
The codes then appear automatically on the Schedule an Event page. 

 

Reducing network bandwidth usage 
By selecting the option Optimize bandwidth usage for attendees within the 
same network, you can help reduce the network bandwidth consumption for 
joining the WebEx event. 

Example. If you are expecting a large number of attendees, and many of 
them come from the same network with limited bandwidth, you may want to 
select the option.  
  
 

Note:  
 The option works only if attendees join from computers running on Windows 2000, 



Chapter 2: Planning an Event 

 

58 

 

Windows Server 2003, Windows XP, and Windows Vista. 
 Your site administrator determines which hosts have the privilege of reducing 

bandwidth usage for their attendees.  
  

To reduce the network bandwidth consumption for joining your event: 

1 On the Schedule an Event or Edit Event page, go to Basic Information. 

2 At Optimize bandwidth usage for attendees within the same network, 
select Yes. 

 

Specifying date and time options 
 

If you want to ... See ... 

get an overview  of specifying the event t ime, 
duration, and time zones 

About specifying the event time, duration, and 
time zones (on page 58) 

specify the event time, duration, and time 
zones 

Specifying the event time, duration, and time 
zones (on page 59)  

allow  attendees to join the event before it 
starts 

Allowing attendees to join the event and 
teleconference early (on page 62)  

send an email reminder to the host before the 
event 

Sending an email reminder to the host before 
the event (on page 63)  

 

About specifying the event time, duration, and time zones 
You can specify the time at which you want to start the event, the estimated 
event duration, and the time zones in which you want to view the event. The 
estimated duration gives participants an idea as to how much time they need 
to reserve from their own schedules. 
 

Note:  
 The estimated duration is for your planning purposes only. An event does not end 

automatically after the estimated duration that you specify. 
 If you invite attendees to an event, their invitation email messages specify the 

event's starting time in the time zones that you specified. However, if attendees 
reside in a different time zone, they can choose to view the starting time in their time 
zones from the List of Events page on your Event Center Web site. 
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Specifying the event time, duration, and time zones 
When setting up and scheduling an event, you must specify the event time, 
duration, and time zone. 

1 On the Schedule an Event or Edit Event page, go to Date & Time . 

2 Do the following: 

 Next to Start date, in the drop-down lists, specify the month, day, and 
year at which you want to start the event. 

 Next to Start time , in the drop-down lists, specify the time at which you 
want to start the event. 

 Next to Estimated duration, in the drop-down lists, specify the event 
duration in hours and minutes. 

 Next to Time zones, in the drop-down list, choose a time zone in 
which you want to view the event. To specify more time zones, click 
Display more time zones. 

 

Planning and selecting event time zones 
If your event participants are located in different geographical regions, Event 
Center makes it easy for you to select a suitable time across up to four time 
zones. 
  
 

 

Click Plan event 
time zones to 
select a suitable 
time for your 
participants in 
different time zone. 
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The time zones you 
select w ill display 
on the scheduling 
page and, later, in 
invitation email 
messages. 

  

To select time zones and a suitable starting time: 

1 On the Schedule an Event or Edit Event page and at the Start time 
option, click Plan event time zones. 

2 Add or select time zones. 
  
 

 

 

  
 

 

 
This is the time zone your site administrator has designated for 
your Event Center Web site. To change it, do so at the Time 
zones option on the Schedule an Event or Edit Event page .  

 To add t ime zones, clic k . 

 Use the drop-dow n list to select a time zone. 

  

3 Optional. To save the time zones you selected here for future use, select 
Save participants time zones. 

4 Click Show Time . 

5 Select the most suitable time across the time zones you have selected. 

6 Click Select Time . 
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About time zones in invitation email messages 

Your invitation email messages include all the time zones, including the base 
time zone (your own time zone) you have selected when scheduling an event. 
  
 

 
 

The time zones you have selected in 
the scheduling page display in 
invitation email messages. The f irst 
time zone is your base time zone.  

 

If  an attendee has a designated time 
zone in the contact information, the 
designated t ime zone w ill replace 
your base time zone in the 
attendee's inv itation email message. 

Example. You have specif ied these 
time zones: San Francisco (base 
time zone), Taipei, Honolulu, and 
London. Attendee Johnson has 
"New  York" in his setting. Johnson 
w ill see this list of time zones in his 
invitation email message: 

 New  York 

 Taipei 

 Honolulu 

 London 

  
 

Note:  
 Attendees who have user accounts can designate time zones, languages, and 

locales in their profiles on the Event Center Web site. For more information, see 
About maintaining your user profile (on page 418). 
If those attendees are already contacts in your address book on the site, you can add them to 
your event inv itation list. Their language and t ime zone preferences w ill then display in their 
invitation email messages. For more information, see Adding existing contacts to your 
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invitation list (on page 26). 

 For attendees who are not yet contacts in your address book or do not have any pre-
defined preferences on the Event Center Web site, you can designate a time zone, 
language, and locale for each of them when scheduling an event. For more 
information, see Adding a new contact to your invitation list (on page 24). 

 You can change any attendees' information, including changing the time zone, 
language, or locale information, by editing the invitation list. For more information, 
see Editing an invitation list (on page 29). 

 

Allowing attendees to join the event and teleconference early 
When scheduling an event, you can choose to allow attendees to join the 
event and WebEx teleconference before the scheduled starting time. If 
attendees join an event before the starting time, you receive an email 
message notifying you that an attendee or panelist has joined your event. 
  
 

Tip: You can set up a presentation to inform or entertain the participants while they wait 
for the event to start. For details, see Sharing a presentation or document automatically 
(on page 50). 
  

To allow attendees to join the event and WebEx teleconference early: 

1 On the Schedule an Event or Edit Event page, go to Date & Time. 

2 Select the check box for Attendees can join X minutes before the 
scheduled start time , and then specify how early they can join the event. 

3 Optional. To allow attendees to join the WebEx teleconference once they 
join the event, select the check box for Attendees can also connect to 
WebEx teleconference . 

  
 

 Note: You can set up a presentation to inform or entertain the participants 
while they wait for the event to start. For details, see Sharing a presentation 
or document automatically (on page 50). 

4 Click Schedule This Event or Update. 
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Sending an email reminder to the host before the event 
You can send an email reminder to yourself, as the host, before the start of 
the event. 

To send an email reminder to the host: 

1 On the Schedule an Event or Edit Scheduled Event page, go to Date & 
Time. 

2 In the drop-down list next to Email reminder, choose how early you want 
the email to be sent before the event starts. 

If you do not want an email sent, select None  in the drop-down list. 
 

Specifying event descriptions and options 
  

If you want to ... See ... 

specify an event description Specifying an event description (on page 64)  

format an event description in HTML Formatting an event description (on page 64)  

upload an image that attendees can view  
from the Event Information page 

Adding an image to an event description (on 
page 64) 

let participants dow nload and cache f iles 
before the event starts  

Providing event material before an event (on 
page 65) 

specify a destination Web page (URL) that 
attendees see after the event has ended 

Specifying a destination URL after an event  
(on page 67)  

prevent attendees from sharing rich media 
f iles in the event 

Preventing event attendees from sharing rich 
media files (on page 67)  

request part icipants to verify that rich media 
players are installed on their computers 

Requesting participants to check their rich 
media players (on page 68)  

specify w hich participants can view  the 
attendee list 

Specifying whether to display attendee list to 
all participants (on page 68)  

include video in your event Selecting video options (on page 69)  

add a post-event survey Adding a post-event survey (on page 69) 
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Specifying an event description 
You can specify a description of the event, which attendees can view from the 
Event Information page before they join the event. 

To specify a description of the event: 

1 On the Schedule an Event or Edit Event page, go to Event Description & 
Options. 

2 In the Description text box, type a description of the event. 

To format the description in HTML code, see Formatting an event 
description (on page 64). 

 

Formatting an event description 
You can format an event description using HTML (Hypertext Markup 
Language) code. The description can include links to Web pages or images 
that reside on a publicly accessible Web server on the Internet, such as the 
server on which your organization’s Web site resides. 

If you use a Web page authoring program, you can create a formatted event 
description using that program and then copy its HTML code and paste it in 
the Description box. 
  
 

Tip: After you format an event description and finish scheduling the event, you can verify 
whether it appears correctly on the Event Information page. 

 

Adding an image to an event description 
You can add a picture to an event description. The picture appears on the 
Event Information page, which attendees can view before the event starts. 

The picture that you add must be a file that meets the following requirements: 

 the GIF or JPEG format 

 approximately 75 x 38pixels 

 less than 100 KB in size 
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To add a picture to an event description: 

1 On the Schedule an Event or Edit Event page, go to Event Description & 
Options. 

2 Next to Host image , click the link. 

The Upload Your Picture window appears. 
  
  

 

 
  

3 Click Browse . 

4 Select the file that you want to add to your event description. 

5 Click Upload. 

Event Center imports your picture and adds it to the Event Information 
page for the event. 

To replace a  picture that you added to an event description: 

Upload a different picture. 

Event Center overwrites the original picture with the new one. 
 

Providing event material before an event 
When scheduling an event, you can add Universal Communications Format 
(UCF) files to the Event Information page, from which attendees can 
download and cache the files on their own computers before the event starts. 
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Providing event material ahead of time especially benefits attendees with a 
slower Internet connection because caching files can significantly reduce the 
loading time during an event. 
  
 

Note: Before you can add event material to the Event Information page, you must first 
upload them to your personal folders in the My WebEx section of your Event Center Web 
site. For more information, see Maintaining files in your personal folders (on page 381). 
  

To add event material to the Event Information page: 

1 On the Schedule an Event or Edit Event page, go to Event Description & 
Options, and then next to Event material, click the link for uploading 
event material. 

The page that appears displays the files or folders stored in your personal 
folders in the My WebEx section of your Event Center Web site. For 
details, see About the Add Event Material page (on page 66). 

2 If you have not uploaded the files to your personal folders, click Browse  to 
select the file, and then click Upload. 

You can upload one file at a time. 

3 Select the radio button next to the folder that contains the files you want to 
add to the Event Information page. 

The files in the selected folder appear. 

4 Select the check boxes for the files you want to add to the Event 
Information page, and then click Add. 

The files you have added appear in the Event material section. 

5 Optional. Type descriptions of the files in the Description text boxes. 
 

About the Add Event Material page 

What you can do on this page 

 Select files already in your personal folders on the Event Center Web site 
to publish to the Event Information page. 

 Upload new files to your personal folders on the Event Center Web site 
and then publish them to the Event Information page. 
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Attendees can download event material for review before the event starts. 

Options on this page 

 

Option Description 

File name box Type the name of the f ile to upload to your folder. 

Browse button Click to select a UCF presentation or document that resides in your 
personal folders. 

Upload button Click to upload the specif ied f ile to your folder. 

Select Select the check box for the f ile to be added to the event. 

Name Indicates the names of the f iles residing in your folder. 

Description Describes the folder or f ile. 

Size Indicates the size of the folder or f ile in kilobytes. 

Add button Click to publish the specif ied f ile on the Event Information page on 
your Event Center Web site, making it available to attendees prior to 
the event start ing time. 

 

Specifying a destination URL after an event 
When scheduling an event, you can specify a destination Web page or Web 
site that displays once the event ends. 

To specify a destination URL: 

1 On the Schedule an Event or Edit Event page, go to Event Description & 
Options. 

2 Type a destination Web site address (URL) in the Destination URL after 
event box. 

 

Preventing event attendees from sharing rich media files 
Event Center, by default, allows attendees to share Universal 
Communications Format (UCF) files in an event. When scheduling an event, 
you can specify to turn off this function for the event. 
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To prevent attendees from sharing rich media files in the event: 

1 On the Schedule an Event page, go to Event Description & Options > 
Other UCF options. 

2 Select Do not allow attendees to share rich media files for this event, 
and then click Schedule This Event. 

 

Requesting participants to check their rich media players 
If you plan to show Universal Communications Format (UCF) multimedia 
presentations in the event, you can request participants to verify that rich 
media players are installed on their computers before they join the event. The 
invitation email messages to invited participants contain this request. 

To request participants to verify their media players: 

1 On the Schedule an Event page, go to Event Description & Options > 
Other UCF options. 

2 Select Request attendees to verify rich media players, and then click 
Schedule This Event. 

 

Specifying whether to display attendee list to all participants 
When scheduling an event, you can specify which event participants can view 
the entire list of attendees during the event. 

To specify who can view the attendee list: 

1 On the Schedule an Event or Edit Scheduled Event page, go to Event 
Description & Options. 

2 Next to Attendee list viewing, select one of the following: 

 All—Allows each event attendee to view a list of all attendees during 
the event. 

 Host, presenter, and panelists only—Allows only the event host, 
presenter, and panelists to view the entire list of attendees. Besides 
their own names, attendees can view only the names of the host, 
presenter, and panelists in the participant list. 

  
 

Tip: Each time an attendee joins or leaves an event, the attendee list gets updated. 
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Thus, for events with a large number of attendees, selecting Host, presenter, and 
panelists only can greatly improve the performance of the Event Center application for 
attendees during an event. 

 
 

Selecting video options 
You can choose to make video available during the event. Only the host and 
panelists can send and receive video. Attendees can only view video that is 
being sent. 
  

Note: The video feature will only be available if it has been turned on by your site 
administrator. 

 

To select video options: 

1 On the Schedule an Event or Edit Event page, go to Event Description & 
Options. 

2 In the Video section, select Turn on video to make video available during 
the event. 

3 Select View high-quality video if would like high-quality video to be 
available during the event. 

Video can be as high as 360p resolution (640x360). However, the quality 
of the video that participants can send and receive depends on each 
participant's webcam and computer capability, and network speed. 

4 Select View thumbnails if would like display thumbnail views of those 
sending video. 

5 Click Schedule This Event or Update . 

  
 

Adding a post-event survey 
When creating a survey, you can do the following: 

 add text, multiple-answer, and single-answer questions 

 add images 
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 save the survey as a template for future use 

The survey that you add will display on attendees’ screens once the event 
ends. 

To view survey results, you can generate an Event Center attendance report, 
attendee history report, or event recording report from the My WebEx Reports 
page in My WebEx. For details, see Generating reports (on page 430). 

To create a post-event survey and add it to an event: 

1 On the Schedule an Event or Edit Scheduled Event page, go to Event 
Description & Options. 

2 Do one of the following: 

 If this is the first time you create a post-event survey on your Event 
Center Web site, click Create post-event survey. 

 If you saved surveys as templates before, click Select survey. On the 
window that appears, click Create New Survey. 

3 Type a survey topic and introductory text. 

4 Optional. Click Add to add a header or footer image. 

For detailed instructions, see About the Upload or Select Image window 
(on page 71). 

5 To add survey questions, click Text Box, Check Boxes, Option Buttons, 
Drop-Down List, or My Survey Questions. 

For detailed instructions, see About the Add Text Box window (on page 
15), About the Add Check Boxes window (on page 17), About the Add 
Option Buttons window (on page 18), and About the Add Drop-Down List 
window (on page 19). 

6 Do one of the following: 

 To save the survey for this event, click Save . 

 To save the survey as a template for future use and also save it for this 
event, click Save As Template . Provide a template name for this 
survey or save it to an existing template, and then click Save . 

7 Click OK - Use This Survey. 

8 On the Schedule an Event or Edit Scheduled Event page and in the Post-
event survey section, select one of these: 

 Display survey in pop-up window—Specifies that this survey will 
display in a separate window 
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 Display survey in main browser window (instead of destination 
URL)—Specifies that this survey will display in the main window 

  
 

Note: If you select Display survey in main browser window (instead of destination 
URL) and also specify a destination URL that displays after the event, the destination 
page will not display after the event. 

 

About the Upload or Select Image window 

How to access this window 

If you are creating or editing a post-event survey, do the following: 

In the Create Survey or Edit Survey: [survey topic] window, click Add next to 
Header image or Footer image. 

If you are editing an email template, do the following: 

In the Edit Event Email: [template name] window, click Add next to Header 
image or Footer image. 

What you can do in this window 

You can upload or select an image for the selected survey or email template. 

Options in this window 

 

Use this option ...  To ...  

 
Upload a new  image to your image library. From the 
image library, you can add images to the selected 
survey or email template. 

 
Add an image to the selected survey or email template. 
Ensure to select an image before you click Add. 

 
Remove an image from the image library. 
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Specifying other options for attendees 
 

If you want to ... See ... 

invite attendees to an event Inviting participants to your event  (on page 
22) 

allow  registrants to invite friends to the event Allowing registrants to invite friends (on page 
72) 

specify a maximum number of registrations 
for the event 

Specifying a maximum number of registrants 
(on page 72)  

 

Allowing registrants to invite friends 
When scheduling an event, you can specify that registrants can invite their 
friends to your event. 

To allow registrants to invite friends: 

1 On the Schedule an Event or Edit Event page, go to Attendees & 
Registration. 

2 Select the check box next to Invite friends. 
 

Specifying a maximum number of registrants 
When scheduling an event, you can specify a maximum number of people 
who can register for your event. When the maximum number of registrants is 
reached, the last registrant receives a message that the maximum number of 
registrants has been met. 

To specify a maximum number of registrants: 

1 On the Schedule an Event page or Edit Event page, go to Attendees & 
Registration. 

2 Type a number in the Maximum number of registrants box. 
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Specifying options for presenters & panelists 
 

If you want to ... See ... 

invite panelists to an event Creating an invitation list and inviting 
panelists to your event  (on page 28)  

allow  panelists to upload f iles to your Event 
Information page 

Allowing panelists to upload documents (on 
page 73) 

 

Allowing panelists to upload documents 
When scheduling an event, you can specify that panelists can provide you 
with documents or presentations by uploading them from the Panelist 
Entrance page. The files uploaded by panelists appear on your Event 
Information page and your personal folders on your Event Center Web site. 
You can then download or organize the files before you start the event. 

To allow panelists to upload documents: 

1 On the Schedule an Event or Edit Event page, go to Presenters & 
Panelists. 

2 Select the check box for Allow panelists to upload documents 
associated with the event. 

Viewing or accessing the files uploaded by panelists 

Before starting the event, you can view, download, or organize the files 
uploaded by panelists. 

To view or access the files uploaded by panelists: 

1 Log in to your Event Center Web site. 

2 Go to either of the following pages: 

 the My WebEx Files page by going to My WebEx > My Files > 
Folders 

 the Event files section on the Event Information page 
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C h a pt er  3 

To schedule, start, edit, or cancel your events, you must have a host account 
on your Event Center Web site. 
  

If you want to ... See ... 

schedule an event Scheduling an event (on page 75)  

start an event Starting an event (on page 76)  

edit a scheduled event Editing a scheduled event (on page 77)  

cancel a scheduled event Canceling a scheduled event  (on page 79) 

 

Scheduling an event 
The Schedule an Event page on your Event Center Web site lets you plan 
and schedule an online event according to your needs. 

For more information about specifying event details on the Schedule an Event 
page, see Planning an Event (on page 7). 

To schedule an event: 

1 Log in to your Event Center Web site. 

2 On the navigation bar, click Host an Event > Schedule an Event. 

Scheduling, Editing, 
Canceling, and Starting an 
Event 
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The Schedule an Event page appears. 

3 Planning the event on the page, such as creating invitation lists, 
customizing the registration form, creating a post-event survey, and so on. 
For details, see Planning an Event on page 9. 

4 Once you finish specifying all the details on the Schedule an Event page, 
click Schedule This Event. 

5 On the Send Event Emails page, select the recipients of the invitation 
email message, and then click Send Now. 

  
 

 Note: Clicking Send Later takes you to the Event Information page, on whcih you 
can send event updates email messages at a later time. 

 

  

6 Click OK and Continue  on the messages that appear on your screen. 

The Event Information page appears. You also receive a confirmation email 
message that includes information about the scheduled event. 
  
 

Note: The Event Information page displays the event addresses for attendees and 
panelists respectively. You can copy and paste the URLs in your own invitation email 
messages if you do not plan to use the WebEx automated email system. 

 
 

Starting an event 
  

If you want to ... See ... 

get an overview  of starting an event About starting an event (on page 77)  

start an event from your My WebEx page Starting an event from My WebEx  (on page 
77) 
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About starting an event 
Events do not start automatically at scheduled times. Unless you specify that 
attendees can join before the host, you must first start an event before 
attendees can join it. For more information, see Allowing attendees to join the 
event and teleconference early (on page 62). 

Once you schedule an event, you receive a confirmation email message that 
includes a link that you can click to start the event. You can also start the 
event from My WebEx on your Event Center Web site. 

 

Starting an event from My WebEx 
You can start your event from the My WebEx page on your Event Center Web 
site. 

To start an event from the My WebEx page: 

1 Log in to your Event Center Web site. 

2 Click My WebEx > My Meetings. 

The My WebEx Meetings page appears. 

3 Find the event that you want to start, and then click Start. 

The Event window appears. 

If the event includes an integrated teleconference, the Join 
Teleconference dialog box appears. Follow the instructions in the dialog 
box to start the teleconference. 

 

Editing a scheduled event 
  

If you want to... See... 

get an overview  of modifying a scheduled 
event 

About editing a scheduled event  (on page 
78) 

modify a scheduled event from your My 
WebEx page 

Editing a scheduled event from My WebEx  
(on page 78)  
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About editing a scheduled event 
Once you schedule an event, you can edit it at any time before you start it, 
including its starting time, topic, password, agenda, invitation lists, and many 
other options. 

If you update any information about an event, including adding or removing 
attendees, you can choose to send attendees a new invitation email message 
that informs them that you have modified information about the event. 
Attendees whom you removed from the attendee list receive an email 
message informing them that the event was cancelled. 

You can edit an event from the confirmation email message that you received 
after you scheduled the event, or from My WebEx on your Event Center Web 
site. 

 

Editing a scheduled event from My WebEx 
You can edit a scheduled event from My WebEx on your Event Center Web 
site and send event updates email messages to participants. 

To edit a scheduled event from My WebEx: 

1 Log in to your Event Center Web site. 

2 Click My WebEx > My Meetings. 

The My WebEx Meetings page appears. 

3 In the Topic column, click the topic for the event. 

The Event Information page appears. 

4 Click Edit Event. 

The Edit Event page appears. 

5 Make your changes. 

For details about the options on this page, see Planning an Event (on 
page 7). 

6 To apply your changes to the event, click Update This Event. 

7 On the Send Event Emails page, select the recipients of the event updates 
email message. If you added participants to your invitation list, you can 
also send them invitation email messages with the latest event information 
from this page. 
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8 Click Send Now, and then click OK and Continue  on the messages that 
appear on your screen. 

  
 

Note: Clicking Send Later takes you to the Event Information page, on which you can 
send event updates email messages at a later time. 

 
 

Canceling a scheduled event 
  

If you want to ... See ... 

get an overview  of canceling a scheduled 
event 

About canceling a scheduled event (on page 
79) 

cancel a scheduled event  Canceling a scheduled event (on page 79)  

 

About canceling a scheduled event 
You can cancel an event that you scheduled at any time. As you are 
canceling an event, you have the option of sending automatic cancellation 
email messages to the event participants. 

 

Canceling a scheduled event 
Cancel a scheduled event from My WebEx on your Event Center Web site. 

To cancel an event you scheduled: 

1 Log in to your Event Center Web site. 

2 Click My WebEx > My Meetings. 

The My WebEx Meetings page appears. 

3 In the Topic column, find the event you want to cancel, select the check 
box next to it, and then click Delete . 

4 Click OK in the message box to confirm that you want to delete the event. 
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A message box appears, allowing you to send email messages about this 
cancellation. 

5 Do one of the following, as appropriate: 

 If you want to notify all invited participants, including attendees and 
panelists, click Yes. 

You also will receive a confirmation email message about this 
cancellation. 

 If you do not want to send a cancellation email message, click No. 

 If you do not want to cancel this event, click Cancel. 
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If you want to... See... 

Get an overview  of MeetingPlace 
Personal Conference meetings 

About MeetingPlace Personal Conference meetings (on 
page 82) 

Set up a MeetingPlace Personal 
Conference meeting 

Setting up a Personal Conference meeting or 
MeetingPlace Personal Conference meeting (on page 
82) 

Add a MeetingPlace Personal 
Conference meeting to your 
calendar  

Adding a scheduled Personal Conference meeting or 
MeetingPlace Personal Conference meeting to your 
calendar program (on page 83)  

Make changes to the 
MeetingPlace Personal 
Conference meeting you have 
scheduled 

Editing a Personal Conference meeting or MeetingPlace 
Personal Conference meeting (on page 84)  

Start your MeetingPlace Personal 
Conference meeting 

Starting a MeetingPlace Personal Conference meeting  
(on page 87)  

Cancel your MeetingPlace 
Personal Conference meeting 

Canceling a Personal Conference Meeting or 
MeetingPlace Personal Conference meeting (on page 
87) 

 

Scheduling a MeetingPlace 
Personal Conference 
meeting 
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About MeetingPlace Personal Conference 
meetings 

A MeetingPlace Personal Conference meeting uses your Cisco Unified 
MeetingPlace audio conferencing account for the audio conference, and does 
not have an online portion for the meeting. MeetingPlace Personal 
Conference meetings are only available if your site supports Cisco Unified 
MeetingPlace audio conferencing and MeetingPlace Personal Conferencing. 

 

Setting up a Personal Conference meeting or MeetingPlace 
Personal Conference meeting 

To set up a Personal Conference meeting or MeetingPlace Personal 
Conference meeting: 

1 Log in to your Event Center website. 

2 On the left navigation bar, select Schedule an Event. 

3 Select Advanced Scheduler. 

The Advanced Scheduler displays. 

4 On the Required Information page, for Meeting type , select Personal 
Conference  or MeetingPlace Personal Conference . 

5 Enter the requested information. 
  

 Note: If you are scheduling a Personal Conference meeting, you do not need to 
specify a password. By default, the password is the attendee access code in your 
Personal Conference number account that is specified for this meeting. If you are 
scheduling a MeetingPlace Personal Conference, you do need to specify a 
password 

 

For an overview of this page and the information requested, select the 
Help button in the upper-right corner of the page. 
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6 Schedule your event now, or add more details. 

 To schedule your event with these details, select Schedule Event 

 To add more options, select Next or select another page in the 
scheduler. After you have added the details you need, select 
Schedule Event. 

 

Adding a scheduled Personal Conference meeting or 
MeetingPlace Personal Conference meeting to your calendar 
program 

Once you schedule a Personal Conference meeting or MeetingPlace 
Personal Conference meeting, you can add the Personal Conference meeting 
or MeetingPlace Personal Conference meeting to your calendar program, 
such as Microsoft Outlook. This option is applicable only if your calendar 
program supports the iCalendar standard, a common format for exchanging 
calendaring and scheduling information across the Internet. 

To add a scheduled Personal Conference meeting or MeetingPlace Personal 
Conference meeting to your calendar 

1 Choose either method: 

 On the Personal Conference Meeting Scheduled page or the Personal 
Conference Meeting Information page, select Add to My Calendar. 

 In the confirmation email message that you receive once you schedule 
or edit a Personal Conference meeting or MeetingPlace Personal 
Conference meeting, click the link to add the meeting to your calendar. 

A meeting opens in your calendar program. 
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2 Select the option to accept the meeting request. For example, in Outlook, 
select Accept to add the Personal Conference event item to your 
calendar. 

  

Note:  
 If you cancel a Personal Conference meeting or MeetingPlace Personal Conference 

meeting, the Personal Conference Meeting Deleted confirmation page and the 
confirmation email message that you receive contains an option that lets you remove 
the meeting from your calendar program. 

 If you invite participants to a Personal Conference meeting or MeetingPlace 
Personal Conference meeting, the invitation email message that they receive also 
contains an option to add the meeting to their calendar programs. 

 

Editing a Personal Conference meeting or MeetingPlace 
Personal Conference meeting 

Once you a schedule a Personal Conference meeting or MeetingPlace 
Personal Conference meeting, you can make changes to it at any time before 
you start it—including its starting time, topic, agenda, attendee list, and so on. 

If you update any information about the Personal Conference meeting or 
MeetingPlace Personal Conference meeting, including adding or removing 
attendees, you can choose to send attendees a new invitation email message 
containing the new details about the meeting. Attendees removed from the 
attendee list receive an email message letting them know that they are no 
longer asked to attend. 

If you are logged in, you can edit the meeting details by clicking the link in the 
confirmation email message that you received after you scheduled the 
Personal Conference meeting or MeetingPlace Personal Conference meeting, 
or from your list of events in My WebEx. 

To edit Personal Conference meeting or MeetingPlace Personal Conference 
meeting from the confirmation email message: 

1 Open your confirmation email message, and then click the link to view 
your Personal Conference meeting information. 

The Personal Conference Meeting Information page appears. 

2 Select Edit. 

3 Make changes to the Personal Conference meeting  details. 
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For details about the information requested on any page, click the Help 
button in the upper-right corner of the page. 

4 To save your changes to the meeting, select Save . 

If you invited attendees, a message appears, asking you whether you 
want to send an updated email invitation to attendees. 

5 If a message box appears, click the appropriate update option, and then 
select OK. 

The Personal Conference Meeting Information page appears. 

You receive a confirmation email message that includes information about 
the changes that you made to the meeting. 

6 Optional. If you added the meeting to your calendar program, such as 
Microsoft Outlook, on the Event Updated page, select Add to My 
Calendar. 

To edit a Personal Conference meeting or MeetingPlace Personal Conference 
meeting from your list of events on your Event Center Web site: 

1 Log in to your Event Center website. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any events that you 
have scheduled. Personal Conference events have "Personal Conference" 
in the Type column. 

3 In the list of events, under Topic, click the topic for the event. or click the 
Display Info link. 

4 Select Edit. 

5 Make changes to the Personal Conference meeting details. 

For details about the options on each page, click the Help button in the 
upper-right corner of the page. 

6 Select Save . 

If you invited attendees, a message appears, asking you whether you 
want to send an updated email invitation to attendees. 

7 If a message box appears, click the appropriate update option, and then 
click OK. 

If you select Cancel in the message box, the Personal Conference 
meeting is not updated. 
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8 Optional. If you added the meeting to your calendar program, such as 
Microsoft Outlook, in the confirmation email message, click the Update My 
Calendar link. 

 

Starting a MeetingPlace Personal Conference meeting 
Personal Conference events do not start automatically at scheduled times. 
You must start the audio portion of the Personal Conference first, and then 
you can start the online portion of the Personal Conference.  

To start a MeetingPlace Personal Conference meeting: 

Call the number listed in the confirmation email or on the Personal 
Conference Event Information page.  

To access the MeetingPlace Personal Conference Meeting Information page: 

1 Log in to your Event Center service site. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any events that you 
have scheduled. Personal Conference meetings are listed as "Personal 
Conference" in the Type column. 

3 In the list of events, select the Topic or Display Info link for your Personal 
Conference event. 

The Personal Conference Event Information page displays. 

4 If necessary, select the More Info link to display all the information about 
the event. 

Under Audio conference, look for the valid phone number or numbers to call 
for your MeetingPlace Personal Conference event, as well as other 
information you need to start the meeting.You may need to click the Show 
detailed dial-in information link. 
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Canceling a Personal Conference Meeting or MeetingPlace 
Personal Conference meeting 

You can cancel any Personal Conference meeting or MeetingPlace Personal 
Conference meeting you have scheduled. Once you cancel a meeting, you 
can choose to send a cancellation email message to all attendees whom you 
invited to the meeting. The Personal Conference meeting is removed 
automatically from your list of events in My WebEx. 

If you are logged in, you can cancel a Personal Conference meeting or 
MeetingPlace Personal Conference meeting from the confirmation email 
message that you received after you scheduled the meeting or from your list 
of events in My WebEx. 

To cancel a Personal Conference meeting or MeetingPlace Personal 
Conference meeting from a confirmation email message: 

1 Open your confirmation email message, and then click the link to view 
your Personal Conference meeting information. 

The Personal Conference Meeting Information page appears. 

2 Select Delete . 

If you invited attendees, a message appears, asking you whether you 
want to send a cancellation email message to all attendees whom you 
invited to the event. 

3 In the message box, click Yes or No, as appropriate. 

If you click Cancel in the message box, the meeting is not canceled. 

The Personal Conference Meeting Deleted page appears. 

4 Optional. If you added the Personal Conference meeting to your calendar 
program, such as Microsoft Outlook, on the Personal Conference Meeting 
Deleted page, click Remove From My Calendar to remove the meeting 
from your calendar. 

To cancel a Personal Conference meeting or MeetingPlace Personal 
Conference meeting on your Event Center website: 

1 Log in to your Event Center website. 

2 On the navigation bar, select My WebEx. 
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The My Meetings page appears, showing a list of any events that you 
have scheduled. Personal Conference meetings are indicated by the 
words "Personal Conference" in the Type column. 

3 In the list of events, under Topic, click the topic for your Personal 
Conference meeting. 

4 Select Delete . 

If you invited attendees, a message appears, asking you whether you 
want to send a cancellation email message to all attendees whom you 
invited to the Personal Conference meeting or MeetingPlace Personal 
Conference meeting. 

5 In the message box, click Yes or No, as appropriate. 

If you click Cancel in the message box, the meeting is not canceled. 

You receive a cancellation confirmation email message. 

6 Optional. If you added the Personal Conference meeting or MeetingPlace 
Personal Conference meeting to your calendar program, such as Microsoft 
Outlook, on the Personal Conference Meeting Deleted page, select 
Remove From My Calendar to remove the meeting from your calendar. 

 

About the Personal Conference Meeting 
Information page (host) 

This page provides the details about the Personal Conference meeting or 
MeetingPlace Personal Conference meeting you have scheduled. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about the 
Personal Conference event. 

 Click the More Info link to view the meeting number, audio conference 
information, and meeting password. This information can help you start 
the audio portion of the Personal Conference event. 

 Edit the details about the Personal Conference meeting or MeetingPlace 
Personal Conference meeting. 

 Cancel the he Personal Conference meeting or MeetingPlace Personal 
Conference meeting. 



 Chapter 4: Scheduling a MeetingPlace Personal Conference meeting 

 

89 

 

 Add the he Personal Conference meeting or MeetingPlace Personal 
Conference meeting to your calendar, if you haven’t already done so. 

 Start the online portion of the Personal Conference after the audio portion 
has started. (Does not apply to MeetingPlace Personal Conference 
meetings.)  

  

Select this button… To… 

Edit Edit the details about the Personal Conference meeting or 
MeetingPlace Personal Conference meeting. For example, you can 
add attendees, change the Personal Conference number account for 
this event, or change the date, time, and duration. 

Delete Cancel the meeting. 

Add to My Calendar Add this Personal Conference meeting or MeetingPlace Personal 
Conference meeting to a calendar program, such as Microsoft 
Outlook. 

To use this feature, your calendar program must conform w ith the 
iCalendar standard, a format used w idely across the Internet for 
exchanging calendar information.  

Go Back  Return to the event calendar. 

Start Start the online port ion of the Personal Conference meeting. This 
button is only available after you have started the audio portion of the 
Personal Conference meeting. (Does not apply to MeetingPlace 
Personal Conference meetings.) 

 

About the Personal Conference Meeting 
Information page (for attendees) 

This page provides the details about Personal Conference meeting or 
MeetingPlace Personal Conference meeting. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about 
thePersonal Conference meeting or MeetingPlace Personal Conference 
meeting.  

 Click the More Info link to see the meeting number, audio conference 
information, and meeting password. This information can help you join the 
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audio portion of the Personal Conference event or the MeetingPlace audio 
conference. 

 Add the meeting to your calendar, if you haven’t already done so 

 Join the online portion of the Personal Conference after the audio portion 
has started. (Does not apply to MeetingPlace Personal Conference 
meetings.)  

Options on this page 

  

Click this button... To... 

View Agenda View  Personal Conference meeting or MeetingPlace Personal 
Conference meeting agenda, if  the host has provided it.  

Add to My Calendar Add Personal Conference meeting or MeetingPlace Personal 
Conference meeting to a calendar program, such as Microsoft 
Outlook. 

To use this feature, your calendar program must conform w ith the 
iCalendar standard, a format used w idely across the Internet for 
exchanging calendar information. 

Go Back  Return to the event calendar. 

Join Once the audio portion of the Personal Conference meeting has 
started, you can select Join to join the online portion of the 
Personal Conference meeting. (Does not apply to MeetingPlace 
Personal Conference meetings.) 
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If you want to... See... 

get an overview  of managing programs  About managing programs (on page 91)  

create a program Creating a program (on page 91)  

 

About managing programs 
For hosts only 

Event Center allows you to group live or recorded events in a program for a 
specific project, product, or audience. A program allows attendees to 
conveniently register for all its events at one time. All the events in a program 
share the same registration form. 

You can modify the programs you created on your Event Center Web site at 
any time. 

 

Creating a program 
 

If  you w ant to ... See...  

get an overview  of creating a program About creating a program (on page 92)  

create a program Creating a program (on page 92)  

obtain the program Web address, or URL Obtaining event, program, and recording 
URLs (on page 93)  

Managing Programs 
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If you w ant to ... See...  

add live events to a program Adding live events to a program (on page 97)  

add recorded events to a program Adding recorded events to a program (on 
page 98) 

view , modify, or delete a program Viewing, modifying, and deleting a program 
(on page 98)  

 

About creating a program 
You can create a program to group related events for a specific project, 
product, or audience. After you add events to a program, you can obtain the 
URL of the program from the program information page and invite participants 
to register for the associated events by sending them the URL. 

 

Creating a program 
You can create a program to group your live or recorded events. 

To create a program: 

1 Do any of the following: 

 On the left navigation bar, click Manage Programs > Create New 
Program. 

 On the Schedule an Event page or Edit Event page, under Event Time 
and Duration, click New program. 

The event that you are scheduling or editing is automatically added to 
this new program. 

 On the navigation bar, click Manage Programs > List of Programs > 
New program. 

The Create a program page appears. 

2 Specify the options on the page, and then click Create program. 

For details about the options you can specify for a program, see About the 
Create a program page (on page 95). 

3 If you created the new program from the Schedule an Event or Edit Event 
page, click OK in the message box, informing you that adding this event 
changes its registration options to be the same as those of the program. 
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This program displays on the Manage Programs page. 
 

Obtaining event, program, and recording URLs 
After you schedule an event, create a program, or upload a recording to your 
Event Center Web site, URLs, or event addresses, for the event, program, or 
recording display on the information page. You can invite attendees and 
panelists to an event or events in a program by sending them the appropriate 
URLs. 

If you want to manually add a source ID for an event, a program, or an event 
recording, obtain the attendee URL and then publish the URL with the ID in 
your email messages. For more information, see Manually appending a 
source ID to your URL (on page 102). 

To obtain an event URL: 

Go to the Event Information page by using one of these methods: 

 Go to My WebEx > My Meetings; then click the name of the event in the 
Topic column. 

 Obtain it after you schedule an event. 

To associate source IDs, use the event address for attendees. 
  
 

 
  

To obtain a program URL: 

1 On the left navigation bar of your Event Center Web site, click Manage 
Programs > List of Programs.  
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2 Go to the program page by clicking the name of the program in the Topic 
column. 

The URL is on the page. 
  

 

  

To obtain a recording URL: 

1 On the left navigation bar of your Event Center Web site, click Host an 
Event > My Event Recordings.  
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2 Go to the Recording Information page by clicking the name of the 
recording in the Topic column. 

The URL is on the page. 
  

 

 

 
 

About the Create a program page 

How to access this page 

Do any of the following: 

 On the left navigation bar, click Manage Programs > Create New 
Program. 

 On the Schedule an Event page or Edit Event page, under Event Time 
and Duration, click New program. 
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 The event that you are scheduling or editing is automatically added to this 
new program. 

 On the navigation bar, click Manage Programs > List of Programs > 
New program. 

What you can do on this page 

 Specify the program details. 

 Specify the registration options. 

 Customize the program information page using the HTML code. 

Options on this page 

  

Use this option .... To .... 

Program name Type the t itle of the program. 

Description Type a description for the program. 

Note You can format the description using the HTML code. 

Expected registration Specify the expected number of registrants. 

Budget Specify the budget for the program. 

Email  Type the host’s email address. 

Program status Specify w hether the program is Listed or Unlisted. 

A Listed program appears on the List of Events by Program 
page for anyone w ho visits your Event Center Web s ite. 

An Unlisted program does not appear on the List of Events by 
Program page. Attendees can view  the upcoming events in the 
program if you send them the URL for the program. 

Registration ID required Specify w hether attendees must register before they can join 
the events in the program. 

Password required to 
register 

Specify w hether to require a passw ord before an attendee can 
register for the events in the program. 

Customize registration 
form 

Customize the registration form by clicking Customize. 

The w ay you customize a program registration form is the same 
as you w ould an event registration form. For details, see  

Note All events in a program share the same registration form. 
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Use this option .... To .... 

Invite friends Allow  registrants to invite their friends to the events in the 
program. 

Destination URL after 
registration 

Specify a Web address, or URL, that displays once an attendee 
f inishes registering for an event in the program. 

Images Upload photos that you w ant to show  on the program 
information page. 

Note After uploading the images, you reference to those images 
from the Custom HTML Area section. 

Custom HTML Area 

 
Format this area using the HTML code, including referencing to 
the images you upload in the Images  section. 

Use the drop-dow n list to place this customized area above or 
below  the tit le of the program. 

 

Adding live events to a program 
You can add events to a program from either of the following pages: 

 the Schedule an Event page or Edit Event page 

 the Manage Programs page 

To add a live event to a program when scheduling or editing the event: 

1 On the Schedule an Event page or Edit Event page, under Event Time 
and Duration, choose a program in the Program drop-down list. 

2 Click OK in the message box, informing you that adding this event 
changes its registration options to be the same with those of the program. 

To add a live event to a program from the Manage Programs page: 

1 On the navigation bar, expand Manage Programs, and then click List of 
Programs. 

The Manage Programs page appears. 

2 In the Topic column, click the title of the program to which you want to add 
an event. 

3 Do one of the following: 

 If you have already scheduled the event that you want to add to the 
program, click the Add other events to this program link. 
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The window that appears lists the events you have scheduled. 

Select the event that you want to add to the program, and then click 
Add. Click OK in the message box, informing you that adding this 
event changes its registration options to be the same with those of the 
program. Then click Continue . 

 If you have not scheduled the event that you want to add to the 
program, click New event to schedule the event and add it to the 
program at the same time. 

For details about scheduling an event, see Planning an Event (on page 
7). 

  
 

Note: All events in a program share the same registration form. Attendees can choose to 
register for all the events in a program at one time. 

 

Adding recorded events to a program 
If you have recorded events that you hosted, you can add them to a program. 

To add a recorded event to a program: 

1 On the navigation bar, expand Manage Programs, and then click List of 
Programs. 

The Manage Programs page appears. 

2 In the Topic column, click the title of the program to which you want to add 
a recorded event. 

3 Click the Add other recordings to this program link. 

4 In the window that appears, select the recordings that you want to add to 
the program, and then click Add. 

5 Click Continue  in the window that appears. 
 

Viewing, modifying, and deleting a program 
Your Event Center Web site displays all the programs that you and the other 
hosts created on the Manage Programs page. You can view a program and 
add events or recordings to it at any time. 
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Note: You cannot modify or delete the programs the other hosts created. 
  

To obtain information about a program: 

1 On the navigation bar, expand Manage Programs, and then click List of 
Programs. 

The Manage Programs page appears. 

2 In the Topic column, click the title of the program that you want to view. 

The program information page appears. 

To modify a program: 

1 On the navigation bar, expand Manage Programs, and then click List of 
Programs. 

The Manage Programs page appears. 
  
 

 Note: The programs you created have check boxes next to them.  
  

2 In the Topic column, click the title of the program that you want to modify. 

3 Click Edit program. 

The Edit a program page appears. 

4 Make your changes, and then click Update program. 

You receive an automatic email message about this update. 

To delete a program you created: 

1 On the navigation bar, expand Manage Programs, and then click List of 
Programs. 

The Manage Programs page appears. 
  
 

 Note: The programs you created have check boxes next to them.  
  

2 Select the check box for the program you want to delete. 
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3 Click Delete . 

4 Click OK to confirm the deletion. 

The Program Deleted page appears. 
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C h a pt er  6 

 

If you want to ... See ... 

get an overview  of how  to use source IDs to 
track your attendees  

About tracking your attendees (on page 101)  

manually append a source ID to your event 
URL 

Manually appending a source ID to your 
event URL (on page 102) 

add a source ID for an email vendor from the 
Event Information page 

Associating a source ID with a vendor (on 
page 105)  

 

About tracking your attendees 
Event Center allows you to gauge the effectiveness of the different methods 
you use to market your events by tracking from which sources attendees join 
or register for an event and view a recording. 

To track your attendees, you add a source ID to the end of the URL in your 
email messages for: 

 live events 

 programs (Event Center captures source IDs for a program and each live 
event in the program.) 

 event recordings 

Tracking Your Attendees 
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Example. You use vendors to promote your events. You can assign a source 
ID for each vendor that will send invitation or recording email messages for 
you. Event Center captures the source ID when an attendee clicks the URL 
link in the event, program, or recording email messages from a particular 
vendor. 

You or your site administrator can then generate an attendance, a 
registration, or a recording report that shows each attendee’s source ID. You 
can compare and analyze which marketing method is more effective than 
another. 

There are two ways of appending a source ID to an event, a program, or a 
recording URL: 

 Manually append a source ID by adding &SourceId= to the event URL, 
and publish this new URL in your email messages. 

 Associate a source ID with a vendor’s email address, if you use vendors to 
forward your email messages to potential attendees. 

 

Manually appending a source ID to your URL 
You can manually append a source ID to your event, program, or recording 
URL. For details about obtaining such URLs, see Obtaining event, program, 
and recording URLs (on page 93). 

To manually append a source ID to an event, a program, or a recording URL: 

1 Obtain the attendee URL. 

2 Add &SourceId=xxx at the end of the URL, and then publish it in your 
email message. 

Example. An event URL with a source ID can be 
https://[eventURL]&SourceId=CompanyWebsite or 
https://[eventURL]&SourceId=anynumber 
  
 

Note: You can specify up to 512 characters, in either letters or numbers, for a source ID. 
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Obtaining event, program, and recording URLs 
After you schedule an event, create a program, or upload a recording to your 
Event Center Web site, URLs, or event addresses, for the event, program, or 
recording display on the information page. You can invite attendees and 
panelists to an event or events in a program by sending them the appropriate 
URLs. 

If you want to manually add a source ID for an event, a program, or an event 
recording, obtain the attendee URL and then publish the URL with the ID in 
your email messages. For more information, see Manually appending a 
source ID to your URL (on page 102). 

To obtain an event URL: 

Go to the Event Information page by using one of these methods: 

 Go to My WebEx > My Meetings; then click the name of the event in the 
Topic column. 

 Obtain it after you schedule an event. 

To associate source IDs, use the event address for attendees. 
  
 

 
  

To obtain a program URL: 

1 On the left navigation bar of your Event Center Web site, click Manage 
Programs > List of Programs.  
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2 Go to the program page by clicking the name of the program in the Topic 
column. 

The URL is on the page. 
  

 

  

To obtain a recording URL: 

1 On the left navigation bar of your Event Center Web site, click Host an 
Event > My Event Recordings.  
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2 Go to the Recording Information page by clicking the name of the 
recording in the Topic column. 

The URL is on the page. 
  

 

 

 
 

Associating a source ID with a vendor 
You can specify a source ID and then associate it with a vendor’s email 
address. 
  
 

 Overview of associating a source ID w ith a vendor 
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 Overview of associating a source ID w ith a vendor 

events 

 

programs 

 

recordings 
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Associating source IDs with vendors for an event 
Follow these steps: 

To associate source IDs with vendor email addresses for an event: 

1 Go to the Send Event Emails portion of the Event Information page by 
using one of these methods: 

 Go to My WebEx > My Meetings; click the name of the event in the 
Topic column; then click . 

 If you just finish scheduling an event, the Send Event Emails portion 
displays immediately. 

2 Select Vendors. 

3 Enter up to three vendors’ email addresses in the Email address boxes, 
and enter source IDs in the corresponding Source ID boxes. 

4 Click Send Now. 

The vendors receive an invitation email message that they can forward to 
potential attendees. The email message includes an event URL with the 
source ID that you associated with a particular vendor. If an attendee 
clicks the link from the vendor’s email message, Event Center captures 
the source ID for the attendee. 

 

Associating source IDs with vendors for a program 
Follow these steps: 

To associate source IDs with vendor email addresses for a program: 

1 On the left navigation bar of your Event Center Web site, click Manage 
Programs > List of Programs. 
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2 Go to the program page by clicking the name of the program in the Topic 
column. 

3 On the program page, click . 

4 Enter up to three vendors’ email addresses in the Email address boxes, 
and enter source IDs in the corresponding Source ID boxes. 

5 Click Send. 

The vendors receive an invitation email message that they can forward to 
potential attendees. The email message includes the program URL with 
the source ID that you associated with a particular vendor. If an attendee 
clicks the link from the vendor’s email message, Event Center captures 
the source ID for the attendee. 

 

Associating source IDs with vendors for an event recording 
Follow these steps: 

To associate source IDs with vendor email addresses for an event recording: 

1 On the left navigation bar of your Event Center Web site, click Host an 
Event > My Event Recordings.  
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2 Go to the Recording Information page by clicking the name of the 
recording in the Topic column. 

3 On the Recording Information page, click . 

4 Enter up to three vendors’ email addresses in the Email address boxes, 
and enter source IDs in the corresponding Source ID boxes. 

5 Click Send. 

The vendors receive an invitation email message that they can forward to 
potential attendees. The email message includes the recording URL with 
the source ID that you associated with a particular vendor. If an attendee 
clicks the link from the vendor’s email message, Event Center captures 
the source ID for the attendee. 
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C h a pt er  7 

 

If you want to... See... 

get an overview  of managing registration 
requests from attendees 

About managing registration requests (on 
page 111)  

manually approve or reject registration 
requests 

Approving or rejecting registration requests 
(on page 112)  

send email reminders to attendees w hose 
registration has been approved 

Sending email reminders to registrants  (on 
page 113)  

 

About managing registration requests 
You can manage attendees’ registration requests by doing the following: 

 Automatically approve registration requests by attendees. Your site 
administrator must set up this option for you. 

 Manually approve or reject registration requests if you required approval 
when scheduling or editing the event. 

 Send email messages to registrants about their registration status—that is, 
pending, approved, or rejected. 

 Send reminder email messages to the attendees whose registration has 
been approved. 

 

Managing Registration 
Requests 
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Approving or rejecting registration requests 
If you require approval for registration requests when scheduling or editing an 
event, you must review and manually approve or reject the requests. 

For details about specifying approval rules for registration, see Setting 
approval rules for registrants (on page 12). 

To approve or reject registration requests for an event: 

1 Log in to your Event Center Web site. 

2 Optional. To specify that attendees will receive registration status email 
messages once you process their requests, do so on the Schedule an 
Event or Edit Event page. For details, About sending email messages to 
participants (on page 31). 

3 Click My WebEx > My Meetings. 

The My WebEx Meetings page appears. The page shows the number of 
requests that are pending , accepted , and rejected  for each 
scheduled event. 

4 Find the event, and then click the link for one of the following: 

 Requests Pending —Each pending request lists the registrant’s 
name, the registrant’s email address, and the date and time on which 
the registrant submitted the request. 

 Requests Approved —Each accepted request lists the registrant’s 
name, the registrant’s email address, and the date and time on which 
the registrant submitted the request. 

 Requests Rejected —Each rejected request lists the registrant’s 
name, the registrant’s email address, and the date and time on which 
the registrant submitted the request. 

5 Optional. To review details about each registration, on the page that 
appears, click the link for the name of the registrant. 

6 Select Approved or Rejected for each individual registrant or do one of 
the following, as appropriate: 

 To accept all requests for this event, click Accept All. 

 To make all requests pending for this event, click Make All Pending. 

 To reject all requests for this event, click Reject All. 
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7 Click Update . 

The email message for approved registrants contains the registration ID, 
event password, if any, event number, and a link they can click to join the 
event. 

 

Sending email reminders to registrants 
You can send email reminders to attendees whose registration has been 
approved. 

To send email reminders to registrants: 

1 Log in to your Event Center Web site. 

2 Click My WebEx > My Meetings. 

The My WebEx Meetings page appears. The page shows the number of 
requests that are pending , approved , and rejected  for each 
scheduled event. 

3 Find the event for which you want to send reminder email, and then click 
the link under the Requests Approved symbol . 

4 On the page that appears, click Send Email. 

5 In the message box that appears, click OK. 

6 On the Email confirmed page that appears, click OK. 

  
 

Tip: When scheduling or editing an event, you can also specify that approved registrants 
automatically receive email reminders at the date and time you specify. 
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C h a pt er  8 

Practice sessions allow the host, presenter, and all other panelists to practice 
an event before starting it for all participants. In a sense, practice sessions are 
similar to working behind a curtain for dress rehearsals. Practice sessions are 
not visible to event attendees, and the event production team can perform all 
event functions in a practice session. 

If a teleconference has been started in the main event when the host starts a 
practice session, the production team automatically enters a subconference, 
away from the main teleconference. Conversations in the subconference are 
private. Therefore, attendees outside the practice session cannot hear about 
the practice. 

If an Integrated VoIP conference has been started in the main event when the 
host starts a practice session, the production team remains in the conference. 
Attendees outside the practice session cannot hear about the practice. 
  
 

Note: The production team is composed of the host, presenter, and all other panelists. 

 
 

Setting up a practice session 
Before the host starts a practice session, all panelists should join the event. 
The host, presenter, and panelists should have all presentation material ready 
to share in the practice session. 
  

Conducting a Practice 
Session 
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Tip:  
 Create a slide presentation for attendees to view while the production team is in a 

practice session. Open the slide presentation and set it to autoplay before you start 
the practice session. If you do not have a presentation for attendees to view while a 
practice session is in progress, they see a message in their Event windows stating 
that the production team is in a practice session. 

 Start the practice session early enough before the event so you can finish it before 
your event is scheduled to start. 

The following table outlines what the production team and attendees can view 
once the host starts a practice session. 
  
 

Feature Production Team Attendees 

Participants panel Can view  the entire participants list. 
The Panelists list appears 
grayed out and is 
unavailable. 

Q & A sessions 
Can receive and answ er questions 
sent by attendees. 

Can send questions to the 
production team. 

Chat 

 Can send chat messages among 
team members. 

 Cannot receive chat messages 
sent by attendees. 

 Can send chat messages to 
attendees by selecting All 
Attendees in the Send to drop-
dow n list. 

 Cannot v iew  chat 
messages w ithin the 
practice session 
unless a production 
team member sends 
chat messages to All 
Attendees. 

 Cannot chat w ith the 
production team. 

 If  the host grants chat 
privileges, an attendee 
can chat w ith other 
attendees by sending 
chat messages to All 
Attendees. 

Document sharing 
Cannot v iew  documents, 
presentations, or applications that 

 Can view  documents, 
presentations, and 
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Feature Production Team Attendees 

were opened before the host starts 
the practice session. 

Web content shared 
before the host starts 
the practice session. 

 Cannot v iew  any 
documents or 
presentations shared 
during the practice 
session. 

Application sharing or 
desktop sharing 

 The host must stop any desktop 
or application sharing before 
starting the practice session. 

 Any desktop or application 
shared w ithin the practice 
session can be view ed only by 
the production team. 

Cannot v iew  any desktop 
or applications shared 
during the practice session. 

Browser sharing 

 The host must stop any brow ser 
sharing before starting the 
practice session. 

 Any brow ser shared w ithin the 
practice session can be view ed 
only by the production team. 

Cannot v iew  any shared 
brow sers during the 
practice session. 

Recording and playback 

Recording and playback is available 
to the production team. 

Recording and playback is 
available to attendees, 
although attendees can 
record only the 
presentations outside the 
practice session. 

Polling 

 The poll coordinator can open a 
poll that w as created or loaded 
(but not opened) outside the 
practice session.  

 Can prepare poll questionnaires, 
and test opening and closing the 
polls. 

 Can view  a poll 
opened before the host 
starts the practice 
session. 

 Cannot v iew  any polls 
opened w ithin the 
practice session. 

 If , w ithin the practice 
session, the poll 
coordinator closes the 
poll that the attendees 
are view ing, the poll 
closes for the 
attendees.  

Video Can view  video w ithin the practice 
session. 

Cannot v iew  video after the 
host starts a practice 
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Feature Production Team Attendees 

session. 

Teleconference 

Automatically enters a 
subconference. The audio 
conversations are private w ithin the 
practice session. 

Can join and stay in the 
main teleconference, but 
they cannot hear 
conversations in the 
practice session. 

Integrated VoIP 

 The host can start an Integrated 
VoIP conference w ithin the 
practice session. 

 Can join an Integrated VoIP 
conference and speak w ithin the 
practice session. 

 Can join and stay in 
the Integrated VoIP 
conference. 

 Cannot hear the 
conversations in the 
practice session. 

 

Starting a practice session 
Once the host starts a practice session, attendees who have joined the event 
cannot view any activities in the practice session. 
  
 

Note:  
 Only the host can start and end a practice session. 

 If  a host designates a panelist or presenter as an attendee during a practice session, the 
person is removed from the practice session. 

To start a practice session: 

1 Optional. Open the presentation that attendees can view while the 
production team is in a practice session. Set the presentation to 
automatically advance pages. 

  
 

 Note: Once the host starts a practice session, the production team cannot access 
the presentations or documents that the presenter opened in the Event window 
before starting the practice session. To use the same presentations or documents 
in the practice session, the presenter must open them again during the practice 
session. 

 

2 In the Event window, on the Event menu, choose Start Practice Session. 
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The practice session starts. The host, presenter, and panelists 
automatically join the practice session. Event attendees can view any 
presentation that the host or presenter opened before starting the practice 
session; they also see a message in the Event window that the production 
team is currently in a practice session. 

3 Rehearse the event, such as opening presentations or preparing a poll 
questionnaire that the production team will use during the actual event. 

  
 

Important: Before you end a practice session, ensure to close any shared documents, 
presentations, whiteboards, Web content, and opened poll that you do not want to share 
with attendees yet. If you do not close them, attendees can view them once you end the 
practice session. 

 
 

Ending your practice session 
When you finish your practice session, on the Event menu, choose End 
Practice Session. 

The practice session ends. Event attendees can now view the activities in the 
Event window. 
  
 

Important: Before you end a practice session, ensure to close any shared documents, 
presentations, whiteboards, Web content, and opened poll that you do not want to share 
with attendees yet. If you do not close them, attendees can view them once you end the 
practice session. 
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If you want to ... See ... 

get an overview  of joining an event About joining an event as a panelist (on page 
121)  

join an event from your invitation email 
message 

Joining an event from an email invitation  (on 
page 123)  

join an event from the URL for the panelist 
entrance 

Joining an event from a URL  (on page 123)  

obtain event information Obtaining event information  (on page 124)  

upload f iles for the host before the event 
starts 

Uploading files  (on page 124)  

  
 

Note: The event host may choose to record the event. 
 

About joining an event as a panelist 
Panelists only 

If the host invites you to an event, you receive an invitation email message 
that contains a link you can click to join the event. Once you click the link, the 
Panelist Entrance page appears. On that page, provide the required 
information before you can join the event. 

Joining an Event As a 
Panelist 
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If you did not receive an invitation email message for an event, contact your 
host to obtain the URL for the Panelist Entrance page. Then join the event 
from the URL. 

For more information, see About the Panelist Entrance page (on page 122). 
  
 

Note: If you have not yet set up the Event Center application on your computer, you can 
do so before joining an event to avoid a delay. Otherwise, once you join an event, your 
Event Center Web site automatically sets up the application on your computer. For more 
information about setting up Event Center on your computer, see Setting up Event 
Center (on page 1). 

 
 

About the Panelist Entrance page 
Panelists only 

To access this page, in your invitation email message, click the link for joining 
the event. 

Panelists join an event via the Panelist Entrance page. Before joining an 
event, you must provide required information on the page. 

Provide the following information, as required, on the Panelist Entrance page, 
and then click Submit: 

 First name, last name, and email address—The information you provide 
here must match what the host specifies when scheduling the event. 
Otherwise, you cannot join the event. 

 Panelist Password—The invitation email message you receive from the 
host contains the panelist password, if any. 

  
 

Important:  
 Do not share the panelist password with event attendees. Attendees must join an 

event from a different "entrance." By not disclosing the panelist password, you can 
prevent attendees from entering the event as panelists. 

 If a message appears informing you that you did not provide the matching 
information, verify it in your invitation email message or contact the host. 
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Joining an event from an email invitation 
Panelists only 

If you receive an invitation email message for an event, you can join it from 
the email message. You can enter the event before the host starts it. 

To join an event from an invitation email message: 

1 Open the email message, and then click the appropriate link. 

The Panelist Entrance page appears. 

2 Provide the required information, and then click Submit. 

For details, see About the Panelist Entrance. (on page 122) 

The Event Information page appears. 

3 Click Join. 

The event window appears. 

If you are the first participant in the event, the host will join shortly. 
 

Joining an event from a URL 
Panelists only 

If you did not receive an invitation email message for an event, contact the 
event host to obtain the URL for the Panelist Entrance page. 

To join an event from the URL for the Panelist Entrance page: 

1 Go to the URL that the host gave to you. 

The Panelist Entrance page appears. 

2 Provide the required information, and then click Submit. 

For details, see About the Panelist Entrance page (on page 122). 

The Event Information page appears. 

3 Click Join. 

The event window appears. 

If you are the first participant in the event, the host will join shortly. 
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Obtaining event information 
Panelists only 

From the Event Information page, you can obtain the event information, such 
as viewing other panelists’ information and event descriptions, and 
downloading event materials. 

On this page, you can also upload the files you are going to use in the event 
so the host can view or organize them before the event starts. For details, see 
Uploading files (on page 124). 

To access the Event Information page: 

1 Do one of the following as appropriate: 

 Open the invitation email message you received, and then click the 
appropriate link. 

 Go to the URL that the host gave to you. 

2 Provide the required information, and then click Submit. 

For details, see About the Panelist Entrance page (on page 122). 
 

Uploading files 
Panelists only 

Before the event starts, you can upload files that you are going to use in the 
event so the host can view or organize them. 
  

Note: This option is available only if the host specifies it. 
  

To upload files to the host: 

1 On the Event Information page and in the Event files section, click 
Upload. 

For information about how to access the Event Information page, see 
Obtaining event information (on page 124). 
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2 In the Upload Event File window that appears, select the files you want to 
upload, and then click OK. 

The files you upload become available on your and the host’s Event 
Information pages respectively and in the host’s personal folder on the 
Event Center Web site. 
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If you want to ... See ... 

get an overview  of registering for an event About registering for an event (on page 127)  

register from your Event Center Web site Registering from your Event Center Web site  
(on page 128)  

register from an event URL given by your 
host 

Registering from an event URL (on page 131)  

simultaneously register for multiple events in 
a program 

Registering for multiple events in a program  
(on page 131)  

obtain information about an event Obtaining information about an event  (on 
page 134)  

change the time zone in w hich you w ant to 
view  event times 

Viewing events in a different locale, 
language, or time zone  (on page 135)  

 

About registering for an event 
Attendees only 

If the event to which you are invited requires registration, the invitation email 
message that you receive from the host contains a link you can click to 
register for the event. 

If you did not receive an email invitation, you can register for the event from 
one of the following, depending on the type of event the host specified: 

 your Event Center Web site. 

 from the URL that the host gave to you. 

Registering for an Event 
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If the host requires a password for registration, you must provide the 
password that the host gave to you in an invitation email message or via 
another method. 

If the host requires that you provide your registration ID, you receive a unique 
registration ID in a registration confirmation email message. Then, you must 
provide the registration ID to join the event. 

 

Registering for an event from your Event Center 
Web site 

Attendees only 

You can register for an event from the List of Events page on your Event 
Center Web site if the host specifies that it is displayed on the service Web 
site.  

To register for an event from your Event Center Web site: 

1 On the navigation bar, expand Attend an Event, and then click List of 
Events. 

The List of Events page appears. 

2 If the List of Events by Date page is not currently displayed, in the upper-
right corner of the page, click View Events by Date . 

For more information, see About the List of Events page (on page 130). 

3 In the list of events, locate the event for which you want to register. 

4 Click Register. 

5 If the Registration Password page appears, type the password that the 
event host gave to you in the Registration password box, and then click 
Submit. 

6 On the Register for [Topic] page that appears, provide the required 
information. 

For details, see About the Register for [Topic]/Register for Events page 
(on page 129). 

7 Click Submit. 

If the host approves your registration, you receive a confirmation email 
message containing instructions for joining the event. 
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Important: If the host approves your registration and requires that you provide your 
registration ID before you can join the event, you will receive the ID in the registration 
confirmation email message. Ensure that you keep the ID so that you can successfully 
join the event. 

 
 

About the Register for [Topic]/Register for Events page 

How to access the Register for [Topic] page 

If you want to register for one event, fill out the registration form on this page. 

Do one of the following, as appropriate: 

 Click the appropriate link in your invitation email message, and then click 
Register. 

 On the List of Events by Date page on your Event Center Web site, locate 
the event you want to join, and then click Register. 

 On the Event Information page for the event you want to join, click 
Register. 

How to access the Register for Events page 

If you want to simultaneously register for multiple events in a program, fill out 
the registration form on this page. 

Do one of the following, as appropriate: 

 Go to the URL for the program that contains those events, select the 
events you want to register for, and then click Register. 

 On the List of Events by Program page on your Event Center Web site, 
locate the program that contains those events, select the events you want 
to register for, and then click Register. 

What you can do on the Register for [Topic]/Register for Events page 

Provide information about yourself, and submit your answers to complete 
registration. 



Chapter 10: Registering for an Event 

 

130 

 

Options on this page 

 

Use this option ... To ... 

Text boxes, option buttons, 
drop-dow n lists, and check 
boxes for the questions 

Provide your answ ers. 

Note Questions w ith an asterisk are required. 

Remember me on this 
computer 

Save your contact information, such as the name, email 
address, and t itle, for future use. 

You can remove your information stored on this computer by 
clicking Clear my information. 

Submit Submit your answ ers, and complete your registration. 

 

About the List of Events page 
The List of Events page provides these three views: 

 List of Events by Date page—events sorted by their dates 

 List of Events by Program page—a list of programs (groups of related 
events) 

 Event Recordings page—a list of recorded events that the event hosts 
have published on your Event Center Web site 

Accessing the List of Events page 

On the left navigation bar, expand Attend an Event, and then click List of 
Events. 

Accessing different views of the List of Events page 

In the upper-right corner of the List of Events page, you see two links. 
  
 

 

Example. In this f igure, the List of 
Events page is displaying a list of 
events by program. To access 
another view , click one of these 
tw o links. 
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Registering from an event URL 
Attendees only 

You can register for an event from its URL if you received the URL from the 
host.  

To register for an event from its URL: 

1 Go to the URL that the host gave to you. 

The Event Information page appears. 

2 Click Register. 

3 If the Registration Password page appears, type the password that the 
event host gave to you in the Registration password box, and then click 
Submit. 

4 On the Register for [Topic] page that appears, provide the required 
information. 

For details, see About the Register for [Topic]/Register for Events page 
(on page 129). 

5 Click Submit. 

If the host approves your registration, you receive a confirmation email 
message containing instructions for joining the event. 

  
 

Important: If the host approves your registration and requires that you provide your 
registration ID before you can join the event, you will receive the ID in the registration 
confirmation email message. Ensure that you keep the ID so that you can successfully 
join the event. 

 
 

Registering for multiple events in a program 
 

If you want to ... See ... 

get an overview  of registering for multiple About registering for multiple events in a 
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If you want to ... See ... 
events in a program program  (on page 132)  

simultaneously register for multiple events 
from the program URL 

Registering from the program URL (on page 
132)  

simultaneously register for multiple events 
from your Event Center Web site 

Registering from your Event Center Web site  
(on page 133)  

 

About registering for multiple events in a program 
Attendees only 

The event host can group related events in a program. Event Center allows 
you to simultaneously register for multiple events in a program. 

 

Registering for events from the program URL 
Attendees only 

If the events to which you are invited are part of a program, and the host gave 
you the program URL, you can simultaneously register for multiple events 
from that URL. 

To register for events from the program URL: 

1 Go to the URL the host gave to you. 

The program information page appears. 

2 Select the events for which you want to register, and then click Register. 

3 If the Registration Password page appears, type the password that the 
host gave to you in the Registration password box, and then click 
Submit. 

The Register for Events page appears. 

4 Provide the required information. 

For details, see About the Register for [Topic]/Register for Events page 
(on page 129). 

5 Click Submit. 
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If the host approves your registration, you receive a registration 
confirmation email message for each event you registered for. The 
message contains instructions for joining an event. 

 

Registering for events from your Event Center Web site 
Attendees only 

If the events to which you are invited are part of a program, and the host has 
specified to display both the program and its events on your Event Center 
Web site, you can simultaneously register for multiple events from the service 
Web site. 

To register for events from your Event Center Web site: 

1 On the navigation bar, expand Attend an Event, and then click List of 
Events. 

The List of Events page appears. 

2 If the List of Events by Program page is not currently displayed, in the 
upper-right corner of the page, click View Events by Program. 

For more information, see About the List of Events page (on page 130). 

3 Click the title of the program. 

The program information page appears. 

4 Select the events for which you want to register, and then click Register. 

5 If the Registration Password page appears, type the password that the 
host gave to you in the Registration password box, and then click 
Submit. 

The Register for Events page appears. 

6 Provide the required information. 

For details, see About the Register for [Topic]/Register for Events page 
(on page 129). 

7 Click Submit. 

If the host approves your registration, you receive a registration 
confirmation email message for each event you registered for. The 
message contains instructions for joining an event. 
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Obtaining information about an event 
 

If you want to ... See ... 

quickly f ind your event Searching for an event  (on page 134)  

obtain event information Obtaining event information (on page 134)  

 

Searching for an event 
You can quickly find an event on your Event Center Web site by doing a 
search if the event host specifies that it is displayed on the Web site. 

To search for an event: 

1 On the left navigation bar of your Event Center Web site, expand Attend 
an Event, and then click Search. 

2 On the page that appears, specify the date range. 

3 Optional. In the Event text box, type complete or partial text of the event 
name. 

4 Click Search. 
 

Obtaining event information before an event 
Attendees only 

Before you join an event, you can view the following information about the 
event: 

 event topic 

 event date, time, and duration 

 presenters’ names and information 

 event description 

  
 

Note: You can quickly find an event that you want to view or join by doing a search. For 
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details, see Searching for an event (on page 134). 
  

To obtain information about an event: 

Do one of the following, as appropriate: 

 Click the link in your invitation email message. 

 On the List of Events by Date page on your Event Center Web site, click 
the link for the event. 

For more information about the List of Events page, see About the List of 
Events page (on page 130). 

 Go to the URL that the host gave to you. 

The Event Information page appears. 
 

Viewing events in a different locale, language, or 
time zone 

Your site administrator designates a locale, language, and time zone in which 
dates, times, and text display on your Event Center Web site. Anyone who 
visits the site can change the locale, language, or time zone by setting 
preferences on the Preferences page. 

Example. You want to change the time zone for viewing events on the Event 
Center Web site because you are traveling and temporarily in another time 
zone. 

Your preferences are saved as a cookie in the browser on your computer. If 
you have a user account and have logged in when changing the preferences, 
your preferences will be saved not only in the browser but also in your profile; 
your preferences will display on any browser or computer as long as you are 
logged in. 
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The current locale, language, 
and time zone display in these 
places: 
 the List of Events by Date 

page 

 the List of Events by 
Program page 

 the Event Recordings page 

 the Event Information page 

 The page on w hich you can 
join an event 

 

 

Fast track 

Click this link in your invitation 
email message to spec ify your 
language or time zone. 
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Changing the locale, language, or time zone for your site 
At any time, you can change your Event Center site preferences, including the 
locale, language, and time zone. 

To select a different locale, language, or time zone on your Event Center Web 
site: 

1 Go to the Preferences page by using one of these methods: 

 In your invitation email message, click the link. 
  
 

 

 
  

 On the left navigation bar of the site, click Set Up > Preferences. 
  
 

 

 
  

2 Select your preferences in the drop-down lists, and then click OK. 

  
 

Note: If you have a user account, you can also set these preferences in your profile. For 
more information, see About maintaining your user profile (on page 418). 
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C h a pt er  1 1 

The Event window displays the content viewer on the left side, where you 
share documents, applications, desktops, and other items with attendees. The 
right side of the Event window contains panels, which you can display or hide 
as you need them. 

This chapter gives you a quick overview of the Event window and the 
elements that compose it. 
  
 

If you want to ... See ... 

learn about the Event w indow  and the tools 
for sharing information 

A quick tour of the Event window (on page 
139)  

learn how  to w ork w ith shared content Performing tasks on shared content (on page 
141)  

learn how  to manipulate the panels Working with panels (on page 145)  

access panels w hile you are in full-screen 
view 

Accessing panels in full-screen view (on page 
152)  

learn about the w ays you can be alerted 
when a minimized or collapsed panel requires 
your attention 

Viewing panel alerts (on page 158)  

 

A quick tour of the Event window 
The Event window provides the online environment where event participants 
interact. 

The Event Window 
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In the Event window, you can share documents, presentations, desktops, and 
Web content, send chat messages, coordinate polls, and perform other event 
management tasks. 
  
 

Content Viewer Tools 

 

The tools on the content view er toolbar 
allow  you to share and perform actions on 
presentations, documents, and 
whiteboards. 

 

annotation toolbar—Select a draw ing 
tool for directing attention onscreen, using 
pointers, a highlighter, or draw ing a 
shape. More… (on page 142)  

Window s 

  
 

Mac 

  

Sharing toolbar—Use these tools to 
share applications, documents, your 
desktop or a w hite board. More… (on 
page 143)  

 
Viewing toolbar—Change to full-screen, 
rotate pages, zoom in or out us ing these 
tools. More… (on page 144)  
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Performing tasks on shared content 
  

If you want to ... See ... 

learn about the menu bar  The menu bar (on page 141)  

learn about the tools available in the content 
view er 

Sharing information (on page 143)  

learn about the annotation tools  Using annotation tools on shared content (on 
page 142)  

learn about the view  tools Changing views of shared content  (on page 
144)  

 

The menu bar 
The following table describes what you can do with each menu. 
  
 

 Window s 

 Mac 

  

 

Menu Description 

Event Center (Mac only) Provides commands for  

 setting up sounds for participant actions and 
incoming chat messages  

 selecting communication tools and display 
preference w ithin the event  

File Provides commands for saving, opening, or printing 
f iles during an event; and ending or leaving an event.  

Edit Provides commands for edit ing shared content in the 
content view er. 
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Menu Description 

Share Provides commands for sharing documents, 
presentations, applications, Web brow sers, desktops, 
mult imedia Web content, and w hiteboards. 

View Provides commands for displaying information in the 
content view er on a host's, presenter's, or attendee's 
screen. 

Communicate Provides commands for setting up an audio 
conference. 

Participant Provides commands pertaining to participants, such 
as invit ing a partic ipant to an event, assigning roles 
and priv ileges, controlling participants’ audio, and so 
on. 

Event Provides commands pertaining to the event, such as 
view ing event information and restricting access to the 
event. 

Help Provides information about the Event Center service 

 

Using annotation tools on shared content 
In an online event, you can use annotation tools on shared content to 
annotate, highlight, explain, or point to information: 
  
 

 
Basic annotation tools  

  

 

Annotation Tool Icon Description 

Pointer 
 

Lets you point out text and graphics on shared content. The 
pointer displays an arrow  w ith your name and annotation color. 
To display the laser pointer, w hich lets you point out text and 
graphics on shared content using a red “laser beam,” click the 
dow nward-pointing arrow . Clicking this button again turns off the 
pointer tool. 



 Chapter 11: The Event Window 

 

143 

 

Text 
 

Lets you type text on shared content. Attendees can view  the 
text once you f inish typing it and click your mouse in the content 
view er, outside the text box. 

To change the font, on the Edit menu, choose Font. Clic king this 
button again turns off the text tool. 

Line 
 

Lets you draw  lines and arrow s on shared content. For more 
options, click the dow nw ard-pointing arrow . Clic king this button 
closes the Rectangle tool.  

Rectangle 
 

Lets you draw  shapes, such as rectangles and ellipses on 
shared content. For more options, click the dow nw ard-pointing 
arrow . Clicking this button again closes the Rectangle tool.  

Highlighter 
 

Lets you highlight text and other elements in shared content. For 
more options, click the dow nward-pointing arrow . Clicking this 
button again closes the Highlighter tool 

Drawing Color 
 

Displays the Annotation Color palette, on w hich you can select a 
color to annotate shared content. Clicking this button again 
closes the Annotation Color palette. 

Eraser 
 

Erases text and annotations or clears pointers on shared 
content. To erase a single annotation, c lick it in the view er. For 
more options, click the dow nward-pointing arrow . Clicking this 
button again turns off the eraser tool. 

 

Sharing information 
You can open a document, whiteboard, desktop, or application to share by 
clicking the sharing icons in the upper left corner. 
  
 

 
Sharing tools for Window s 

 
Sharing tools for the Mac  

  



Chapter 11: The Event Window 

 

144 

 

 

Sharing Tool Icon Description 

Share Document 
 

Share a document or presentation that resides on your 
computer. Participants view  the shared document or 
presentation in their content view ers. 

Share Application 
 

Share any application on your computer w ith meeting 
attendees. Attendees can view  the shared application in a 
sharing w indow  on attendees' screens. 

Share Desktop 
 

Share your computer desktop* w ith meeting attendees, 
including any applications, w indow s, and f ile directories that are 
currently open. Attendees can view  the shared desktop in a 
sharing w indow  on attendees' screens 

Share Whiteboard  
 

Share a w hiteboard on w hich you can draw  and w rite. 
Attendees can view  a shared w hiteboard in their content 
view ers. 

  
 

Note: Click Share on the Menu bar to see more options for sharing information in an 
event. 

 

Changing views of shared content 
You can switch views in the content viewer by clicking the viewing icons in the 
bottom left corner of the content viewer: 
  
 

 
View  tools 

  

 
Tool Icon Description 

Standard View/  
Clicking Standard View  displays the shared content as you w ould 
normally view  it.  

View Thumbnails  

To display thumbnails, or miniatures, of shared pages, slides, or 
whiteboards to the side of the content, click View Thumbnails. 
This tool helps you locate a page or slide quickly. 
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Full-Screen View  

Displays shared content in a full-screen view . Helps you to ensure 
that part icipants can view  all activity on your screen. Also helps to 
prevent part icipants from view ing or using other applications on 
their screens during a presentation. 

Click ESC to return to the content view er. 

Rotate page  
For documents in landscape orientation, you can rotate the pages 
to the left or right so they appear correctly in the content v iew er. 

Zoom In/ 

Zoom Out  

Lets you display shared content at various magnif ications. Click 
this button, and then click the page, slide, or w hiteboard to 
change its magnif ication. For more magnif ication options, clic k the 
dow nward-pointing arrow . 

Synchronize 
Displays for All  

For presenters, synchronizes all partic ipants' displays w ith your 
display. Helps to ensure that all participants are view ing the same 
page or slide, at the same magnif ication, as in your display. 

 

Working with panels 
Your service determines which panels display initially. 
  
 

For Windows  
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For Windows  

 

 To restore panel layout, minimize all 
panels, or manage panels, clic k this button 
and choose a command from the menu. 

 Click these icons to restore or minimize 
the panels. More… (on page 148)  

 In this example, the Q & A panel is 
collapsed. More… (on page 149)  

 Use these icons to collapse or expand 
a panel. More… (on page 149)  

 Use this icon to minimize the panels on 
the icon tray. More…  (on page 148)  

Note: To access panel options, right-click 
in the panel t it le bar. More… (on page 150)  

  
 

Note for Windows users: In sharing mode, you can have one or more panels "float" on 
top of the shared document, presentation, Web browser, or other shared item. See 
Accessing panels in full-screen view (on page 152). 
  
 

For the Mac  
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For the Mac  

 

 Click these icons to restore or 
minimize the panels. More… (on 
page 148)  

 Click this icon to restore 
panel layout or manage panels. 

 Use these icons to collapse 
or expand a panel. More… (on 
page 149)  

 

 

Managing panels 
You can determine which panels are displayed in the event window, and in 
which order they will be displayed: 

To manage the display of panels: 

1 Click this button. 
  

 
 for Window s 

  

  for the Mac 
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2 Choose Manage Panels from the menu. 
  

 

 

 Use the Add or Remove 
buttons to specify w hich panels 
should display in your event 
w indow . 

 Use the Move Up or Move 
Down buttons to spec ify the 
order of the panel display. 

 Click the Reset button to 
restore the panel view  to the 
default layout. 

 Clear the check box beside 
Allow participants to change 
the sequence of panels  if  you 
want to permit attendees to 
manage their ow n display of 
panels. 

  

 

Minimizing panels 
Minimizing a panel causes the panel to disappear from the display and 
reappear as an icon on the icon tray. 

To minimize or close a panel (for Windows): 

  
 

 

Click the Minimize icon on 
the title bar of the panel you 
want to minimize. 

  

To restore a minimized panel (for Windows): 
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Click its icon on the icon 
tray 

To minimize or restore a panel (for the Mac): 

  
 

 

On the bottom of the panels, you see a tray 
holding icons of the displayed panels. Clic k its 
icon to minimize or restore the panel.  

The icon of a minimized panel appears grayed 
on the tray. 

 

 

Expanding and collapsing panels 
When you collapse a panel, the body of the panel disappears, leaving just the 
title bar visible. When you expand the panel, it reappears in its full form.  

To collapse or expand a panel: 

  
 

 

Click the icon in the upper 
left corner of a panel to 
collapse or expand it.  

 

Restoring the panel layout 
If you have closed, minimized, or expanded or collapsed panels, you can 
restore the display to the layout 

 you specified in the Manage Panels dialog box. 

 that existed when you first joined the event (if you did not specify a layout 
via the Manage Panels dialog box) 

To restore the panel layout: 

1 Click this button. 
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 for Window s 

  

  for the Mac 

2 Choose Restore Layout. 
 

Accessing panel options 
Each panel provides a menu of commands related to the panel. Expanding 
and minimizing are two common commands for all the panels. 

Depending on what operating system you are using, access the commands 
for a panel by following these steps: 

 Windows—Right-click the panel title bar to see a menu of commands 
related to the panel.  

 Mac—Select ctrl and then click to see a menu of commands related to the 
panel. 

  
 

Panel Options 

Participants Sound Alerts: Lets you choose a sound to play w hen a part icipant:  

 joins the event 

 leaves the event 

 clicks the Ask for Mic button on the Participants panel. 
Attendee Privileges: Available for only the event host. Displays the 
Attendee Pr ivileges dialog box. For details about these pr ivileges, see 
Granting privileges to attendees (on page 162). 
My Information: Lets you specify a URL or Web address that you w ant 
to make available during the event. To access the Web site that you 
specify, event participants can clic k the icon  next to the host’s or 
presenter’s name on their Participants panels. 
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Panel Options 

Chat Sound Alerts: Lets you choose the kinds of chat messages for w hich 
you w ant a sound to play. Select a sound from the drop-dow n list or click 
Browse to f ind a sound in a different location on your computer. 

Attendee Privileges: Available for only the event host. Displays the 
Attendee Pr ivileges dialog box. For details about these pr ivileges, see 
Granting privileges to attendees (on page 162). 

Media Viewer Share Multimedia: Available for only the presenter. Lets you share 
mult imedia Web content in the media view er on this panel.  

Stop Multimedia Sharing: Available for the presenter, w ho has started 
sharing mult imedia content. 

Q & A  Attendee Options: For privacy, lets you show  or hide names of 
attendees w ho send questions, names of panelists w ho send answ ers, 
or time stamps for each question and answ er, w hen questions and 
answ ers are published on attendees’ Q & A panels. 

 

Resizing the content viewer and panels area 
You can control the size of the content viewer by making the panel area 
narrower or wider. 

To change the size of the content viewer and panels: 

Click the dividing line between the content viewer and the panels. 

 Drag the line to the left to make the area devoted to the panels wider. 

 Drag the line to the right to make the content viewer larger. 
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Accessing panels in full-screen view 
If you are viewing a document in full-screen mode, or remotely controlling a 
shared application, or desktop, the Event window appears as a full-screen 
sharing window. In a sharing window, you access panels from the Event 
Controls Panel. 
  
 

 
  
 

Control Descriptions 

 Displays icons for w orking w ith attendees  

 
Displays a maximum of 4 icons. You can open any remaining panels from this 
menu. 

 

 
Stops sharing and returns to the Event w indow 
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Control Descriptions 

 
Provides access to event controls and panels that are not displayed on the Event 
Controls Panel. 

 Opens the Participants panel 

 Opens the Chat panel 

 Opens the Q & A panel 

 Opens the Annotation Tools panel 

 Opens the Polling panel 

 Opens the Video panel 

 Opens the Recorder panel 

  
 

Tip:  
 Windows: To clear space on your desktop, you can drag the Event Controls Panel 

to the top, left, or right to dock it on the edge of the window. To undock the icon tray 
and float it again, simply drag it away from the edge of the window. 

 Mac: To clear space on your desktop, you can drag the Event Controls Panel and 
dock it anywhere on your desktop. 

 

Manipulating panels in full-screen view 
For Windows users only 

You can open and float panels on the window, redock floating panels, and 
resize floating panels to meet your viewing requirements. 

To open a panel when your view is full-screen mode: 

Click its icon on the Event Controls Panel. For example, to open the Chat 
panel, click the Chat icon. 

 If the Event Controls Panel is docked on the edge of the window, the panel 
appears and “floats” on top of the shared document, presentation, or other 
shared item.  
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 If the Event Controls Panel is floating on top of the window, the panel 
appears and is docked to the Event Controls Panel.  

To float a panel: 

  
 

 

Click the f loat icon. 

  

To resize a floating panel: 

Grab any corner and drag the panel to the required size. 

To dock a floating panel onto the Event Controls Panel, do either of these: 

 click the slanted arrow on the right side of the panel title bar 

 drag and drop the panel onto the Event Controls Panel or another docked 
panel.  

  
 

Note: The Event Controls Panel must be in floating mode before you can dock panels on 
it. 

  

To open and float all panels during full screen mode: 

On the Select Panel menu, choose Float All Panels. 

All panels display, even those you had minimized previously. 
 

Sharing in full-screen view 
Host and Presenter only 

In full-screen view, you have access to sharing options from the Event 
Controls Panel. 
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Click the Share icon to see 
available options for sharing 
content. 

  

 Share Document-select a document that you already have open or open 
a new document. More… (on page 156) 

 Share Application-select an application that you already have open or 
open a new application. More… (on page 156) 

 Share Desktop-your attendees can see your desktop, and you can 
proceed to show or demonstrate content. 

 Share Whiteboard-select a whiteboard that you already have open or 
start a new whiteboard. More… (on page 157) 

 Share Web Content-select a Web site that you already have open or 
specify a URL to share the content of another Web site. More… (on page 
157) 

 Share Web Browser-your default browser opens; your attendees can see 
it, and you can proceed to browse the Web 

 Share Remote Computer-select a remote computer and an application 
on that computer that you want to share. To share a computer in an event, 
you must have already set it up for remote access. 
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If you are sharing a document 

If you have already opened several documents, you can switch sharing from 
one document to another, or you can open a document that is currently 
closed. 
  
 

 

 Select Share Document and 
choose an open document from 
the list. 

 Select Share Document > 
Share Document... to open a 
new  document. 

  

 

If you are sharing an application 

If you have already opened several applications, you can switch sharing from 
one application to another, or you can open an application that is currently 
closed. 
  
 

 

 Select Share 
Application and 
choose another open 
application from the 
list. 

 Select Share 
Application > Share a 
new Application to 
open a closed 
application. 

  
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If you are sharing a whiteboard 

If you have already opened started several whiteboards, you can switch 
sharing from one whiteboard to another, or you can start another whiteboard. 
  
 

 

 Select Share Whiteboard and choose 
another w hiteboard from the list.  

 Select Share Document > Share a 
New Whiteboard to start a new  
whiteboard. 

  

 

If you are sharing Web content 

If you have already set up one or more Web sites for content viewing, you can 
switch sharing from one to another, or you can specify a URL to share the 
content of another Web site. 
  
 

 

 Choose Share Web 
Content > a Web site 
URL listed on the menu. 

 Choose Share Web 
Content > Share New 
Web Content... to open 
another Web site. 

  
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Synchronizing attendee displays 
To resize the display of participants to match your display: 

1 Click this button on the Event Controls Panel. 
  

 
 

2 On the menu, choose View > Synchronize for All. 

All attendee displays now match your display. 
 

 

Viewing panel alerts 
If a panel you collapsed or minimized requires your attention, the icon 
representing the panel blinks for a few seconds and changes color to get your 
attention to a change. 

Here are some reasons for seeing alerts: 

 A participant arrives or leaves an event. 

 A Raise Hand or Request Phone indicator appears on the Participants 
panel. 

 An attendee sends a question using the Q & A panel. 

 An attendee sends a chat message. 

 A poll closes. 

 Poll answers are received. 

  

Example. A participant clicks the Request Phone icon in your event, and you 
do not have the Participants panel open. This table shows you different ways 
you can be alerted.  
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Participants panel alerts Ways to see alerts 

 

panel is minimized on an 
icon tray  

 

panel is collapsed 

 

 

panel is minimized in a 
full-screen view 

 

panel is collapsed in a full-
screen view 

 

panel is f loating and 
collapsed in a full-screen 
view 

  

The panel remains in the alert status until you open the panel. 
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C h a pt er  1 2 

 

If you want to... See... 

get an overview  of privileges  About granting privileges to participants  (on 
page 161)  

assign part icular pr ivileges to attendees or 
panelists 

Granting privileges to attendees and panelists  
(on page 162)  

review  specif ic details about each attendee 
privilege 

Overview of attendee privileges  (on page 
163)  

review  specif ic details about each panelist 
privilege 

Overview of panelist privileges  (on page 165) 

 

About granting privileges to participants 
Once the event starts, participants automatically receive default privileges that 
allow them to perform activities during the event. You, as the event host, can 
grant additional privileges to participants. 

For example, you can allow participants to do the following event activities: 

 saving, printing, or annotating shared content in the content viewer 

 viewing thumbnails of pages, slides, or whiteboards in the content viewer 

 viewing any page, slide, or whiteboard of the current content the presenter 
is sharing in the content viewer 

Assigning Privileges During 
an Event 
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 viewing any document, presentation, or whiteboard in the content viewer, 
regardless of the current content that the presenter is sharing 

 chatting with specific participants 

 recording the event 

For information about which privileges participants receive by default, see 
Overview of attendee privileges (on page 163) and Overview of panelist 
privileges (on page 165). 

 

Granting privileges to attendees and panelists 
 

If you want to... See... 

grant privileges to or remove privileges from 
attendees 

Granting privileges to attendees  (on page 
162)  

grant privileges to or remove privileges from 
panelists 

Granting privileges to panelists  (on page 
164)  

 

Granting privileges to attendees 
You can grant privileges to or remove privileges from attendees during an 
event. 

To assign attendee privileges during an event: 

1 In the Event window, on the Participant menu, click Assign privileges to 
> Attendees. 

The Attendee Privileges dialog box appears. 

2 Do any of the following: 

 To grant a privilege to all attendees, select its check box. 

 To grant all privileges to attendees, select the All attendee privileges 
check box. 

 To remove a privilege from all attendees, clear its check box. 

For descriptions of each option in the Attendee Privileges dialog box, see 
Overview of attendee privileges (on page 163). 

3 Click Assign. 
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Overview of attendee privileges 
To access the Attendee Privileges dialog box, in the Event window, on the 
Participant menu, click Assign privileges to > Attendees. 

The following table describes each option in the Attendee Privileges dialog 
box. 
  
 

Under this area ... Use these options to allow attendees to ... 

Document  Save—Save any shared documents, presentations, or 
whiteboards that appear in the content view er. 

 Print—Pr int any shared documents, presentations, or 
whiteboards that appear in the content view er. 

 Annotate— Annotate any shared documents, presentations, or 
whiteboards that appear in the content view er, using the 
annotation tools. 

View  Attendee list—View  the names of all other attendees on the 
Participants panel. If  this option is unavailable, it means you 
have specif ied during scheduling that attendees can view  only 
the names of the event host and the panelists on the 
Participants panel. 

 Thumbnails—Display miniatures of any pages, slides, or 
whiteboards that appear in the content view er, regardless of the 
current content the presenter is sharing in the content view er. 

 Any page—View  and navigate betw een the pages or slides of 
the current document or presentation that the presenter is 
sharing in the content view er. 

 Any document—View  and navigate betw een any document, 
presentation, or w hiteboard that appears in the content view er. 

 Number of attendees—View  the total number of attendees on 
the Participants panel. 

Event  Record the event—Record all interactions dur ing an event 
using WebEx Recorder and play back recordings at any time. 
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Under this area ... Use these options to allow attendees to ... 

Communications  To let attendees chat w ith the follow ing persons privately, select 
Private chat w ith. 

 Host—Chat pr ivately w ith only the event host. If  an attendee 
sends a chat message to the host, it appears on only the host's 
Chat panel. 

 Presenter—Chat pr ivately w ith only the presenter. If  an attendee 
sends a chat message to the presenter, it appears on only the 
presenter's Chat panel. 

 Panelists—Chat privately w ith any panelist or all panelists. 

 All attendees—Chat w ith either of the follow ing: 

 All Attendees, excluding the event host and panelists 

 All Participants, including the event host and panelists, if  you 
also selected all the other check boxes under 
Communications 

If  you w ant to grant the teleconferencing privilege to attendees 
w ithout having to approve their requests, select Automatically 
approve teleconferencing requests . 

All Attendee 
Pr ivileges  

Have all the attendee privileges. 

 

 

Granting privileges to panelists 
You can grant privileges to or remove privileges from panelists during an 
event. 

To assign panelist privileges during an event: 

1 In the Event window, on the Participant menu, click Assign privileges to 
> Panelists. 

The Panelist Privileges dialog box appears. 

2 Do any of the following: 

 To grant a privilege to all panelists, select its check box. 

 To grant all privileges to panelists, select the All panelist privileges 
check box. 

 To remove a privilege from all panelists, clear its check box. 
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For descriptions of each option in the Panelist Privileges dialog box, see 
Overview of panelist privileges (on page 165). 

3 Click Assign. 
 

Overview of panelist privileges 
To access the Panelist Privileges dialog box, in the Event window, on the 
Participant menu, click Assign privileges to > Panelists. 

The following table describes each option in the Panelist Privileges dialog 
box. 
  
 

Under this area ... Use these options to allow panelists to ... 

Document  Save— Save any shared documents, presentations, or 
whiteboards that appear in the content view er. 

 Print—Pr int any shared documents, presentations, or 
whiteboards that appear in the content view er. 

 Annotate— Annotate any shared documents, presentations, or 
whiteboards that appear in the content view er, using the 
annotation tools, and use pointers on shared documents, 
presentations, and w hiteboards. 

View  Attendee list—View  all attendees ’ names on the Participants 
panel. 

 Thumbnails—Display miniatures of any pages, slides, or 
whiteboards that appear in the content view er, regardless of the 
current content the presenter is sharing in the content view er. 

 Any page—View  and navigate betw een the pages or slides of 
the current document or presentation that the presenter is 
sharing in the content view er. 

 Any document—View  and navigate betw een any document, 
presentation, or w hiteboard that appears in the content view er. 

Event  Record the event—Record all interactions dur ing the event 
using WebEx Recorder and play back recordings at any time. 

 Share documents—Share presentations or documents dur ing 
the event. 
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Under this area ... Use these options to allow panelists to ... 

Communications   Private chat w ith—To chat w ith the follow ing persons privately:  

Host: Chat pr ivately w ith only the event host. If  a panelist sends 
a chat message to the host, it appears on only the host's Chat 
panel. 

Presenter: Chat pr ivately w ith only the presenter. If  a panelist 
sends a chat message to the presenter, it appears on only the 
presenter's Chat panel. 

Panelists: Chat privately w ith any other panelist or all panelists. 

All attendees: Chat w ith one of these groups: 

 All Attendees, excluding the event host and panelists 

 All Participants, including the event host and panelists, if  you 
also selected all the other check boxes under Private chat 
w ith. 

 Attention Tracking—View  attention indicator and learn w hich 
attendee is not pay ing attention during the event. 

All Panelist Pr ivileges  Have all the panelist privileges. 
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C h a pt er  1 3 

Host only 

During an event, you can assign sounds to play when a participant: 

 Joins the event 

 Leaves the event 

 Clicks Raise Hand on the Participants panel 
 

 Clicks Ask for Mic on the Participants panel 
 

 Clicks Request on the Participants panel to ask to join the teleconference 
during audio broadcast 

 

To assign sounds to participant actions: 

1 Open the Preferences dialog box by performing these steps: 

 Windows: On the Edit menu, choose Preferences. 

 Mac: On the Event Center menu, choose Preferences. 

2 Depending on your operating system, follow one of these steps: 

 Windows: Click the Participants tab. 

 Mac: Select the Alerts button. 

3 Select the check box for each action for which you want to play a sound. 

4 Select a sound from the appropriate drop-down list. 

By default, the drop-down list contains the names of all sound files that 
reside at the default location on your computer. 

Assigning Sounds to 
Participant Actions 
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5 To select a sound that does not appear in the drop-down list, follow one of 
these steps: 

 Windows: Click Browse , and then select a sound file that resides in 
another folder. 

 Mac: Select Others in the drop-down list. 

6 Windows only. To play the currently selected sound, click the button . 

7 Click OK. 
 

  

Note:  
 Event Center saves your sound preferences on your computer. However, if you start 

or join an event on another computer, you need to set your preferences again on that 
computer. 

 If you are using Windows, sound files must have a .wav extension. 
 In most cases, the default location for sound files is C:\WINDOWS\Media. You can 

copy other sound files to the default folder or any other directory to make them 
available in the Preferences dialog box. 
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Host only 

As the event host, you run the event using the features provided by Event 
Center. For example, you can: 

 Manage the Attendee List More… (on page 170) 

 Invite additional attendees to the event More… (on page 174) 

 Remind the panelists who were invited but have not yet joined the event 
More… (on page 180) 

 Tell which participants are not paying attention in the event More… (on 
page 183) 

 Designate a presenter More… (on page 185) 

 Designate panelists More… (on page 186) 

 Transfer the host role to a panelist; reclaim the host role later More… (on 
page 187) 

 Control access to an event More… (on page 189) 

 Remove a participant from the event More… (on page 189) 

 End the event More… (on page 190) 

  
 

Note:  
 A host must be an authorized user—that is, the host must have a user account. 
 After an event starts, the host is initially the presenter. The host can then designate a 

panelist as the presenter. 
 

Managing an Event 
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Obtaining information about an event 
During an event, you can obtain the following information about the event. If 
necessary, you can instruct attendees about how to obtain this information: 

 event topic 

 location, or URL, of your Event Center Web site 

 event number 

 teleconferencing information 

 current host 

 current presenter 

 current user—that is, the attendee's name 

 current number of participants 

To obtain information about an event in progress: 

In the Event window, on the Event menu, choose Information. 
 

Managing the Attendee List 
Host only 

The Attendee List shows not only the names of the attendees in the event but 
also their: 

 Lead scores—The Score column displays each attendee's total lead score 
based on the attendee's response to the questions on the registration 
form.    

 Company names—The Company column displays each attendee's 
company name based on the attendee's response to the Company 
question on the registration form.  

Lead scores and company names can help you identify which attendees 
should be given priority in the event. For example, these two features can 
help you and the panelists to set priorities for the questions attendees ask 
during the event. 
  

Important: If you want to display lead scores and company names on the Attendee List, 
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you must do these two things on the registration form: 
 Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add 

Drop-Down List windows. 
 Specify that the "Company" and all questions with assigned scores are required 

information—that is, select the symbol . 

For more information, see Customizing the registration form (on page 13) and About lead 
scores (on page 20). 
  

This figure gives an overview of how you can manage the Attendee List. 
  
 

 

  
 

 
To search for an attendee's name or company name, enter all or a port ion of the text and 
then click Find.  



Chapter 14: Managing an Event 

 

172 

 

 Use this button to hide or display the Score column. 

 Use this button to hide or display the Company column. 

 To sort the Attendee List by score, click the column name. 

 To alphabetically sort the Attendee List by company name, click the column heading. 

 To alphabetically sort the Attendee List by attendee name, click the column heading. 

 
For events using Audio Broadcast only. If  an attendee requests to speak in a 
teleconference, select the attendee's name and then click Allow . After the attendee joins 
the teleconference, you can mute or unmute his or her microphone. 

 
To promote an attendee as a panelist, select the attendee's name and then clic k Make 
Panelist. 

 To remove an attendee from the event, select the attendee's name and then clic k Expel. 

 

Viewing the attendee list 
Typically, only the host, presenter, and other panelists, instead of all 
participants, can see the attendee list in an event. When scheduling an event, 
you determine who can view the attendee list. For more information, see 
Specifying whether to display attendee list to all participants (on page 68). 

To view the Attendee List: 

  
 

 

On the Participants panel, 
click View all attendees. 

The Attendee List dialog box appears. 
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Allowing panelists to view attendees' company names 
Host only 

Panelists cannot view attendees' company names unless you grant them the 
privilege to do so. 

To grant a panelist the privilege to view attendees' company names: 

1 On the Participants panel, right-click the panelist's name and then choose 
Privileges. 

  
 

 

 
  

2 In the Panelist Privileges dialog box, select Company name and then 
click Assign. 

  



Chapter 14: Managing an Event 

 

174 

 

 

 

 
 

Inviting attendees to an event in progress 
After you start an event, the Quick Start tab in your Event window allows you 
to use email, a phone, or instant messaging (IM) to invite additional attendees 
to the event. 

During an event, you can also create a greeting message for attendees when 
they first join the event. 

 

Inviting attendees by email to an event in progress 
During an event, you can send your invitation email message using one of the 
following delivery methods: 

 WebEx email system 

 your default local email program 

An invitation email message you send from the event contains information 
pertaining to the event. You do not need to type the information yourself.  

Each person that you invite receives an invitation email message that includes 
information about the event—including the password, if any—and a link that 
the attendee can click to join the event. 
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To invite additional attendees by email, after you start your event: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the Email tab. 

3 Do one of the following, as appropriate: 

 Enter the email addresses of the attendees, and then click Send. 

 If you want to use your local default email program, such as Microsoft 
Outlook or IBM Lotus Notes, select your local email, and then send 
the email message as usual. 

 

Inviting attendees by phone to an event in progress 
During an event, you can extend your event invitation with just a phone. You 
can call and verbally instruct attendees on how to join your online event. 

To invite an attendee to your event in progress by phone: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the Phone  tab, and then enter the required information. 

3 Verbally give the attendee the instructions on how to join the event. 

After following the instructions on the screen, the attendee joins the event. 
 

Inviting attendees by WebEx Connect to an event in progress 
After starting an event, you can use the WebEx Connect integration to invite 
additional attendees and remind panelists of attending the event. When you 
click the IM option on the QuickStart tab, a WebEx Connect window appears, 
allowing you to send instant messages (IMs) to your contacts. 

The IM automatically includes the event topic, starting time, and a link for 
joining the event. 

Before using WebEx Connect, ensure all of the following: 

 You have WebEx Connect installed and running on your computer. 

 You are logged in to WebEx Connect. 
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 The attendees or panelist who receive your IMs have WebEx Connect or 
other IM applications installed, such as AIM (AOL Instant Messenger), 
GoogleTalk, or Jabber. 

 The attendees or panelists who receive your IMs are logged in to their IM 
programs. 

If your contact is not online when you try to send him or her an IM, WebEx 
Connect automatically switches the method of sending the message to email. 
The email message will still contain the event topic, starting time, and a link 
for joining the event. 
  
 

Note:  
 WebEx Connect is a productivity tool you can use to send instant messages, make 

video and voice calls, share files on your desktop, manage meetings, and 
communicate more efficiently within and outside your company. 

 If you do not have WebEx Connect and want to learn more about it, go to the Cisco 
WebEx Connect Web site (http://www.webex.com/go/wc). 

 To download WebEx Connect, go to the Cisco WebEx Connect Web site 
(http://www.webex.com/go/wc). 

  

To send an invitation IM using WebEx Connect: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the IM  tab and click Invite . 

3 Open the Invite More window in Connect by using one of these methods: 

 In the content viewer of the Event window, under Quick Start > Invite 

Participants, click . 

 On the Participants panel, click the downward-pointing arrow on the 
 button, and then choose Invite by IM . 

4 In the Invite More window that appears, enter the contact's screen name 
or email address: 

 Type the attendee’s Connect screen name or email address in the box. 

 WebEx Connect integrates with your Microsoft Outlook Global Address 
List. Click  to obtain and enter the attendee’s email address from 
Microsoft Outlook. 

http://www.webex.com/go/wc�
http://www.webex.com/go/wc�
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5 Ensure that you select the check boxes next to the names of the 
attendees you want to invite. 

6 Click Invite . 

The attendee receives the IM. The attendee receives an email message if 
he or she is not logged in. 

The following shows an example of the invitation IM. 
 

Inviting attendees by instant messaging (IM) to an event in 
progress 

If you use an IM program other than WebEx Connect, copy and paste the link 
for joining the event and send the IM to the attendee you want to invite. 

 To send an invitation IM using a program other than WebEx Connect: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 
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2 Select the IM  tab. 

3 Click Copy. 

4 Paste the link in an IM window and then send it to the attendee. 
 

Inviting participants by text message (SMS) to an event in 
progress 

You can invite participants by text message (SMS) to an event in progress. 
This feature must be enabled by your site administrator. 

To invite a participant by text message from the meeting: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the SMS tab. 

3 Enter a phone number in the Invitee Mobile Number box. 

4 Click Send. 

The participant receives a text message, which includes: 

 A number the participant can call to join the event 

 The account code 

 Event topic 

 Event start time 

 The host name 

 A reply code to receive a call from the meeting. 
 

Creating a greeting message for attendees 
During an event, you can create a message and display it to attendees once 
they join the event. You can write your own message or edit the default text. 

Example. In your message, you can welcome the attendee to the event and 
provide important information or special instructions about the event. 

To create a greeting message during an event: 

1 In the Event window, on the Event menu, choose Welcome Message . 
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The Create an Attendee Greeting window appears. 
  

 

 

2 Select Display this message when attendees join the event to have the 
message displayed on attendees’ screens when they join the event. 

3 Edit the message in the Message  box. 

4 Click OK. 
 

Inviting attendees to a teleconference in 
progress 

You can invite attendees to only the audio portion of the event by having them 
join a teleconference. 

Example. You are hosting a large all-hands company event online. One of the 
executives prefer listening in to the event because he is on the road. You 
provide his phone number in the Invite by Phone dialog box. When he 
receives a call back at the phone number you provided, he can join the 
teleconference in the event by following the instructions in the voice message. 
  

Important: To use this option, you must set up a call-back teleconference when 
scheduling the event. 
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To invite attendees to only a teleconference in an event: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the Phone  tab. 

3 Enter the attendee’s name and phone number, including the area code. 

4 Ensure that the country or region code is correct. To select a different 
country code, click the down arrow in the Phone Number field. 

5 Click Call. 

The teleconferencing service calls the attendee. The Conference  button 
becomes available for you to call another attendee. 

 

Reminding panelists to join an event in progress 
After you start an event, the Quick Start tab in your Event window allows you 
to use email, a phone, or instant messaging (IM) to remind the invited 
panelists who have not yet joined the event. 

 

Reminding panelists by email 
To remind the invited panelists to join an event in progress, you can send 
reminder email messages using one of the following delivery options: 

 WebEx email system 

 your default local email program, if you use Microsoft Outlook or IBM 
Lotus Notes 

A reminder email message you send from the event contains information 
pertaining to that event, including the password, if any, and a link that the 
panelist can click to join the event. You do not need to type the information 
yourself. 

To remind panelists by email, after you start your event: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the Email tab. 

3 Do one of the following, as appropriate: 
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 Enter the email addresses of the attendees, and then click Send. 

 If you want to use your local default email program, such as Microsoft 
Outlook or IBM Lotus Notes, select your local email, and then send 
the email message as usual. 

 

Reminding panelists by WebEx Connect 
After starting an event, you can use the WebEx Connect integration to invite 
additional attendees and remind panelists of attending the event. When you 
click the IM option on the QuickStart tab, a WebEx Connect window appears, 
allowing you to send instant messages (IMs) to your contacts. 

The IM automatically includes the event topic, starting time, and a link for 
joining the event. 

Before using WebEx Connect, ensure all of the following: 

 You have WebEx Connect installed and running on your computer. 

 You are logged in to WebEx Connect. 

 The attendees or panelist who receive your IMs have WebEx Connect or 
other IM applications installed, such as AIM (AOL Instant Messenger), 
GoogleTalk, or Jabber. 

 The attendees or panelists who receive your IMs are logged in to their IM 
programs. 

If your contact is not online when you try to send him or her an IM, WebEx 
Connect automatically switches the method of sending the message to email. 
The email message will still contain the event topic, starting time, and a link 
for joining the event. 
  
 

Note:  
 WebEx Connect is a productivity tool you can use to send instant messages, make 

video and voice calls, share files on your desktop, manage meetings, and 
communicate more efficiently within and outside your company. 

 If you do not have WebEx Connect and want to learn more about it, go to the Cisco 
WebEx Connect Web site (http://www.webex.com/go/wc). 

 To download WebEx Connect, go to the Cisco WebEx Connect Web site 
(http://www.webex.com/go/wc). 

  

http://www.webex.com/go/wc�
http://www.webex.com/go/wc�
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To send your panelists a reminder IM using WebEx Connect: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the IM  tab and click Invite . 

In the window that appears, the names of the panelists you invited display 
automatically. 

  

 

 
  

3 Ensure that you select the check boxes for the names of the panelists you 
want to remind. 

4 Click Send. 
 

Reminding panelists by instant messaging (IM) 
If you use an IM program other than WebEx Connect, you can copy and paste 
the link for joining the event and send the IM to the invited panelists who are 
not yet in the event. 

 To send a reminder IM using a program other than WebEx Connect: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the IM  tab. 

3 Click Copy. 
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4 Paste the link in an IM window and then send it to the attendee. 
 

Tracking participant attention 
During your event, you can easily tell if attendees  are no longer focused on 
your presentation. The attention indicator shows if an attendee  has: 

 Minimized the event window 

 Brought another window, such as any kind of instant messaging (IM) 
window, in focus on top of the event window 

  
 

 
During an event, you can check: 

 

 Overall attentiveness 

The left side of the bar graph 
indicates the percentage of 
attendees w ho are paying attention; 
the right side indicates the 
percentage of attendees w ho are not 
paying attention.  

 

Individual attentiveness 

If  an attendee  is not paying 
attention, an exclamation mark 
appears next to the name of the 
attendee . 
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After an event ends, you can generate reports to obtain data about individual 
attentiveness. A report contains this information for each attendee : 

 Attention-to-attendance ratio: Attentiveness based on how long the 
attendee  was in the event 

 Attention-to-duration ratio: Attentiveness based on the duration of the 
event 

For details, see About generating reports (on page 430). 
  
 

Note: The attention indicator is unavailable when the host and panelists are in a practice 
session. 

 
 

Checking participant attention in an event 
During an event, you can easily check which attendees  are not paying 
attention.  

To check who is not paying attention in the event: 

Look for the icon  that appears next to the name of the attendee  who is not 
paying attention.   

To check overall attentiveness: 

Click the icon  on the toolbar of your Participants panel. 
 

  
 

 

 
 

Turning on or off attention tracking in an event 
Host only 

You can turn on or off attention tracking in an event. 
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To turn on or off attention tracking in an event (Windows): 

1 On the Event menu, choose Options. 

2 On the Communications tab, select Attention tracking. 

To turn on or off attention tracking in an event (Mac): 

1 On the Event Center menu, select Preferences. 

2 Select the Tools button. 

3 Select Attention tracking. 

4 Select OK. 

  
 

Note: If the Attention tracking option is unavailable, contact your site administrator. 

 
 

Granting attention tracking privilege 
Host only 

By default, all panelists in an event have the privilege to view the attention 
indicator. You can remove the privilege from them or grant the privilege to 
them at any time during the event. 

To remove or grant the attention tracking privilege: 

1 On the Participant menu, choose Assign Privileges To > Panelists.  

2 If you use the Mac, select the Communications tab. 

3 Check or uncheck Attention Tracking, as appropriate. 
 

Designating a presenter 
As the host, you are initially the presenter as well. During an event, you can 
designate any panelist as the presenter. You can also reassume the 
presenter role or change the presenter at any time. 
  



Chapter 14: Managing an Event 

 

186 

 

 

Important: Changing the presenter discontinues any application, Web browser, or 
desktop sharing session currently in progress. However, any documents, presentations, 
or whiteboards that the current presenter is sharing remain in the content viewer of the 
Event window. 
  

To designate a presenter: 

1 On the Participants panel, select the name of the panelist whom you want 
to designate as the presenter. 

2 Do either of the following: 

 On the Participants panel, click the Make presenter button . 

 On the Participant menu, choose Change Role to > Presenter. 

The green presenter indicator appears to the left of the panelist’s name. 

To reclaim the presenter role: 

On the Participants panel, select your own name, and then click the Make 
presenter button . 
  
 

Note: If the presenter leaves the event, the host becomes the presenter. 
 

Designating a panelist 
During an event, you can designate any attendee as a panelist. You can also 
change panelists at any time. For details about a panelist’s role, see About 
panelist roles and privileges (on page 187). 

To designate a panelist: 

1 On the Participants panel, click View all attendees. 

The Attendee List appears. 

2 Select the name of the attendee whom you want to designate as a 
panelist, and then click Make Panelist. 

The attendee’s name appears in the panelists list. 
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About panelist roles and privileges 
The host can designate any attendee as a panelist during an event. A panelist 
is a participant who is primarily responsible for assisting the presenter and 
participating in presentation. Any number of attendees can be panelists. 

A panelist can do the following during an event: 

 participate in discussions to which other attendees listen 

 serve as a subject matter expert in a Q & A session 

 view and answer questions by attendees in a Q & A session 

 respond to public and private chat messages 

 participate in a practice session 

 annotate shared documents 

 annotate shared applications, Web browsers, and desktops, if the 
presenter grants annotation control to the panelist 

 become a polling coordinator to manage polls 

 view feedback 

 record an event 

 save chat messages to a file 

 download files that the presenter publishes 
 

Transferring the host role 
  

If you want to... See... 

transfer the host role to a panelist Transferring the host role (on page 188)  

reclaim your host role after you transfer it Reclaiming the host role (on page 188)  
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Transferring the host role 
As the event host, you can transfer the host role—and control of the event—to 
a panelist at any time. This option is useful if you need to leave an event for 
any reason. You can reclaim the host role at any time. 

To transfer the host role to a panelist: 

1 Optional. If you plan to reclaim the host role later, write down the host key 
that is displayed on the Info tab in the Event window's content viewer. 

2 On the Participants panel and in the panelists list, select the name of the 
panelist to whom you want to transfer the host role. 

3 On the Participant menu, click Change Role to > Host. 

A confirmation message appears, in which you can verify that you want to 
transfer control of the event to the panelist whom you selected. 

4 Click OK. 
 

Reclaiming the host role 
If you have transferred control of an event to a panelist, you can gain control 
of the event by reclaiming the host role. 

To reclaim the host role: 

1 On the Participants panel, select your own name. 

2 On the Participant menu, choose Reclaim Host Role . 

The Reclaim Host Role dialog box appears. 

3 Type the host key in the Host key box. 

4 Click OK. 
 

Tip:  
 If you did not write down the host key before transferring the host role to another 

panelist, you can ask the current host to send you the host key in a private chat 
message. The host key appears on the current host's Info tab in the content viewer. 

 If you leave an event—whether intentionally or inadvertently—and then log back in to 
your Event Center Web site, you automatically become the event host once you 
rejoin the event. You can rejoin an event using your list of scheduled events under 
My WebEx. 
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Restricting access to an event 
Once you start an event, you can restrict access to it at any time. This option 
prevents anyone from joining the event, including attendees whom you invited 
to the event but have not yet joined it. 

To restrict access to an event: 

In the Event window, on the Event menu, choose Restrict Access. 

Attendees can no longer join the event. 

To restore access to an event: 

On the Event menu, choose Restore Access. 
 

Removing a participant from an event 
You can remove a panelist or an attendee from an event at any time. 

To remove an attendee from an event: 

1 On the Participants panel, click View all attendees. 

The Attendee List dialog box appears. 

2 Select the name of the attendee whom you want to remove, and then click 
Expel. 

A confirmation message appears. 

3 Click Yes. 

The attendee is removed from the event. 

To remove a panelist from an event: 

1 On the Participants panel, and in the panelists list, select the name of the 
panelist whom you want to remove. 

2 On the Participant menu, choose Expel. 

A confirmation message appears. 

3 Click Yes. 
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The panelist is removed from the event. 

  
 

Tip: To prevent an expelled attendee from rejoining an event, you can restrict access to 
the event. For details, see Restricting access to an event (on page 189). 

 

Ending an event 
 

If you want to... See... 

leave an event as the host Leaving an event as the host (on page 190)  

end an event for all part icipants Ending an event (on page 191) 

 

Leaving an event as the host 
If you want to leave an event but do not want to end the event for all 
participants, you can transfer the host role to a panelist before leaving. 

If you are participating in a call-back teleconference or an Internet phone 
conference, Event Center disconnects you from the conference once you 
leave the event. 

To leave an event: 

1 In the Event window, on the File  menu, choose End Event. 

The End Event dialog box appears. 

2 Select Leave this event without ending it. 

3 In the New Host drop-down list, choose the panelist to whom you want to 
transfer the host role. 

4 Click OK. 

If you have not yet saved annotated documents or presentations, poll 
questionnaire, poll results, or chat messages, Event Center asks you 
whether you want to save them before ending the event. Once you 
respond to the message, the Event window closes. 
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Ending an event 
Once you end an event, the Event window closes for all participants. If the 
event includes an integrated teleconference or an Internet phone conference, 
the conference also ends. 

To end an event: 

1 In the Event window, on the File  menu, choose End Event. 

The End Event dialog box appears. 

2 Select End this event for all participants, and then click OK. 

If you have not yet saved annotated documents or presentations, poll 
questionnaire, poll results, or chat messages, Event Center asks you 
whether you want to save them before ending the event. Once you 
respond to the message, the Event window closes. 
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Host only 

During a question-and-answer (Q & A) session, you can respond to questions 
that attendees ask during the event. A Q & A session not only provides instant 
text messaging similar to that in Chat, but also does the following: 

 Provides a more formal procedure for asking and answering questions in 
text format 

 Automatically groups questions to help you manage the queue, such as 
quickly identifying questions that you have or have not answered 

 Displays visual cues for the status of questions 

 Lets you assign questions to the appropriate domain expert on your team 

 Allows you to quickly send a standard response to questions for which you 
cannot or do not want to answer immediately 

You can save the questions and answers in a Q & A session to either a text 
(.txt) file or a comma-separated/comma-delimited values (.csv) file for future 
reference. 
  
 

Tip: If you use Q & A during an event, WebEx recommends that a panelist (the host or 
presenter) monitors the Q & A panel at all times during the event. 

 
 

Managing Question-and-
Answer Sessions 
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Allowing participants to use Q & A 
Host only 

To use Q & A during an event, ensure that the Q & A option is turned on. You 
can also turn it off at any time, if necessary. 

To turn on or off Q & A during an event (Windows): 

1 In the Event window, on the Event menu, choose Options. 

An options dialog box appears. 

2 On the Communications tab, check or uncheck Q & A, as appropriate, 
and then select OK. 

To turn on or off Q & A during an event (Mac): 

1 In the Event window, on the Event Center menu, select Preferences. 

2 Select Tools. 

3 Check or uncheck Q & A, and then select OK. 
 

 

Setting privacy views in Q & A sessions 
Host only 

To protect the privacy of panelists and attendees during an event, you can 
hide or show the following information when questions and answers are 
published on attendees' Q & A panels: 

 Names of attendees who send questions 

 Names of panelists who send answers 

 Time stamps for questions and answers respectively 

  
 

Note: The names of attendees and panelists and time stamps are always visible on 
panelists' Q & A panels. 
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To set privacy views: 

1 Open the Attendee Options dialog by following one of these steps: 

 Windows: Right-click the title bar of your Q & A panel, and then choose 
Attendee Options. 

 Mac: Select ctrl, click, and then choose Attendee Options. 
  
 

 

 

2 In the dialog box that appears, select any of the options that you want 
attendees to see, and then click OK. 

  

 

 

 
 

Managing questions on your Q & A panel 
The tabs and visual cues on your Q & A panel allow you to manage the 
questions you receive in the queue in the following ways: 
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 Set a priority for any question you have received 

 Identify the status of questions and answers—answered, unanswered, 
assigned, private, dismissed, or deferred—and address questions that 
need your attention. 

 Assign questions to the appropriate expert on your team in the event. 

 Get an idea of the interactions between the panelists and attendees who 
ask questions. 

  
  

 
  
 

 The auto-grouping of questions by tab make it easy for you to f ilter and answ er questions.  

Examples: 

Follow  up on the questions that are sent or assigned to you on the My Q & A panel. 

View  questions that have been given a priority status on the Prioritized tab; view  only 
questions w ith a certain prior ity status on the Prioritized tab. 

 Visual cues, such as "deferred" and "private,"  tell you the status of a question.  

 A question appears bold if  no panelist has answ ered it.  
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 Right-click (Windows) or select ctrl and click (Mac) a question to: 

 Assign it to a subject-matter expert, defer it, or dismiss it  

 Assign a priority status  

 Send a standard response if this question has been answ ered verbally 

 

Working with the tabs on your Q & A panel 
Your Q & A panel consists of five tabs. The All tab displays by default. The 
following table describes what each tab displays. 
  
 
Tab Displays ...  

All All questions and answ ers—unansw ered, answ ered, 
private, deferred, and dismissed—in the queue 

Unanswered Questions that have not been answ ered by a panelist  

Answered Questions that have been answ ered by a panelist and 
answ ers 

My Q & A  Questions that 

 attendees specif ically send to you by your name 

 other panelists assign to you 

 attendees send to All Panelists and that you have 
answ ered 

 attendees send to Host&Presenter, Host, or 
Presenter, if  you are the host or presenter  

Prioritized Questions that have been assigned a priority status  

 

 

Opening a tab 
When you open the Q & A panel, the All tab appears by default. 

To open other tabs on the Q & A panel: 

1 Depending on the operating system you are using, follow one of these 
steps: 
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 Windows: Right-click the All tab. 

 Mac: Select ctrl and then click the All tab. 

2 Choose Open Tab > the tab you want to open. 
  

 

 

3 If you want to open one more tab, right-click (Windows) or select ctrl and 
click (Mac) any of the open tab, and then choose Open Tab > the tab you 
want to open. 

Displaying hidden tabs 

The Q & A panel cannot display all open tabs at one time unless you expand 
the panels to the left. 

To display a hidden tab on the Q & A panel: 

Click the downward arrow, and then choose the tab you want to display. 
  

 

 
 

Closing a tab 
You can close all the tabs, except the All tab, on your Q & A panel. 

To close a tab on the Q & A panel: 

Click the X button on the tab you want to close. 
  
 

Note: Closing a tab does not remove the information on the tab. You can view the 
information on that tab by opening it again. More… (on page 197) 
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Assigning a question 
You can assign questions to yourself or another panelist. The questions 
appear on the designated panelists' My Q & A tab, with the text assigned next 
to them. 

To assign a question: 

From any of the tabs on which you received the question, right-click 
(Windows) or select ctrl and then click (Mac) the question, and then choose 
Assign to > the person you want to assign it to. 
  

 
  
 

Note:  
 To assign multiple questions at the same time, hold down the Ctrl key while 

selecting the questions. 
 If an assigned question is answered, the text assigned still displays. 
 The text assigned does not display on attendees' Q & A panels. 

 

Prioritizing questions 
You can set priorities—high, medium, or low—for any questions you have 
received on the Q & A panel. Your prioritized questions display on the 
Prioritized tab. 

To set a priority for a question: 
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Right-click (Windows) or select ctrl 
and then click (Mac) the question, 
and then choose Priority > High, 
Medium , or Low . 

 

Fast track 

After you set a priority for a question 
for the f irst time during an event, a 
column appears to the left of the Q & 
A panel show ing rectangular icons. 

Click the rectangular icon for the 
question you w ant to set priorities 
for, and then choose High, Medium , 
or Low . 

 

To remove the priority status from 
a question: 
Click the rectangular icon for the 
question, and then choose Clear. 

 

 

Viewing prioritized questions 
You view your prioritized questions on the Prioritized tab. 

To view your prioritized questions: 

1 Click the Prioritized tab. 
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2 Optional. To view only questions with a certain priority status, select the 
status at the "View priority" option. 

  
 

 

 

If  you do not w ant to view  
questions w ith a certain 
status, uncheck the 
appropriate check box. 

 

 

Answering questions in a Q & A session 
During a Q & A session, you can: 

 Provide an answer to a question publicly. More… (on page 202) 

 Provide an answer to a question privately. More… (on page 202) 

 Defer a question. More… (on page 204) 

 Dismiss a question. More… (on page 203) 

  
 

Tip: You can respond to a question from any of the four tabs on which you receive the 
specific question. If a question shows as assigned on the All tab, you can check whether 
this question has been assigned to you on your My Q & A tab.  
  

When a panelist is typing an answer to a question that no one else has 
responded to yet, an in-progress indicator displays under that question for all 
participants. This figure shows an example. 
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Providing a public answer 
Your answer to a question appears on all participants' Q & A panels, unless 
you choose to send your answer privately. 

To provide a public answer during a Q & A session: 

1 On your Q&A panel, select the question from any of the tabs on which you 
received the question. 

  
 

 

 

To select a question, click it once.  

To copy the question into the text box, right-
click (Windows) or press ctrl and then click 
(Mac) your mouse, choose Copy , and then 
paste it in the text box. 

To clear the selection, right-clic k (Window s) 
or press ctrl and then click (Mac) the 
question, and then choose Deselect. 

  

2 Type your answer in the text box. 

To edit your answer before sending it, highlight the text you want to edit 
and then right-click (Windows) or press ctrl and then click (Mac) the 
highlighted text. The menu that appears provides editing commands. 

3 When you finish typing your answer, click Send. 

The answer appears on all panelists' and attendees' Q & A panels. 
 

Answering a question privately 
If you send your answer privately, these participants can see the private 
answer: 

 the attendee who sent you the question 

 all panelists 

To answer a question privately: 

1 On your Q&A panel, select the question from any of the tabs on which you 
received the question, and then click Send Privately. 
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To select a question, click it once.  

To copy the question into the text box, right-clic k 
(Windows) or press ctrl and then click (Mac) your 
mouse, choose Copy, and then paste it in the text 
box. 

To clear the selection, right-clic k (Window s) or press 
ctrl and then click (Mac) the question, and then 
choose Deselect. 

  

2 In the dialog box that appears, type your answer in the text box. 

3 If you want to save the answer you typed as the standard private answer 
for all panelists to use, click Save or Save as Default. 

4 Click Send. 
 

Dismissing a question 
In a Q & A session, you can dismiss a question using a standard or 
customized answer. The standard answer reads: Thank you for your question. 
The information that you requested cannot be provided by any of the 
panelists. 

If you dismiss a question, these participants can see the Dismiss answer: 

 the attendee who sent the question 

 all panelists 

To dismiss a question during a Q & A session: 

1 From any of the tabs where you received the question, right-click the 
question, and then choose Dismiss. 

  
 

 Tip for Windows users: To dismiss multiple questions at one time, hold down 
the Ctrl key while selecting the questions, right-click your mouse, and then 
choose Dismiss. 

The Respond Privately dialog box appears, containing the standard 
Dismiss answer. 
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2 Optional. To customize the standard answer, click Custom, and then edit 
the text in the text box. 

3 Optional. To save your customized answer as the standard Dismiss 
answer for all panelists to use, click Save  (Windows) or Save as Default 
(Mac). 

4 Click Send. 

5 Click Yes in the confirmation message box. 
 

Deferring a question 
In a Q & A session, you can defer a question using a standard or customized 
answer. The standard answer reads: Thank you for your question. Your 
question was deferred but will remain in the queue. A panelist will answer 
your question at a later time. 

If you defer a question, the following participants can see the Defer answer: 

 the attendee who sent the question 

 all panelists 

To defer a question during a Q & A session: 

1 From any of the tabs where you received the question, right-click the 
question, and then choose Defer. 

  
 

 Tip for Windows users: To defer multiple questions at one time, hold down the Ctrl 
key while selecting the questions, right-click your mouse, and then choose Defer. 

The Respond Privately dialog box appears, containing the standard Defer 
answer. 

2 Optional. To customize the standard answer, click Custom, and then edit 
the text in the text box. 

3 Optional. To save your customized answer as the standard Defer answer 
for all panelists to use, click Save  (Windows) or Save as Default (Mac). 

4 Click Send. 
 



 Chapter 15: Managing Question-and-Answer Sessions 

 

205 

 

Responding to questions answered verbally 
If a question has been answered verbally, you can send a standard response: 
This question has been answered verbally. 

Follow these steps: 
  
 

 

Right-click (Windows) or select 
ctrl and then click (Mac) the 
question and then choose 
Answered Verbally. 

 

 

 

Archiving Q & A sessions 
At any time during an event, you can save the questions and answers on the 
All tab on your Q & A panel to a .txt or .csv (comma-separated/comma-
delimited values) file. If there are updates in the Q & A session, you can save 
them to the existing file. 

Once you save a new Q & A session to a file, you can also save a copy to 
another file. 

 

Saving a Q & A session 
At any time during an event, you can save the questions and answers on the 
All tab on your Q & A panel to a .txt or .csv file. 
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Note: Event Manager automatically saves Q & A sessions every two minutes to the 
WebEx folder in the My Documents folder on the host and presenter computers. 
  

To save a Q & A session: 

1 In the Event window, on the File  menu, choose Save > Questions and 
Answers. 

2 Choose a location at which to save the file. 

3 Type a name for the file. 

4 In the Save as type box, select Text Files (*.txt) or CSV (comma-
separated/comma-delimited values). 

5 Click Save . 

Event Manager saves the file at the location and format that you chose. 

To review the content of an archived Q & A session, open the .txt file in a text 
editor or the .csv file in a spreadsheet program, such as Microsoft Excel. 

 

Saving changes to a saved Q & A session 
If you have previously saved a Q & A session, and there are additional 
changes in the Q & A session, you can save the updates to the existing file. 

To save changes in an existing Q & A file: 

In the event window, on the File  menu, choose Save > Questions and 
Answers. 

Event Center saves the changes to the existing Q & A file. 
  
 

Note: If there are no changes on the All tab on your Q & A panel, the Save option is 
unavailable. 

 

Saving a copy of a previously saved Q & A session 
If you have previously saved a Q & A session, and you want to save another 
copy of the session, you can do so by following these steps: 
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1 In the Event window, on the File  menu, choose Save As > Question and 
Answers. 

The Save Questions and Answers As dialog box appears. 

2 Do any or all of the following: 

 Type a new name for the file. 

 Choose a new location at which to save the file. 

 Choose a different format for the file. 

3 Click Save . 

Event Manager saves the file with any additional changes in the Q & A 
session. 

 

Opening a Q & A file 
The Q & A files that you saved during an event have either a .txt or .csv 
extension. 

To view a .txt file, open it in a text editor, such as Notepad. 

To view a .csv file, open it in a spreadsheet program, such as Microsoft Excel. 
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Question-and-Answer (Q & A) sessions during an event allow you to ask 
questions and receive answers using your Q & A panel, in a more formal way 
than Chat. 

Your Q & A panel automatically groups questions and answers into these two 
tabs, which make it easy for you to check whether your questions have been 
answered: 

All—all questions and answers in a Q & A session during the event More… 
(on page 209) 

My Q & A—the questions you sent and the answers to your questions More… 
(on page 209) 
  
 

Note: The host has to turn on the Q & A function in the event before you can use the Q & 
A panel. 

 
 

Working with the tabs on your Q & A panel 
Your Q & A panel provides two views of the question-and-answer queue: the 
All and My Q & A tabs. The All tab stays open all the time on your Q & A 
panel. 

The My Q & A tab displays as soon as you send your first question using Q & 
A. You can close the My Q & A tab at any time. 

Participating in a Question-
and-Answer Session 
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To open the My Q & A tab: 

Right-click (Windows) or select ctrl and then click (Mac) the All tab, and then 
choose Open Tab > My Q & A. 

To close the My Q & A tab: 

Right-click (Windows) or select ctrl and then click (Mac) the My Q & A tab, 
and then choose Close Tab. 
  
 

Note: Closing the My Q & A tab does not cause you to lose the questions and answers 
on the tab. You can re-open it at any time. 

 
 

Asking a question in a Q & A session 
During an event, you can send your questions to all or specific panelists in a 
Q & A session. 

To ask a question in a Q & A session: 

1 Open the Q & A panel. 

2 On the Q & A panel, type your question in the text box. 

3 Optional. To edit your question, highlight the text you want to edit, and 
then right-click (Windows) or select ctrl and then click (Mac) to use the 
editing commands in the menu. 

4 In the Ask drop-down list, select the recipient, and then click Send. 
 

Checking the status of your questions 
The auto-grouping of questions and answers and visual cues on attendees' Q 
& A panels make it easy for you to check whether a panelist has responded to 
your question. 

Always check the My Q & A tab to quickly find out whether your question has 
been answered. More… (on page 211) 

When a panelist is answering your question, an indicator appears under the 
question. More… (on page 211) 
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My Q & A tab 
Your Q & A panel provides two views of the question-and-answer queue: the 
All and My Q & A tabs. Always check the My Q & A tab to quickly find out 
whether your question has been answered. This tab displays a list of the 
questions you sent and the answers, whether public or private, to those 
questions. 
  
 

 

 

 The My Q & A tab displays the questions that you sent and the answ ers to those 
questions. 

 

 If  a panelist answ ers your question privately, the text private appears next to the answ er. 
No attendee can see this private answ er, except yourself. 

 

 

Answering indicator 
When a panelist is typing an answer to a question, an in-progress indicator 
displays under that question. This figure shows an example. 
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C h a pt er  1 7 

An integrated teleconference can be either a call-in teleconference or call-
back teleconference. 

Your user role in a teleconference determines your level of participation. 
Whichever role you take, the following table describes the basic tasks 
associated with that role. For detailed instructions on a particular task, click 
“More” by the task description. 
  
 

Role  Task description: 

Host 

 

Start and manage a 
teleconference: 

 join the 
conference 
More… (on page 
214)  

 invite participants 
More… (on page 
179)  

 use caller 
identif ication to 
start or join 
teleconferences 
More… (on page 
216)  

 mute or unmute 
one or more 
microphones 
More… (on page 
216)  

Using Teleconferencing 
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Role  Task description: 

Participants 

 

Participate in a 
teleconference: 

 Join, rejoin, or 
leave a 
conference 
More… (on page 
214)  

 Mute or unmute 
your microphone 
More… (on page 
219)  

 Ask to speak 
More… (on page 
219)  

  
 

Note: If you set up another type of teleconference, such as that of a third-party 
teleconferencing service, you must manage the conference using the options that service 
provides. 

 

Joining or leaving a teleconference 
Once you join an event, instructions for joining the teleconference 
automatically appear on your screen. The instructions differ, depending on 
whether the host set up a call-back teleconference or a call-in teleconference. 

During an event, you can leave a teleconference without leaving the event. 
You can also rejoin the teleconference at any time. 
  

 

 

Once you join a teleconference, the 
Teleconference indicator appears to the left of 
your name on the Participants panel. 

To join a call-back teleconference: 

In the Join Teleconference dialog box, provide your phone number. The 
automated system will call you and add you to the teleconference. 
 

Tips for joining a call-back teleconference:  
 Select the Remember phone number on this computer check box if you want this 
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number to be entered automatically each time you join a teleconference. 
 If you are unable to join a call-back conference, you can dial the backup call-in 

number instead. To obtain the call-back number, see your invitation email message, 
if you received one; find it on the Info tab in the Event window; or find it by choosing 
Information on the Event menu. 

  

To join a call-in teleconference: 

In the Join Teleconference dialog box, dial the appropriate number to join the 
teleconference. 
 

Note for joining a call-in teleconference: If the global call-in numbers option is 
available, a list of international phone numbers appears on the Join Teleconference 
dialog box. Dial the appropriate number for your location, and then click OK to close the 
dialog box. For a list of toll-free calling restrictions by country, see 
www.webex.com/pdf/tollfree_restrictions.pdf.  

To display teleconference instructions during an event: 

On the Communicate  menu, choose Join Teleconference . 

To rejoin a teleconference: 

On the Communicate  menu, choose Join Teleconference . 

To leave a teleconference: 

Hang up the phone; or choose Leave Teleconference  on the Communicate  
menu. 

 

Inviting attendees to a teleconference in 
progress 

You can invite attendees to only the audio portion of the event by having them 
join a teleconference. 

Example. You are hosting a large all-hands company event online. One of the 
executives prefer listening in to the event because he is on the road. You 
provide his phone number in the Invite by Phone dialog box. When he 
receives a call back at the phone number you provided, he can join the 
teleconference in the event by following the instructions in the voice message. 
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Important: To use this option, you must set up a call-back teleconference when 
scheduling the event. 
  

To invite attendees to only a teleconference in an event: 

1 In your content viewer, select the Quick Start tab and click Invite and 
Remind. 

2 Select the Phone  tab. 

3 Enter the attendee’s name and phone number, including the area code. 

4 Ensure that the country or region code is correct. To select a different 
country code, click the down arrow in the Phone Number field.  

5 Click Call. 

The teleconferencing service calls the attendee. The Conference  button 
becomes available for you to call another attendee. 

 

Muting and unmuting microphones in a 
teleconference 

The following table illustrates how to quickly mute and unmute microphones in 
a teleconference depending on your user role. For detailed instructions, click 
“More” by the task description. 
 

Role Task description 

Host You can: 

 Mute all attendees' microphones automatically w hen they join a 
meeting More… (on page 217)  

 Mute or unmute a spec if ic participant's microphone More… (on 
page 217)  

 Mute or unmute all attendees' microphones simultaneously at any 
time during a meeting More… (on page 218) 

Participant Mute or unmute your ow n microphone at any time More… (on page 
219)  
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Muting participants' microphones automatically when they 
join an event 

Host only 

In a teleconference, you can automatically mute all participants' microphones 
as they join the event. You can then allow specific participants to speak by 
unmuting their microphones. 

To mute all participants' microphones when they join the event : 

On the Participant menu, choose Mute on Entry. 

Once a participant joins the event, the Muted indicator appears to the left of 
the participant's name. For example: 
  

 

You can see the attendee list by clicking View all attendees on the 
Participants panel. 
  
 

Note: Attendees for whom you have muted microphones can request to speak at any 
time during an event, by clicking Raise Hand on their Participant panels. 

 
 

Muting and unmuting a specific participant's microphone 
Host only 

In a teleconference, you can mute or unmute a specific participant's 
microphone, including the microphone for: 

 An attendee 

 The presenter 

 Any panelist 

To mute or unmute a specific participant's microphone: 

1 On the Participants panel, select one or more participants for whom you 
want to mute or unmute microphones. 
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To select multiple attendees, hold down the Ctrl key on your keyboard. 

2 On the Participants panel, click Mute  or Unmute  to control each 
participant's microphone. 

  
 

 

The indicator beside the attendee's name 
changes state w hen you mute or unmute 
the attendee's microphone. 

  
 

Note: Attendees for whom you have muted microphones can request to speak at any 
time during an event, by clicking Raise Hand on their Participant panels. 

 
 

Muting and unmuting all attendees' microphones 
simultaneously 

Host only 

During a teleconference, you can mute or unmute all attendees' microphones 
simultaneously. 

This option does not affect the host’s, the presenter’s, and any panelists’ 
microphones. 
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To mute all attendees' microphones To unmute all attendees' microphones 

 Using your phone keys, press “##” 

 On the Participant menu, choose Mute 
All 

 Using your phone keys, press “99” 

 On the Participant menu, choose 
Unmute All 

  
 

Note: Attendees for whom you have muted microphones can request to speak at any 
time during an event, by clicking Raise Hand on their Participant panels. 

 
 

Muting and unmuting your microphone in a teleconference 
Participant 

In a teleconference, you can mute or unmute your microphone at any time. 
However, if the host has muted your microphone, you cannot unmute it.  

To mute or unmute your microphone: 

On the Participants panel, select your name, and then click Mute  or UnMute . 
 

Asking to speak in a teleconference 
Participant 

If the host has muted your microphone during a teleconference, you can ask 
the host to unmute your microphone so that you can speak. You can cancel a 
request to speak at any time. 
  

To ask to speak  Result 

Click Raise Hand On 
the Participants' panel 

 

 

The Raised Hand indicator appears on the 
Participant panel for the host, presenter, and 
panelists. 
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To cancel a request to speak 
 

Result 

Click Lower Hand On the 
Participants' panel 

 

 

The Raised Hand indicator is 
removed from the Partic ipant panel 
for the host, presenter, and panelists. 

 

Determining who is speaking in a teleconference 
Participant 

During a teleconference, you can quickly determine which participants are 
speaking. When a participant speaks, the Teleconference  indicator on the 
Participants panel animates. For example: 
  
 

 

 

Broadcasting audio streams to all attendees 
Audio broadcast allows the host, presenter, and other panelists to speak to 
attendees without requiring them to connect to a teleconference. Attendees 
can listen to the audio part of the event through their speakers or headsets. 

Using audio broadcast can help reduce the cost of a large event because 
attendees do not need to connect to a teleconference. 

During an audio broadcast, attendees must have the necessary audio 
capacity such as speakers or headsets to listen to the audio part of the event. 

Your user role in an audio broadcast determines your level of participation. 
The following table describes the tasks you may want to perform in an audio 
broadcast. For detailed instructions, click "More" by a task description. 
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Role 
 

Task description: 

host  

 

Start and manage a 
teleconference: 

 Broadcast audio 
to all attendees in 
the event. More…  
(on page 221)  

 Accept an 
attendee’s request 
to speak. More… 
(on page 224)  

attendee 

 

Connect to an audio 
broadcast: 

 Ask to join the 
teleconference so 
that you can 
speak. More… (on 
page 224)  

 Control the audio 
on your computer. 
More… (on page 
225)  

 Leave audio 
broadcast. More… 
(on page 226)  

 Rejoin audio 
broadcast. More… 
(on page 226)  

 

Starting an audio broadcast 
Host only 

You and the other panelists must join a teleconference first before you can 
use audio broadcast.  
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To broadcast audio stream in an event, you must select the audio broadcast 
option when scheduling the event. If you select the audio broadcast option 
when scheduling an event, Integrated VoIP becomes unavailable. 

 

Using a third-party teleconference for audio broadcast 

If you use a third-party teleconference provider, rather than the WebEx 
teleconferencing service, you must also connect your third-party 
teleconference bridge to the audio broadcast.  

To connect your third-party teleconference bridge to audio broadcast: 

Provide your teleconference account information in the Audio Broadcast 
Connection dialog box. 
  
 

 

After you enter your account 
information, click Next to 
connect to the teleconference 
bridge. 

  

This table describes each option and text box in the Audio Broadcast 
Connection dialog box: 
  
 

 Use this option or text box To… 

Dial-in number 
Enter the dial- in number for a teleconference.  

Note: The number cannot contain characters, such as - 
— (). 
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 Use this option or text box To… 

Greeting bypass digit 
Select the key or digit, if  there is one, that you use to 
bypass the greeting w hen you call the dial-in number.  

Pause before user ID 

Specify the amount of time you have to w ait before you 
are asked to enter your user ID. Note that if  you choose to 
bypass the greeting, the w ait is shorter. 

Depending on your teleconference service, a user ID 
could be called a pin number, conference ID, meeting 
number, or an access code. 

User ID 

Enter your user ID. If  you are asked to press a key at the 
end of your user ID, ensure to include it.  

Depending on your teleconference service, a user ID 
could be called a pin number, conference ID, meeting 
number, or an access code. 

Pause before user PIN 

Specify the amount of time you have to w ait from the t ime 
you f inish entering the last key to the time you are asked 
to enter a second user ID, if  there is one.  

Depending on your teleconference service, a pin could be 
called a pin number, user ID, conference ID, meeting 
number, or an access code. 

User PIN 

Enter your pin number—that is, the second user ID you 
are asked to enter, if  there is one. 

Depending on your teleconference service, a pin could be 
called a pin number, user ID, conference ID, meeting 
number, or an access code. 

 

Tips for connecting a third-party teleconference to audio broadcast 

These are tips that can help you connect to audio broadcast more efficiently 
during an event: 

 Do dry runs to understand the call flow. For example, take notes of what is 
the greeting bypass key and how long is the pause before you are asked 
to provide your access code. 

 Start your event early, and connect to a teleconference early to ensure no 
delay in your event. 
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Asking to speak during an audio broadcast 
Attendees only 

Once you join the event, audio broadcast starts automatically, and you will 
hear the audio part of the event. If necessary, you can request to join the 
teleconference to speak. 

To request to join the teleconference to speak: 

On your Participant’s panel, click Request.  

 If your request is granted, instructions for joining the teleconference 
appear on your screen. 

 If your request is denied, a message appears on your screen to that effect. 
 

Accepting an attendee’s request to speak 
During audio broadcast, attendees can listen to only the audio part of the 
event. If it is necessary, an attendee can request to join the teleconference 
and speak. After an attendee makes a request, an indicator appears to the left 
of the attendee’s name on the Participants panel and the Attendee List dialog 
box.  

To grant the teleconferencing privilege to an attendee who makes a request: 

Do either of the following: 

 On your Participants panel, select the attendee’s name, and then click 
Allow. 

 Click View all attendees on your Participants panel to open the Attendee 
List dialog box. In the dialog box, select the attendee’s name, and then 
click Allow. 

The attendee then sees instructions for joining the teleconference on his or 
her screen. 

The following figure shows an example of your Participants panel during audio 
broadcast. You can open the Attendee List dialog box by clicking View all 
attendees. 
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An indicator appears next to the attendee’s 
name w hen the attendee is asking to join the 
teleconference. 

 

 

Automatically granting attendees the teleconferencing privilege 

If you want to automatically grant the teleconferencing privilege to each 
attendee who makes a request, do the following: 

1 On the Participant menu, click Assign Privileges To > Attendees.  

2 Select Automatically approve teleconferencing requests, and then 
click Assign. 

Attendees will receive instructions for joining the teleconference once they 
request to speak. 

 

Controlling the audio on your computer 
During an audio broadcast, you can use the Audio broadcast panel to pause, 
stop, or resume audio broadcast and to adjust the audio volume. 
  
 

 
  
 

 To pause or resume audio broadcast on your computer, clic k this button. 
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 To stop audio broadcast on your computer, click this button. 

 To adjust the audio volume, use the volume slider. 

 

Leaving audio broadcast 
You can leave audio broadcast at any time. 

To leave audio broadcast: 

In the Event window, choose Communicate  > Leave Audio Broadcast. 

Your Audio broadcast panel closes. 
 

Joining audio broadcast 
If you closed your Audio Broadcasting panel for any reason, you can rejoin 
audio broadcast at any time. 

To join audio broadcast: 

In the Event window, choose Communicate  > Join Audio Broadcast. 

Your Audio Broadcast panel appears. 
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During an event, you can join an integrated voice conference in which 
participants speak to each other using Voice over Internet Protocol (VoIP)—a 
technology that transmits voice calls over the Internet. Integrated voice 
conferences are useful if  

 Participants are located a great distance away and do not want to incur 
long distance phone charges. 

 The event is a presentation rather than a discussion and does not involve 
interaction among participants. 

Your user role in an integrated VoIP conference determines your level of 
participation. Whichever role you take, the following table describes the basic 
tasks associated with that role. For detailed instructions on a particular task, 
click “More” by a task description. 

Using Integrated VoIP 
Conferences 
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Role  Task description: 

host   

 

Start and manage an integrated 
VoIP conference: 

 set conference options 
More… (on page 234)  

 start or end a conference 
More… (on page 228)  

 Allow  a participant to speak 
More… (on page 230)  

 mute or unmute part icipant 
microphones More…  (on 
page 232)  

 Mute or unmute your 
microphone More… (on 
page 233)  

participant 

 

Participate in an integrated 
VoIP conference: 

 Join or leave a conference 
More… (on page 229)  

 Mute or unmute your 
microphone More… (on 
page 233)  

 Ask to speak More…  (on 
page 229)  

  

Note: For better audio quality and greater convenience, use a computer headset with a 
high-quality microphone, rather than speakers and a microphone. 

 

Starting or ending an integrated voice 
conference 

Once a host and panelist starts an integrated VoIP conference, any 
participant whose computer has a supported sound card can join the 
conference. Up to seven participants can speak at a time in an integrated 
VoIP conference. The host and panelist determines who can speak by 
passing the microphone to a participant. 

A host and panelist can end an integrated VoIP conference at any time. 
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To start or end an integrated VoIP conference: 

On the Audio menu, choose Integrated VoIP > Start Conference  or End 
Conference . 

  
 

Note: To start an integrated VoIP conference, you must have selected the integrated 
VoIP option when setting up your event. Otherwise, integrated VoIP is unavailable during 
the event. 

 
 

 

Joining or leaving an integrated VoIP conference 
During an event, you can leave an integrated VoIP conference without leaving 
the event. You can also rejoin the conference at any time. 

To join or leave an integrated VoIP conference, do one of the following: 

 Click Yes to join the conference when the Join Integrated VoIP message 
appears on your screen. 

 On the Audio menu, choose Integrated VoIP > Join Conference or 
Leave Conference respectively. 

To rejoin an integrated VoIP conference: 

On the Audio menu, choose Integrated VoIP > Join Conference . 
  

Tip:  
 Before starting or joining an integrated VoIP conference, use the Audio Setup Wizard 

to fine-tune your computer's settings for integrated VoIP. For details, see Setting 
integrated VoIP conference options (on page 234). 

 As a participant, at any time during an integrated VoIP conference, you can ask the 
event host to pass the microphone to you. For details, see Asking to speak in an 
integrated VoIP conference. (on page 229) 

  
 

Asking to speak in an integrated VoIP conference 
Participant only 
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During an integrated VoIP conference, you can indicate that you want to 
speak. You can cancel a request to speak at any time. Speaking in an 
integrated VoIP conference (on page 231) 

 

To request to speak, or to cancel a request to speak: 

On the Participants panel, click Ask for Mic.  

 

 If you ask to speak, Event Center places your request in the speaker 
queue. A number appears to right of your Integrated VoIP indicator, to 
indicate your position in the queue. 

 

 The number indicates your posit ion in the speaker 
queue. 

 If you cancel a request to speak, the number to the right of your Integrated 
VoIP indicator is removed. 

 

 

Allowing a participant to speak in an integrated 
VoIP conference 

Host and panelist only 

Once you start an integrated VoIP conference, participants can join the 
conference and listen to integrated VoIP audio. Up to seven participants can 
speak at a time. 

You can specify which participants can speak, by passing the microphone to a 
participant. 

To allow a participant to speak in an integrated VoIP conference: 

1 On the Participants panel, select the name of the participant whom you 
want to allow to speak. 

2 On the Participant panel, click Pass Mic. 

 

The Integrated VoIP indicator appears to the left of the participant's name on 
the Participants panel. For example: 
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If you pass the microphone to an attendee, Event Center removes the 
attendee’s name from the Participants panel and places it back on the list in 
the List of Attendees dialog box. You can view this list by clicking View all 
attendees on the Participants panel. 

 

The participant can now speak until you either pass the microphone to 
another participant or mute the participant's microphone. 
  

Note: A request to speak can be made at any time during an event, by clicking Raise 
Hand on the Participants panel. 
 

 
 

 
 

 

Speaking in an integrated VoIP conference 
If you are a current speaker, the method by which you speak depends on the 
speaker setup option that is currently selected for your event: 

 Desktop speakers (default): If this option is selected, the following 
appears in the bottom-right corner of your Event window: 

  

 

 
 

Press the Ctrl key on your keyboard while speaking. Pressing this key 
mutes your speakers, thereby preventing your voice from echoing in the 
conference. 

 Headset: If this option is selected, the following appears in the bottom-
right corner of your Event window: 

  

 

 
 

Simply speak into your microphone. 
  

Tip: Before you join an integrated VoIP conference, you can use the Audio Setup Wizard 
to select your speaker setup. For details, see Setting integrated VoIP conference options 
(on page 234). 
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Muting and unmuting microphones in an 
integrated VoIP conference 

The following table illustrates how to quickly mute and unmute microphones in 
a conference depending on your user role. If you want detailed instructions, 
click “More” by the task description. 
  

Role  Task description: 

host 

 

You can: 

 mute or unmute your ow n 
microphone at any time 
More… (on page 233)  

 mute all partic ipants' 
microphones More…  (on 
page 232)  

 mute or unmute a spec if ic 
participant's microphone 
More… (on page 232)  

participant mute or unmute your ow n 
microphone at any time More… 
(on page 233)  

 

 

Muting and unmuting participant microphones 
Host and panelist only 

In an integrated VoIP conference, you can mute or unmute one or more 
participant microphones.  

 

To mute or unmute a specific participant's microphone: 

1 On the Participants panel, select the participant for whom you want to 
mute or unmute the microphone. 

2 Click Mute  or Unmute  to control the participant's microphone 
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The Muted or Unmuted indicator appears to the left of the participant's 
name. For example: 

  

 The indicator beside the attendee's name changes state 
when you mute or unmute the attendee's microphone. 

 

  

Note: If a participant is a current speaker in an integrated VoIP conference and you have 
not muted his or her microphone, that participant can mute or unmute his or her own 
microphone independently. 

 To mute or unmute an attendee’s microphone, click View all attendees on the Participants panel. Select 
the attendee’s name, and then click Mute or Unmute. 
 

To mute or unmute all participant microphones at t ime of joining: 

On the Participant menu, choose Mute on Entry. 

To mute or unmute all participants' microphones during an event: 

On the Participant menu, choose Mute All or Unmute All, respectively. 
 

 

Muting and unmuting your microphone 
If you are the current speaker in an integrated VoIP conference, you can mute 
or unmute your microphone at any time. However, if the host has muted your 
microphone, you cannot unmute it. 

To mute or unmute your microphone: 

1 On the Participants panel, select your name. 

2 Click Mute or Unmute . 
  

 The indicator to the left of your name 
changes state. 
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Understanding the speaker queue for integrated 
VoIP 

During an integrated VoIP conference, a participant can request to speak. 

Once a participant requests to speak, Event Manager places the participant in 
the speaker queue, as indicated by a number to the right of the integrated 
VoIP symbol. For example: 
  

 

The number next to a participant's name indicates that 
participant's position in the speaker queue. 

The speaker queue lets you keep track of the order in which participants have 
requested to speak. To let a participant speak, you can pass the microphone 
to the participant. For details, see Allowing a participant to speak in an 
integrated VoIP conference. 

Once you pass the microphone to a participant, Event Manager removes the 
participant from the speaker queue, and then renumbers the remaining 
participants. For example, speaker 2 in the queue becomes speaker 1. 

 

Setting integrated VoIP conference options 
 Use the Audio Setup Wizard to 

 specify your audio equipment and set optimal volume levels. You can 
specify whether you are using speakers and a separate microphone, or 
a headset with an integrated microphone 

 ensure that your microphone and speakers are set to their optimal 
volume levels. 

 Use the Volume dialog box to adjust the volume for your speakers or 
microphone at any time. 

 

To set integrated VoIP conference options: 

On the Audio menu, choose one of these options, and follow the directions: 

 Audio Setup Wizard 
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 Integrated VoIP > Volume 
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Your user role in an event determines your level of sharing. Whichever role 
you take, the following table describes the basic tasks associated with that 
role. For detailed instructions on a particular task, click “More” by the task 
description. 
  

Role 
 

Task description: 

Host 

 

Start and control sharing a 
document or presentation 

 learn about tools for sharing 
More… (on page 239)  

 start sharing More… (on page 
242)  

 assigning sharing privileges 
to attendees More…  

 save a document More… (on 
page 260)  

Sharing Presentations, 
Documents, and 
Whiteboards 
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Role 
 

Task description: 

Attendee 

 

View  and interact w ith shared 
documents and presentations  

 display slides or pages 
More… (on page 263)  

 use tools to annotate a 
document More…  (on page 
240)  

 synchronize your view  with 
the host More… (on page 
264)  

 

Granting privileges to attendees 
You can grant privileges to or remove privileges from attendees during an 
event. 

To assign attendee privileges during an event: 

1 In the Event window, on the Participant menu, click Assign privileges to 
> Attendees. 

The Attendee Privileges dialog box appears. 

2 Do any of the following: 

 To grant a privilege to all attendees, select its check box. 

 To grant all privileges to attendees, select the All attendee privileges 
check box. 

 To remove a privilege from all attendees, clear its check box. 

For descriptions of each option in the Attendee Privileges dialog box, see 
Overview of attendee privileges (on page 163). 

3 Click Assign. 
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Content viewer tools 
  

Content Viewer Tools 

 

The tools on the content view er toolbar allow  
you to share and perform actions on 
presentations, documents, and w hiteboards. 

 

annotation toolbar-Select a draw ing tool for 
directing attention onscreen, using pointers, a 
highlighter, or draw ing a shape More… (on 
page 240)  

Window s 

 
 

Mac 

  

Sharing toolbar-Use these tools to share 
applications, documents, your desktop or a 
white board. More… (on page 241) 

 

Viewing toolbar-Change to full-screen, 
rotate pages, zoom in or out us ing these 
tools. More… (on page 239)  

 

Changing views in a file or whiteboard 
You can switch views in the content viewer by clicking the viewing icons in the 
bottom left corner of the content viewer: 
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 View  tools 

  

Tool Icon Description 

Standard View  
Clicking Standard View  displays the shared content as you w ould 
normally view  it.  

View Thumbnails  

To display thumbnails, or miniatures, of shared pages, slides, or 
whiteboards to the side of the content, click View Thumbnails . 
This tool helps you locate a page or slide quickly. 

Full-Screen View 
 

Displays shared content in a full-screen view . Helps you to ensure 
that part icipants can view  all activity on your screen. Also helps to 
prevent part icipants from view ing or using other applications on 
their screens during a presentation. 

Click ESC to return to the content view er. 

Rotate page  
For documents in landscape orientation, you can rotate the pages 
to the left or right so they appear correctly in the content v iew er. 

Zoom In/ 

Zoom Out  

Lets you display shared content at various magnif ications. Click 
this button, and then click the page, slide, or w hiteboard to 
change its magnif ication. For more magnif ication options, clic k the 
dow nward-pointing arrow . 

Synchronize 
Displays for All  

For presenters, synchronizes all partic ipants' displays w ith your 
display. Helps to ensure that all participants are view ing the same 
page or slide, at the same magnif ication, as in your display. 

 

 

Using annotation tools on shared content 
In an online event, you can use annotation tools on shared content to 
annotate, highlight, explain, or point to information: 
  

 
Basic annotation tools  
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Annotation 
Tool Icon Description 

Pointer 
 

Lets you point out text and graphics on shared content. The pointer 
displays an arrow  with your name and annotation color. To display the 
laser pointer, w hich lets you point out text and graphics on shared 
content using a red “laser beam,” click the dow nw ard-pointing arrow . 
Clicking this button again turns off the pointer tool.  

Text 
 

Lets you type text on shared content. Participants can view  the text 
once you f inish typing it and click your mouse in the content view er, 
outside the text box. 

To change the font, on the Edit menu, choose Font. Clic king this button 
again turns off the text tool. 

Line 
 

Lets you draw  lines and arrow s on shared content. For more options, 
click the dow nw ard-pointing arrow . Clicking this button closes the 
Rectangle tool. 

Rectangle 
 

Lets you draw  shapes, such as rectangles and ellipses on shared 
content. For more options, click the dow nward-pointing arrow . Clic king 
this button again closes the Rectangle tool.  

Highlighter 
 

Lets you highlight text and other elements in shared content. For more 
options, click the dow nw ard-pointing arrow . Clic king this button again 
closes the Highlighter tool 

Annotation 
Color  

Displays the Annotation Color palette, on w hich you can select a color 
to annotate shared content. Clicking this button again closes the 
Annotation Color palette. 

Eraser 
 

Erases text and annotations or clears pointers on shared content. To 
erase a single annotation, click it in the view er. For more options, click 
the dow nw ard-pointing arrow . Clicking this button again turns off the 
eraser tool. 

  

 

Sharing information 
You can open a document, whiteboard, desktop, or application to share by 
clicking the sharing icons in the upper left corner: 
  

 
Sharing tools for Window s 
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Sharing tools for the Mac  

  

Sharing Tool Icon Description 

Share Document 
 

Share a document or presentation that resides on your 
computer. Participants view  the shared document or 
presentation in their content view ers. 

Share Application 
 

Share any application on your computer w ith event part icipants. 
Participants can view  the shared application in a shar ing 
w indow  on participant screens. 

Share Desktop 
 

Share your computer desktop* w ith meeting participants, 
including any applications, w indow s, and f ile directories that are 
currently open. Participants can view  the shared desktop in a 
sharing w indow  on participant screens  

Share Whiteboard  
 

Share a w hiteboard on w hich you can draw  and w rite. 
Participants can view  a shared w hiteboard in their content 
view ers. 

  

Note: Click Share on the Menu bar to see more options for sharing information in a 
meeting.  

 
 

Sharing files 
File sharing is ideal for presenting information that you do not need to edit 
during the event, such as a video or slide presentation. Participants can 

 view shared files in their content viewers without the need for the 
application with which it was created.  

 view a media file, such as a video, without the need for special software or 
hardware.  

 view any animation and transition effects on shared Microsoft PowerPoint 
slides.  

After an event starts, you can open a presentation or document to share. You 
do not need to select it or “load” it before the event. 
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While sharing a file, you can: 

 Draw on the screen More (on page 240) 

 Use a pointer to emphasize text or graphics More (on page 240) 

 Print it More (on page 262) 

 Display it at various magnifications, in miniature (thumbnails), and in a full-
screen view More 

 Synchronize all participants' displays with the display in your content 
viewer More 

 Save it to a file More (on page 260) 
 

At any time during a meeting, you can grant participants privileges that allow 
them to annotate, save, print, and display different views of shared content. 

 

 

Sharing a file 
You can share a file, such as a document, presentation, or video, that resides 
on your computer. Participants view the shared file in their content viewers. 

To share a document or presentation: 

1 On the Share  menu, choose File (Including video). 

The Share File dialog box appears. 

2 Select the file that you want to share. 

3 Click Open. 

The shared file appears in the content viewer. 
  

Tip: See Tips for sharing files (on page 243) for information that can help you to share 
files more effectively.  

 
 

Tips for sharing files 
These tips can help you share files more effectively. 

 To import slide presentations quickly: 

 Limit the number of animations and slide transitions. 
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 Minimize the number of screen shots that you add to slides, especially 
bitmap graphics. Bitmaps do not compress well.  

 To improve the speed at which shared pages or slides appear in 
participant content viewers, save the document or presentation as a .ucf 
(Universal Communications Format) file before the event starts. Then 
share the .ucf file instead of the document or presentation itself. More… 
(on page 260)  

 You can annotate shared presentations or documents in the content 
viewer; however, you cannot edit them. If you want to edit shared 
information, you can use application sharing instead. 

  

 

 

If  you are sharing a Pow erPoint presentation, you can open 
the Pow erPoint Notes panel and v iew  any notes you have 
added to the slide in the presentation. 

 

 To save time during an event, begin sharing the document or presentation 
before the event's starting time. That way, after participants join the event, 
they can begin viewing your presentation. 

 

 

Choosing an import mode for presentation sharing 
For Windows users only 

Before you share a presentation, you can choose one of the following import 
modes: 

 Universal Communications Format (UCF)-The default mode. Lets you 
display animations and slide transitions in Microsoft PowerPoint 
presentations. In the UCF mode, Event Manager imports presentations 
more quickly than it does in the printer driver mode. However, pages or 
slides may not appear consistently in Event Manager across platforms. 

 Printer driver-Displays shared presentations as they appear when you 
print them, providing a consistent appearance of pages and slides in Event 
Manager across platforms. However, this mode does not support 
animations or slide transitions. In this mode, the first page or slide may 
appear quickly, but the total import time for all pages or slides is usually 
longer than it is in the UCF mode. 
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Note: Changing the import mode does not affect any presentations that you are currently 
sharing. To apply a new import mode to a shared presentation, you most close it first, 
and then share it again. 

To choose an import mode for shared presentations: 

1 In the Event window, on the Event menu, choose Options. 

The Event Options dialog box appears, with the Options tab selected by 
default. 

2 Click the Import Mode  tab. 
  

 

 

The Import Mode tab 
options appear. 

3 Select either Universal Communications Format or Printer driver. 
 

Closing shared files 
You can close any files that you are sharing in your content viewer. 

To close a shared file: 

1 In the content viewer, select the tab for the file that you want to close. 

2 On the File  menu, choose Close . 

If you have not yet saved any annotations that you made on the document 
or presentation, a message appears, allowing you to save it.  
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Sharing a whiteboard 
Sharing a whiteboard allows you to draw objects and type text that all 
Participants can see in their content viewers. You can also use a pointer to 
emphasize text or graphics on a whiteboard. 

Other things you can do while sharing a whiteboard: 

 Display it at various magnifications, in miniature (thumbnails), and in a full-
screen view.  

 Copy and paste images into it 

 Reorder its position in reference to any other whiteboards 

 Print it 

 Synchronize Participants' displays with the display in your content viewer  
More 

 Save it 

If you allow participants to annotate slides and pages, you and participants 
can draw and type on a whiteboard simultaneously. You can also allow 
participants to save, print, and display different views of shared whiteboards. 
For details, see Granting sharing privileges. 

 

Starting whiteboard sharing 
You can share a whiteboard on which you can draw and write. Participants 
can view a shared whiteboard in their content viewers. 

To share a whiteboard: 

On the Share  menu, choose Whiteboard. 
  

Note:  
 You can add multiple pages to a shared whiteboard. For details, see Adding new 

pages or slides (on page 252). 
 You can share multiple whiteboards. For each whiteboard that you share, you see a 

new Whiteboard tab in the content viewer. 
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Closing a shared whiteboard 
You can close any whiteboards that you are sharing in your content viewer. 

To close a shared whiteboard: 

1 In the content viewer, select the tab for the whiteboard you want to close. 

2 On the File  menu, choose Close . 

If you have not yet saved any annotations that you made on the 
whiteboard, a message appears, allowing you to save it.  

 

Navigating presentations, documents, or 
whiteboards 

When sharing a document, presentation, or whiteboard, you can 

 Navigate slides, pages, or whiteboards using the toolbar More… (on page 
247) 

 Advance pages or slides automatically, at an interval of time that you 
specify More… (on page 248) 

 Perform animations and slide transitions in a presentation More… (on 
page 249) 

 Use keys on your computer's keyboard to navigate a presentation and 
display animations on the slides More… (on page 250) 

 

Navigating slides, pages, or whiteboards using the toolbar 
You can navigate to different pages, slides, or whiteboard “pages” in the 
content viewer. Each document, presentation, or whiteboard being shared 
appears on a tab at the top of the content viewer. 

To display pages or slides in the content viewer: 

1 In the Event window, in the content viewer, select the tab for the 
document, presentation, or whiteboard that you want to display. 

If there are more tabs than can appear at one time, click the Next Tab 
button to cause the next tab to scroll into view. 
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Click sample to view  
next tab 

2 On the toolbar, click a button to change the page or slide you are viewing. 
  

 

 

Click the  

 drop-dow n arrow  to select any page or slide 

 left arrow  to see the previous page or slide 

 right arrow  to see the next page or slide 

If Microsoft PowerPoint slides are being shared, the drop-down list also 
displays the title of each slide. 

  

Note:  
 Alternatively, you can navigate to different pages or slides in a shared document, 

presentation, or whiteboard by opening the thumbnail viewer. For details, see 
Viewing thumbnails of slides, pages, or whiteboards (on page 255). 

 You can advance pages or slides automatically at a time interval that you specify. 
For details, see Advancing pages or slides automatically (on page 248). 

 You can also use the keys on your computer's keyboard to display different pages or 
slides and perform animations and slide transitions. For details, see Using keyboard 
shortcuts to control a presentation (on page 250). 

 If you your presentation includes animations or slide transitions, you can use the 
toolbar or keyboard shortcuts to perform them. For details, see Animating and 
adding effects to shared slides (on page 249). 

  
 

Advancing pages or slides automatically 
When sharing a document or presentation in the content viewer, you can 
automatically advance pages or slides at a specified interval. Once you start 
automatic page or slide advancement, you can stop it at any time. 

To automatically advance pages or slides: 

1 In the Event window, in the content viewer, select the tab for the document 
or presentation for which you want to advance pages or slides 
automatically. 

2 On the View menu, choose Automatically Advance Pages. 



 Chapter 19: Sharing Presentations, Documents, and Whiteboards 

 

249 

 

The Automatically Advance Pages dialog box appears. 

3 To change the time interval for advancing pages, do one of these: 

 click the up or down buttons to increase or decrease the interval 

 type a specific time interval 
  

 

 

Optional:To restart page or slide 
advancement once all pages or slides 
are displayed, select the Return to 
beginning and continue advancing 
pages check box. 

4 Click Start. 

5 Optional. Close the Automatically Advance Pages dialog box by clicking 
the Close button in the upper-right corner of the dialog box. 

The pages or slides continue to advance at the specified interval. 

To stop automatic page or slide advancement: 

1 If you closed the Automatically Advance Pages dialog box, on the View 
menu, choose Automatically Advance Pages. 

The Automatically Advance Pages dialog box appears. 

2 Click Stop. 
 

Animating and adding effects to shared slides 
When sharing a Microsoft PowerPoint slide presentation in the content viewer, 
you can animate text and slide transitions, just as you can when using the 
Slide Show option in PowerPoint. 
  

Note: To show slide animations and transitions, you must share the presentation as a 
Universal Communications Format (UCF) file (.ucf). The UCF import mode automatically 
converts a PowerPoint file (.ppt) to a UCF file when you share it. More (on page 244) 
 For best results when sharing a presentation created using Microsoft PowerPoint 

2002 for Windows XP, use a computer with an Intel Celeron or Pentium 500 MHz or 
faster processor. 

 Alternatively, use the keys on your computer keyboard to show animations and slide 
transitions in a PowerPoint slide presentation. For details, see Using keyboard 
shortcuts to control a presentation (on page 250). 
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 If at least one event participant is using the Java Event Manager, animations and 
slide transitions will not display during the event. The event host can prevent 
participants from joining an event using the Java Event Manager when scheduling 
the event. 

To show slide animations and transitions in a shared presentation: 

1 Ensure that the content viewer has input focus by clicking in the viewer. 

The content viewer has input focus if a blue border appears around the 
outside of the slide in the viewer. 

2 On the toolbar, click the appropriate arrows to move through your 
presentation. 

  

 

 

Click the  

 drop-dow n arrow  to select any page or slide 

 left arrow  to see the previous page or slide 

 right arrow  to see the next page or slide 

 

Using keyboard shortcuts to control a presentation 
When sharing a document or presentation in the content viewer, you can use 
the keys on your keyboard to display pages or slides. If you are sharing a 
Microsoft PowerPoint slide presentation, you can also use keyboard keys to 
show animations on the slides and in slide transitions, just as you can when 
using the Slide Show option in PowerPoint. 
  

Note: Before using keyboard shortcuts, click in the viewer to set the input focus in the 
content viewer. A blue border around the shared page or slide indicates that the viewer 
has input focus. 

 

Sharing a Presentation 

Use these keystrokes to move quickly through your presentation. 
  

To... Press... 

Display the next slide or perform the next 
animation or slide transition 

Space Bar, Page Down, Right Arrow , or 
Down Arrow 

Display the previous slide or perform the previous 
animation or slide transition 

Page Up, Left Arrow , or Up Arrow 
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To... Press... 

Display the f irst slide Home 

Display the last slide End  

  

Note: To show animations and slide transitions, you must share the presentation as a 
Universal Communications Format (UCF) file. The UCF import mode automatically 
converts a PowerPoint file to a UCF file when you share it. For information about 
choosing an import mode, see Choosing an import mode for presentation sharing (on 
page 244). 

 

Sharing a Document 

Use these keystrokes to move quickly through your document. 
  

To... Press... 

Display the next page Space Bar, or Page Down, Right Arrow , or 
Down Arrow 

Display the previous page Page Up, Left Arrow , or Up Arrow 

Display the f irst page Home 

Display the last page End  

 

 

Working with pages or slides 
When sharing a document, presentation, or whiteboard, you can 

 Add new, blank pages or slides for annotation More (on page 252) 

 Paste images that you copy to your computer's clipboard into a new page 
or slide in a shared document, presentation, or whiteboard More (on page 
252) 
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Adding new pages to shared files or whiteboards 
When sharing a file or whiteboard in the content viewer, you can add a new, 
blank page for annotation. 

To add a new page or slide: 

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard to which you want to add a page or slide. 

2 Select Add Page  from the Edit menu. 

A new page appears in the content viewer at the end of the currently 
selected document, presentation, or whiteboard. 

  

Tip: If you have added multiple pages to a shared file or whiteboard tab, you can view 
thumbnails to make it easy to view and navigate around your added pages. 

 
 

Pasting images in slides, pages, or whiteboards 
If you copy any bitmap image to your computer's clipboard, you can paste the 
image into a new page, slide, or whiteboard in the content viewer. 

For example, you can copy an image on a Web page or in an application, 
then quickly share that image by pasting it in the content viewer. 

To paste an image in a page, slide, or whiteboard in the content viewer: 

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard in which you want to paste an image. 

2 On the Edit menu, choose Paste Page Image . 

The image appears on a new page in the content viewer, at the end of the 
currently selected document, presentation, or whiteboard. 

  

Note: You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF 
image in the content viewer. However, you cannot paste other types of images-such as 
EPS or Photoshop (PSD) images-in the content viewer. 
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Managing views of presentations, documents, or 
whiteboards 

All shared presentations, documents, or whiteboards appear in the content 
viewer in the Event window. A tab at the top of the content viewer appears for 
each document, presentation, or whiteboard that is being shared. 

Depending on your role and the privileges that you have, you can do the 
following when viewing shared content in the content viewer: 

 Magnify (on page 253) slides, pages, or whiteboards 

 View thumbnail (on page 255)s of slides, pages, or whiteboards. 

 Display a full-screen view (on page 254) of a page, slide, or whiteboard. 

 Synchronize all participant views (on page 256) of a page or slide with the 
view that appears in your content viewer 

 

Zooming in or out 
Using the tools on the content viewer toolbar, you can: 

 Zoom in to or out from on a page, slide, or whiteboard 

 Adjust the size of a page, slide, or whiteboard to fit the content viewer 

 Adjust the size of a page, slide, or whiteboard to fit it width in the content 
viewer 

 Turn off the Zoom tool at any time 

To zoom in to or out from on a page, slide, or whiteboard: 

Do one of the following on the content viewer toolbar: 

 To zoom in or out incrementally, click the downward pointing arrow to the 
left of the Zoom In/Zoom Out button, and then choose Zoom In or Zoom 
Out. To continuing zooming in or out, click the Zoom In/Zoom Out button. 

  

 
 

Click the dow n arrow  to choose a 
view ing option  
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 To zoom in to a specific area, click the downward-pointing arrow to the 
right of the Zoom In button, and then drag your mouse to the area. 
Release your mouse button. 

 To zoom in or out to a preset percentage, click the downward-pointing 
arrow to the left of the Zoom In/Zoom Out button, and then choose the 
percentage. 

To adjust the size of a page, slide, or whiteboard to fit the content viewer: 

1 On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button. 

  

 
 

Click the dow n arrow  to choose a view ing 
option  

2 On the menu that appears, choose Fit to Viewer. 

To adjust the size of a page, slide, or whiteboard to fit its width in the content 
viewer: 

1 On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button. 

2 On the menu that appears, choose Fit to Width. 

To turn off the zoom tool: 

On the toolbar, click the Zoom In/Zoom Out button. 
 

Controlling full-screen view 
You can maximize the size of a page, slide, or whiteboard in the content 
viewer to fit your monitor's entire screen. A full-screen view replaces the 
normal Event window view. You can return to a normal view at any time. 
  

Note: If an event presenter displays a full-screen view of a page, slide, or whiteboard, 
attendees' screens automatically display a full-screen view as well. However, attendees 
can control full-screen view independently in their Event windows. 

To display a full-screen view: 

  

 On the content view er toolbar, click the Full Screen View  button.  



 Chapter 19: Sharing Presentations, Documents, and Whiteboards 

 

255 

 

To return to a normal view: 

  

 
On the Event Controls Panel, clic k the stop icon to return to the main w indow .  

 

 

Viewing thumbnails 
You can view thumbnails of the shared pages, slides, and whiteboards that 
appear in the content viewer. Viewing thumbnails can help you to locate 
quickly a shared page or slide that you want to display in the content viewer. 

To view thumbnails of slides, pages, or whiteboards: 

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard for which you want to view miniatures. 

2 On the content viewer toolbar, click the View Thumbnails button. 
  

  View  Thumbnails button. 

Thumbnails of all pages or slides in the selected document, presentation, 
or whiteboard appear in the thumbnail viewer, in the left column. 
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3 Optional. To display any page or slide in the content viewer, double-click 
its miniature in the thumbnail viewer. 

  

Note: Participants must have both the View thumbnails and View any page privileges 
to display a miniature of a page or slide at full size in the content viewer. 

To close the thumbnail viewer: 

On the content viewer toolbar, click the Standard View button. 
  

 
Standard View  button. 

 

 

Synchronizing all participant views 
You can synchronize the display of a shared page, slide, or whiteboard in all 
attendees' content viewers with the display in your viewer. Once you 
synchronize displays, the page, slide, or whiteboard in attendees' content 
viewers appears at the same magnification as in your content viewer. 
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To synchronize participant views of slides, pages, or whiteboards: 

On the View menu at the bottom of the window, select Sync Display for All. 
  

 Sync Display for All.  

 

 

Clearing annotations 
You can clear any annotations made by you or another participant on a 
shared page, slide, or whiteboard in the content viewer. You can clear: 

 All annotations at once 

 Only specific annotations 

 If you are the presenter or host, clear all annotations you have made 
  

 annotation tools 

To clear all annotations on a shared page, slide, or whiteboard: 

1 On the annotation toolbar, click the downward-pointing arrow to the right of 
the Eraser Tool icon. 

  

 
 

Eraser tool 

2 Choose Clear All Annotations. 
  

Note: Only annotations on the page or slide that currently appears in your content viewer 
are cleared. Annotations on other pages or slides are not cleared. 

If you are the host or presenter, you can clear all the annotations you've 
made. 

To clear all annotations you have added to a shared page, slide, or 
whiteboard: 

1 On the annotation toolbar, click the downward-pointing arrow to the right of 
the Eraser Tool icon. 
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Eraser tool 

2 Choose Clear My Annotations. 

To clear specific annotations on a shared page, slide, or whiteboard: 

1 On the toolbar, click the Eraser Tool icon. 
  

 
 

Eraser tool 

Your mouse pointer changes to an eraser. 

2 Click the annotation you want to clear. 

To turn off the eraser tool: 

On the toolbar, click the Eraser Tool icon. 
  

 
Eraser tool 

 

 

Clearing pointers 
You can clear your own pointers on all shared slides, pages, or whiteboards in 
the content viewer. If you are a presenter, you can also clear all participant 
pointers. 
  

 
annotation tools 

To clear your own pointer on all shared slides, pages, or whiteboards: 

1 On the toolbar, click the downward-pointing arrow to the right of the 
Eraser Tool icon. 

  

 
 

Eraser tool 



 Chapter 19: Sharing Presentations, Documents, and Whiteboards 

 

259 

 

2 Choose Clear My Pointer. 
 

 

Renaming tabs 
As you are sharing an item, such as a presentation, in the content viewer, you 
can easily change its name on the tab. Later, when you end the event, you 
can save the document, presentation, or whiteboard with this new name. 

To rename a tab in the content viewer: 

1 Right click the tab name you want to change. 

2 Enter the new name on the tab. 

3 Press Enter or click outside the tab. 

The tab displays the new name. 
  

Tip: You can also click the tab name to select it. 

This feature is handy if participants have used the annotation tools to make 
comments and notes or highlight elements in your document. You can save 
your document with the annotations as a new document, separate from your 
original. 

Of course, you can still use the Save As command on the File  menu to save 
the document at the end of your event. Changing the name on the tab itself 
allows others to see the name you are giving the file. Also, you are making the 
change at the moment that action is meaningful, rather than at the end of the 
event. 

 

Reordering tabs 
The tabs in the content viewer are arranged in the order you open them. That 
order may not be the most logical way to display them. You can easily move 
the tabs, so the most current and important items are visible. 

To reorder the tabs in the content viewer: 

1 Right-click any tab. 

2 In the Reorder View Tabs dialog box, use the arrows change the order of 
the tabs. 
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Moving a tab up in the order moves that tab to the left in the content 
viewer. 

  

 

 

Use the up and dow n arrows to 
reorder the tabs 

  

Tip: To quickly move a tab to the left or right, select the tab and use a drag and drop 
operation to move it. 

 

Saving, opening, and printing presentations, 
documents, or whiteboards 

Event participants (hosts, presenters, and participants with privileges) can 
access and print documents, presentations, and whiteboards shared in an 
event. For example, you can: 

 save a shared presentation More (on page 260) 

 open a saved document More (on page 261) 

 print a whiteboard More (on page 262) 
 

Saving a presentation, document, or whiteboard 
You can save any shared document, presentation, or whiteboard that appears 
in the content viewer. A saved file contains all the pages or slides in the 
document, presentation, or whiteboard that is currently displayed in the 
content viewer, including any annotations and pointers that you or other 
attendees added to them. 
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Files that you save are in the Universal Communications Format (UCF), which 
have a .ucf extension. You can open a .ucf file either in another event or at 
any time outside of an event. 

Once you save a new document, presentation, or whiteboard to a file, you can 
save it again to overwrite the file or save a copy to another file. 

To save a new document, presentation, or whiteboard that appears in the 
content viewer: 

1 On the File  menu, choose Save > Document. 

The Save Document As dialog box appears. 

2 Choose a location at which to save the file. 

3 Type a name for the file in the File name  box. 

To save changes to a saved document, presentation, or whiteboard that 
appears in the content viewer: 

On the File  menu, choose Save > Document. 

Event Manager saves the changes to the existing file. 

To save a copy of a document, presentation, or whiteboard: 

1 On the File  menu, choose Save As > Document. 

The Save Document As dialog box appears. 

2 Do either or both of the following: 

 Type a new name for the file. 

 Choose a new location at which to save the file. 
 

Opening a saved document, presentation, or whiteboard 
If you saved a document, presentation, or whiteboard that appeared in the 
content viewer during an event, you can do either of the following: 

 Open file in the content viewer during another event for sharing. Only a 
presenter or participants who have the Share documents privilege can 
open a saved file during an event. 

 Open the file at any time on your computer's desktop. If you open a saved 
file on your desktop, it appears in the WebEx Document Manager, a 
standalone, or “offline,” version of the content viewer. 
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A saved document, presentation, or whiteboard is in the saved Universal 
Communications Format (UCF) and has a .ucf extension. 

To open a saved document, presentation, or whiteboard file in the content 
viewer: 

1 On the File  menu, choose Open and Share . 

The Share Document dialog box appears. 

2 Select the document, presentation, or whiteboard file that you want to 
open. 

3 Click Open. 

To open a saved document, presentation, or whiteboard on your computer's 
desktop: 

Double-click the saved file. 

The document, presentation, or whiteboard opens in the WebEx Document 
Viewer. 

 

Printing presentations, documents, or whiteboards 
You can print any shared presentations, documents, or whiteboards that 
appear in your content viewer. A printed copy of shared content includes all 
added annotations and pointers. 

To print shared content: 

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard that you want to print. 

2 On the File  menu, choose Print > Document. 

3 Select the printing options that you want to use, and then print the 
document. 

  

Note: When printing shared content in the content viewer, Event Manager resizes it to fit 
on the printed page. However, for whiteboards, the Event Manager prints only the 
content that lies within the dashed lines on the whiteboard. 
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If you are an event participant... 
If you are participating in an event, (and have not taken on another role, such 
as host or presenter), you can move around independently in shared 
documents and presentations, if the host has assigned these privileges to 
you. For shared documents, presentations, and whiteboards, you can: 

 display any page More… (on page 263) 

 synchronize your view with the host's view More… (on page 264) 

 save shared documents More… (on page 260) 

 open shared documents More… (on page 261) 

 print shared documents More… (on page 262) 
 

Displaying pages, slides, or whiteboards 
For attendees 

If you have been granted the necessary privileges, you can navigate to 
different pages, slides, or whiteboard “pages” in the content viewer. Each 
document, presentation, or whiteboard being shared appears on at the top of 
the content viewer. 

To display pages or slides in the content viewer: 

1 In the Event window, in the content viewer, select the tab for the 
document, presentation, or whiteboard that you want to display. 

If you have more tabs than can be displayed on the content viewer, click 
the down-arrow button at the end of the tabs to view the list of other tabs. 

  

 

 

To return to the document or page the 
host is view ing, you can synchronize 
your view  More… (on page 264)  

2 On the toolbar, click a button to change the page or slide you are viewing: 
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3 To display the next page or slide, click the Next button. 
  

 

 

 To move forw ard or back betw een pages, click the 
left or right arrow s. 

 To select any page or slide, select it in the Go To 
drop-dow n list. 

 

Synchronizing your view of pages, slides, or whiteboards 
During an event, you can synchronize the display of shared content in your 
content viewer with the display in the presenter's viewer. This option is useful, 
for example, if you are viewing a previous slide in a presentation and want to 
quickly return to the actual slide that the presenter is discussing. 
Synchronizing your display also resizes it to that in the presenter's content 
viewer. 

To synchronize your view of shared content in the presentation viewer: 

In the Event window, on the viewing toolbar, click the Synchronize My 
Display button. 
  

 
Synchronize your view  
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C h a pt er  2 0 

Sharing a tool, like a software application, works differently from sharing a 
document or presentation. When you share software during an event, a 
sharing window opens automatically on all participant screens. You can show, 
in this special sharing window: 

 an application (for example, you want to edit a document as a group or 
show your team how a tool works) 

 computer desktop (for easily sharing several applications at once and for 
sharing file directories open on your computer) 

 web browser (useful for sharing particular Web pages with participants or 
showing a private intranet)  

 

Your user role in a meeting determines your level of participation in sharing 
software. Whichever role you take, this table describes the basic tasks 
associated with that role. For detailed instructions on a particular task, click 
"More" by the task description. 
  

Sharing Software 
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Role  Task description: 

host and 
panelist  

 

Share softw are: 

 Share applications More… (on 
page 266)  

 Share your desktop (if  this feature 
is available) More…  (on page 
269)  

 Share a Web brow ser More… (on 
page 271)  

 Annotate shared softw are More… 
(on page 281)  

participant 

 

View  and w ork w ith shared software: 

 Control the appearance of shared 
softw are More… (on page 278)  

 Annotate shared softw are More… 
(on page 281)  

 Stop participating in softw are 
sharing More… (on page 279)  

 

 

Sharing applications 
You can use application sharing to show all event participants one or more 
applications on your computer. Application sharing is useful for demonstrating 
software or editing documents during an event. 

Participants can view the shared application, including all mouse movements 
without having to run the application that you are sharing on their computers. 

Here are just a few tasks you can perform: 

 Start sharing an application More… (on page 267) and open more 
applications to share More… (on page 268) 

 Control the appearance and viewing of shared software (pausing, 
changing to full-screen view, and so on) More… (on page 273) 
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 Annotate and draw on a shared application More… (on page 281) and 
allow attendees to draw More… (on page 284) 

 Learn about sharing application effectively More… 

 Stop sharing an application More… (on page 269) 
 

Starting application sharing 
Host or Presenter only 

You can share any application on your computer with event attendees. 

To share an application: 

1 On the Share  menu, choose Application. 

The Application Share dialog box appears, showing a list of all 
applications currently running on your computer. 

  

 

 

2 Do one of the following: 

 If the application you want to share is currently running, select it in the 
list, and then click Share . 

 If the application you want to share is not currently running, click New 
Application. The New Application dialog box appears, showing a list 
of all applications on your computer. Select the application, and then 
click Share . 

Your application appears in a sharing window on attendees' screens. 
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For tips that can help you to share applications more effectively, see Tips for 
Sharing Software. 

 

Sharing several applications at once 
Host or Presenter only 

If you are already sharing an application, you can share additional 
applications simultaneously. Each application that you share appears in the 
same sharing window on attendees' screens. 

To share an additional application: 

Select the application you want to share: 

 If that application is currently running: Click the Share  button. 
  

  
Each application you have open on your 
desktop has these buttons in the upper right 
corner 

  

 Tip: When you open any application that you have minimized, it opens with the 
sharing buttons in the upper-right corner. 

 

 If that application is not currently running: Click the Select 
Content to Share button in the Event Controls Panel. You can also 
find it using File Explorer or other tool you use to locate applications on 
your computer. When you open it, it appears with the Share button. 

Your application appears in a sharing window on attendees' screens. 

Event Center tracks the number of applications you are currently sharing: 
  

 

 

The button to the right of Pause  is the Select 
Content to Share button. 

  

Tip: Alternatively, you can share multiple applications by sharing your computer's 
desktop. For details, see Sharing your desktop. 
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Stopping application sharing for all participants 
Host or Presenter only 

You can stop sharing an application at any time. Once you stop sharing an 
application, attendees can no longer view it.  

If you are sharing multiple applications simultaneously, you can stop sharing 
either a specific application or all applications at once. 

To stop sharing a specific application when sharing multiple applications: 

On the title bar of the application that you no longer want to share, click the 
Stop button. 
  

 

To stop all application sharing: 

In the Event Controls box, click the STOP button. 
  

 

You can also pause sharing: Click the Pause 
button ( located next to the Stop button). 

 

 

Sharing your desktop 
The presenter uses desktop sharing to show all event attendees his or her 
entire computer desktop-including any applications, windows, and file 
directories that are currently open. The presenter can use desktop sharing to 
share several applications simultaneously or to share other areas of the 
computer, such as file directories. 

Attendees can view the presenter's shared desktop, including all mouse 
movements, in a sharing window on their screens. 

Tasks related to sharing your desktop: 

 Start sharing your desktop More... (on page 270) 
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 Manage how attendees view your shared software (pausing, changing to 
full-screen view, and so on) More... (on page 273) 

 Annotate and draw on your desktop More... (on page 281) and allow 
attendees to draw More... (on page 284) 

 Read a few tips for sharing your desktop effectively More... 

 Stop sharing your desktop More... (on page 271) 
 

Starting desktop sharing 
Host or Presenter only 

You can share your computer's desktop with event participants. 

To share your desktop: 

1 On the Share  menu, choose Desktop. 

If you have more than one monitor, a submenu shows the available 
monitors. 

  

 

 

2 Select the monitor to share. 

Your desktop appears in a sharing window on participants' screens. 

For ideas that can help you to share your desktop more effectively, see Tips 
for Sharing Software. 
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Note: If your desktop has any background images or patterns, or wallpaper, your Event 
Manager software may remove them from attendees' views to improve the performance 
of desktop sharing. 

 
 

Stopping desktop sharing 
You can stop desktop sharing at any time. 

To stop sharing your desktop: 

In the Event Controls box, click the Stop button. 
  

 

You can also pause sharing: Click the Pause 
button ( located next to the Stop button). 

If you are an attendee , rather than the presenter, click the Return button to 
leave the sharing session. 
  

 

You do not leave the event, just the sharing 
portion of it.  

 

 

Sharing a Web browser 
A presenter uses Web browser sharing to show all event attendees all Web 
pages that he or she accesses in a browser. Web browser sharing is useful 
for showing attendees Web pages on the Internet, or the presenter's private 
intranet or computer. 

Attendees can view the presenters Web browser, including mouse 
movements, in a sharing window on their screens. 

Tasks related to sharing a Web browser: 

 Start sharing a web browser More… (on page 272) 
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 Manage how attendees view the shared Web browser More… (on page 
273) 

 Annotate and draw on a shared Web browser More… (on page 281) and 
let an attendee draw on a shared Web browser More… (on page 284) 

 Learn how to share Web browsers effectively More… 

 Stop sharing a Web browser More… (on page 272) 
 

Starting Web browser sharing 
Host or Presenter only 

You can share a Web browser with event participants. 

To share a Web browser: 

1 On the Share  menu, choose Web Browser. 

Your default Web browser opens. 

2 Go to a Web page in your browser. 
  

Note: Participants view all new Web browser windows that you open. You can 
show participants several Web pages simultaneously 

 

 
 

Stopping Web browser sharing 
You can stop sharing a Web browser at any time. 

To stop Web browser sharing: 

On the title bar of the application that you no longer want to share, click the 
Stop button. 
  

 
  

Tip: You can temporarily pause Web browser sharing, rather than stopping Web browser 
sharing. For details, see Pausing and resuming software sharing (on page 274) 
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Controlling views of shared software 
  

Role 
 

Task description: 

Host or 
Presenter 

 

 Pause or resume sharing 
More… (on page 274)  

 Control full-screen view  of 
shared softw are More… (on 
page 274)  

 Synchronize view s More… (on 
page 275)  

Participant 

 

 Control your view  of shared 
softw are More… (on page 278)  

 Close your sharing w indow  
More… (on page 279)  

The presenter can control attendees' views of a shared desktop, remote 
computer (if available), application or Web browser. 

Attendees can manipulate their individual displays of the shared software 
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Pausing and resuming software sharing 
Host or Presenter only 

While sharing software, you can temporarily pause sharing to freeze 
attendees' views. 

If you want to return attendees to the Event window while sharing software, 
pausing shared software conserves resources on your computer and 
bandwidth for your Internet connection. This option is also useful if you do not 
want attendees to see certain actions that you take with shared software. 

You can resume sharing to restore attendees' views of shared software at any 
time. 

To pause software sharing: 

Click the Pause  button, located to the right of the Stop button. 
  

 

The word "Paused" now appears in the panel. 
  

 

To resume software sharing: 

Click the Pause  button again. 
 

Controlling full-screen view of shared software 
Host or Presenter only 

You can switch attendees' views of a shared application, remote computer 
(if available), or Web browser between a standard window and a full-screen 
view. 

A full-screen view of shared software fits attendees' entire screens and does 
not include a title bar or scroll bars. 
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Attendees can override your setting to control full-screen view or to zoom in or 
out on the shared software on their computers. 

To display shared software in a full-screen view: 

On the Event Controls Panel, click the down arrow (the last button on the 
panel)and then choose View. Then choose Full screen for Participants. 
  

 

To see panel controls, clic k 
the gray dow n-arrow  button 
(it is the last button). 

To display shared software in a standard window: 

1 Do either of the following: 

 On the title bar of the window you are sharing, click the Sharing menu. 
If you are sharing a remote computer, the Access Anywhere menu 
appears instead of the Sharing menu. 

 In the lower-right corner of your desktop, click the WebEx icon to 
display the Sharing menu. 

2  On the menu that appears, choose Views > Restore View for 
Attendees. 

 

Synchronizing views of shared software 
Host or Presenter only 

While sharing an application, desktop (if desktop sharing is available), or 
Web browser, you can synchronize all attendees' views of the software with 
your view. 
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Synchronizing views of shared software ensures that the sharing window 
appears as the active window on attendees' screens. For example, if an 
attendee has minimized the sharing window, or moved another window on top 
of it, the sharing window becomes the active window when you synchronize 
views. 
 

Note: Synchronizing views has no effect on the size in which the shared software 
appears on attendees' screens. Attendees can control the size of their views 
independently. 

To synchronize your view with attendees: 

On the Event Controls Panel, click the down arrow (the last button on the 
panel) and then choose View. Then choose Synchronize for All. 
  

 

 
 

Selecting a monitor to share 
To select a monitor to share: 

1 Start sharing your desktop: 

 On the Quick Start page, select Share Desktop. 

If two or more monitors are detected on your system, a window 
appears and allows you to select one of the monitors.  
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 On the Share menu, select Desktop. 

A submenu shows the available monitors. 
  

 

 

2 Select the monitor you want to share. 

The Event Controls Panel indicates which monitor you are sharing. If you are 
sharing the same monitor where the Event Controls Panel is, it says, "You are 
sharing this monitor." 
  

 

If you are sharing a monitor that is not the same monitor where the Event 
Controls Panel is, it says, "You are sharing monitor <number>." 
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In addition, a green border appears around the monitor you are sharing. 

To select a different monitor to share: 

1 On the Meeting Control Panel, select the Select Content to Share button. 
  

 

 

2 In the submenu that appears, select Share Desktop. 

A submenu shows you the available monitors. 
  

 

 

3 Select the monitor number you want to share. 

The Event Controls Panel indicates which monitor you are sharing. In 
addition, a green border appears around the monitor you are sharing. 

 

Controlling your view as an attendee 
Attendee only 

When viewing or remotely controlling shared software, you can set these 
options, which determine how shared software appears on your screen: 

 Display the shared software in a full-screen view or a standard window. A 
full-screen view of a shared application or desktop fits your entire screen 
and does not include a title bar or scroll bars. 

 Scale, or resize, a shared desktop or application to fit the full-screen view 
or standard window in which it appears. 

To control your view of shared software: 

On the Event Controls Panel, click the down arrow (the last button on the 
panel)and then choose View. Then choose an option from the menu. 
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Tip: To switch quickly from the standard window to a full-screen view of shared software, 
double-click the shared software. 

 
 

Closing your attendee sharing window 
Attendee only 

While viewing or remotely controlling shared software, you can close the 
sharing window in which the software appears at any time. Closing a sharing 
window returns you to the Event window. If you close a sharing window, you 
can reopen it at any time. 

To close a sharing window: 

1 On the Event Controls Panel, click the down arrow (the last button on the 
panel)and then choose Options. Then choose an option from the menu. 

  

 
 

2 On the menu that appears, choose the appropriate option: 

 Exit Application Sharing 

 Exit Web Browser Sharing 

 Exit Desktop Sharing 

 Exit Remote Application Sharing 
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 Exit Remote Desktop Sharing 

The sharing window closes. The Event window then automatically opens. 

To return to the sharing window at any time: 

In the Event window, on the Sharing menu, click a sharing option (desktop, 
remote computer, application or Web browser). 

 

Switching your attendee view 
Attendee only 

While a presenter is sharing software, you can return to the Event window at 
any time. The sharing window remains open on your computer, so you can 
return to viewing the shared software at any time. 

To return to the Event window while the presenter is sharing software: 

On the Event Controls Panel, click the Return to Event Manager icon. 
  

 

The Event window then appears. 

To return to a sharing window: 

Do either of the following: 

 In the Application Share dialog box, which appears in the Event window, 
click Return. 

  

 

 In the Event window, on the Sharing menu, click the appropriate sharing 
option remote computer (if available), application, desktop, or Web 
Browser). 
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Annotating shared software 
  

Role 
 

Task description: 

Host or 
Presenter 

 

 Start or stop annotation mode 
More… (on page 281)  

 Use annotation tools More… 
(on page 283)  

 Let an attendee use 
annotation More… (on page 
284)  

 Save annotations More… (on 
page 287)  

Participant 

 

 Ask for permission to use 
annotation More… (on page 
285)  

 Use annotation tools More… 
(on page 283)  

 Save annotations More… (on 
page 287)  

 Give up annotations More… 
(on page 286)  

You can annotate a shared desktop, application or Web browser during an 
event, using the highlighter or other annotation tool. 

Event participants can see annotations in their sharing windows. 
 

Starting and stopping annotation 
Host or Presenter only 

When you are sharing a desktop, application or Web browser, you can 
make annotations on the software. 

Attendees can see all your annotations. 

To start annotating shared software: 

1 On the Event Controls panel, click the Start Annotating button. 
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The Annotation button has the image of a 
pencil on it.  

The Tools panel appears. 
  

 

 

2 Select a tool for making annotations. 

For details about annotation tools, see Using annotation tools (on page 283). 
  

Note:  
 You can let one or more attendees annotate the shared software. For details, see 

Letting an attendee annotate shared software (on page 284). 
 Once you or an attendee makes annotations, you can save an image of the 

software, including the annotations. For details, see Taking a screen capture of 
annotations on shared software (on page 287). 

To stop making annotations on shared software and return your mouse to a 
normal pointer, you must stop annotation mode. 

To stop annotation mode: 

Click the Stop Annotating button in the Tools panel. 
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Using annotation tools 
If, while sharing software, you are the presenter or the presenter allows you to 
annotate, you can use the Annotation Tools panel that appears to make 
annotations. The Annotation Tools panel provides a variety of tools for 
annotating a shared desktop or application. 
  

 
  

Annotation 
Tool Icon Description 

Pointer 
 

Lets you point out text and graphics on shared content. The pointer 
displays an arrow  with your name and annotation color. To display the 
laser pointer, w hich lets you point out text and graphics on shared 
content using a red “laser beam,” click the dow nw ard-pointing arrow . 
Clicking this button again turns off the pointer tool.  

Text 
 

Lets you type text on shared content. Participants can view  the text 
once you f inish typing it and click your mouse in the content view er, 
outside the text box. 

To change the font, on the Edit menu, choose Font. Clic king this button 
again turns off the text tool. 

Line 
 

Lets you draw  lines and arrow s on shared content. For more options, 
click the dow nw ard-pointing arrow . Clicking this button closes the 
Rectangle tool. 

Rectangle 
 

Lets you draw  shapes, such as rectangles and ellipses on shared 
content. For more options, click the dow nward-pointing arrow . Clic king 
this button again closes the Rectangle tool.  

Highlighter 
 

Lets you highlight text and other elements in shared content. For more 
options, click the dow nw ard-pointing arrow . Clic king this button again 
closes the Highlighter tool 

Annotation 
Color  

Displays the Annotation Color palette, on w hich you can select a color 
to annotate shared content. Clicking this button again closes the 
Annotation Color palette. 
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Annotation 
Tool Icon Description 

Eraser 
 

Erases text and annotations or clears pointers on shared content. To 
erase a single annotation, click it in the view er. For more options, click 
the dow nw ard-pointing arrow . Clicking this button again turns off the 
eraser tool. 

  

 

Letting an attendee annotate shared software 
Host or Presenter only 

You can let one or more event attendees annotate a shared desktop (if 
available), application or Web browser. 

You can let several attendees annotate shared software at the same time. 

To let an attendee annotate shared software: 

1 On the Event Controls Panel, click the Start Annotating icon 
  

 
 

The Start Annotating button is the fourth 
gray button from the left . 

The tools panel appears. 
  

 

 

2 Click the down arrow on the Allow to Annotate button. 

3 On the menu that appears, choose which participants can annotate the 
shared software: 

You can choose "All" or select someone from the list. 
  

Note:  
 To quickly allow a participant to start drawing, just click the Access Controls button 
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on the Event Controls Panel. Choose Allow to Draw and then choose that person's 
name from the drop-down list. 

 You can stop an attendee from annotating shared software at any time. For details, 
see Stopping an attendee from annotating shared software (on page 286). 

  
 

Requesting annotation control of shared software 
Attendee  only 

If a presenter is sharing a desktop, Web browser or application, you can 
ask the presenter to allow you to annotate the shared software. 

After you have permission, you can: 

 Make annotations by highlighting areas on the software, drawing lines and 
shapes, typing text, and using pointers. 

 Clear annotations at any time. 

 Change the color that you are using to make annotations. 

 Save an image of your annotations on the shared software. 

To request annotation control of shared software: 

1 In the Event Controls Panel, click the Ask to Annotate button. 
  

 
 

The Ask to Annotate button has the image of a 
pencil on it.  

A request message appears on the presenter's screen. 

After the presenter allows you to annotate, the Annotation Tools panel 
appears: 

  

 

 

2 Select the tool you want to use. 

3 Optional. Choose another annotation tool. For details, see Using 
annotation tools (on page 283). 
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Note: If you are controlling shared software remotely, the presenter must take back 
control to turn on annotation mode. You and the presenter can then annotate the shared 
software simultaneously. 

 
 

Giving up annotation control 
Participant  only 

If the presenter has granted permission to you to annotate, you can stop 
annotating at any time. 

To stop annotating: 

In the Annotation Tools panel, select the Stop Annotating button. 
 

Stopping an attendee from annotating shared software 
Host or Presenter only 

If an event attendee is drawing on shared software, you can turn off the 
drawing feature 

To turn off the drawing feature: 

1 On the .Event Controls Panel, click the Assign Control button.. 
 

 

2 On the menu that appears, choose Allow to Draw. 

On the menu that appears, a check mark appears next to the name of 
those who can annotate the shared software. 
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3 Choose the name of the attendee to cancel the selection. 
 

Taking a screen capture of annotations on shared software 
If you make annotations on shared software, you can save an image of the 
shared software, including all annotations and pointers, to a WebEx Universal 
Communications Format (.ucf) file. You can open a .ucf file on your computer 
desktop or in the content viewer in an event. 
  

Note: Participants cannot use this option unless the Host or Presenter grants the Screen 
Capture privilege to them. As Host, if you are sharing proprietary software, you may 
want to ensure that this privilege is turned off. 

To take a screen capture of annotations on shared software: 

1 On the Tools panel, select the Screen Capture button. 
  

 

 

The Save As dialog box appears. 

2 Choose a location at which to save the file, and then select Save . 
  

Note: The file you save is an image of your entire desktop. 

 
 

Sharing applications with detailed color 
(Windows) 

For Windows users only 
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By default, Event Manager sends images of shared software using 16-bit 
color mode, which is the equivalent of your computer's “High Color” (16-bit) 
setting. This mode provides an accurate representation of color for most 
shared applications. However, if your shared application contains detailed 
color images-such as color gradients-the color may not appear accurately on 
participants' screens. For example, color gradients may appear and color 
“bands.” 

If the accuracy and resolution of color in a shared application is important, you 
can turn on True Color mode in Event Manager. Using this mode, however, 
may affect the performance of application sharing. 

When using True Color mode, you can select one of the following options: 

 Better imaging (no image compression) 

 Better performance (some image compression) 

“Performance” refers to the “speed” at which images appear on participant 
screens, and “imaging” refers to the quality of the color in shared images.  
  

Note: Before turning on True Color mode, ensure that your monitor display is set to True 
Color (either 24- or 32-bit color). For more information about setting options for your 
monitor, refer to Windows Help. 

To turn on True Color mode: 

1 If you are currently sharing an application, stop your sharing session. 

2 On the Event menu, choose Event Options. 

The Event Options dialog box appears. 

3 Select the True Color Mode  tab. 

4 Select Enable True Color mode . 

5 Select one of the following options: 

 Better imaging 

 Better performance 

6 Select OK or Apply. 
 

Sharing applications with detailed color (Mac) 
For Mac users only 
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Before sharing an application or your desktop, you can choose one of the 
following display modes: 

 Better performance : The default mode. Lets you display your content 
faster than you do using the better image quality mode.  

 Better image quality: Lets you display your content with better image 
quality. In this mode, your shared content may take longer time to display 
than in the better performance mode.  

  

Note: Changing the display mode does not affect presentation or document sharing. 

To choose a display mode for your shared desktop or applications: 

1 In the Event window, on the Event Center menu, choose Preferences. 

The Preferences dialog box appears. 

2 Select Display. 
  

 

 

The display mode options 
appear. 

3 Select Better performance  or Better image quality, as appropriate. 
 

Tips for sharing software 
The following tips can help you to share software more effectively: 

 Application sharing only: To save time during an event, ensure that any 
applications you intend to share are open on your computer. At the 
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appropriate time during the event, you can then quickly begin sharing an 
application, without waiting for the application to start. 

 If attendees cannot see all of the shared software without scrolling their 
sharing windows, they can adjust their views of the shared software. They 
can reduce the size of the shared software in decrements, or scale it to fit 
inside their sharing windows. 

 To improve the performance of software sharing, close all applications that 
you do not need to use or share on your computer. Doing so conserves 
processor usage and memory on your computer, thus helping to ensure 
that Event Manager can send images of shared software quickly during an 
event. Also, to ensure that a maximum amount of bandwidth is available 
for software sharing, close any applications that use bandwidth, such as 
instant messaging or chat programs, and programs that receive streaming 
audio or video from the Web. 

 If you are sharing an application for which the rendering of color on 
participants' screen is important, you can improve color quality by turning 
on True Color mode. For details, see Sharing applications with detailed 
color (on page 287). 

 Application and Web browser sharing only: Avoid covering a shared 
application or Web browser with another window on your computer's 
desktop. A crosshatched pattern appears in attendees' sharing windows 
where the other window is covering the shared application or browser. 

 Application and Web browser sharing only: If you want to switch your 
display between shared software and the Event window, you can pause 
software sharing before you return to the Event window, and then resume 
sharing once you return to the shared application. Pausing software 
sharing conserves processor usage and memory on your computer while 
you view the Event window. For details, see Pausing and resuming 
software sharing (on page 274). 

 Application and Web browser sharing only: If you have more than one 
monitor, when you share an application or web browser, the attendees can 
see it on whichever monitor you are displaying it. If you move the 
application or Web browser to another monitor, it is still visible to the 
attendees. If you are sharing more than one application, the attendees will 
see the best view if you make sure the applications are displaying on the 
same monitor. 

 Because software sharing requires additional bandwidth during an event, it 
is recommended that you use a dedicated, high-speed Internet connection 
when sharing software. However, if attendees are using dial-up Internet 
connections, they may notice a delay in viewing or controlling shared 
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software. If you want to share a document, such as a Microsoft Word or 
Excel document, you can improve the event experience for these 
attendees by using document sharing instead of application sharing. 
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C h a pt er  2 1 

  

If you want to... See... 

get an overview  of sharing Web content About sharing Web content (on page 293)  

share Web content w ith meeting part icipants Sharing Web content (on page 294)  

understand the differences betw een sharing a 
brow ser and sharing Web content 

Differences between sharing Web content 
and sharing a Web browser (on page 294)  

 

About sharing Web content 
You can share Web content that resides on: 

 The public Internet or Web 

 Your company's intranet 

 Your computer or another computer on your private network 

Web content includes: 

 Web pages, including pages that contain embedded media files, such as 
Flash, audio, or video files 

 Standalone media files, such as Flash, audio, or video files 

The Web content that you share opens in the content viewer on each 
participant's screen. If you share a Web page, participants view and interact 
independently with the content on the page. If the page contains links to other 
pages, they can also navigate independently to those pages. 

Sharing Web Content 
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If you use Web content sharing, then, participants can experience audio and 
video effects on a Web page. However, unlike Web browser sharing, this 
option does not allow you to guide participants to other Web pages. For more 
information, see Differences between sharing Web content and sharing a 
Web browser (on page 294). 
  

Important: If you share content that requires a media player, participants can view and 
interact with the content only if the appropriate player is installed on their computers. 

 

Sharing Web content 
You can share a Web page that contains multimedia effects. The page opens 
in the content viewer on each participant's screen. 

To share Web content: 

1 On the Share  menu, choose Web Content. 

The Share Web Content dialog box appears. 

2  In the Address box, enter the address, or URL, at which the content 
resides. 

Or, if you have previously shared the content, select it in the drop-down 
list. 

3 In the Type  box, select the type of Web content that you want to share. 

4 Click OK. 
  

Tip: You can copy a URL from any source, such as another browser window, and then 
paste it in the Address box. 

 

Differences between sharing Web content and 
sharing a Web browser 

Event Center provides two options for sharing Web-based information. You 
can share Web content or share a Web browser with event participants. 
Choose the feature that better suits your needs. 
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Sharing option Advantages Disadvantages 

Web browser sharing  Lets you guide 
participants to various 
Web pages and sites on 
the Web. 

 Lets you grant attendees 
control of your Web 
brow ser. 

 Lets you and other 
participants annotate 
Web pages. 

 Does not display media 
effects or transmit 
sounds on Web pages. 

 Does not let participants 
interact w ith Web pages 
independently. 

Web content shar ing  Displays Web pages, 
and lets partic ipants 
experience media effects 
on Web pages, including 
video and sound. 

 Lets participants interact 
w ith Web pages 
independently in their 
content view ers. 

Does not let you guide 
participants to other Web 
pages. 
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If you want to ... See ... 

get an overview  of sharing multimedia on the 
Media View er panel 

About sharing multimedia Web content on the 
Media Viewer panel  (on page 297)  

share or stop sharing mult imedia on the 
Media View er panel 

Sharing multimedia content in the media 
viewer (on page 298)  

 

About sharing multimedia Web content on the 
Media Viewer panel 

You can share multimedia content that resides at a Web address, or URL, on 
the Media Viewer panel. For details about working with the panels, see 
Working with panels (on page 145). 

This option ensures that the multimedia content you are sharing remains 
visible or playing to event participants, regardless of the types of content you 
are presenting in the content viewer. 
  
 

Note: The content viewer displays one or more documents, presentations, applications, 
and whiteboards that you share during an event. Document tabs at the top of the viewer 
allow you to switch among multiple shared documents, presentations, and whiteboards. 
  

Sharing Multimedia on the 
Media Viewer Panel 



Chapter 22: Sharing Multimedia on the Media Viewer Panel 

 

298 

 

The multimedia content you can share include audio, video, Flash movies, 
graphics, and WebEx Recording Format files. 

 

Sharing multimedia content in the media viewer 
You can share multimedia content that resides at a Web address, or URL, in 
the dedicated media viewer on the Media Viewer panel. You can also stop 
sharing multimedia content at any time during an event. 

To share multimedia content on the Media Viewer panel: 

1 On the Share  menu, choose Multimedia. 

The Share Multimedia dialog box appears. 

2 In the Address box, type the URL that contains the multimedia content 
you want to share. 

The content appears in the media viewer on the Media Viewer panel. 

To replace the currently displayed content with new content: 

1 On the Media Viewer panel, right-click (Windows) or select ctrl and then 
click (Mac) the Media Viewer title bar. 

2 On the menu that appears, choose Share Multimedia. 
  
 

 

 

The Share Multimedia dialog box appears. 

3 In the Address box, type the URL that contains the multimedia content 
you want to share. 

The content replaces the old content in the media viewer. 

To stop sharing multimedia content in the media viewer: 

1 On the Media Viewer panel, right-click the Media Viewer title bar. 
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2 On the menu that appears, choose Stop Multimedia Sharing. 
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Chat is useful during an event if you want to: 

 send brief information to all participants 

 send a private message to another participant 

 ask a question but do not want to use the Q & A option, which provides a 
formal procedure for asking and answering questions  

All chat messages that you send or receive appear on the Chat panel in the 
event window. 

The Chat function allows you to perform these tasks: 

 Send chat messages More… (on page 301) 

 Assign sounds to incoming messages More… (on page 303) 

 Print chat messages More… (on page 304) 

 Save chat messages More… (on page 305) 

 Open a chat file during an event More… (on page 306) 
 

Sending chat messages 
During an event, the presenter can specify chat privileges for participants. 
These privileges determine to whom participants can send chat messages. 

To send a chat message: 

1 Open the Chat panel. 

2 In the Send to drop-down list, select the recipient of the message. 

Using Chat 
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3 Enter your message in the chat text box. 

4 Depending on the operating system you use, follow this step: 

 Windows: Click Send. 

 Mac: Select enter on your keyboard. 
  

Note: If you join an event in progress, you can see only the chat messages that 
participants send after you join the event 

 
 

Sending chat messages to an attendee 
Host and panelists only 

During an event, you can send chat messages to any particular attendee. If 
there is a large number of attendees in the event, you can search for an 
attendee's name. 

To send a chat message to an attendee: 

1 Open the Chat panel. 

2 In the Send to drop-down list, select Select an Attendee... 
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3 In the Select an Attendee dialog box, select the attendee's name in the list, 
and then click OK.  

  
 

 

 

To search for an attendee's name, enter all or 
a portion of the name and then click Find.  

To refresh the attendee list, click Refresh. 

  

4 Enter your message in the chat text box. 

5 Depending on the operating system you use, follow one of these steps: 

 Windows: Click Send. 

 Mac: Select enter on your keyboard. 

The attendee's name you selected are added to the Send to drop-down 
list. If you need to send a chat message to the same attendee again, you 
can do so more quickly. 

 

Assigning sounds to incoming chat messages 
You can choose to play a sound for one of these occasions: 

 If you are not viewing the Chat panel 

 For only the first chat message that you receive in a thread 

To assign sounds to incoming chat messages: 

1 Open the Preferences dialog box by following these steps: 

 Windows: On the Edit menu, choose Preferences. 
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 Mac: On the Event Center menu, choose Preferences. 

2 Depending on your operating system, follow one of these steps: 

 Windows: Click the Chat tab. 

 Mac: Select the Alerts button. 

3 Select the check box for each action for which you want to play a sound. 

4 Select a sound from the appropriate drop-down list. 

By default, the drop-down list contains the names of all sound files that 
reside at the default location on your computer. 

5 To select a sound that does not appear in the drop-down list, follow these 
steps: 

 Windows: Click Browse , and then select a sound file that resides in 
another folder. 

 Mac: Select Others in the drop-down list. 

6 Windows only. To play the currently selected sound, click the button . 

7 Click OK. 
 

  

Note:  
 Event Center saves your sound preferences on your computer. However, if you start 

or join an event on another computer, you need to set your preferences again on that 
computer. 

 If you are using Windows, sound files must have a .wav extension. 
 In most cases, the default location for sound files is C:\WINDOWS\Media. You can 

copy other sound files to the default folder or any other directory to make them 
available in the Preferences dialog box. 

  
 

 

Printing chat messages 
You can print all the chat messages that appear on the Chat panel. 

To print chat messages: 

1 In the Event window, on the File  menu, choose Print > Chat. 

A print dialog box appears. 

2 Optional. Specify printer options. 
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3 Print. 
 

Saving chat messages 
You can save chat messages that appear on the Chat panel to a .txt file. You 
can then reopen the file for use in any event or view the file's content outside 
an event by opening the file in a text editor. 

Once you save chat messages to a file, you can save changes to the 
messages or save a copy of them to another file. 

For help in performing these tasks, click the "More" link: 

 Save chat messages for the first t ime in an event More… (on page 305) 

 Save change to a chat file More… (on page 306) 

 Create a copy of a chat file More… (on page 306) 
 

  
 

Note: Event Center also automatically saves chat messages every two minutes to the 
WebEx folder in the My Documents folder on the host and panelist computers. 

 
 

Saving chat messages to a new file 
You can save chat messages you have sent or received to a new chat file. 

To save chat messages to a new file: 

1 In the Event window, on the File  menu, choose Save > Chat. 

The Save Chat As dialog box appears. 

2 Choose a location at which you want to save the file. 

3 Type a name for the file. 

4 Click Save . 

Event Manager saves the chat messages in a .txt file at the location you 
selected. 
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Saving changes to a chat file 
If you make changes to the messages on your Chat panel, you can save them 
to an existing chat file. 

To save changes to a chat file: 

1 In the Event window, on the File  menu, choose Save > Chat. 

2 Event Manager saves the changes to the existing chat file. 
 

Creating a copy of previously saved chat messages 
If you have saved chat messages and want to create another copy of the 
messages, you can do so by saving the chat messages to a chat file with a 
different name. 

To create a copy of chat messages that have been previously saved: 

1 In the Event window, on the File  menu, choose Save As > Chat. 

The Save Chat As dialog box appears. 

2 Do either or both of the following: 

 Type a new name for the file. 

 Choose a new location at which you want to save the file. 

3 Click Save . 

Event Manager saves the file at the location you chose. The file name has a 
.txt extension. 

 

Opening a chat file during an event 
If you saved chat messages to a .txt f ile, you can display those chat 
messages on your Chat panel by opening the file. 

To open a chat file in an event: 

1 In the Event window, on the File  menu, choose Open > Chat. 

The Open Chat dialog box appears. 

2 Select the chat file that you want to open. 
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3 Click Open. 

The chat messages appear on the Chat panel. 

If there are already chat messages in your chat viewer, Event Manager 
appends the messages from the chat file to the existing messages. 
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During an event, you can poll attendees by presenting them with a 
questionnaire. Conducting a poll can be useful for gathering feedback from 
attendees, allowing attendees to vote on a proposal, testing attendees' 
knowledge of a topic, and so on. 

 

The host assigns the role of poll coordinator to a panelist in an event. More... 
(on page 310) 

 

During the event, the poll coordinator is responsible for: 

 Preparing a poll questionnaire More… (on page 310) 

 Conducting a poll during the event More… (on page 318) 

After closing a poll, the poll coordinator can: 

 View poll results More…. (on page 320) 

 Share poll results with participants More… (on page 321) 

 Save poll results for viewing outside an event More… (on page 323) 
 

Preparing a poll questionnaire 
When preparing a poll questionnaire, you can: 

 Create a questionnaire More… (on page 310) 

 Edit a questionnaire More… (on page 315) 

 Set a timer for polling More… (on page 317) 

 Specify options for poll results More… (on page 317) 
 

Polling Attendees 
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Designating the role of polling coordinator 
Host only 

In the beginning of an event, the host is the polling coordinator by default. You 
can assign the role of polling coordinator to a panelist. 

The poll coordinator is responsible for preparing and conducting polls during 
the event. 

To designate the role of the polling coordinator: 

1 On the Participants panel and in the list of panelists, select the name of 
the panelist whom you want to designate as the polling coordinator. 

2 On the Participant menu, choose Change Role To > Polling 
Coordinator. 

The polling functions become available on the designated panelist's Polling 
panel. 

 

Creating a poll questionnaire 
Polling coordinator only 

To conduct a poll, you must first create a poll questionnaire. You can create 
poll questionnaires by using one of these methods: 

 WebEx Poll Questionnaire Editor—This standalone version of the WebEx 
Poll Questionnaire Editor allows you to create poll questionnaires outside 
an event, save them, and open them during an event.  

To download the Editor, go to the Downloads page by clicking Support > 
Downloads on the left navigation bar of your Event Center Web site. 

 Polling panel inside an event—To save time in an event, you can start the 
event earlier than the scheduled time, create questionnaires on the Polling 
panel, save them, and then open them during the actual event. 

 

To create a questionnaire (for Windows): 
 

1 Open the WebEx Poll Questionnaire Editor or the Polling panel in an 
event. 

You can start the WebEx Poll Questionnaire Editor by going to Start > 
Programs > WebEx on your desktop. 
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2 In the Question section, select one of these question types: 

 To create a multiple-answer question, select Multiple choice , and 
then select Multiple Answers in the drop-down list. 

 To create a single-answer question, select Multiple choice , and then 
select Single Answer in the drop-down list. 

 To create a text question, select Short answer. 

3 Click New. 

4 Type a question in the box that appears. 

5 In the Answer section, click Add. 

6 Type an answer in the box that appears. 

7 To type another answer, click Add once you finish typing an answer. 

The question and answers appear in the Poll Questions area. 

8 To add questions, repeat steps 2 to 7. 

This figure shows an example of a poll questionnaire. 
  

 
 

To create a questionnaire (for the Mac): 

1 Open the Polling panel in the event. 

2 Add a question by clicking this button and then typing the question. 
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3 Add an answer by clicking this button and then typing the answer. 
  

 
 

4 To add more answers, repeat step 3. 

5 To add more questions, repeat step 2. 

6 To change the question type for a question, click the text "Click here to 
change question type" that appears under the specific question and then 
do one of the following: 

 To create a multiple-answer question, select Multiple Answers. 

 To create a single-answer question, select Single Answer. 

 To create a question that requires a text answer, select Short Answer. 
  

 

 

 
 

 

Displaying multiple poll questionnaires on Polling panel 
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When an event is in progress, 
you can: 
 Display or create multiple poll 

questionnaires on your Polling 
panel. 

Each poll questionnaire 
displays on a tab. 

 Click any of the poll tabs to 
edit or open the poll.  

  

To display additional poll questionnaires on your Polling panel:  

 If the poll questionnaire has not been created, click the icon New. For 
more information, see Creating poll questionnaires (on page 310). 

  
 

 

 

Window s 

 

 

Mac 
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 If the poll questionnaire has been created, click the icon Open to open the 
poll questionnaire file. For more information, see Opening a poll 
questionnaire file (on page 325). 

  
 

 

 

Window s 

 

 

Mac 

  

To close a poll tab: 

Click this icon. 
  
 

 

Window s 

 Mac 
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Renaming and reordering poll tabs 
You can easily change a tab name or change the tab order on your Polling 
panel. 

To rename a tab on your Polling panel (Windows): 

1 Do one of the following: 

 Right-click the tab name and choose Rename . 

 Double-click the tab name. 

2 Enter the new name on the tab. 

3 Press Enter or click outside the tab. 

This tab displays the new name. 

To rename a tab on your Polling panel (the Mac): 

Double-click the tab, type the new name, and then press enter. 

To reorder the tabs on your Polling panel: 

1 Right-click any tab and choose Reorder Polling Tabs. 

2 In the Reorder Viewer Tabs dialog box, use the arrows to change the 
order of the tabs. 

Moving a tab up in the order moves that tab to the left on the Polling panel. 

3 Click OK. 

  
 

Tip: To quickly move a tab to the left or right, select the tab and use a drag-and-drop 
operation to move it. 

 
 

Editing a questionnaire 
You can change the type of a question and edit, rearrange, or delete the 
questions and answers. 
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To change the type of a question: 

1 Select the question by clicking it, and then select the new type of question 
in the Question section. 

For more information about the different types of questions, see Creating 
poll questionnaires (on page 310). 

2 Click Change Type . 

To edit any question or answer that you entered: 

1 Select the question or answer by clicking it, and then click the Edit icon. 
  

 

 

2 Make your changes. 

To delete a question or an answer: 

Select the question or answer by clicking it, and then click the Delete  icon. 
  

 
Window s 

 
Mac 

To rearrange questions or answers: 

Select the question or answer by clicking it, and then click the Move Up or 
Move Down icon, as appropriate. 
  

 

To delete an entire questionnaire: 

Click Clear All. 

If you have not saved the questionnaire, a message box appears, asking 
whether you want to save it or not. 
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Displaying a timer during polling 
You can specify that a timer displays for participants and yourself when a poll 
is in progress. 

To display a timer: 

1 Open the Polling Options dialog box. 

 If you use Windows, click Options at the bottom of your Polling panel. 

 If you use the Mac, click this button on the lower-right portion of the 
Polling panel. 

  

 

 

2 In the dialog box that appears, select Display, and then type the length of 
time in the Alarm: box. 

3 Click OK. 
 

Specifying options for poll results 
Poll results may contain the number of responses for each answer and the 
percentage of participants who choose each answer. When preparing a poll 
questionnaire, you can choose to base the percentage for each answer on 
either of the following: 

 the total number of attendees in the event, including those who do not 
respond to the poll 

 the number of attendees who submit at least one answer to the poll 

To specify options for poll results: 

1 Open the Polling Options dialog box. 

 If you use Windows, click Options at the bottom of your Polling panel. 
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 If you use the Mac, click this button on the lower-right portion of the 
Polling panel. 

  
 

 

 
  

2 Select one or both of these options: 

 Include no answer—Specifies that the poll results will include “non-
respondents,” that is—attendees who do not respond to any of the 
answers in the poll. 

 Show number of responses—Specifies that the poll results for each 
answer will show the number of respondents out of the total number of 
attendees in the poll. 

  
 

 Note: The total number of attendees in the poll can be all attendees in the event or 
only those who respond to the poll, depending on whether you select Include no 
answer in the Polling Options dialog box. If you do not select Include no answer, 
the percentage for each answer in your poll results will be based on only those who 
respond to the poll. 

 

  

3 Click OK. 
 

Opening a poll 
After you finish preparing a poll questionnaire, you can open the poll.  

If you prepared your questionnaire in advance and saved it, you must first 
display it on the Polling panel. For details, see Opening a poll questionnaire 
file (on page 325). 
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To open a poll: 

1 Display your poll questionnaire on the Polling panel, if you have not done 
so. 

2 Click Open Poll. 

The questionnaire appears on participants' Polling panels. Participants can 
now answer the poll. 

As participants answer the questions, you can watch the polling status on 
your Polling panel.  

  

 

 

Window s: 

To view  each participant’s 
polling status, click one of 
these three buttons. 

 

 

 

Mac: 

To view  each participant’s 
polling status, select the text 
"Click to see detailed status."  

3 Click Close  Poll when the time is up. 

If you specify a timer and the poll times out, the poll automatically closes. 

Participants can no longer answer questions. 

Once you close a poll, you can view the poll results and optionally share them 
with participants. For details, see Viewing and sharing poll results (on page 
319). 

 

Viewing and sharing poll results 
After closing a poll, you can: 

 View the complete results of the poll. More… (on page 320)  

 Share group results with participants. More… (on page 321) 
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The poll results you can share during an event are anonymous. However, 
Event Center records responses from each participant, in addition to group 
results, and allows you to save those individual and group results. For 
more information, see Saving results of a poll (on page 323).  

 

Viewing poll results 
Poll results may contain the number of responses for each answer and the 
percentage of participants who choose each answer. If you did not specify to 
show the number of responses when preparing the questionnaire, you see 
only the percentage for each answer. 
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The Results column 
indicates the 
percentage of 
attendees w ho chose 
each answ er. The Bar 
Graph column 
provides a graphic 
representation of each 
percentage in the 
Results column. 

 

 

Sharing poll results with participants 
After you close a poll, you can share the poll results with participants. 

The poll results you can share during an event are anonymous. However, 
Event Center records responses from each participant, in addition to group 
results, and allows you to save those individual and group results. For more 
information, see Saving results of a poll (on page 323).  



Chapter 24: Polling Attendees 

 

322 

 

To share the results of a poll: 

In the Share with attendees section on your Polling panel, select Poll 
results, and then click Apply. 

The results of the poll appear in the participants' Polling panels, just as they 
do on your Polling panel. 

 

Saving and opening poll questionnaires and 
results 

  
 

Task description 

 

If you have prepared a poll questionnaire, you can: 

 Save the questionnaire More… (on page 322) 

 Open the saved questionnaire for use in any event More…  
(on page 325)  

After you close a poll, you can: 

 Save group results to a .txt or .csv f ile More… (on page 323)  

 Save responses from individual participants to a .txt or .csv 
f ile More…  (on page 323)  

  

 

Saving a poll questionnaire in an event 
After you create a poll questionnaire in an event, you can save it as a .atp file. 
You can open the file for use in any event. 

To save a poll questionnaire: 

1 On the File  menu, choose Save > Poll Questions. 

The Save Poll Questions As dialog box appears. 

2 Choose a location at which to save the file. 
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3 Type a name for the file. 

4 Click Save . 

Event Manager saves the poll questionnaire to a file at the location you 
specified. Poll questionnaire file names have a .atp extension. 

 

Saving results of a poll 
After closing a poll, you can save the responses in one of these ways: 

 Text File group result—Saves the percentage of attendees who chose 
each answer in a .txt file  

 Text File individual attendees result—Saves the responses from each 
attendee, in addition to the group results, in a .txt file 

 CSV group result—Saves the percentage of attendees who chose each 
answer in a .csv file 

 CSV individual attendees result—Saves the responses from each 
attendee, in addition to the group results, in a .csv file 

  
 

 

When you are saving poll 
results, you can select a 
format in w hich you w ant to 
save the results. 

To save results of a poll: 

1 Close the poll if you have not done so. 

2 On the File  menu, choose Save > Poll Results. 

The Save Poll Results As dialog box appears. 

3 Select a location at which to save the file. 

4 In the "File name" drop-down list, enter a name for the file. 

5 In the "Save as type" drop-down list, select the format in which you want to 
save the results. 
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6 Click Save . 

You can now view poll results by opening the file. 
  
 

Tip: Event Center automatically saves poll questionnaires and group and individual 
results every two minutes to the default folder C:\Documents and Sett ings\<$USER 
ROOT$>\My  Documents\WebEx on your computer. If the folder does not exist and cannot 
be created when the event starts, the alternative folder is C:\My WebEx Documents. If you 
ever lose your poll questions or results, recover them in the designated folder or contact 
the WebEx Technical Support for more information. 

 
 

Saving results of all polls in one file 
After closing a poll, you can save the responses in one of these ways: 

 Text File group result—Saves the percentage of attendees who chose 
each answer in a .txt file  

 Text File individual attendees result—Saves the responses from each 
attendee, in addition to the group results, in a .txt file 

 CSV group result—Saves the percentage of attendees who chose each 
answer in a .csv file 

 CSV individual attendees result—Saves the responses from each 
attendee, in addition to the group results, in a .csv file 

  
 

 

When you are saving poll 
results, you can select a 
format in w hich you w ant to 
save the results. 

  

To save results of all polls in one file: 

1 Close all the polls if you have not done so. 

2 On the File  menu, choose Save  > All Poll Results. 
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The Save All Poll Results dialog box appears. 

3 Select a location at which to save the file. 

4 In the "File name" drop-down list, enter a name for the file. 

5 In the "Save as type" drop-down list, select the format in which you want to 
save the results. 

6 Click Save . 

You can now view poll results by opening the file. 
  
 

Tip: Event Center automatically saves poll questionnaires and group and individual 
results every two minutes to the default folder C:\Documents and Sett ings\<$USER 
ROOT$>\My  Documents\WebEx on your computer. If the folder does not exist and cannot 
be created when the event starts, the alternative folder is C:\My WebEx Documents. If you 
ever lose your poll questions or results, recover them in the designated folder or contact 
the WebEx Technical Support for more information. 
  

 

Opening a poll questionnaire file 
If you saved a poll questionnaire to a file, you can display the questionnaire 
on your Polling panel by opening the file. 
  

Note: You can open a poll questionnaire file only during an event. 
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To open a poll questionnaire file: 

1 Use one of these methods to browse to the file: 

 On the File  menu, choose Open Poll Questions. 

 Click the Open icon on your Polling panel. 
  

 
 

 
Window s 

   Mac 

The Open Poll Questions dialog box appears. 

2 Select the poll questionnaire file that you want to open. 

A poll questionnaire file has a .atp extension. 

3 Click Open. 

The poll questionnaire appears on your Polling panel. You can now open 
the poll to the participants. 
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C h a pt er  2 5 

 

If you want to... See... 

get an overview  of using Feedback About using Feedback  (on page 327) 

allow  participants to use Feedback options  Allowing participants to provide feedback  (on 
page 328)  

view  a running tally of responses Viewing a running tally of responses (on page 
328)  

provide feedback Providing feedback  (on page 329)  

remove responses from the Participants 
panel 

Removing feedback  (on page 330)  

 

About using Feedback 
Feedback is a feature that allows the presenter to pose a question at any 
time—either verbally during a teleconference or Internet phone conference, or 
in a chat message—and receive instant feedback from other participants. 

As the host, you can: 

 allow attendees to provide feedback 

 respond to the presenter's verbal request for feedback 

 provide unsolicited feedback 

 view the results on the Feedback palette 

As the presenter, you can: 

 pose a question and request feedback 

Using Feedback 
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 share the feedback results with all participants 

 clear the feedback results 

 view the results on the Feedback palette 

As a participant, you can: 

 click the Raise Hand button if the presenter asks for a show of hands in 
response to a question or if you have a question 

 select yes or no in response to a question 

 select too slow or too fast to indicate that the presenter’s pacing is too 
slow or too fast 

 select Applause  or Laughter to express your emotions 
 

Allowing participants to provide feedback 
Host only 

You can allow participants to use the Feedback options during an event. 

To allow participants to use the Feedback options: 

1 On the Participants panel, click the Feedback icon. 
  
 

 
 Window s  

 
 Mac  

The Feedback palette appears. 

2 Check Allow feedback. 

3 To close the palette, click the "close" button. 
 

Viewing a running tally of responses 
You can view a running tally of responses from attendees during an event. 

To view a running tally of responses: 

On the Participants panel, click the Feedback icon . 
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The Feedback palette appears. 

Your Feedback palette displays a running tally of responses. See the 
following figure for an example. 
  
 

 
  

In your participants list, a response indicator appears to the right of the name 
of each participant who has responded to a presenter's question. 

 

Providing feedback 
You can provide feedback from the Participants panel. 

The following table shows the types of feedback you can provide during an 
event: 
  
 

 
Click the button if  the presenter asks for a show  of 
hands in response to a question or if  you have a 
question. 

Window s 

  
 

Mac 

  

Click the icon to provide feedback. 
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To provide feedback: 

1 Click either the Feedback icon or the downward-pointing arrow to the right 
of the Feedback icon. 

2 Select one of the following responses from the drop-down list. 
  
 

 Yes or No in response to a question 

 Too Slow or TooFast to indicate that the presenter’s pacing is too fast or slow 

 Applause to applaud the presenter  

 Laughter to laugh at the presenter's remarks 

  

3 Click Send. 

Your Feedback palette displays a running tally of responses. On the 
Participants panel, a response indicator appears to the right of the name 
of each participant who has responded to a presenter's question. 

 

Removing feedback 
You can remove all the feedback at any time during an event. 

To remove feedback (erase all responses): 

1 On the Participants panel, click the Feedback button on the toolbar. 

2 Click Clear. 
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C h a pt er  2 6 

If you record an event using WebEx Recorder, you can publish and make 
available the recording on your event service Web site's Event Recordings 
page in one of the following ways: 

 If the recording is made from the integrated or standalone WebEx 
Recorder, upload the recording file, with a .wrf extension, from your local 
computer to the My Event Recordings page and publish it from that page. 

For details about uploading a recording, see Uploading a recording file (on 
page 333). 

 If the event was recorded on the server, the WebEx server automatically 
uploads the recording file to the My Event Recordings page. You can 
maintain and publish the recording from that page. 

 Specify the Web address, or URL, at which the recording resides on a 
publicly accessible Web server, such as your organization's Web site. To 
use this option, you can ask your organization's Webmaster to store the 
recording on the server and provide you with the URL for the recording. 

 Send an email to share the event recording. For details about sharing a 
recording with others, see Sending an email to share an event recording 
(on page 345). 

 Send an email to vendors to share an event recording. For details about 
sharing a recording with vendors, see Sending an email to vendors to 
share an event recording (on page 346). 

Before publishing a recorded event, you can: 

 Specify that users provide registration information before viewing the 
recording and customize the registration form. 

 Provide information about the recording, such as a description of the 
recording and the presenter, the duration, and so on. 

Publishing a Recorded Event 
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 Set an access password for viewing the recording. 

Once you publish a recording, you can edit information about it at any time. 
  
 

Note: For more information about using the different types of WebEx Recorder and 
WebEx Player, see the guide WebEx Recorder and Player User's Guide on the Support 
page of your Event Center Web site. 
  

 

Opening the My Event Recordings page 
To upload or maintain event recordings, you must do so from the My Event 
Recordings page on your Event Center Web site. 

To open the My Event Recordings page: 

Do either of the following: 

 Log in to your Event Center Web site, and then click My WebEx. From the 
left navigation bar, click My Files > My Event Recordings. 

 Log in to your Event Center Web site. On the left navigation bar, click My 
Event Recordings. 

The following figure shows an example of the page. 
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For details about the My Event Recordings page, see About the My Event 
Recordings page (on page 336). 

 

Uploading a recording file 
If you recorded an event using the integrated or standalone WebEx Recorder, 
you can upload the recording file, with a .wrf extension, from your local 
computer to the My Event Recordings page and then publish it from that 
page. 

For instructions on publishing a recording, see Publishing a recorded event 
(on page 333). 
  
 

Note: If you recorded an event on the server, the WebEx server automatically uploads 
the recording file, with an .arf extension, to the My Event Recordings page once you stop 
the Recorder. You do not need to upload it yourself. 
  

To upload a recording file: 

1 Go to the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Click Add Recording. 

3 On the Add Event Recording page, enter information and specify options. 

For details about what you can do with each option on the page, see 
About the Add/Edit Event Recording page (on page 339). 

4 Click Save . 
 

Publishing a recorded event 
All event recordings are unlisted by default—that is, they appear only on the 
My Event Recordings page. You must log in to your Event Center We site to 
view and maintain the recordings. 

To publish a recording and make it available for all visitors to your site, you 
must specify to list the recording—that is, the recording appears on the Event 
Recordings page, which is accessible to each site visitor. 
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After a recording is added to the My Event Recordings page, your event 
service generates URLs for streaming and downloading the recording on the 
Recording Information page. You can copy and paste the URLs in an email 
message that you send to event participants. 

To publish a recorded event: 

1 Open the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Upload your recording, if you have not yet done so. For details, see 
Uploading a recording file (on page 333) . 

3 Click the More icon for the recording that you want to edit: 
  
 

 
 

  

4 Click Modify from the menu. 
  
 

 

 
  

The Edit Event Recording page appears. 

5 In the Type drop-down list, select Listed. 

For details about what you can do with each option on the Edit Event 
Recording page, see About the My Event Recordings page (on page 336). 

6 Click Save . 

The recording appears on the Event Recordings page. You can verify it by 
clicking Attend an Event (left navigation bar) > List of Events > View 
Event Recordings. 
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7 Optional. Send an email share an event recording. For details, see 
Sending an email to share an event recording (on page 345). 

8 Optional. Send an email to vendors to share an event recording and track 
viewing. For details, see Sending an email to vendors and tracking viewing 
of recording (on page 346). 

  
 

Important: If you require a password for playing or downloading a recording, ensure that 
you communicate it to the intended viewers, such as in an email message. 
  

 

Deleting a published recording 
You can remove a published recording at any time. 

To delete a published recording: 

1 Go to the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Click the More button next to the event recording to display additional 
options. 

  
 

  
  

3 Click Delete from the menu. 
  
 

 

 
  

4 Click OK to confirm. 

Once you remove a recording from the My Event Recordings page, you also 
remove it from the Event Recordings page. 
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Editing information about a recorded event 
Whether you publish a recording or not, you can edit information about it at 
any time. If you already published a recording, the changes you make to the 
recording information will appear on the Event Recordings page, which is 
accessible to all visitors to your Event Center Web site. 

To edit information about a recorded event: 

1 Go to the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Click the More icon for the recording that you want to edit: 
  
 

 
 

  

3 Click Modify from the menu. 
  
 

 

 
  

4 The Edit Event Recording page appears. 

5 Make your changes. 

For details about what you can do with each option on the Edit Event 
Recording page, see About the Add/Edit Event Recording page (on page 
339). 

6 Click Save . 
 

About the My Event Recordings page 

How to access this page 

Do either of the following: 
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 Log in to your Event Center Web site, and then click My WebEx. From the 
left navigation bar, click Manage My Stuff > My Recordings > Events. 

 Log in to your Event Center Web site. On the left navigation bar, click My 
Event Recordings. 

 

What you can do here 

Manage, upload, and maintain recording files of events you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 

Search Allow s you type text to search for w ithin recording names. Clic k 
Search to start the search. 

 

 

Topic 

The name of the recording. If  you record an event on the server, 
the WebEx server automatically uploads the recording to this 
page. In this case, the topic of the recording is the topic of the 
event. You can edit the topic at any time. 

 

 

Capacity: n MB The percentage of available personal storage space on your 
WebEx Service Web site that is being used by your recordings. 

Used: n MB 
The percentage of total available storage space on your WebEx 
Service Web site that is being used by all recordings on your 
site. 

 

 

Panelist Information about the panelists in the event w here the recording 
was made. 

Type 

The publication status of the event recording: 

 Listed: The recording is published—that is, the recording 
appears on the Event Recordings page, w hich is accessible 
to all visitors to your Event Center Web site. 

 Unlisted: The recording is not published—that is, the 
recording appears only on the My Event Recordings page. 
You must log in to your Event Center Web site to view  and 
maintain the recordings. 
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Size The size of the recording. 

Create Time/Date The date and time the recording w as created. 

Duration The length of the recording. 

Format 

The format of the recording f ile. 

A recording f ile can be in WebEx Advanced Recording Format 
(ARF) or WebEx Recording Format (WRF). You can also store 
recording f iles that are in Window s Media Audio/Video (WMV) 
or Shockw ave Flash Object (SWF) format. 

 

Lets you play the recording (available only for recording f iles 
w ith an .arf extension that w ere recorded by the Netw ork-Based 
Recorder). 

If  playback of the f ile requires a passw ord, you must provide the 
passw ord. 

 Lets you send an email to share this recording w ith others. 
 

 

 
 

Displays a menu w ith more options for your recording: 

 Download: Lets you dow nload the recording to your local 
computer. 

If  dow nloading the f ile requires a passw ord, you must 
provide the passw ord. 

 Modify: Lets you edit information of the recording. For 
details, see About the Add/Edit Event Recording page (on 
page 339). 

  Send to vendor: Lets you send an email to share this 
recording w ith a vendor. 

 Delete: Lets you delete the recording from this page. 

 
 

 

Lets you upload a new  recording. 

For details, see Uploading a recording file (on page 333) and 
About the Add/Edit Event Recording page (on page 339). 

 

 

 Indicates that a recording is passw ord-protected. 
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 Indicates that registration is required to view  the recording. 

 

About the Add/Edit Event Recording page 

How to access this page 
If you are adding a recording... 

1 Do either of the following: 

 Log in to your Event Center Web site, and then click My WebEx. From 
the left navigation bar, click My Files > My Recordings > Events. 

 Log in to your Event Center Web site. On the left navigation bar, click 
My Event Recordings. 

2 Click Add Recording. 

If you are editing information of a recording... 

1 Do either of the following: 

 Log in to your Event Center Web site, and then click My WebEx. From 
the left navigation bar, click My Files > My Recordings > Events. 

 Log in to your Event Center Web site. On the left navigation bar, click 
My Event Recordings. 

2 Click the More icon for the recording that you want to edit: 
  
 

 
 

  

3 Click Modify. 
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What you can do here 
 Edit general information about an event recording, including the event 

topic and description. 

 Specify whether to list an event recording—that is, the recording appears 
on your site's Event Recordings page, which is accessible to all site 
visitors. 

 Require a password or registration to play or download the recording. 

Options on this page 
  
 

Use this option.... To.... 

Topic Specify the topic of the recording. 

Type Specify the publication status of the event recording, w hich can 
be one of the follow ing: 

 Listed: The recording is published—that is, the recording 
appears on the Event Recordings page, w hich is accessible 
to all visitors to your Event Center Web site. 

 Unlisted: The recording is not published—that is, the 
recording appears only on the My Event Recordings page. 
You must log in to your Event Center We site to view  and 
maintain the recordings. 

Program Assign the recording for a program. Select a program in the 
drop-dow n list. 

Note A program is a group of live events or recorded events for 
a specif ic project, product, or audience. 

Panelist information Provide information about the panelists in this event.  

Description Provide a description of this recording. 
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Use this option.... To.... 

Recording file I w ill provide URL—Specify the Web address, or URL, at w hich 
the recording resides on a publicly accessible Web server, such 
as your organization's Web s ite. 

Enter a URL in the box. 

Use the file on my local machine—Select a recording f ile that 
resides on your local computer. 

Click Browse to select the f ile. 

Use a file that is already on the WebEx network—Specify a 
recording f ile that res ides on the My Recordings page (in My 
WebEx), w hich lists the follow ing types of recordings: 

 all the netw ork-based recordings (ARF format) that you 
made during an event 

 other recordings (WRF format) that you upload to the page  

Click Look Up to brow se and select a recording from the My 
Recordings page. If  you cannot f ind a certain recording, it may 
have been removed or used on the My Training Recordings 
page, if  your site inc ludes the training service. 

Recording date Specify the date on w hich the recording w as created. 

Recording start time Specify the time at w hich you started recording this event. 

Time zone Specify the time zone in w hich you recorded this event. 

Duration Specify the duration of this recording. 

Panel Display Options Determines w hich panels are displayed in the recording w hen it 
is played back. You can select any of the follow ing panels to be 
included the recording playback: 

 Chat 

 Q & A 

 Video 

 Polling 

 Notes 

 File Transfer 

 Participants  

 Table of Contents  

Panel display options do not modify the panel display in the 
actual recording that is stored on the WebEx netw ork.  
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Use this option.... To.... 

Recording Playback 
Range 

Determines how  much of the recording is actually played back. 
You can select either of the follow ing: 

Full playback: Plays back the full length of the recording. This 
option is selected by default.  

Partial playback: Plays back only part of the recording based 
on your settings for the follow ing options: 

Start: X min X sec of the recording: Specif ies the time to start 
playback; for example, you can use this option if  you w ould like 
to omit the "dead time" at the beginning of the recording, or if  
you w ould like to show  only a port ion of the recording. 

End: X min X sec of the recording: Specif ies the t ime to end 
playback; for example, you can use this option if  you w ould like 
to omit the "dead time" at the end of the recording. You can not 
specify an end time greater than the length of the actual 
recording. 

The partial playback range you specify does not modify the 
actual recording that is stored on the server.  

Include NBR player 
controls 

Inc ludes full Netw ork Recording Player controls, such as stop, 
pause, resume, fast forward, and rew ind. This option is selected 
by default. If  you w ould like to prevent view ers from skipping 
portions of the recording, you can turn off this option to omit 
Netw ork Recording Player controls from the playback.  

Registration required Require that users f ill out a registration form before they can 
view  the recording. 

To require registration, select Yes . 

Customize Registration 
form 

Customize the questions on the registration form. 

To customize the form, click Customize . 

Use password Set a passw ord that users must provide to view  the recording. 

Downloadable Specify that users can dow nload the recording f ile to their local 
computers. 

Playable  Specify that users can play the recording on their local 
computers. 
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Use this option.... To.... 

Post-recording survey Allow s you to create a survey for users to complete after playing 
the recording. You can select one of the follow ing options: 

 Do not display survey to attendees 

 Display survey in pop-up window 

 Display survey in main browser w indow (instead of 
destination URL)  

You can click Create Post-Recording Survey to open the 
Create Survey page, w hich allows you to specify survey 
information and questions. 

Allow direct access If  your site administrator has enabled hosts to expose a direct 
recording access URL, this option generates a direct recording 
access link. If  the recording is not passw ord-protected, clicking 
the direct recording access link plays the recording immediately, 
w ithout requiring registration. 

Display this URL at end 
of playback 

Specify a Web page to display once a user stops the playback 
and closes WebEx Player. 

 

About the Recording Information page 

How to access this page 

Open your event recordings list: 

 Log in to your Event Center Web site, and then click My WebEx. From the 
left navigation bar, click My Files > My Recordings > Events. 

 Log in to your Event Center Web site. On the left navigation bar, click My 
Event Recordings. 

What you can do here 

 View information about an event recording. 

 Obtain URLs for playback or downloading of an event recording. 

 Open the Edit Recording Information page, on which you can edit 
information about an event recording. 

Options on this page 
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Option Description 

Topic The name of the recording 

If you record an event using the Netw ork-Based Recorder, the 
WebEx server automatically uploads the recording to this page. 
In this case, the topic of the recording is the topic of the event. 

You can edit the topic at any t ime. 

Type The publication status of the event recording, w hich can be one 
of the follow ing: 

 Listed: The recording is published—that is, the recording 
appears on the Event Recordings page, w hich is accessible 
to all visitors to your Event Center Web site. 

 Unlisted: The recording is not published—that is, the 
recording appears only on the My Event Recordings page. 
You must log in to your Event Center Web site to view  and 
maintain the recordings. 

Recording date The date and time at w hich the recording w as made 

Panelist information Information about the panelists for the event w here the 
recording w as made 

Duration The length of the recording 

Description A description of the recording 

Number of viewers The number of people w ho view ed the recording 

Use password? Indicates w hether a user must prov ide a passw ord to view  the 
recording 

Post-recording survey Indicates w hether a survey displays after the recording has 
f inished playing. 

Playback/Download link Clicking the link lets you playback the recording directly, 
bypassing registration. This option replaces the Download link 
option if  the Add/Edit Event Recording page has Allow Direct 
Recording Access  set to Yes. 

 

Clicking the button lets you play the recording (available only for 
recording f iles w ith the .arf extension that w ere recorded by 
NBR). 

If  you w ant to dow nload the recording, you can also click the 
link for dow nloading under Play Recorded an event Now . 

 
Clicking the button opens the Share My Recording w indow , 
which allow s you to send an email message to selected 
recipients, invit ing them to play your recording. 
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Option Description 
If  you w ant to send the email w ith your local email client instead, 
click the link for using the email client under Share My 
Recording. 

 

Clicking the button opens the Edit Event Recording page. 

For details about the page, see About the Add/Edit Event 
Recording page  (on page 339). 

 

Allow s you to send the recording to up to three vendors and use 
source IDs to track attendees w ho view  the recording. 

For more information about using source IDs, see About 
tracking your attendees (on page 101). 

 
Clicking the button returns you to the My Event Recordings 
page. 

  
 

Sending an email to share a recording 
You can send an email one or more people to share your recording with them.  

To send an email to share a recording with others: 

1 Go to the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Open the Share My Recording window: 

 Click the following icon for the recording that you want to share with 
others. 

  

  

 Click the linked name of the recording you want to share. On the 
Recording Information page, click Send Email. 

  

  

The Share My Recording window appears. 
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3 Select recipients for your email: 

 Click Select Recipients to select contacts from your Contacts list 

 Type email addresses in the Send to list, separated by commas. 

4 (Optional) Type a message in the Your message  box. 

5 Click Send. 

Your email message will be sent to the selected recipients, and will include 
information about the recording and a link to play it.  

 

Sending an email to vendors and tracking 
viewing of recording 

You can send an email to up to three vendors and use source IDs to track 
from which sources attendees view the recording. For details about using 
source IDs, see About tracking your attendees (on page 101). 

To send an email to share a recording with others: 

1 Go to the My Event Recordings page. For details, see Opening the My 
Event Recordings page (on page 332). 

2 Open the Send Recording to Vendor window: 
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 On the My Event Recordings page, click the More button next to the 
recording you want to share to display additional options. 

  

  

From the More menu, click the Send to Vendor link. 
  

 

 

 On the My Event Recordings page, click the name of the recording you 
want to share. On the Recording Information page, click Send to 
Vendor. 

  

 
 

The Send Recording to Vendor window appears. 
  

 

 

3 Specify up to three vendors for your email: 



Chapter 26: Publishing a Recorded Event 

 

348 

 

 Type the vendor's email address in the Email address # boxes. 

 Type the vendor's source ID in the Source ID box. 

4 Click Send. 

Your email message will be sent to the specified vendors, and will include 
information about the recording and a link to play it.  
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C h a pt er  2 7 

If a video camera is installed on your computer, you can send video. Other 
participants can see you, or whatever you focus your webcam on. To see 
video, participants do not need to have a webcam installed on their 
computers. 

WebEx Meeting Center supports high-definition (HD) video with up to 720p 
resolution. Other WebEx services, such as Training Center, Event Center, 
and Support Center, support high-quality video with up to 360p resolution. 
The Cisco technology automatically adjusts video to the highest quality for 
each participant according to the computer capabilit ies and network 
bandwidth. 

Your administrator can set video options at the site level. A meeting host can 
set video options on the scheduler as well as in the meeting. If your site or 
meeting is not set up to use HD or high-quality video, standard video is used. 

To start or stop sending video, select the video icon beside your name.  

  

 

The icon turns green w hen you are 
sending video. 

After you start sending video, you can perform the following tasks depending 
on your role. 

Sending and Receiving 
Video 
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Role 
 

Tasks 

Host 

 

 

What you can do: 

 Start or stop sending video at w ill.  

 Lock focus on one participant (on page 351). 

 View everyone who is sending video (on page 353) on one big screen. 

 List participants or show thumbnails. (on page 352)  

 Set webcam options (on page 356). 

Participant 

 

What you can do: 

 Start or stop sending video at w ill.  

 View everyone who is sending video (on page 353) on one big screen. 

 List participants or show thumbnails. (on page 352)  

 Set webcam options (on page 356). 

  

Note: If you are managing a meeting that includes TelePresence systems (Meeting 
Center only), the following WebEx features are unavailable: 
 Recording 
 Polling 
 File Transfer 
 Chat with TelePresence room participants 

 

Minimum system requirements 
To send or receive video with a resolution of 360p, ensure that your system 
meets the following minimum requirements: 
  

Action What you need 

Send 

 A w ebcam capable of produc ing high-quality video. WebEx supports 
most w ebcams of this type 

 A computer w ith at least 1 GB of RAM and a dual-core processor  

 A fast netw ork connection  

Receive 
 A computer w ith at least 1 GB of RAM and a dual-core processor  

 A fast netw ork connection  
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To send or receive video with a resolution of 720p, ensure that your system 
meets the following minimum requirements: 
  

Action What you need 

Send 

 A w ebcam capable of produc ing HD video. WebEx supports most 
webcams of this type 

 A computer w ith at least 2 GB of RAM and a quad-core processor  

 A fast netw ork connection  

Receive 
 A computer w ith at least 2 GB of RAM and a dual-core processor  

 A fast netw ork connection  

 

Locking focus on one participant 
If you are the host, you can select whose video you want everyone to see. 
Follow these steps: 

1 Select the name on the video display. 
  

 

 

2 In the dialog box, select one of the following: 
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 The active speaker. This is the 
default. The display focuses on the 
person currently speaking and 
sw itches as the loudest speaker 
changes.  

 A specific participant. The display 
focuses on only the specif ic 
participant that you select. All 
participants see that person, 
regardless of w ho is speaking. 

 

Switching between a list or thumbnail view of 
participants 

You can switch between the Participant List and participants' video 
thumbnails. 
  

 
 

 
 

To view video thumbnails: 

1) Select the list icon. 

2) Select Thumbnails. 

 

To view Participant List: 

1) Select the thumbnail icon. 

2) Select List. 
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In the thumbnails view , select the dow n or 
up arrow  to view  additional thumbnails. 

 

Viewing everyone who is sending video 
With one click, you can view live, high-quality video display across your entire 
screen. In the video view, you see all participants who are sending video, 
including: 

 the active speaker or a specific participant whom the host chose to lock on 

 five thumbnails on the bottom. To see more participants, use the arrow on 
either side. 
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To view all participants who are sending 
video: 
Select the icon in the upper-right corner of 
the display. 

 

To return to the Event w indow: 
Select Exit Full-Screen Mode in the 
upper-right corner of the screen. 

 

 

Understanding the large video view 
When you are viewing everyone who is sending video, high-quality video 
displays across your entire screen. 
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One of the follow ing is displayed here: 

 The active speaker's video, w hich sw itches as the loudest speaker changes  

 A specif ic participant's video that the host chose to lock on 

 

Your self-view  appears in this corner. You can 

 Minimize or restore the display by selecting the icon in the upper-right corner of the 
self-view . 

 Mute or unmute your audio by selecting Mute Me  or Unmute Me. 

 Stop or show  your self-view  by selecting Stop My Video or Start My Video. 

 Video thumbnails of f ive other participants appear here.  

 Use these controls to see addit ional participants. 

 
If  you are the host or presenter, you can choose to lock everyone's focus on the active 
speaker's video or a specif ic participant's video. Select the name to get started. More… (on 
page 351)  

 You can expand the active speaker's video display to full screen. More… (on page 356)  
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Expanding the active speaker's video display 
When you are viewing all participants who are sending video, you can expand 
the active speaker's video display to full screen. With the full-screen display, 
you can continue sending or receiving HD video (applicable for Meeting 
Center only). 
  

 
 

To see the active speaker (or the specif ic participant 
the host chose to lock on) in full-screen view , select 
this icon in the upper-right corner of the active 
speaker's display. 

 

To return to the view  w here you see everyone w ho 
is sending video, select this icon in the upper-right 
corner of your screen. 

 

 

Setting webcam options 
If you have a working webcam, you can set options that are available for that 
webcam directly from your event. 

To set webcam options: 

  

 

Window s: 

At the top r ight of the 
Participants panel, select the 
options icon. 

 
 

Mac: 

At the bottom right of the 
Participants panel, select the 
options icon. 
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Typically, you can set options for general settings, such as contrast, 
sharpness, and brightness. But options can vary depending on your webcam. 

 

Managing video display during sharing 
When you are sharing information or someone else is sharing information with 
you, a floating panel containing participant video and your self-view appears 
on the right-hand side of your screen.  
  

 

What you can do on the floating panel: 

 Stop or start your video. More… (on page 358) 

 Minimize or restore your video. More… (on page 358) 

 Move the panel by dragging it. More… (on page 358) 

 Switch to view everyone who is sending video. More… (on page 358) 

 Lock focus on another participant (for host and presenter only). More… 
(on page 351) 

  

Note: If your are viewing everyone sending video and the presenter starts sharing, you 
will automatically exit the video view so that you can view what is being shared. 
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Controlling your self-view 
During sharing, your self-view appears in the lower-right portion of the floating 
panel. You can manage your self-view in several ways. 
  

 
 

To minimize self-view: 
Select the icon in the upper-right portion of the self-
view  display. 

To restore self-view: 
Select the icon in the low er-right portion of the 
f loating panel. 

To stop or show self-view: 
Select the video icon at the center of the self-view  
display. 

 

 

Controlling video display 
During sharing, you see the active speaker's video or a specific participant's 
video, if the host chose to lock on the participant, in a floating panel. You can 
manage this video display in several ways. 
  

 

To minimize: 
Select the dow nward arrow  in the upper-left 
corner. 

To resize:  
Select the bottom right-corner and drag the 
edge. 

To move: 
Select and drag the display to another 
location on your screen. 

To lock another participant's video: 
Select the name and then select the 
participant in the dialog box. For details, see 
Locking focus on one participant (on page 
351). 

To switch to view everyone: 
Select the icon in the upper-right corner of 
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the display. 

 

 

Obtaining video and audio data during an event 
Having video or audio problems in a meeting? If you contact technical 
support, the video and audio data you can obtain within the meeting comes in 
handy. 

To obtain audio and video data while in the Event window: 

Select Meeting > Audio & Video Statistics... 
  

 
 

To obtain audio and video data while viewing everyone sending video: 

Right-click the active speaker's display and then select Audio & Video 
Statistics...  
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If you want to… See… 

get an overview  of My WebEx  About My WebEx (on page 362)  

set up a user account on your WebEx service 
Web site 

Obtaining a user account (on page 363) 

log in to or out from My WebEx  Logging in to and out of the WebEx service 
site (on page 364)  

use your list of meetings Using your list of meetings (on page 364)  

view  or set options for your Personal Meeting 
Room page 

Maintaining Your Personal Meeting Room 
Page (on page 376) 

set up or access remote computers, using 
Access Anywhere 

Using Access Anywhere (My Computers) (on 
page 380)  

add, edit, or delete f iles in your personal 
storage space for f iles 

Maintaining files in your personal folders (on 
page 381)  

publish recorded events on your event 
service Web site 

Publishing a recorded event  (on page 333)  

add, edit, or delete information about your 
contacts in your online address book 

Maintaining contact information (on page 
403)  

change information or sett ings in your user 
profile, including personal information and 
preferences 

Maintaining your user profile (on page 418)  

manage the scheduling templates you saved Managing scheduling templates (on page 
425)  

generate reports about online sessions  Generating Reports (on page 430) 

 

Using My WebEx 



Chapter 28: Using My WebEx 

 

362 

 

 

About My WebEx 
My WebEx is an area on your WebEx service Web site in which you can 
access your user account and personal productivity features. The following 
features are available, depending on the configuration of your site and user 
account: 

 Personal list of meetings: Provides a list of all the online meetings that 
you are hosting and attending. You can view the meetings by day, week, 
or month, or you can view all meetings. 

 Productivity Tools Setup: Optional feature. Lets you set up options for 
instant or scheduled meetings that you can start from applications on your 
desktop. If you install WebEx Productivity Tools, you can start or join 
meetings, sales meetings, training sessions, and support sessions 
instantly from One-Click or from other applications on your desktop, such 
as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, 
and instant messengers. You can also schedule meetings, sales 
meetings, events, and training sessions using Microsoft Outlook or IBM 
Lotus Notes without going to your WebEx service site. 

 Personal Meeting Room: Optional feature. A page on your WebEx 
service Web site on which visitors can view a list of meetings that you are 
hosting and join a meeting in progress. Visitors can also access and 
download files that you share.  

 Access Anywhere: Optional feature. Lets you access and control a 
remote computer from anywhere in the world. For more information about 
Access Anywhere, refer to the guide Getting Started with Access 
Anywhere, which is available on your WebEx service Web site. 

 File storage: Lets you store files in personal folders on your WebEx 
service Web site, where you can access them on any computer that has 
access to the Internet. Also lets you make specific files available on your 
Personal Meeting Room page, so visitors to your page can access them. 

 

 Recorded events management: Lets you maintain recorded events files 
and publish them on your WebEx service Web site. For more information, 
see Publishing a recorded event (on page 333). 

 

 Address book: Lets you keep information about your personal contacts 
on your WebEx service Web site. Using your address book, you can 
quickly access contacts when inviting them to a meeting. 
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 User profile: Lets you maintain your account information, such as your 
username, password, and contact information. Also lets you specify 
another user who can schedule meetings on your behalf, set options for 
your Personal Meeting Room page, and manage scheduling templates. 

 Web site preferences: Lets you specify the home page for your WebEx 
service Web site—that is, the page that appears first whenever you 
access your site. If your site provides multiple languages, you can also 
choose a language and locale in which to display text on your site. 

 Usage reports: Optional feature. Lets you obtain information about 
meetings that you hosted. If you use the Access Anywhere option, you can 
also obtain information about computers that you access remotely. 

 

Obtaining a user account 
Once you obtain a user account, you can use My WebEx features and host s 
on the Web. 

You can obtain a user account in one of two ways: 

 The site administrator for your WebEx service Web site can create a user 
account for you. In this case, you need not sign up for an account on your 
site, and you can begin hosting s immediately. 

 If your site administrator has made the self-registration feature available, 
you can sign up for an account on your WebEx service Web site at any 
time. 

To obtain a user account using the self-registration feature: 

1 Go to your WebEx service Web site. 

2 On the navigation bar, click Set Up > New Account. 

The Sign Up page appears. 

3 Provide the required information. 

4 Click Sign Up Now. 

You receive an email message, confirming that you have signed up for a 
user account. 

Once your site administrator approves your new user account, you receive 
another email message containing your username and password. 
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Note: Once you obtain a user account, you can edit your user profile to change your 
password and provide additional personal information. You can also specify site 
preferences, such as your default home page and time zone. For details, see Maintaining 
your user profile (on page 418). 

 

Logging in to and out of the WebEx service site 
To manage your online meetings and maintain your user account, you must 
log in to your WebEx service Web site. If you do not yet have a user account, 
see Obtaining a user account (on page 363). 

To log in to your WebEx service site: 

1 Go to your WebEx service Web site. 

2 In the upper-right corner of the page, click Log In. 

The Log In page appears. 

3 Enter your username and password. 

Passwords are case-sensitive, so you must type your password exactly as 
you specified it in your user profile. 

4 Click Log In. 
  

Tip: If you have forgotten your username or password, click Forgot your password. 
Provide your email address, type verification characters, and then click Submit. You will 
receive an email message containing your username and password. 

To log out from your WebEx service site: 

In the upper-right corner of the page, click Log Out. 
 

Using your list of meetings 
  

If you want to… See… 

get an overview  of your list of meetings About your list of meetings (on page 365)  

open your list of meetings Opening your meetings list (on page 365) 



 Chapter 28: Using My WebEx 

 

365 

 

If you want to… See… 

maintain your list of meetings  Maintaining your scheduled meetings list (on 
page 367)  

 

About your list of meetings 
On your WebEx service Web site, your My Meetings page in My WebEx 
includes: 

 

 A list of all the online meetings that you have scheduled, including both 
listed and unlisted meetings. 

 A list of meetings on your site to which you are invited. 
 

 An option to start a One-Click meeting (not available for Event Center). 

 Any Personal Conference meetings that you scheduled (if your site and 
account have the Personal Conferencing feature turned on). 

  

Tip: You can specify that your My WebEx meetings page is the home page that appears 
once you log in to your WebEx service Web site. For details, see Maintaining your user 
profile (on page 418). 

 

Opening your meetings list 
You can open your personal list of scheduled meetings on your WebEx 
service Web site to: 

 Start an event 

 Modify an event 

 Cancel an event 

You can open your personal list of meetings to which you are invited: 

 Obtain information about an event 

 Join an event in progress 

To open your meetings list: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

The My Meetings page appears, showing your list of scheduled meetings. 
  



Chapter 28: Using My WebEx 

 

366 

 

 

 

 
  

2 Click one of the tabs to navigate to different views of the My Meetings 
page: 

You can choose Daily, Weekly, Monthly, or All Meetings. 

3 Optional. Do either of the following: 

 To view the list of meetings to which you are invited, select The 
meetings you are invited to from the list. 

 To include s in the view that have already occurred, turn on Show past 
meetings. 

4 (Optional) Select options to control the view: 

 To view the list of meetings to which you are invited, select The 
meetings you are invited to from the list. 

 To include meetings in the view that have already occurred, turn on 
Show past meetings. 

  
  

Tip: You can specify that your My WebEx Meetings page is the home page that appears 
once you log in to your WebEx service Web site. For details, see Maintaining your user 
profile (on page 418). 
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Maintaining your scheduled meetings list 
Once you schedule an event, it appears in your meetings list on your My 
Meetings page. For more information, see Opening your meetings list (on 
page 365). 

An online event remains on your My Meetings page until you delete it. When 
scheduling an event, you can choose to automatically delete the event from 
your list of meetings once both of these conditions occur: 

 You start and end the event. 

 The scheduled time for the event has passed. 

However, if you required registration for a scheduled event, the event remains 
in your list until you remove it. That way, you can still view information about 
attendees who registered for the event at any time after you host the event. 

To remove an event from your list of meetings on your My Meetings page, you 
must cancel the event by deleting it on this page. 

For details about the options on the My WebEx Meetings page, see About the 
My WebEx Meetings page (on page 367). 

 

 

About the My WebEx Meetings page 

How to access this tab 

On your WebEx service Web site, click the My WebEx tab. 

What you can do here 

Access these features: 

 A link to your personal meeting room 

 A list of meetings you are hosting or are invited to for the specified day, 
week, or month 

 A list of all meetings you are hosting or are invited to 
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Options on this page 

  

Use this option… To… 

Go To My Personal 
Meeting Room 

Go to your Personal Meeting Room page. 

Your Personal Meeting Room page lists any events that you 
scheduled and any in-progress events that you are currently 
hosting. 

Users to w hom you provide your personal URL can use this 
page to join any event that you are hosting. They can also 
dow nload f iles in any folders that you share. 

Daily View  a list all of the meetings for the specif ied day. For details, 
see About the My WebEx Meetings - Daily tab (on page 368). 

Weekly View  a list all of the meetings for the specif ied w eek. For details, 
see About the My WebEx Meetings - Weekly tab (on page 370). 

Monthly View  a list all of the meetings for the specif ied month. For 
details, see About the My WebEx Meetings - Monthly tab (on 
page 373)  

All Meetings View  a list all meetings, or search for meetings by date, host, 
topic, or w ords in the agenda. For details, see About the My 
WebEx Meetings - All Meetings tab (on page 374) 

Refresh 

 

Refresh the information in the meeting list.  

 

About the My WebEx Meetings page - Daily tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Daily 
tab. 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 
list of events. 
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Option Description 

Language link 
Click to open the Preferences page, w here you can select the 
language setting for your WebEx service Web site. 

Time zone link Click to open the Preferences page, w here you can select the 
time zone sett ing for your WebEx service Web site. 

Date The date for the daily list of events. The default is the current 
date. 

 
Click the Previous Day icon to display a list of events for the 
previous day. 

 
Click the Next Day icon to display a list of events for the next 
day. 

The meetings you host Show s a list all of the online events or Personal Conference 
meetings that you are hosting. 

The meetings you are 
invited to 

Show s a list all of the events or Personal Conference meetings 
to w hich you have been invited. 

Show past meetings Select to include concluded events in the list of meetings. 

 
The Ascending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
ascending order. 

 
The Descending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
descending order. 

Time 

The starting time for each scheduled event. Click the box next 
to a meeting start t ime to select that event. Click the box next 
to the Time column heading to select or clear all events in the 
list. 

Topic 
The topic for an event that you are hosting. Click the topic 
name to get information about that event. 

Type 
Indicates the type of online event that you are hosting. 
Available event types depend on the configuration of your 
WebEx service Web s ite. 

Assist 

If  an Assist has been requested for this event, indicates the 
type of Assist: 

 None 

 Dry Run  

 Consult 
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Option Description 

 Live Event Support 

 Audio Streaming 

 Video 

 Indicates that the live event is in process. 

Status The status of the event. 

 Start: You can start this event that you are hosting at any 
time by clicking the link. 

 Join | End: (for hosts) For a event in progress that you 
are hosting, you can join or end the event. Appears if  you 
left a event, or you allow ed participants to join the event 
before its starting time and participants have already 
joined the event. 

 Join: Lets you join the event in progress. 

 End: Ends the event. 

 Join: (for attendees) The event that you are invited to has 
started, and you can now  join the event. 

 Registration: (for attendees) The event that you are 
invited to requires registration. To display a page on w hich 
you can register to attend the event, click the link. (Does 
not apply to sales meetings or support sessions.)  

Delete Cancels any eventsthat are currently selected in the list. If  you 
click this link, a message appears, allow ing you to confirm that 
you w ant to cancel the event. Another message appears, 
allow ing you to inform any invited attendees that you canceled 
the event. (Does not apply to support sessions.) 

 

About the My WebEx Meetings page - Weekly tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Weekly 
tab. 
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Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 
list of events. 

Language link 
Click to open the Preferences page, w here you can select the 
language setting for your WebEx service Web site. 

Time zone link Click to open the Preferences page, w here you can select the 
time zone sett ing for your WebEx service Web site. 

Week link The beginning and ending date for the w eekly list of events. 

 
Click the Previous Week icon to display a list of meetings for 
the previous w eek. 

 
Click the Next Week icon to display a list of meetings for the 
next w eek. 

 
Click the Calendar icon to open the Calendar w indow  for the 
current month. Click on any date to open its schedule in the 
Daily view . 

The meetings you host Show s a list all of the online events or Personal Conference 
meetings that you are hosting. 

The meetings you are 
invited to 

Show s a list all of the events or Personal Conference meetings 
to w hich you have been invited. 

Show past meetings Select to include concluded events in the list of meetings. 

Day link 

 

Opens the Daily view , which show s the scheduled events for 
the selected day. 

 
The Ascending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
ascending order. 

 
The Descending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
descending order. 

 The Expand button appears next to a Day link. Click this 
button to expand and display the list of events for that day. 

 The Collapse button appears next to a Day link. Clic k this 
button to collapse and hide the list of events for that day. 
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Option Description 

Time 

The starting time for each scheduled event. Click the box next 
to a meeting start t ime to select that event. Click the box next 
to the Time column heading to select or clear all events in the 
list. 

Topic 
The topic for an event that you are hosting. Click the topic 
name to get information about that event. 

Type 
Indicates the type of online event that you are hosting. 
Available event types depend on the configuration of your 
WebEx service Web s ite. 

Assist 

If  an Assist has been requested for this event, indicates the 
type of Assist: 

 None 

 Dry Run  

 Consult 

 Live Event Support 

 Audio Streaming 

 Video 

 
Indicates that the live event is in process. 

Status The status of the event. 

 Start: You can start this event that you are hosting at any 
time by clicking the link. 

 Join | End: (for hosts) For a event in progress that you 
are hosting, you can join or end the event. Appears if  you 
left a event, or you allow ed participants to join the event 
before its starting time and participants have already 
joined the event. 

 Join: Lets you join the event in progress. 

 End: Ends the event. 

 Join: (for attendees) The event that you are invited to has 
started, and you can now  join the event. 

 Registration: (for attendees) The event that you are 
invited to requires registration. To display a page on w hich 
you can register to attend the event, click the link. (Does 
not apply to sales meetings or support sessions.)  

Delete Cancels any eventsthat are currently selected in the list. If  you 
click this link, a message appears, allow ing you to confirm that 
you w ant to cancel the event. Another message appears, 
allow ing you to inform any invited attendees that you canceled 
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Option Description 

the event. (Does not apply to support sessions.) 

 

About the My WebEx Meetings page - Monthly tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Monthly 
tab. 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 
list of events. 

Language link 
Click to open the Preferences page, w here you can select the 
language setting for your WebEx service Web site. 

Time zone link Click to open the Preferences page, w here you can select the 
time zone sett ing for your WebEx service Web site. 

Month 
The month for the monthly calendar of events. The default is 
the current month. 

 
Click the Previous Month icon to display a list of events for 
the previous month. 

 
Click the Next Month icon to display a list of events for the 
next month. 

 
Click the Calendar icon to open the Calendar w indow  for the 
current month. Click on any date to open its schedule in the 
Daily view . 

Week Number link 

 

Opens the Weekly view , w hich show s the scheduled events 
for each day of the selected w eek. 

Day link 

 

Opens the Daily view , which show s the scheduled events for 
the selected day. 
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Option Description 

The meetings you host Show s a list all of the online events or Personal Conference 
meetings that you are hosting. 

The meetings you are 
invited to 

Show s a list all of the events or Personal Conference meetings 
to w hich you have been invited. 

Show past meetings Select to include concluded events in the list of meetings. 

Topic 
The topic for an event that you are hosting. Click the topic 
name to get information about that event. 

 
Indicates that the live event is in process. 

 

About the My WebEx Meetings page - All Meetings tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > All 
Meetings tab. 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 
list of events. 

Language link 
Click to open the Preferences page, w here you can select the 
language setting for your WebEx service Web site. 

Time zone link Click to open the Preferences page, w here you can select the 
time zone sett ing for your WebEx service Web site. 

Date The date for the daily list of events. The default is the current 
date. 

 
Click the Previous Day icon to display a list of events for the 
previous day. 

 
Click the Next Day icon to display a list of events for the next 
day. 
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Option Description 

Search for meetings by 
date, host, topic, or words 
in the agenda 

Allow s you type or select a date range to search for events, or 
allows you to type text to search in host names, topics, or 
agendas. Click Search to start the search. 

 
Click the Calendar icon to open the Calendar w indow . Clic k on 
any date to select that date as part of your search criteria. 

The meetings you host Show s a list all of the online events or Personal Conference 
meetings that you are hosting. 

The meetings you are 
invited to 

Show s a list all of the events or Personal Conference meetings 
to w hich you have been invited. 

Show past meetings Select to include concluded events in the list of meetings. 

 
The Ascending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
ascending order. 

 
The Descending Sort indicator appears next to a column 
heading, and the events are sorted by the column, in 
descending order. 

Time 

The starting time for each scheduled event. Click the box next 
to a meeting start t ime to select that event. Click the box next 
to the Time column heading to select or clear all events in the 
list. 

Topic 
The topic for an event that you are hosting. Click the topic 
name to get information about that event. 

Type 
Indicates the type of online event that you are hosting. 
Available event types depend on the configuration of your 
WebEx service Web s ite. 

Assist 

If  an Assist has been requested for this event, indicates the 
type of Assist: 

 None 

 Dry Run  

 Consult 

 Live Event Support 

 Audio Streaming 

 Video 

 Indicates that the live event is in process. 
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Option Description 

Status The status of the event. 

 Start: You can start this event that you are hosting at any 
time by clicking the link. 

 Join | End: (for hosts) For a event in progress that you 
are hosting, you can join or end the event. Appears if  you 
left a event, or you allow ed participants to join the event 
before its starting time and participants have already 
joined the event. 

 Join: Lets you join the event in progress. 

 End: Ends the event. 

 Join: (for attendees) The event that you are invited to has 
started, and you can now  join the event. 

 Registration: (for attendees) The event that you are 
invited to requires registration. To display a page on w hich 
you can register to attend the event, click the link. (Does 
not apply to sales meetings or support sessions.)  

Delete Cancels any eventsthat are currently selected in the list. If  you 
click this link, a message appears, allow ing you to confirm that 
you w ant to cancel the event. Another message appears, 
allow ing you to inform any invited attendees that you canceled 
the event. (Does not apply to support sessions.) 

 

Maintaining Your Personal Meeting Room Page 
  

If you want to… See… 

get an overview  of your Personal Meeting 
Room page 

About your Personal Meeting Room (on page 
377)  

access your Personal Meeting Room page Viewing your Personal Meeting Room (on 
page 377)  

add images and text to your Personal 
Meeting Room page 

Setting options for your Personal Meeting 
Room (on page 378)  

share f iles on your Personal Meeting Room 
page 

Sharing files on your Personal Meeting Room 
(on page 379)  
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About your Personal Meeting Room page 
Your user account includes a Personal Event Room page on your WebEx 
service Web site. Users who visit your page can: 

 View a list of online events that you are hosting, either scheduled or in 
progress. 

 Join an event in progress. 

 View your personal folders and upload or download files to or from your 
folders, depending on the settings you specify for your folders. 

You can customize your Personal Meeting Room page by adding images and 
text to it. 

To provide users with access to your Personal Meeting Room page, you must 
provide them with your Personal Meeting Room URL. For more information, 
see Viewing your Personal Meeting Room page (on page 377). 
  

Tip: Add your Personal Meeting Room URL to your business cards, your email 
signature, and so on. 

 
 

Viewing your Personal Meeting Room page 
You can view your Personal Meeting Room page at any time, by going to the 
link for the page. The link for your Personal Meeting Room page is available 
on your: 

 My WebEx Meetings page 

 My WebEx Profile page 

To view your Personal Meeting Room page: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

The My WebEx Meetings page appears. 

2 Click the Go to My Personal Meeting Room link. 

Alternatively, in My WebEx, click My Profile , and then click the Personal 
Meeting Room URL link in the Personal Meeting Room section. 
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Your Personal Meeting Room page appears. The following is an example 
of a Personal Meeting Room page. 

  

 

 
  

Tip: Add your Personal Meeting Room URL to your business cards, your email 
signature, and so on. 

  
 

Setting options for your Personal Meeting Room page 
You can add the following to your Personal Meeting Room page: 

 An image (for example, you can add a picture of yourself or your 
company's product). 

 A custom banner image to the header area of your Personal Meeting 
Room page, if your user account has the “branding” option. For example, 
you can add your company's logo. 

 A welcome message. For example, you can provide a greeting; 
instructions on joining an online session; information about yourself, your 
product, or your company. 

At any time, you can replace or delete images and text that you add. 

To add an image to your Personal Meeting Room page: 

1 If you have not already done so, log in to your WebEx service Web site. 
For details, see Logging in to and out of the WebEx service site (on page 
364). 

2 On the navigation bar at the top of the page, click My WebEx. 

3 Click My Profile . 

The My WebEx Profile page appears. 

4 Under Personal Meeting Room, specify options for your page. 
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5 At the bottom of the My WebEx Profile page, click Update . 

6 For details about the options for your Personal Meeting Room page, see 
About your Personal Meeting Room page (on page 377) . 

 

Sharing files on your Personal Meeting Room page 
You can share folders on your My WebEx Files: Folders page so that they 
appear on the Files tab on your Personal Meeting Room page. For any folder 
that you share, you can specify whether users can download files from or 
upload files to the folder. 

For more information about your Personal Meeting Room page, see About 
your Personal Meeting Room page (on page 377). 

To share files on your Personal Meeting Room page: 

1 Open the My WebEx Files page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Under Name , locate the folder in which you want to share files. 

3 If the file or folder is in a closed folder, click the folder to open it.  

4 Click the Properties icon for the folder in which you want to share files. 
  

 
 

The Edit Folder Properties window appears. 
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5 Specify sharing options for the folder. 

6 Click Update . 

For details about sharing options, see About the Edit Folder Properties page 
(on page 390). 

 

Using Access Anywhere (My Computers) 
For information about and instructions for using Access Anywhere to set up 
and access a remote computer, please refer to the guide Getting Started with 
WebEx Access Anywhere. This guide is available on the Support page on 
your WebEx service Web site. 

 

About the My Computers page 

How to access this page 

On your WebEx service Web site, click My WebEx Files > My Computers. 
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What you can do here 

Set up and access remote computers using Access Anywhere. 

Options on this page 

  

Link or option Description 

Computer The name you have assigned to your remote computer. 

Status 

The status of your remote computer: 

 Available—the computer is available for remote access. 

 Offline—the computer is off line and is not available for 
remote access. 

Application 

The application on your remote computer that you have 
allow ed to access, based on w hat you specif ied during set up. 
It may be Desktop, if  you set up your desktop for access, or it 
may be a specif ic application name. 

Status If  the computer is available for access, you can click the 
Connect link to connect to your remote computer. 

 
Removes the selected computer from the list of remote 
computers. 

 

Sets up the current computer for Access Anyw here and adds 
it to the list of remote computers. 

Download manual installer Dow nloads the manual installer for the Access Anyw here 
softw are. 

 

 

Maintaining files in your personal folders 
  

If you want to… See… 

get an overview  of your personal storage 
space for f iles 

About maintaining files in your folders (on 
page 382)  

open your personal storage space for f iles Opening your personal folders, documents, 
and files (on page 383)  
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If you want to… See… 

create new  folders to organize your f iles  Adding new folders to your personal folders 
(on page 384)  

upload f iles to your personal folders  Uploading files to your personal folders (on 
page 384)  

move or copy f iles or an entire folder to 
another folder 

Moving or copying files or folders in your 
personal folders (on page 385)  

change information about f iles or folders, 
including their names or descriptions  

Editing information about files or folders in 
your personal folders (on page 386)  

search for f iles or folders in your personal 
storage space for f iles 

Searching for files or folders in your personal 
folders (on page 387)  

dow nload f iles in your personal storage space 
to your computer 

Downloading files in your personal folders (on 
page 388)  

share, or publish, f iles in your personal 
folders on your Personal Meeting Room, so 
others can access them 

Sharing files on your Personal Meeting Room 
page (on page 379)  

remove f iles or folders from your personal 
folders 

Deleting files or folders in your personal 
folders (on page 388)  

 

About maintaining files in your folders 
Your user account includes personal storage space for files on your WebEx 
service Web site. 

In your personal storage space, you can: 

 Create folders to organize your files. 

 Edit information about any file or folder in your personal folders. 

 Move or copy a file or folder to a different folder. 

 Share a folder so it appears on your Personal Meeting Room page. 
  

Tip:  
 You can use this storage space to access important information when you are away 

from the office. For example, if you are on a business trip and want to share a file 
during an online session, you can download the file in your personal folders to a 
computer, and then share the file with attendees. 

 If you share a folder, visitors to your Personal Meeting Room page can upload files 
to or download them from the folder. For example, you can use your personal folders 
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to exchange documents that you share in your sessions, archive recorded events, 
and so on. For more information about your Personal Meeting Room, see About your 
Personal Meeting Room (on page 377). 

  
 

Opening your personal folders, documents, and files 
To store files on your WebEx service Web site, or to access files that you 
stored, you must open your personal folders. 

To open your personal folders: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Files. 

The My WebEx Files page appears, showing your personal folders and 
files. Depending on the settings for your WebEx Service Web site, you 
may see different categories of folders and files, and you can click on the 
heading links to see each category: 

 My Documents 

 My Recordings 

 My Event Recordings (available only in Event Center)  

 My Training Recordings (available only in Training Center)  
  

 

 

For details about the My WebEx Files page, see About the My WebEx Files > 
My Documents page (on page 388) and About the My WebEx Files > My 
Recordings page (on page 399). 
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Adding new folders to your personal folders 
To organize your files on your WebEx service Web site, you can create 
folders in your personal storage space for files. 

To create a new folder: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Under Action, click the Create Folder button for the folder in which you 
want a new folder. 

  

 
 

The Create Folder window appears. 

3 In the Folder Name  box, type a name for the folder. 

4 Optional. In the Description box, type a description to help you to identify 
the folder's contents. 

5 Click OK. 
 

Uploading files to your personal folders 
To store files in your personal folders on your WebEx service Web site, you 
must upload them from your computer or a local server. 

You can upload up to three files at once. The is no limit to the size of the files, 
as long as you have available storage space. The amount of space available 
for storing files is determined by your site administrator. If you require more 
disk space, contact your site administrator. 

To upload files to your personal folders: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Locate the folder in which you want to store the file. 

3 Under Action for the folder, click the Upload button for the folder in which 
you want to store the file. 
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The Upload File window appears. 

4 Click Browse . 

The Choose File dialog box appears. 

5 Select the file that you want to upload to your folder. 

6 Click Open. 

The file appears in the File name  box. 

7 Optional. In the Description box, type a description to help you to identify 
the file. 

8 Optional. Select up to two additional f iles to upload. 

9 Click Upload. 

The files are uploaded to the folder that you selected. 

10 Once you are finished uploading files, click Finish. 
  

 

Moving or copying files or folders in your personal folders 
You can move one or more files or folders to another folder on your WebEx 
service Web site. 

To move or copy a file or folder: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Locate the file or folder that you want to move. 

3 Select the check box for the file or folder that you want move. 

You can select multiple files or folders. 

4 Click Move  or Copy. 

The Move/Copy File or Folder window appears, showing a list of your 
folders. 

5 Select the option button for the folder in which you want to move or copy 
the file or folder. 

6 Click OK. 
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Editing information about files or folders in your personal 
folders 

You can edit the following information about a file or folder in your personal 
folders on your WebEx service Web site: 

 Name 

 Description 

You can also specify sharing options for folders that appear on your Personal 
Event Room page. For more information, see Sharing files on your Personal 
Event Room page (on page 379). 

To edit information about a file or folder: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Locate the file or folder for which you want to edit information. 

3 Click the Properties icon for the file or folder for which you want to edit 
information. 

  

 
 

The Edit File Properties or Edit Folder Properties window appears. 
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 In the Description box, type a new name for the file or folder. 

 In the Name  box, type a new name for the file or folder. 

4 Click Update . 
 

Searching for files or folders in your personal folders 
In your personal folders on your WebEx service Web site, you can quickly 
locate a file or folder by searching for it. You can search for a file or folder by 
text that appears in either its name or description. 

To search for a file or folder: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 In the Search For box type all or part of the file's name or description. 

3 Click Search. 

A list of any files or folders that contain the search text appears. 
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Downloading files in your personal folders 
In your personal folders on your WebEx service Web site, you can download 
any files to your computer or a local server. 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Locate the file that you want to download. 

3 Under Action, click the Download button for the file that you want to 
download. 

  

 
 

The File Download dialog box appears. 

4 Follow any instructions that your Web browser or operating system 
provides to download the file. 

 

Deleting files or folders in your personal folders 
You can delete files or folders in your personal folders on your WebEx service 
Web site. 

To delete a file or folder: 

1 Open the My Documents page. For details, see Opening your personal 
folders, documents, and files (on page 383). 

2 Under Name , locate the file or folder that you want to delete. 

3 Select the check box for the file or folder that you want delete. 

You can select multiple files or folders. 

4 Click Delete . 
 

About the My WebEx Files > My Documents page 

How to access this page 

On your WebEx service Web site, click My WebEx Files > My Documents. 
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What you can do here 

 Store files that you use in your online sessions or that you want to access 
when away from your office. 

 Specify in which folders that visitors to your Personal Meeting Room can 
download or upload files. 

Options on this page 

  

Link or option Description 

Capacity The storage space available for your f iles, in megabytes (MB). 

Used 
The amount of storage space that your f iles occupy, in megabytes 
(MB). Once this value exceeds your capacity, you can no longer store 
f iles until you remove existing f iles from your folders. 

Search for 

Lets you locate a f ile or folder by searching for it. You can search for a 
f ile or folder by text that appears in either its name or description. To 
search for a f ile or folder, type all or part of its name or description in 
the box, and then click Search. 

 
Click this button to refresh the information on the page. 

Name 

The name of the folder or f ile. Click a folder or f ile name to open the 
Folder Information page or File Information page. From the 
Information page, you can access the properties of a folder or f ile. 

  Indicates that the item is a folder. Clic k the image to display 
the contents of the folder. 

  Indicates that the item is a f ile. 

Path The folder hierarchy for the folder or f ile. The Root folder is the top-
most folder in w hich all other folders and f iles reside. 

Size The size of the folder or f ile, in kilobytes (KB). 

Actions 

Click the icons to perform an action on the folder or f ile that is 
associated w ith it.  

 Upload file: Available only for f iles. Click this icon to open 
the File Upload page, on w hich you can select up to three 
f iles at a t ime to upload to a specif ied folder. 

 Download file: Available only for f iles. Click this icon to 
dow nload the f ile associated w ith it.  
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Link or option Description 

 Edit File Properties or Edit Folder Properties: Clic k this 
icon to open the Edit File Properties page or Edit Folder 
Properties page, on w hich you can edit information about 
the f ile or folder, respectively. 

 Create Folder: Available for folders only. Clic k this icon to 
open the Create Folder page on w hich you can create a new  
folder in your personal storage space. 

Shared 

 

Specif ies the sharing settings for a folder; that is, how  others w ho visit 
your Personal Meetings Room can access your folder and its f iles. 

R Read only: Visitors to your Personal Meeting Room can 
view  the list of f iles in the folder and dow nload the f iles. 

W Write only: Visitors to your Personal Meeting Room can 
upload f iles to the folder, but they cannot view  the f iles in it.  

R/W Read and write: Users can view  files in the folder, 
dow nload f iles from the folder, and upload f iles to the folder. 

 Password Protected: Indicates that the folder is passw ord 
protected. Visitors to your Personal Meeting Room must 
provide the passw ord you specify to access the folder. 

Select All 
Selects the check boxes for all the folders and f iles that are visible in 
the list. You can then click the Copy or Move button or clic k the 
Delete link to perform an action on the selected folders or f iles. 

Clear All Clears the check boxes for all the folders and f iles that are selected in 
the list. 

Delete Deletes the selected folders and f iles from the list.  

Copy Opens a page on w hich you can copy the selected folder or f ile to 
another folder. 

Move Opens a page on w hich you can move the selected folder or f ile to 
another folder. 

 

About the Edit Folder Properties page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Files > Properties 
icon for folder. 
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What you can do here 

Specify a name, a description, and sharing options for a folder that you 
created in your personal folders. 

Options on this page 

  

Use this option… To… 

Name Enter the name of the folder. 

Description Enter the description of the folder. 

Share Specify w ho can access this folder. 

 Do not share this folder: This folder does not appear on your 
Personal Meeting Room page. Thus, vis itors to your page 
cannot view  the folder or access any f iles in it.  

 Share this folder: This folder appears on your Personal 
Meeting Room. 

The drop-dow n list specif ies w hich users can access the folder, 
as follows: 

 With all: All v isitors to your Personal Meeting Room can 
access this folder. 

 With users w ith host or attendee accounts: Only visitors 
to your Personal Meeting Room w ho have either a host 
account or an attendee account on your WebEx service 
Web site can access this folder. 

 With users w ith host accounts only: Only visitors to your 
Personal Meeting Room w ho have a host account on your 
WebEx service Web s ite can access this folder. 

Share as Enter the name for the folder that w ill appear on your Personal 
Meeting Room page. 

Read  Let visitors to your Personal Meeting Room view  the list of f iles in the 
folder and dow nload the f iles. 

Write Let visitors to your Personal Meeting Room upload f iles to the folder 
but does not allow  them to v iew  the f iles in it .  

Read & write Let users view  files in the folder, dow nload f iles from the folder, and 
upload f iles to the folder. 

Allow files to be 
overwritten 

Let users upload a f ile w ith the same name as an existing f ile in the 
folder and replace the existing f ile. If  this option is not selected, users 
cannot overw rite any f iles in the folder. 
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Use this option… To… 

Password protected Let only visitors to your Personal Meeting Room w ho know  the 
passw ord view  the list of f iles in the folder, dow nload f iles from the 
folder, or upload f iles to the folder, depending on the read/w rite 
settings for the folder. 

Password: The passw ord that visitors to your Personal Meeting 
Room must provide to access the folder. 

Confirm: If  you specif ied a passw ord, type it again to verify that you 
typed it correctly. 

Update Save any changes that you made to folder's properties, and then 
closes the Edit Folder Properties w indow . 

Cancel Close the Edit Folder Properties w indow , w ithout saving any of the 
changes that you made. 

  
 

Opening the My Recordings Page 
To upload or maintain recordings, you must do so from the My Recordings 
page on your WebEx service Web site. 

To open the My Recordings page: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Files > My Recordings. 

The My Recordings page appears, showing your recording files. 

For details about the My Recordings page, see About the My WebEx Files > 
My Recordings page (on page 399). 

 

Uploading a recording file 
If you recorded an event using the integrated or standalone WebEx Recorder, 
you can upload the recording file, with a .wrf extension, from your local 
computer to the My Recordings page. 

For instructions on editing a recording, see Editing information about a 
recording (on page 393). 
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Note: If you recorded an event using the WebEx Network-Based Recorder (NBR), the 
WebEx server automatically uploads the recording file, with an .arf extension, to the 
appropriate tab on the My Recordings page once you stop the Recorder. You do not 
need to upload it yourself. 

To upload a recording file: 

1 Go to the My Recordings page. For details, see Opening the My 
Recordings page (on page 392). 

2 Click Add Recording. 

3 On the Add Recording page, enter information and specify options. 

For details about what you can do with each option on the Add/Edit 
Recordings page, see About the My WebEx Files > My Recordings page 
(on page 399).  

4 Click Save . 
 

Editing information about a recording 
You can edit information about a recording at any time. 

To edit information about a recording: 

1 Go to the My Recordings page. For details, see Opening the My 
Recordings page (on page 392). 

2 Click the following icon for the recording that you want to edit.  
  

  

The Edit Recording page appears. 

3 Make your changes. 

For details about what you can do with each option on the Edit Recording 
page, see About the My WebEx Files > My Recordings page (on page 
399).  

4 Click Save . 
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Sending an email to share a recording 
You can send an email one or more people to share your recording with them.  

To send an email to share a recording with others: 

1 Go to the My Recordings page. For details, see Opening the My 
Recordings page (on page 392). 

2 Click the appropriate link for your recording type: 

 Meetings 

 Events 

 Sales Meetings 

 Training Sessions 

 Miscellaneous 

3 Open the Share My Recording window: 

 Click the following icon for the recording that you want to share with 
others. 

  

  

 Click the linked name of the recording you want to share. On the 
Recording Information page, click Send Email. 

  

  

The Share My Recording window appears. 
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4 Select recipients for your email: 

 Click Select Recipients to select contacts from your Contacts list 

 Type email addresses in the Send to list, separated by commas. 

5 (Optional) Type a message in the Your message  box. 

6 Click Send. 

Your email message will be sent to the selected recipients, and will include 
information about the recording and a link to play it.  

 

About the Add/Edit Recording page 

How to access this page 

If you are adding a recording... 

1 On your WebEx service Web site, click My WebEx > My Files > My 
Recordings. 

2 Click Add Recording. 

If you are editing information about a recording... 

1 On your WebEx service Web site, click My WebEx > My Files > My 
Recordings. 
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2 Click the More button in the row of the recording that you want to edit. 
  

  

3 Click Modify. 
  

 

 

What you can do here 

 Edit general information about a recording, including the topic and 
description. 

 Require a password to play or download the recording. 

Options on this page 

  

Use this option.... To.... 

Topic Specify the topic of the recording. 

Description Provide a description of this recording. 

Recording file Click Browse to select the recording f ile that res ides on your 
local computer. 

Duration Specify the duration of the recording. 

File size Displays the s ize of the recording f ile. (Available only w hen 
edit ing recording information.)  

Set password Set an optional passw ord that users must provide to view  the 
recording. 

Confirm password Confirm the passw ord that users must provide to view  the 
recording. 
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Playback control options 
  

Use this option.... To.... 

Panel Display Options Determines w hich panels are displayed in the recording w hen it 
is played back. You can select any of the follow ing panels to be 
included the recording playback: 

 Chat 

 Q & A  

 Video 

 Polling 

 Notes 

 File Transfer 

 Participants 

 Table of Contents 

Panel display options do not modify the panel display in the 
actual recording that is stored on the WebEx netw ork. 

Recording Playback 
Range 

Determines how  much of the recording is actually played back. 
You can select either of the follow ing: 

 Full playback: Plays back the full length of the recording. 
This option is selected by default.  

 Partial playback: Plays back only part of the recording 
based on your settings for the follow ing options: 

 Start: X min X sec of the recording: Specif ies the 
time to start playback; for example, you can use this 
option if  you w ould like to omit the "dead t ime" at the 
beginning of the recording, or if  you w ould like to show  
only a portion of the recording. 

 End: X min X sec of the recording: Specif ies the 
time to end playback; for example, you can use this 
option if  you w ould like to omit the "dead t ime" at the 
end of the recording. You can not specify an end t ime 
greater than the length of the actual recording. 

The partial playback range you specify does not modify the 
actual recording that is stored on the server. 

Include NBR player 
controls 

Inc ludes full Netw ork Recording Player controls, such as stop, 
pause, resume, fast forward, and rew ind. This option is selected 
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Use this option.... To.... 
by default. If  you w ould like to prevent view ers from skipping 
portions of the recording, you can turn off this option to omit 
Netw ork Recording Player controls from the playback. 

 

 

About the Recording Information page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Files > My 
Recordings > [recording type] > [topic of a recording]. 

What you can do here 

 View information about the recording. 

 Play back the recording. 

 Send an email to share the recording with others. 

 Download the recording. 

 Enable or disable the recording 

 Open the Edit Recording page on which you can edit information about a 
recording. 

Options on this page 

  

Option Description 

Topic The name of the recording. You can edit the topic at any time. 

Create time The time and date the recording w as created. 

Duration The length of the recording. 

Description A description of the recording. 

File size The f ile size of the recording. 

Create time The date and time at w hich the recording w as created. 
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Option Description 

Status The status of the recording. The possible options are Enable or 
Disable.  

Password Indicates w hether a user must prov ide a passw ord to view  the 
recording. 

Stream recording link 
Clicking the link lets you play the recording (available only for 
recording f iles w ith the .arf extension that w ere recorded by 
NBR). 

Download recording link Clicking the link lets you dow nload the recording. 

 

Clicking the button lets you play the recording (available only for 
recording f iles w ith the .arf extension that w ere recorded by 
NBR). 

If  you w ant to dow nload the recording, you can also click the 
link for dow nloading under Play Recorded an event Now . 

 

Clicking the button opens the Share My Recording w indow , 
which allow s you to send an email message to selected 
recipients, invit ing them to play your recording. 

If  you w ant to send the email w ith your local email client 
instead, click the link for using the email client under Share My 
Recording. 

 Clicking the button opens the Edit Recording page. 

 Clicking the button deletes the recording. 

 
Clicking the button disables the recording everyw here it is 
published on your WebEx Service Web site. (Available only for 
enabled recordings.)  

 
Clicking the button enables the recording everyw here it is 
published on your WebEx Service Web site. (Available only for 
disabled recordings.) 

 Clicking the button returns you to the recording list.  
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About the My WebEx Files > My Recordings page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the 
left navigation bar, click My Files > My Recordings. 

What you can do here 

Manage, upload, and maintain your recording files. 

Options on this page 

View different categories of recordings: 

 Meetings 

 Events 

 Sales Meetings 

 Training Sessions 

 Miscellaneous 
 

About the My WebEx Files > My Recordings > Events page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the 
left navigation bar, click My Files > My Recordings > Events. 

 

What you can do here 

Manage, upload, and maintain recording files of events you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 
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Option Description 

Search Allow s you type text to search for w ithin recording names. Clic k 
Search to start the search. 

Capacity: n MB The percentage of available personal storage space on your 
WebEx Service Web site that is being used by your recordings. 

Used: n MB 
The percentage of total available storage space on your WebEx 
Service Web site that is being used by all recordings on your 
site. 

Topic 

The name of the recording. If  you record an event on the server, 
the WebEx server automatically uploads the recording to this 
page. In this case, the topic of the recording is the topic of the 
event. You can edit the topic at any time. 

Panelist Information about the panelists in the event w here the recording 
was made. 

Type 

The publication status of the event recording: 

 Listed: The recording is published—that is, the recording 
appears on the Event Recordings page, w hich is accessible 
to all visitors to your Event Center Web site. 

 Unlisted: The recording is not published—that is, the 
recording appears only on the My Event Recordings page. 
You must log in to your Event Center Web site to view  and 
maintain the recordings. 

Size The size of the recording. 

Create Time/Date The date and time the recording w as created. 

Duration The length of the recording. 

Format 

The format of the recording f ile. 

A recording f ile can be in WebEx Advanced Recording Format 
(ARF) or WebEx Recording Format (WRF). You can also store 
recording f iles that are in Window s Media Audio/Video (WMV) 
or Shockw ave Flash Object (SWF) format. 

 

Lets you play the recording (available only for recording f iles 
w ith an .arf extension that w ere recorded by the Netw ork-Based 
Recorder). 

If  playback of the f ile requires a passw ord, you must provide the 
passw ord. 

 Lets you send an email to share this recording w ith others. 

 
Displays a menu w ith more options for your recording: 
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Option Description 
 

 Download: Lets you dow nload the recording to your local 
computer. 

If  dow nloading the f ile requires a passw ord, you must 
provide the passw ord. 

 Modify: Lets you edit information of the recording. For 
details, see About the Add/Edit Event Recording page (on 
page 339). 

  Send to vendor: Lets you send an email to share this 
recording w ith a vendor. 

 Delete: Lets you delete the recording from this page. 

 

Lets you upload a new  recording. 

For details, see Uploading a recording file (on page 333) and 
About the Add/Edit Event Recording page (on page 339). 

 Indicates that a recording is passw ord-protected. 

 Indicates that registration is required to view  the recording. 

 

About the My WebEx Files > My Recordings > Miscellaneous 
page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the 
left navigation bar, click My Files > My Recordings > Miscellaneous. 

 

What you can do here 

Manage, upload, and maintain recording files of events you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 
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Option Description 

Search Allow s you type text to search for w ithin recording names. Clic k 
Search to start the search. 

 Indicates a disabled recording. 

Topic 

The name of the recording. If  you record an event on the server, 
the WebEx server automatically uploads the recording to this 
page. In this case, the topic of the recording is the topic of the 
event. You can edit the topic at any time. 

Size The size of the recording. 

Create Time/Date The date and time the recording w as created. 

Duration The length of the recording. 

Format 

The format of the recording f ile. 

A recording f ile can be in WebEx Advanced Recording Format 
(ARF) or WebEx Recording Format (WRF). You can also store 
recording f iles that are in Window s Media Audio/Video (WMV) 
or Shockw ave Flash Object (SWF) format. 

 

Lets you play the recording (available only for recording f iles 
w ith an .arf extension that w ere recorded by the Netw ork-Based 
Recorder). 

If  playback of the f ile requires a passw ord, you must provide the 
passw ord. 

 Lets you send an email to share this recording w ith others. 

 

Displays a menu w ith more options for your recording: 

  Download: Lets you dow nload the recording to your 
local computer. 

If  dow nloading the f ile requires a passw ord, you must 
provide the passw ord. 

  Modify: Lets you edit information of the recording. For 
details, see About the Add/Edit Recordings page (on page 
395). 

  Disable: Lets you disable the recording in all locations. 

  Delete: Lets you delete the recording from this page. 

 Indicates that a recording is passw ord-protected. 
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Maintaining contact information 
  

If you want to… See… 

get an overview  of your personal address 
book 

About maintaining contact information (on 
page 404)  

open your personal address book Opening your address book (on page 404) 

add a new  contact to your personal address 
book 

Adding a contact to your address book (on 
page 405)  

add mult iple contacts to your address book at 
once 

Importing contact information in a file to your 
address book (on page 408)  

add contacts in Microsoft Outlook to your 
personal address book 

Importing contact information from Outlook to 
your address book (on page 411)  

view  or change information about contacts in 
your personal address book 

Viewing and editing contact information in 
your address book (on page 412)  

f ind a contact in your personal address book Finding a contact in your personal address 
book (on page 413)  

combine multiple contacts into a single 
distribution list 

Creating a distribution list in your address 
book (on page 413)  

edit information about a distribution list Editing a distribution list in your address book 
(on page 415)  

delete a contact or distribution list Deleting contact information in your address 
book (on page 417)  

 

About maintaining contact information 
You can maintain a personal online address book, in which you can add 
information about contacts and create distribution lists. When scheduling a 
meeting or starting an instant meeting, you can quickly invite any contacts or 
distribution lists in your personal address book. You can also invite contacts in 
the Company Address Book for your WebEx service Web site, if one is 
available.  

You can add contacts to your personal address book in any of the following 
ways: 



 Chapter 28: Using My WebEx 

 

405 

 

 Specify information about contacts one at a time. 

 Import contact information from your Microsoft Outlook contacts. 

 Import contact information from a comma-separated/comma-delimited 
values (CSV) file. 

You can also edit or delete the information about any contact or distribution 
list in your personal address book. 

 

Opening your address book 
You can open your personal address book on your WebEx service Web site, 
to view or maintain information about your contacts. 

To open your address book: 

1 Log in to your WebEx service Web site. For details, see Logging in to and 
out of the WebEx service site (on page 364). 

2 On the navigation bar at the top of the page, click My WebEx. 

3 Click My Contacts. 

The My WebEx Contacts page appears. 
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4 In the View drop-down list, select one of the following contact lists: 

 Personal Contacts: Includes any individual contacts or distribution 
lists that you added to your personal address book. If you have a 
Microsoft Outlook address book or contacts folder, you can import its 
contacts to this list of contacts. 

 Company Address Book: Your organization's address book, which 
includes any contacts that your site administrator has added to it. If 
your organization uses a Microsoft Exchange Global Address List, your 
site administrator can import its contacts to this address book. 

 

Adding a contact to your address book 
You can add contacts to your personal address book, one at a time. 

To add a contact to your personal address book: 

1 Open your personal address book. For details, see Opening your address 
book (on page 404). 

2 In the View drop-down list, select Personal Contacts. 

A list of contacts in your Personal Contacts list appears. 

3 Click Add Contact. 

The Add Contact page appears. 
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4 Provide information about the contact.  

5 Click Add. 

For descriptions of the information and options on the New Contact page, see 
About the New/Edit Contact page (on page 407). 
  

Note:  
 You cannot add contacts to your Company Address Book. 
 If you want to add multiple contacts, you can them all at once, instead of adding one 

contact at a time. For details, see Importing contact information in a file to your 
address book (on page 408). 
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About the New/Edit Contact page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add 
Contact or [check box for contact] > Edit. 

What you can do here 

Enter information about a new or existing contact for your personal address 
book. 

Options on this page 

  

Use this option… To… 

Full name Enter the contact's f irst and last name. 

Email address Enter the contact's email address. 

Language Set the language in w hich any email messages that you send to 
the contact us ing your WebEx  service site appear. 

Available only if  your WebEx service Web site can be displayed in 
tw o or more languages. 

Company Enter the company or organization for w hich the contact w orks. 

Job title Enter the contact's pos ition in a company or organization. 

URL  Enter the URL, or Web address, for the contact's company or 
organization. 

Phone number/Phone 
number for mobile 
device/Fax number 

Enter the contact's phone numbers. For each number, you can 
specify the follow ing: 

Country Code Specify the number that you must dial if  the contact resides in 
another country. To select a different country code, click the link to 
display the display the Country Code w indow . From the drop-
dow n list, select the country in w hich the contact resides. 

Area or city code Enter the area or city code for the contact's phone number. 

Number Enter the phone number. 

Extension Enter the extension for the phone number, if  any. 
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Use this option… To… 

Address 1 Enter the contact's street address. 

Address 2 Enter addit ional address information, if  necessary. 

State/Province Enter the contact's state or province. 

ZIP/Postal code Enter the contact's Z IP or postal code. 

Country Enter the country in w hich the contact resides. 

Username Enter the username w ith w hich the user logs in to your WebEx 
service Web site, if  the contact has a user account. 

Notes Enter any additional information about the contact.  

 

Importing contact information in a file to your address book 
You can add information about multiple contacts simultaneously to your 
personal address book, by importing a comma-separated values (CSV) file. A 
CSV file has the .csv  file extension; you can export information from many 
spreadsheet and email programs in CSV format. 

To create a CSV file: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, ensure that Personal Address Book is 
selected. 

3 Click Export. 

4 Save the .csv  file to your computer. 

5 Open the .csv  file that you saved in a spreadsheet program, such as 
Microsoft Excel. 

6 Optional. If contact information exists in the file, you can delete it.  

7 Specify information about the new contacts in the .csv  file. 
  

 Important: If you add a new contact, ensure that the UID field is blank. For 
information about the fields in the .csv file, see About the Contact Information CSV 
template (on page 409). 

 

8 Save the .csv  file. Ensure that you save it as a .csv  file. 
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To import a CSV file containing new contact information: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, ensure that Personal Contacts is selected. 

3 In the Import From drop-down list, select Comma Delimited Files. 

4 Click Import. 

5 Select the .csv  file in which you added new contact information. 

6 Click Open. 

7 Click Upload File . 

The View Personal Contacts page appears, allowing you to review the 
contact information you are importing. 

8 Click Submit. 

A confirmation message appears. 

9 Click Yes. 
  

Note: If an error exists in any new or updated contact information, a message appears, 
informing you that no contact information was imported. 

 
 

About the Contact Information CSV template 

How to access this template 

On your WebEx service Web site, click My WebEx > My Contacts > View > 
Personal Address Book > Export. 

What you can do here 

Specify information about multiple contacts, which you can then import to your 
personal address book. 
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Fields in this template 

  

Option Description 

UUID A number that your WebEx service site creates to identify the contact. If  
you add a new  contact to the CSV file, you must leave this f ield blank. 

Name Required. The contact's f irst and last name. 

Email  Required. The contact's email address. The email address must be in 
the follow ing format: 

name@company.com 

Company The company or organization for w hich the contact w orks. 

JobTitle The contact's posit ion in a company or organization. 

URL  The URL, or Web address, for the contact's company or organization. 

OffCntry The country code for the contact's off ice phone-that is, the number that 
you must dial if  the contact resides in another country. 

OffArea The area or city code for the contact's off ice phone number. 

OffLoc The contact's off ice phone number. 

OffExt  The extension for the contact's off ice phone number, if  any. 

CellCntry The country code for the contact's cellular or mobile phone-that is, the 
number that you must dial if  the contact resides in another country. 

CellArea The area or city code for the contact's cellular or mobile phone number. 

CellLoc The contact's cellular or mobile phone number. 

CellExt  The extension for the contact's cellular or mobile phone number, if  any. 

FaxCntry The country code for the contact's fax number-that is, the number that 
you must dial if  the contact resides in another country. 

FaxArea The area or city code for the contact's fax number. 

FaxLoc The contact's fax number. 

FaxExt  The extension for the contact's fax machine, if  any. 

Address 1 The contact's street address. 

Address 2 The additional address information, if  necessary. 

State/Province The contact's state or province. 
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Option Description 

ZIP/Postal The contact's Z IP or postal code. 

Country The country in w hich the contact resides. 

Username The user name w ith w hich the user logs in to your WebEx service Web 
site, if  the contact has a user account. 

Notes Any additional information about the contact.  

 

Importing contact information from Outlook to your address 
book 

If you use Microsoft Outlook, you can import the contacts that you maintain in 
your Microsoft Outlook address book or folder to your personal address book 
on your WebEx service Web site. 

To import contacts from Outlook to your personal address book: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, select Personal Contacts. 

3 In the Import from drop-down list, select Microsoft Outlook. 

4 Click Import. 

The Choose Profile dialog box appears. 

5 In the Profile Name  drop-down list, select the Outlook user profile that 
includes the contact information that you want to import. 

6 Click OK. 
  

Note:  
 When you import contacts in Outlook, your WebEx service Web site retrieves contact 

information from the Outlook address book or folder in which you have chosen to 
keep personal addresses. For information about keeping personal addresses in 
Outlook, refer to Microsoft Outlook Help. 

 If your personal address book already includes a contact who is also in your Outlook 
contacts list, the contact is not imported. However, if you change the contact's email 
address in your personal address book, importing the contact from Outlook creates a 
new contact in your personal address book. 

  
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Viewing and editing contact information in your address 
book 

In your personal address book, you can view and edit information about 
individual contacts in your Personal Contacts list. You can view, but not edit, 
information about contacts in your Company Address Book. 

To view or edit contact information: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, select one of the following: 

 Personal Contacts 

 Company Address Book 

A list of contacts appears. 

3 Locate the contact whose information you want to view or edit. For details 
about locating a contact, see Finding a contact in your personal address 
book (on page 413). 

4 Under Name , select the contact whose information you want to view or 
edit. 

5 Do one of the following: 

 If the contact is in your Personal Contacts list, click Edit. 

 If the contact is in your Company Address Book, click View Info. 

Information about the contact appears. 

6 Optional. If the contact is in your Personal Contacts list, edit the 
information that you want to change on the Edit Contact's Information 
page. 

For descriptions of the information and options of the Edit Contact's 
Information page, see About the New/Edit Contact page (on page 407). 

7 Click OK. 
 

Finding a contact in your personal address book 
You can quickly locate a contact in your personal address book, using one of 
several methods. 
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To search for a contact in your address book: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, select a contacts list. 

3 Do any of the following: 

 In the Index, click a letter of the alphabet to display a list of contacts 
whose names begin with that letter. For example, the name Susan 
Jones appears under S. 

 To search for a contact in the list you are currently viewing, type text 
that appears in either the contact's name or email address in the 
Search for box, and then click Search. 

 If the entire list of contacts does not fit on a single page, view another 
page by clicking the links for the page numbers. 

 Sort your personal contacts or company address book by name, email 
address, or phone number by clicking the column headings. 

 

Creating a distribution list in your address book 
You can create distribution lists for your personal address book. A distribution 
list includes two or more contacts for which you provide a common name and 
appears in your Personal Contacts list. For example, you can create a 
distribution list named Sales Department, which includes contacts who are 
members of your Sales Department. If you want to invite members of the 
department to an event, you can select the group rather than each member 
individually. 

To create a distribution list: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 Click Add Distribution List. 

The Add Distribution List page appears. 
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3 In the Name  box, type the name of the group. 

4 Optional. In the Description box, type descriptive information about the 
group. 

5 Under Members, locate the contacts that you want to add to the 
distribution list, by doing any of the following: 

 Search for a contact, by typing all or part of the contact's first or last 
name in the Search box. 

 Click the letter that corresponds to the first letter of the contact's first 
name. 

 Click All to list all contacts in your Personal Contacts list. 

6 Optional. To add a new contact to your Personal Contacts list, under 
Members, click Add Contact. 

7 In the box on the left, select the contacts that you want to add to the 
distribution list. 

8 Click Add to move contacts you selected to the box on the right. 

9 After you finish adding contacts to the distribution list, click Add to create 
the list. 
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In your Personal Contacts list, the Distribution List indicator appears to 
the left of the new distribution list: 

  

 
 

For descriptions of the information and options on the Add Distribution List 
page, see About the Add/Edit Distribution List page (on page 416). 

 

Editing a distribution list in your address book 
You can add or remove contacts from any distribution list that you have 
created for your personal address book. You can also change a group's name 
or descriptive information. 

To edit a distribution list: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 

2 In the View drop-down list, select Personal Contacts. 

A list of the contacts in your Personal Contacts list appears, including any 
distribution lists that you have created. The Distribution List indicator 
appears to the left of a distribution list: 

  

 
 

Under Name , select the name of the distribution list. The Edit Distribution 
List page appears. 
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3 Edit information about the distribution list.  

4 Click Update . 

For descriptions of the information and options on the Edit Distribution List 
page, see About the Add/Edit Distribution List (on page 416). 

 

About the Add/Edit Distribution List page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add 
Distribution List. Or, select distribution list in Personal Contacts list. 
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What you can do here 

Add contacts to your distribution list or remove contacts from your distribution 
list. 

Options on this page 

  

Use this option… To… 

Name Enter the name of the distribution list. For example, if  you w ant to 
add a distribution list that includes members of your company's 
sales department, you might name the list Sales Department. 

Description Optionally enter descriptive information about the distribution list, 
to help you identify it later. 

Search Find a contact, by typing all or part of the contact's f irst or last 
name. 

Index Find a contact, by clicking the letter that corresponds to the f irst 
letter of the contact's f irst name. To list contacts for w hich you 
identif ied w ith a number, click #.  To list all contacts in your 
Personal Contacts list, click All .  

Add> Add a one or more selected contacts to your distribution list.  

<Remove Remove one or more selected contacts from your distribution list.  

Add Contact Add a new  contact to your Personal Contacts list and add the 
contact to your distribution list.  

Add Add a new  distribution list to your Personal Contacts list.  

Update Update an existing distribution list that you have edited. 

 

Deleting contact information in your address book 
You can delete any contact or distribution lists that you have added to your 
personal address book. 

To delete a contact or contact group: 

1 Open your address book. For details, see Opening your address book (on 
page 404). 
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2 In the View drop-down list, select Personal Contacts. 

3 In the list that appears, select the check box for the contact or distribution 
list that you want to delete. 

4 Click Delete . 

A message appears, asking you to confirm the deletion. 

5 Click OK. 
 

Maintaining your user profile 
  

If you want to… See… 

get an overview  of maintaining your user 
profile 

About maintaining your user profile (on page 
418)  

edit your user profile Editing your user profile (on page 425) 

 

About maintaining your user profile 
Once you obtain a user account, you can edit your user profile at any time to 
do the following: 

 Maintain personal information, including your 

 Full name 

 Username (if your site administrator provides this option) 

 Password 

 Contact information (including your street address, email address, and 
phone numbers) 

 Tracking codes that your organization uses to keep records of your 
events (such as project, department, and division numbers)  

 Specify whether to display links to your company's partner sites in the My 
WebEx navigation bar, if your site administrator set up partner links 

 Manage any scheduling templates that you saved 

 Set options for your Personal Event Room options, including the images 
and welcome message that appear on the page 
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 Set default options for your online sessions, including 

 The default session type that you want to use, if your account includes 
multiple session types 

 Whether your scheduled events are automatically removed from your 
list of events once the event ends 

 Whether the Quick Start page appears in the content viewer once you 
start an event 

 The users who can schedule events on your behalf 

 Set Web site preferences, including: 

 The home page that appears when you access your WebEx service 
Web site 

 The time zone in which event times appear 

 The language in which your Web site displays text, if your site includes 
multiple languages 

 The locale (the format in which your Web site displays dates, times, 
currency values, and numbers) 

 

About the My WebEx Profile page 

How to access this template 

On your WebEx service Web site, click My WebEx > My Profile . 

What you can do here 

Manage the following: 

 Account information 

 Personal information 

 Partner integration options 

 Scheduling templates (does not apply to Support Center)  

 Personal Meeting Room information 

 Event options 

 Web page preferences, including your home page and language 

 Support Center CSR Dashboard options (Support Center only)  
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Personal Information options 

  

Use this option… To… 

Username Specify the username for your account. You can change this 
name only if  the administrator for your WebEx service Web site 
provides this option. 

Tip: If  you need to change your username, but cannot edit it on 
this page, ask your site administrator to change your username 
or create a new  account for you. 

Change Password  Old password: Type the old passw ord for your account. 

 New password: Specify the new  password for your 
account. A passw ord: 

 Must contain at least four characters 

 Can consist of a max imum of 32 characters 

 Can include any letters, numbers, or special 
characters, but not spaces  

 Is case sensit ive 

 Retype New password: Verify that you typed your 
passw ord correctly in the New password box. 

Call-in authentication If  enabled by your site administrator, allow s you to be 
authenticated and placed into the correct teleconference w ithout 
needing to enter a meeting number w henever you dial into any 
CLI (caller line identif ication) or ANI (automatic number 
identif ication) enabled teleconference. Selecting this option for a 
phone number in your user profile maps your email address to 
that phone number. Caller authentication is available only if  you 
have been inv ited to a CLI/ANI enabled teleconference by email 
during the meeting scheduling process. Caller authentication is 
not available if  you are dialing in to a CLI/ANI enabled 
teleconference. 

Call-back When selected for a phone number in your user profile, allow s 
you to receive a call from the teleconferencing service if  it is 
using an integrated call-back feature. If  your site inc ludes the 
international call-back option, part icipants in other countries 
receive a call back. For more information about this option, ask 
your site administrator. 

PIN If  enabled by your site administrator, allow s you specify a call-in 
authentication PIN to prevent “spoofers” from using your 
number to dial into a teleconference. If  your site administrator 
sets the authentication PIN as mandatory for all accounts using 
call-in authentication on your site, you must specify a PIN 
number or caller authentication w ill be disabled for your 
account. This option is available only if  you have selected the 
Call-in authentication option for at least one of the phone 
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Use this option… To… 
numbers in your profile. The PIN can also be used to provide a 
secondary level of authentication for calls w here the host is 
using the phone and may need to invite additional attendees. 

Other personal 
information options 

Enter any personal information that you w ant to maintain in your 
profile. 

Partner integration options 

Your site administrator can set up custom links to the Web sites of your 
company's partners, and then display the links on the My WebEx navigation 
bar. For example, if your company uses another company's Web site to 
provide a service, your site administrator can provide a link to that company's 
site in your My WebEx navigation bar. You can then show or hide that link. 
  

Use this option.... To.... 

Display partner links in 
My WebEx 

Show s or hides partner site links in the My WebEx navigation 
bar. 

 

Calendar Work Hours options 

Use these options to specify working hours to use with scheduling calendars. 
  

Use this option… To… 

Start time Select the start t ime for your daily w ork calendar. 

End time Select the end t ime for your daily w ork calendar. 

 

Scheduling template options  

Use these options to manage scheduling templates that you set up using the 
scheduling options on your site. 
  

Use this option… To… 

Get Info Show s the settings you set for the selected template. 
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Use this option… To… 

Edit Opens the scheduling options on your site for the selected 
template. 

Delete Removes the selected template from your profile. 

Select All Selects all the scheduling templates, allow ing you to delete 
them all at once. 

 

Personal Meeting Room options 

  

Use this option… To… 

Personal Meeting Room 
URL  

Go to your Personal Meeting Room page. You can click the 
URL from the My Profile page to preview  your current Personal 
Meeting Room page. 

Your Personal Meeting Room page show s online sessions that 
you scheduled and any in-progress sessions that you are 
currently hosting. 

Users to w hom you provide your personal URL can use this 
page to join any meeting that you are hosting. They can also 
dow nload f iles in any folders that you share. 

Welcome Message Enter the message that appears on your Personal Meeting 
Room page. A message can be a maximum of 128 characters, 
including spaces and punctuation. 

To spec ify a message, type it in the box, and then clic k Update. 

Upload Image Upload an image f ile from your computer or another computer 
on your netw ork to your Personal Meeting Room page. For 
example, you can upload a picture of yourself, your company's 
logo, or a picture of your company's product. Visitors to your 
page can see the image that you upload. 

The image can be an max imum of 160 pixels w ide. If  you 
upload a larger image, its w idth is automatically reduced to 160 
pixels. How ever, the image's aspect ratio is maintained. 

Browse: Lets you locate an image. 

Upload: Uploads the image that you selected. 

Current Image: Displays the image that currently appears on 
your Personal Meeting Room page. 

Delete: Removes the current image from your Personal 
Meeting Room page. This button is available only if  you have 
uploaded an image for the page. 

Customize branding of Upload a banner image to the non-scrolling header area for 
your Personal Meeting Room page. For example, you can 
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Use this option… To… 
header area upload your company's logo or an advertisement. Visitors to 

your page can see the image that you upload. Available only if  
your site administrator has turned on this option for your 
account. 

The image can be an max imum of 75 pixels high. If  you upload 
a larger image, its height is automatically reduced to 75 pixels. 
How ever, the image's aspect ratio is maintained. 

Browse: Lets you locate a banner image. 

Upload: Uploads the banner image that you selected. 

Current Image: Displays the banner image that currently 
appears on your Personal Meeting Room page. 

Delete: Removes the current banner image from your Personal 
Meeting Room page. This button is available only if  you have 
uploaded an image for the page. 

Productivity Tools Options 

  

Use this option.... To.... 

Automatically download 
Productivity Tools when 
logging in to the WebEx 
service site 

Specify that WebEx Productivity Tools should be dow nloaded 
automatically w hen you log in to the WebEx service site. If  this 
option is turned off, you can still dow nload Productivity Tools 
manually. 

 

Session Options 

  

Use this option… To… 

Default session type Specify the default session type that you host, if  your user 
account lets you host different types of online sessions. 

For more information about session types, ask the site 
administrator for your WebEx service. 

You can change this default sett ing w hen scheduling a meeting. 
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Use this option… To… 

Quick Start Specify w hether the Quick Start page appears in the content 
view er once you start a meeting. The Quick Start lets you start 
sharing activities quickly, as an alternative to starting them from 
a menu or toolbar. 

 Show Quick Start to host and presenter: The Quick Start 
appears in the content v iew er for the host and presenter. 

 Show Quick Start to attendees: The Quick Start appears 
in the content view er for attendees. Select this option only if  
you intend to let attendees share information during your 
meetings. 

You can change this default sett ing w hen scheduling a meeting. 

 

Web page preferences options 

  

Use this option… To… 

Home page Set the f irst page that appears w hen you access your WebEx service 
Web site. 

Time zone Set the time zone in w hich you reside. 

If  you select a time zone for w hich daylight saving t ime (DST) is in 
effect, your WebEx service Web site automatically adjusts its clock for 
daylight saving time 

Note: The selected time zone appears: 

 Only on your view of your WebEx service Web site, not 
other users' views 

 In all meeting invitations that you send using your WebEx 
service Web site 

Language Set the language in w hich your WebEx service Web s ite displays text.  

Note: The languages that appear in this list are limited to the languages 
that have been set up for your Web site. 

Locale Set the format in w hich your Web site displays dates, t imes, currency 
values, and numbers. 
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Editing your user profile 
Once you obtain a user account, you can edit your user profile at any time to 
change account login information, contact information, and other options 
available for your account. 

To edit your user profile: 

1 Log in to your WebEx service Web site. For details, see Logging in to and 
out of the WebEx service site (on page 364). 

2 On the navigation bar, click My WebEx. 

3 Click My Profile . 

4 Edit the information on the page. 

5 When you are finished editing your user profile, click Update . 

For descriptions of the information and options on the My Profile page, see 
About the My WebEx Profile page (on page 419). 

 

Managing scheduling templates 
  

If you want to… See… 

get an overview  of managing your scheduling 
templates  

About managing scheduling templates (on 
page 425)  

view , edit, or delete a scheduling template Managing scheduling templates (on page 
426)  

 

About managing scheduling templates 
Scheduling templates let you save the options you set for an event for later 
use. Once you save a scheduling template, you can use it to quickly schedule 
another event, instead of setting the same options again. If you saved a 
scheduling template using the Save As Template  option when scheduling an 
event, you can manage the template, as follows: 

 View the options you set in the template. 

 Edit the options you set in the template. 
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 Delete the template. 
 

Managing scheduling templates 
You can view, edit, or delete any scheduling templates that you saved. 

To manage scheduling templates: 

1 Log in to your WebEx service Web site. For details, see Logging in to and 
out of the WebEx service site (on page 364). 

2 On the navigation bar, click My WebEx. 

3 Click My Profile . 

The My Profile page appears. 

4 Under Scheduling Templates, select a template in the list. 
  
 

 

 
  

5 Click one of the following buttons to perform an action on the template: 

 Get Info: Shows the options you set in the template. 

 Edit: Opens the scheduling options on your site. 

 Delete: Removes the template from your profile. 
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Maintaining your Cisco Unified MeetingPlace 
Audio Conferencing accounts 

  

If you want to… See… 

get an overview  of maintaining Cisco Unif ied 
MeetingPlace audio conferencing account 
numbers  

About maintaining Cisco Unified 
MeetingPlace audio conferencing account 
numbers (on page 427)  

reset the passw ord for your Cisco Unif ied 
MeetingPlace audio conferencing account 

Resetting the password for your Cisco Unified 
MeetingPlace audio conferencing account 
number (on page 427) 

 

About maintaining Cisco Unified MeetingPlace audio 
conferencing account numbers 

If your site includes support for Cisco Unified MeetingPlace audio 
conferencing, you should already have a Cisco Unified MeetingPlace audio 
conferencing account assigned to you. With your account, you can use Cisco 
Unified MeetingPlace audio in your meetings and in MeetingPlace Personal 
Conference meetings. 

Your account number includes a toll number to call as well as a Cisco Unified 
MeetingPlace profile number. For additional security, you can specify or reset 
a profile PIN that can be used to authenticate your account. You can also 
synchronize your account settings for your WebEx and Cisco Unified 
MeetingPlace accounts. 

 

Resetting the profile PIN for your Cisco Unified MeetingPlace 
audio conferencing account number 

If your site includes support for Cisco Unified MeetingPlace audio 
conferencing, you should already have a Cisco Unified MeetingPlace audio 
conferencing account assigned to you. You can change the personal 
identification number (PIN) for your Cisco Unified MeetingPlace audio 
conferencing account. 
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To add or edit a Personal Conference number account: 

1 Log in to your WebEx service Web website, and then select My WebEx. 

2 Select Personal Conferencing. 

The Personal Conferencing page appears. 
  

 

 

3 Under Change Profile PIN, in the New profile PIN and Confirm profile 
PIN boxes, type new a new personal password that contains only numbers 
and is between 5 and 24 digits in length. 

4 To synchronize your account settings for your WebEx and Cisco Unified 
MeetingPlace accounts, select Sync. 

 

About the Personal Conferencing page 

How to access this page 

On your WebEx service Web site, click My WebEx > Personal 
Conferencing. 

What you can do here 

 Add, edit, or delete a Personal Conference number account. 
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 View information about your existing Personal Conference number 
accounts. 

 If you are a MeetingPlace user, view information about your Cisco Unified 
MeetingPlace Audio Conferencing account and change your profile PIN. 

Options on this page for Personal Conference number accounts only 

  

Option Description 

Personal Conference 
number 

Show s the numbers for your Personal Conference number accounts.  

With a Personal Conference number ccount, you can use the same 
conference numbers for all your meetings, including Personal 
Conference meetings that you schedule on your WebEx service Web 
site or that you start instantly from a phone. 

A Personal Conference number account also lets you specify the 
access codes that you w ant to use to start the audio portion of the 
Personal Conference meeting, and the access codes that you w ant 
attendees to use to join the audio port ion. 

For details about the information in a Personal Conference number 
account, see About the Add/Edit Personal Conference Number page. 

Account [x] Allow s you to add a new  Personal Conference number accounts or 
view  and edit information about each of your Personal Conference 
number accounts.  

Add account: Opens the Create Personal Conference Number page, 
on w hich you can obtain a Personal Conference number (PCN) 
account. Appears only if  you have not yet added the maximum of 
three accounts. 

Default account: Indicates that the PCN account is the default 
account that is selected w hen you schedule a Personal Conference 
meeting. 

Set as default: If  you set up more than one PCN account, you can 
click this link to specify w hich account is your default account.  

Edit Opens the Edit Personal Conference Number page, on w hich you can 
change the access codes for your PCN account.  

For details about the information in a PCN account, see About the 
Create/Edit Personal Conference Number. 

Delete Deletes the Personal Conference number (PCN) account from your 
user profile. 

Important: If  you delete a PCN account that you have already 
selected for a scheduled a meeting, you must edit the meeting to 
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Option Description 
select another PCN account or voice-conferencing option. 

Options on this page for MeetingPlace users only 

  

Option Description 

Toll Number Show s the toll telephone number for your Cisco Unif ied MeetingPlace 
audio conferencing account. 

Cisco Unified 
MeetingPlace profile 
number 

Show s your Cisco Unif ied MeetingPlace audio conferencing account 
profile number. 

New profile PIN Allow s you to reset your Cisco Unif ied MeetingPlace audio conferencing 
account profile personal identif ication number (PIN) in order to provide an 
addit ional level of security to your audio account. 

 

Generating Reports 
  

If you want to… See… 

get an overview  of w hat reports you can 
generate from your WebEx  service Web site 

About generating reports (on page 430)  

generate usage reports that provide 
information about each session that you have 
hosted on your site 

Generating reports (on page 432)  

 

About generating reports 
If your user account includes the reports option, you can view the following 
reports: 
  

 Note:   
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  For some reports, if you click on the report link within 15 minutes after the 
event ends, you will see a preliminary version of that report. The preliminary 
report provides quick access to data before the final, more accurate data is 
available. The preliminary report contains only a subset of the information that 
is available in the final report. 

 When the final, more accurate data is available, which is usually 24 hours after 
the event ends, the preliminary report is replaced by the final report. 

 You can download both preliminary reports and final reports as comma-
separated values (CSV) files. 

 

General Event Usage reports 

These reports contains information about each online session that you host. 
You can view the following reports: 

 Summary Usage report: Contains summary information about each 
event including topic, date, start and end time, duration, number of 
attendees you invited, number of invited attendees who attended, and type 
of voice conference you used.  

  

 Note: Initially, this report appears as a Preliminary Usage Summary Report, but 
after the final, more accurate usage data is available, it is replaced by the Final 
Usage Summary Report. 

 

 Summary Usage report CSV (comma-separated values) file: Contains 
additional details about each event, including the minutes that all 
participants were connected to the event and tracking codes. 

 Session Detail report: Contains detailed information about each 
participant in an event, including the time the participant joined and left the 
event, the attentiveness during the event, and any information that the 
attendee provided.  

  

 Note: Initially, this report appears as a Preliminary Session Detail Report, but after 
the final, more accurate session detail data is available, it is replaced by the Final 
Session Detail Report. 

 

Access Anywhere usage report 

This report shows information about the computers that you access remotely, 
including the date and start and end times for each session. 

 

Event Center reports 

These reports contain detailed information about the events that you host. 
You can view the following types of Event Center reports: 
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 Registration Report: Contains registration information for an event that 
you hosted, including the name, date, and time of the event, and the 
numbers of participants who were invited, who registered, who attended, 
or who were absent. It also allows you to send reminder emails before the 
event. 

 Attendance Report: Contains detailed information about attendees and 
absentees for an event that you hosted. The report includes the event ID, 
key, name, start and end time, duration, number of attendees, the host 
name, and the minutes that all attendees spent in the event. The report 
also includes each attendee’s username, email address, IP address, the 
time the attendee joined, and the time the attendee left the event, and the 
attendee attentiveness during the event, . You can also use the 
attendance report to send follow-up emails after the event.  

  
 

 Note: Initially, this report appears as a Preliminary Attendance Report, but after the 
final, more accurate attendance data is available, it is replaced by the Final 
Attendance Report. 

 

  

 In-Event Activity Report: Contains the event name, date, and time, 
information about the number of attendees, the number of questions 
asked and the response rate for the questions, and the number of polls 
and the response rate for the polls. 

  
 

 Note: This report is available only for events recorded on the server.  
  

 Attendee History Report: Contains a list of all events that an attendee 
has joined on your Event Center Web site. 

 Event Recording Report: Contains access and registration information 
about people who have downloaded a recording for a specific event from 
your Event Center Web site. 

 

 

Generating reports 
You can generate usage reports that provide information about each online 
event that you have hosted on your site. 
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You can export or download the data to a comma-separated values (CSV) file 
which you can then open in a spreadsheet program such as Microsoft Excel. 
You can also print reports in a printer-friendly format. 

To generate a report: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Reports. 

The My Reports page appears. 

3 Choose the type of report you want to generate. 

4 Specify your search criteria, such as a date range for which you want to 
view report data. 

5 Click Display Report. 

6 To change the order in which report data is sorted, click the column 
headings. 

The report data is sorted by the column that has an arrow next to the 
column heading. To reverse the sort order, click the column heading. To 
sort using another column, click that column's heading. 

7 Do one of the following, as appropriate: 

 If you are viewing a general event usage report and want to display the 
report in a format that is suitable for printing, click Printer-Friendly 
Format. 

 If you are viewing the usage report for an event and want to view the 
content in the report, click the link for the event name. 

 If you are viewing an WebEx Service Registration Report, you can click 
the number in the Registered column to send an email reminder to the 
registered attendees for that event. An email editor opens and allows 
you to edit the default email template. 

 If you are viewing an WebEx Service Registration Report or an Event 
Center Attendance Report, you can click the event name in the Event 
Name column to view a detailed report of the registered users for that 
event, which provides additional options for sending email reminders to 
registered attendees. 

 If you are viewing an WebEx Service Attendance Report, you can click 
the number in the Attended column to send an email message to the 
attendees for that event, or you can also click the number in the 
Absent column to send an email message to the absentees for that 
event. An email editor opens and allows you to edit the default email 
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template; for example, you could add a link to the edited event 
recording. 

 If you are viewing an Event Center Attendance Report, you can click 
the event name in the Event Name column to view a detailed report of 
the attendees for that event, which provides additional options for 
sending email messages to attendees for the event. 

8 To export the report data in comma-separated values (CSV) format, click 
Export Report or Export. 

9 If available, click links on the report to display more details. 
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C h a pt er  2 9 

 

If you want to... See... 

get an overview  of view ing a recorded event About viewing a recorded event  (on page 
435)  

view  a recorded event Viewing a recorded event  (on page 435) 

 

About viewing a recorded event 
If an event host publishes a recorded event on your Event Center Web site, 
you can view the recording. A host may require that you do one or both of the 
following to view a recorded event: 

 Register to view a recorded event. In this case, you must provide your 
name, email address, and any other information that the host requires. 

 Provide a password. In this case, you must obtain the password from the 
host. 

To view a recorded event, you must use WebEx Player. Your Event Center 
Web site automatically downloads WebEx Player to your computer the first 
time you view a recorded event. 

If you have a user account, you can also download WebEx Player from the 
Support page on your Event Center Web site. 

 

Viewing Recorded Events 
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Viewing a recorded event 
You can stream or download a recording file, depending on which option the 
host specifies. 

When you play a recording for the first time, your WebEx site automatically 
downloads WebEx Player to your computer. 

To play or download a recorded event: 

1 If the host requires that you have a user account to view a recording, sign 
in to your WebEx site. 

2 On the left navigation bar, select Attend an Event > Event Recordings. 

3 Do one of the following, as appropriate: 

 Click for the recording you want to play. 

 Click for the recording you want to download. 

4 If playing or downloading the recording requires a password, type the 
password that the host gave to you in the Password box. 

5 Select Playback or Download, as appropriate. 

6 If viewing the recording requires registration, provide the required 
information on the form that appears, and then select Submit. 

 



 

439 

 

. 

.atp files • 322, 325 
attendees to event in progress • 175, 177 
by email • 174 
by instant messaging (IM) • 177, 182 
by phone • 175 
by WebEx AIM Pro • 175, 181 
Cisco Unified MeetingPlace 

audio conferencing accounts • 429  

MeetingPlace Personal Conference • 82, 83, 
84, 86, 87, 430 

contact group • 417 
creating for attendees • 178 
creating message for • 178 
event templates • 54 

creating greeting for • 178 

email messages, overview  • 31 

overview  • 174 

to enrollees • 113 

to host • 62 
events • 77, 78 
files, overview • 383 
from My WebEx • 77, 78 
host role • 188 
in address book • 417 
in personal folders, overview • 383 
information about • 394 
information about files • 387 
information about in personal folders • 387 
information about recorded events • 336 
obtaining during event • 170 
on Event Information page • 124 
options for panels • 150 
overview • 78, 273 
panelists to join event in progress • 182 

reclaiming • 188 
recorded events, overview • 331 
scheduling events • 54 
specifying during scheduling • 68 
using to reclaim host role • 188 
viewing information about • 112 

.txt files • 323 
for chat messages • 305 

.ucf files 
opening • 261 
saving documents • 260 
saving presentations • 260 
saving whiteboards • 260 

A 
Access Anywhere 

using • 381 
Access Anywhere Usage report 

description • 432 
access to events • 189 

by phone • 175 
restricting • 189 
setting options • 150 

accessing • 7 
account, user 

obtaining • 363 
adding 

contacts to address book • 407 
new personal folders for file storage • 385 
pages to shared documents • 252 
post-event surveys • 69 
slides to shared presentations • 252 

adding existing contacts • 26 
accessing, viewing • 73 

adding new contacts • 24 
adding to event descriptions • 64 
adding to invitation list • 24 
address book 

adding contacts • 407 
creating contact group • 415 
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using, overview • 406 
viewing or editing contact information • 414 
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annotating, shared software 
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using annotation tools • 283 
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overview • 240 
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starting • 281 
stopping • 281 

annotation tools 
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Line tool, overview • 240 
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Rectangle tool, overvie • 240 
Text tool, overview • 240 
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overview • 281 
stopping • 281, 286 
taking screen capture • 287 
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overview • 266 
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application, shared 
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closing and reopening attendee window • 279 
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customizing for future events • 38 
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software • 283 
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overview • 240 
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adding to invitation list • 26 
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feedback 
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overview • 383 
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font 
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Highlighter tool 

overview • 240 
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whiteboards • 252 
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setting up • 2 
system requirements • 2 
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system requirements • 2 
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creating for attendees • 178 
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automatically • 217 
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muting 
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file for • 306, 325 
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poll questionnaire file • 325 
poll questionnaires • 318 
saved chat files • 306 
saved document • 261 
saved presentation • 261 
saved whiteboard • 261 
shared documents • 243 
shared presentations • 243 
shared whiteboard • 246 
user profile • 427 
your list • 393 

options 
for integrated VoIP conference • 234 

overview • 121, 124, 130, 297, 437 
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adding new • 252 
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clearing pointers • 258 
controlling full-screen view • 254 
displaying • 247 
moving to previous • 263 
navigating • 247 
pasting images • 252 
printing • 262 
synchronizing display for all atten • 256 
synchronizing view • 264 
viewing miniatures (thumbnails) • 255 

zooming in • 253 
zooming out • 253 

pages, of shared documents, moving to next • 
263 
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required information • 122 
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panelists to join event in progress • 180 
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returning to default settings • 149 
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setting options • 150 
passing to panelist • 188 
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canceling • 87 
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setting up • 82 
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overview • 378 
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presentation • 252 
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49 
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Pointer tool 
overview • 240 
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creating • 310 
deleting • 315 
opening • 318 
saving • 322 
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changing type of, editing, rearrangi • 315 
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saving • 323 
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specifying options for, including • 317 
specifying options for, overview • 317 
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preferences 
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See also presentations, shared; • 247 
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adding blank slides • 252 
annotating • 257 
clearing pointers • 258 
closing in content viewer • 253 
controlling full-screen view • 254 
displaying slides • 247 
navigating slides • 247 
pasting images • 252 
printing slides • 262 
saving to file • 260 
synchronizing display for all attendees • 256 
using animations • 249 
using slide transitions • 249 
viewing thumbnails of slides • 255 

zooming in • 253 
zooming out • 253 

presenter 
designating in event • 185 

printing 
chat messages • 304 
pages in shared documents • 262 
shared whiteboards • 262 
slides in shared presentations • 262 

privileges 
granting to attendees during event • 162 
granting to panelists during event • 164 
overview • 161 

privileges (attendees) • 163 
annotating documents • 163 
chatting with all attendees • 163 
chatting with host only • 163 
chatting with panelists • 163 
chatting with presenter only • 163 
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• 163 
printing documents • 163 
saving documents • 163 
viewing any document • 163 
viewing any page • 163 
viewing attendee list • 163 
viewing number of attendees • 163 
viewing thumbnails • 163 

privileges (panelists) • 165 
annotating documents • 165 
chatting with all attendees • 165 
chatting with host only • 165 
chatting with panelists • 165 
chatting with presenter only • 165 
printing documents • 165 
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sharing documents • 165 
viewing any document • 165 
viewing any page • 165 
viewing thumbnails • 165 

privileges in events • 187 
profile, user 

editing • 427 
program URLs • 132 

for registering in events • 132 
programs • 91 

deleting • 98 
editing • 98 
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for specific projects • 91 
obtaining information about • 98 
overview • 132 
registering for events from URL • 132 
registering for multiple events • 132 
registering from Event Center Web site • 133 
viewing • 98 

publishing 
recorded event URLs • 333 
recorded events • 333 
recorded events, overview • 331 

R 
recorded event URLs 

publishing • 333 
recorded events • 438 

deleting published • 335 
editing information about • 336 
opening your list • 332 
publishing • 333 
publishing, overview • 331 
uploading • 333 
viewing • 438 

Recorded Events page • 130 
options • 336 

recording 
events • 163, 165 

Recording Information page 
options • 343 

recordings 
uploading • 393 

Rectangle tool 
overview • 240 

reducing view 
of shared pages or slides • 253 
of shared whiteboards • 253 

registering 
for multiple events • 132 
from event URL • 131 

registering for events • 133 
registrants • 72 

allowing to invite friends to event • 72 
registration form • 13 

customizing • 13 
question types • 13 

saving • 13 
registration ID • 11 

requiring • 11 
registration options • 12 
registration requests 

overview • 111 
rejected registration requests • 112 

viewing • 112 
rejoining 

teleconference • 214 
reminders • 62 
reminding • 181 

panelists to join event in progress • 181 
remote computer sharing 

overview • 4 
remote computer, shared 

as attendee, switching between views • 280 
closing and reopening attendee window • 279 
controlling full-screen view • 278 
resizing view • 278 
zooming in or out • 278 

removing 
attendees from event • 189 
from event • 189 
panelists from event • 189 
participants from • 189 
participants from event • 189 
recorded event from Event Recordings page • 

335 
replacing current content • 298 
replacing in event descriptions • 64 
reports 

generating • 434 
generating, overview • 432 
types of • 432 

requesting • 11 
requesting attendees • 68 

verifying rich media players • 68 
resetting 

panels • 149 
restricting 

access to event • 189 
results, for poll 

saving • 323 
resuming 

software sharing • 274 
reviewing • 112 

details about registrants • 112 
information about registrants • 112 
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S 
saving 

annotations on shared software • 287 
chat messages • 305 
copy of chat messages • 306 
documents, shared • 260 
poll questionnaires • 322 
poll results • 323 
presentations, shared • 260 
shared documents • 260 
shared presentations • 260 
shared whiteboards • 260 
whiteboards, shared • 260 

scheduling events • 8 
creating event templates • 54 
include iCalendar attachments in email 

messages • 34 
make unlisted • 8 
providing security • 8 
requiring password • 8 
requiring registration IDs • 8 
restricting access • 8 
using event template • 54 

scheduling templates 
about managing • 427 

scoring • 20 
surveys, registration forms • 20 

screen capture 
taking of annotations on shared software • 

287 
searching 

for contacts in address book • 414 
for events • 134 
for files in personal folders • 388 

selecting 
panelists for event • 186 
presenter in event • 185 

sending 
chat messages • 301 
email reminders for events • 113 

Session Detail report 
description • 432 

setting for events • 58 
setting maximum for event • 72 
setting options • 150 

for panels • 150 
setting up 

approval rules • 12 

for Access Anywhere • 381 
for events • 46, 47 
for remote access • 381 
for Windows • 2 
Integrated VoIP conferences • 47 
Meeting Manager • 2 
Personal Conference meetings • 82 
teleconferences • 46 

sharing 
Flash files, as Web content • 294 
poll results with participants • 321 
streaming audio, as Web content • 294 
streaming video, as Web content • 294 
Web browsers • 294 
Web content, overview • 293 

sharing a Web browser. See Web browser 
sharing. • 271 

sharing applications. See application sharing. • 
266 

sharing window 
as attendee, returning to • 280 
closing your attendee window • 279 
overview • 265 

showing number of responses 
in poll results • 317 

slide titles 
viewing while sharing • 247 

slides, in shared presentations 
adding • 252 
clearing annotations • 257 
clearing pointers • 258 
controlling full-screen view • 254 
displaying • 247 
moving to next • 263 
moving to previous • 263 
navigating • 247 
pasting images • 252 
printing • 262 
synchronizing display for atte • 256 
synchronizing view • 264 
viewing miniatures (thumbnails • 255 
viewing title • 247 
zooming in • 253 
zooming out • 253 

software sharing 
See also software, shared • 265 
tips for improving performance • 289 

software, shared 
annotating • 281 
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controlling attendees' views • 273 
controlling full-screen view • 274, 278 
ensuring good imaging of color • 287 
improving performance • 289 
letting attendees annotate • 284 
pausing and resuming • 274 
resizing view • 278 
synchronizing views • 275 
using annotation tools • 283 
viewing • 265 

sound alerts 
assigning to incoming chat messages • 303 

sounds 
assigning to incoming chat messages • 303 

speaker queue, for integrated VoIP conference • 
234 

speaker, in teleconference 
determining • 220 

specifying • 52 
specifying for post-registration • 22 
specifying in enrollment form • 17 
specifying options 

for poll results • 317 
for poll results, overview • 317 

specifying URLs • 150 
specifying who can view • 68 
Standard View tool 

overview • 239 
starting 

annotation mode for shared software • 281 
application sharing • 267 
desktop sharing • 270 
document sharing • 243 
presentation sharing • 243 
Web browser sharing • 272 
whiteboard sharing • 246 

stopping 
annotation mode • 281 
annotation mode for shared software • 281 
annotations on shared software • 286 
application sharing • 269, 279 
attendees from annotating • 286 
attendees from making • 286 
desktop sharing • 271, 279 
from making annotations on shared software 

• 286 
remote application sharing • 279 
remote desktop sharing • 279 

Web browser sharing • 272, 279 
whiteboard sharing • 247 

streaming audio 
sharing as Web content • 294 

streaming video 
sharing as Web content • 294 

Summary Usage report 
description • 432 

Summary Usage report CSV file 
description • 432 

surveys, creating • 69 
post-event • 69 

switching, as attendee 
between sharing window and main window • 

280 
Synchronize Displays for All tool 

overview • 239 
synchronizing 

attendees' content viewers • 256 
view of pages • 264 
view of slides • 264 
view of whiteboard • 264 
views of shared software • 275 

system requirements 
Meeting Manager • 2 

T 
teleconference 

asking to speak • 219 
determining who is speaking • 220 
displaying instructions for • 214 
joining • 214 
leaving • 214 
muting and unmuting a specific microphone • 

217 
muting and unmuting all • 218 
muting and unmuting participants 

automatically • 217 
muting and unmuting your microphone • 219 
rejoining • 214 
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